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Preface

This guide describes how to use Cisco Tidal Enterprise Scheduler (TES) 6.2.

Audience
This guide is for engineers who use TES for workload automation tasks, and who troubleshoot TES 
issues.

Related Documentation
See the Cisco Tidal Enterprise Scheduler 6.2 Documentation Overview for a list of all TES guides.

Note We sometimes update the documentation after original publication. Therefore, you should also review 
the documentation on Cisco.com for any updates.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see What’s New in Cisco Product Documentation at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html.

Subscribe to What’s New in Cisco Product Documentation, which lists all new and revised Cisco 
technical documentation, as an RSS feed and deliver content directly to your desktop using a reader 
application. The RSS feeds are a free service.
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C H A P T E R 1

Introduction

Tidal Enterprise Scheduler Design Concepts

Overview
Welcome to Cisco Tidal Enterprise Scheduler (TES), the premiere enterprise job scheduling solution. 
TES automates repetitive computer-related tasks and can be easily tailored to your specific business 
needs. If your business requires small or large amounts of batch processing on a regular basis, TES is 
the software for the job.

TES Scheduling Layer
TES exists as a scheduling layer above your jobs to control when, where, and how they are run. It is 
expandable to many users and can run many jobs throughout your network, all from a centralized master 
production schedule.

TES makes it easy to run your jobs on a repeating schedule. Daily, weekly, monthly, or even yearly 
schedules can be created easily, and can be tested in advance before jobs are run on them. Jobs can even 
depend on the status of other jobs and files, to make sure that all your resources are in place before 
running the jobs.

Network Support
TES has all the tools for controlling and organizing jobs on your network. It includes a fully 
configurable queue feature to distribute, prioritize, and queue up jobs so that your network load is 
optimized at all times. It includes smart agent communication that runs jobs on behalf of the system, and 
reports back when the jobs finish. Agents are available on Windows, Unix, z/OS or MPE/iX platforms 
and dependencies can be set up between them. TES integrates your network to run like a giant 
processing machine, maximizing throughput.

Monitoring and Messaging Services
TES includes exception-based job monitoring and messaging services. It monitors the progress of each 
job that is submitted, and can provide user-defined messaging when jobs enter phases of the production 
schedule. For example, if your job stops for some reason, you can be automatically notified of the 
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problem, then diagnose it from a remote location, and start the job again. Messaging services include 
console alerts, email notifications, SNMP traps for network management systems, and telephone and 
pager notifications. Using TES tools, you can achieve previously unequaled levels of scheduling 
efficiency.

Additionally, TES includes a complete messaging and auditing system that fully tracks all actions taken 
by users, all error messages, and all system messages. Within TES, search tools and filters enable you 
to diagnose and cure problems quickly.

Security
TES supports a secured, configurable working model through security policies and per-agent passwords. 
You can subdivide scheduling tasks among various types of users based on their scheduling 
responsibilities. Agents can be restricted to specific users. Scheduling activity can be filtered for a 
production environment that is safe and customized to accommodate your expanding business.

Flexibility
TES supports the way people work on scheduling projects with its workgroups feature. Users can 
configure their own workgroup environment, enabling a group of users to have access to a set of jobs 
and other supporting data objects (i.e. calendars) owned by the group. Users can be insulated from the 
vast scheduling activity that is possible. All users can change and view only the information that is 
allowed by their security profile.

Fault Tolerance
Fault tolerance is an optional module for TES. Fault tolerance ensures that you have uninterrupted 
scheduling when a primary master scheduler goes down. It includes a fault monitoring system that will 
automatically and seamlessly transfer control to a backup master. If your scheduling activity is mission 
critical, you need fault tolerance.

Note To add fault tolerance to your TES network, you need to purchase a license agreement.

TES Components

Master (or Primary Master) 

The master is the computer that conducts all scheduling tasks. You can have one or more masters in your 
network. If you are using fault tolerance, the first master installed becomes the primary master and the 
second master installed is known as the backup master. Fault tolerance requires one backup master for 
each primary master.

The master can be installed on either the Windows platform or the Unix platform. The basic functionality 
of TES remains the same regardless of the platform of the master. The different hardware and software 
requirements for the master are listed in the Installation and Configuration Guide.

Each master computer must supply a unique port number to which Client Managers connect. This port 
number ensures that communication between the Client Manager and master is clear.
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Client Manager

Two main components of the TES architecture are the Master and Client Manager. Client Manager 
allows TES to achieve higher performance and scalability needs. The purpose of the Client Manager is 
to service requests from user initiated activities, such as through the Tidal Web Client, Tidal Transporter 
and from other external sources that utilize the Command Line Interface (CLI) or published TES Web 
services. Client Manager allows the Tes Master to focus more capacity on core scheduling needs related 
to job execution and job compilations, while the Client Manager addresses demands from activities such 
as users viewing/configuring scheduling data and output. A single Client Manager is mandatory and 
additional Client Managers can be deployed to address additional performance needs.

Agent 

An agent is a separate installation of TES that runs jobs on behalf of the master. Offloading jobs to 
agents frees the master for intensive scheduling tasks such as production compiles. Agents exist for 
various platforms. Check with your sales representative for the current list of the types of agents 
available.

Each agent can connect to a master by specifying the master-to-agent communication port and the 
master-to-agent file transfer port numbers.

Backup Master 

The backup master is used in a fault tolerance setup. It operates exactly like the primary master, but is 
activated only if the primary master experiences a system, network or machine failure. The backup 
master must run on the same platform and version of software used by the primary master. The hardware 
specifications of the backup machine should be equal or greater than the specifications for the primary 
machine.

The backup master must specify the backup-to-master port number for transferring scheduling data from 
the primary master to keep the masters synchronization.

Fault Monitor 

The fault monitor is part of the TES fault tolerance module. The fault monitor continually monitors a 
primary master and backup master for error conditions. If a failure indicator appears on the primary 
master, the fault monitor transfers control to the backup master. The fault monitor must be installed on 
a separate machine independent from the primary and backup machines

Network Configuration
TES can be configured on a network in many different ways. You can connect any number of licensed 
masters using any number of licensed agents, each located anywhere on your network.

Fault Tolerance Configuration
Fault tolerance can be added to a TES network to provide an extra degree of scheduling reliability. In a 
fault tolerant environment, each primary master is connected to a dedicated backup master and a fault 
monitor machine.
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In this setup, the primary master periodically shares data with the backup master during normal 
operation. Only one master (normally the primary master) has control of scheduling at any time. If the 
primary master has a network, power, or software failure, control is transferred to the backup master.

System Requirements

Note Contact support or your account manager for the latest information on the system requirements for TES.

There are different requirements for the Windows and Unix platforms. Both platforms use the Client 
Manager. 

Your Cisco Tidal Enterprise Scheduler Installation Guide contains the minimum system requirements 
for installing and running TES. The specified quantities of CPU, memory and disk space must be 
available for exclusive use by Tes. Use additional RAM and disk space as necessary for your particular 
environment.
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Getting Started

Licensing 

Overview
Before you can run TES, you need to run through the licensing procedure. This applies whether you are 
just trying out the software, or have already decided to implement TES. TES provides different types of 
licenses to fit your needs.

Note Ensure that your database is licensed in line with your database vendors licensing terms and conditions.

Table 2-1 Software License Types

License Type Description

Demo License (unrestricted) If you want to demo the product, you can ask for a demo license 
from a sales representative. You will be given a license code to 
enter when you run the product for the first time. Full use of the 
software will be available for a limited amount of time.

Demo License (restricted) The restricted demo license allows full use of the product on a 
limited number of machines for a limited amount of time.

Production License If you decide to purchase TES, your sales representative can give 
you a production license. This license will be customized to match 
your planned installation. Apply your license file as soon as 
possible so that the software does not expire. You will receive a 
Master/Agent License Summary which you should keep for your 
records.

Floating License Usually a product license specifies that the software works on a 
particular machine, but a floating license is not tied to a specific 
machine. Instead the right to use the license “floats” among many 
users but only the approved number of users can use the license at 
once.
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Extensions and modules that add extra functionality to TES may require separate licenses. For example, 
SACmd (TES command line interface), the job monitoring tool and intermaster dependencies all require 
individual licenses. For more information and current availability, contact your sales representative.

You can license TES with a Demo license or a Full license. During installation, the installer will prompt 
you for a demo code, and if you give it a code, then it will create this file for you. When your Demo 
license expires, or if you did not enter it during installation, you can manually license TES.

Registered License Dialog
The Registered License dialog displays by selecting Activities>Registered License from the main menu 
of the Tidal Web client.

Master License Tab
This tab displays the following information about the master:

• Company Name – Your company name. No company name displays if you have a demo license. The 
company name displayed here is used in all Tes reports.

• Master License for machine – The licensed master machine name.

• Serial Number – The unique identification number of the master machine.

• Operating System – The operating system of the Tes master machine.

• Database – The type of database used. This field will show either Oracle or Microsoft SQL Server.

• Expiration – The license’s expiration date. You may need to renew your license before the 
expiration date.

• Options – Displays added purchased software options that complement Tes (e.g. fault tolerance).

• Connections – Contains the available connections associated with the license.

Licensed Agents Tab
The Licensed Agents tab displays information about the agents licensed to work with the master.

Annual Use Production License This has provisions similar to a Production License and is renewed 
on a yearly basis.

Emergency License If you already have a license, and you need to expand your 
scheduling capabilities for a short period of time for disaster 
recovery, you can request an Emergency License code. This code 
will give you unlimited use. You will be able to add as many agents 
as you need, or to transfer your master to another machine to help 
you through your situation.

Table 2-1 Software License Types

License Type Description
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Note If your license has a floating agent provision or if you are running an unrestricted demo, you can define 
your own agents. Consequently, the Licensed Agents tab will display no information.

This tab displays the following information about the agents:

• Agent – The machine name for the licensed agent.

• Serial – The serial number of the licensed agent.

• Floating – Specifies if the license is floating or not.

• Operating System – The operating system type of the licensed agent. Tes supports MPE/iX, MVS, 
z/OS, OS/400, Windows and Unix platforms.

• Expiration – The license’s expiration date. You may need to renew your license before the 
expiration date.

• Max Jobs – The maximum number of jobs that you can run on the agent concurrently. You can 
configure a lower value for the agent from the Connections pane, but this value cannot exceed your 
licensed value.

• Jobs – Displays the current count of jobs, tracking the number of jobs to enforce the license 
restriction on an agent as shown in the Max Jobs column.

• CPU – The number of CPUs on an agent machine. If the number of CPUs on a machine exceeds the 
authorized number, the master disables the agent connection and logs a licensing error. The licensing 
discrepancy must be resolved by contacting the Licensing Administrator for Tidal Software before 
the agent connection can be re-established.

Warning Restart the Client Manager after a new license has been loaded. 

Licensing Procedure
Registering the license for TES is done from the Tidal Web client.

To license with a Demo license:

Step 1 Stop the master. You must stop the master before you can load a license file. An error message will 
display if you attempt to load a license while the master is still running.

For Windows:

a. Click Start and select Programs>TIDAL Software>Scheduler>Master>Service Control Manager.

b. Verify that the master is displayed in the Service list and click the Stop button to stop the master.

For Unix:

• Enter tesm stop.

Step 2 Create a file called demo.lic.

Step 3 Type the demo code into the demo.lic file.

Step 4 Save and place the file in the C:\Program File\TIDAL\Scheduler\Master\config directory.

Step 5 Restart the master:

– For Windows, restart the master by clicking Start in the Service Control Manager.
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– For Unix, restart the master by entering tesm start.

The master will read and apply the demo code when it starts.

To license with a Full license:

Step 1 Stop the master:

For Windows:

a. Click Start and select Programs>TIDAL Software>Scheduler>Master>Service Control Manager.

b. Verify that the master is displayed in the Service list and click the Stop button to stop the master.

For Unix:

• Enter tesm stop.

Step 2 Rename your Full license file to master.lic.

Step 3 Place the file in the C:\Program File\TIDAL\Scheduler\Master\config directory.

Step 4 Restart the master:

– For Windows, restart the master by clicking Start in the Service Control Manager.

– For Unix, restart the master by entering tesm start.

The master will read and apply the demo code when it starts.

Tidal Web Client Features
The Tidal Web client has many built-in features designed for productivity and easy access to your 
production data.

Main Menu Bar 
The Main Menu bar is accessible from any pane. However, some menu options are not available from all 
panes. 

For more information about the main menus, see <Jumps>“Main Menus” on page 33.

Note Context menus, available when you right-click the Navigator pane or current pane, are context-sensitive. 
The menus change according to your current, active pane.

Navigator Pane 
The Navigator pane lists all the components of the Tidal Web client in a hierarchal format. Each TES 
function has a different pane.
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An arrow sign next to a folder indicates that there are folders hidden underneath. Click the plus sign to 
expand the listing. A solid arrow sign next to a folder indicates that the listing is expanded. Click the 
minus sign to collapse the listing.

This panel contains the following containers:

• Operations – A container for the Job Activity, Event Activity, Alerts, Logs, Schedules and Master 
Status panes. These panes are dynamic, displaying data that continually changes. TES updates the 
information in the pane to provide an accurate picture of the current state of your productions 
operations.

• Definitions – A container for the Jobs, Calendars, Actions, Events, Job Classes, Variables, Agent 
Lists, Queues, Resources and Fiscal Calendars panes. These panes list the definitions for various 
items that you create through TES.

In addition, Actions, Events and Agent Lists both have sub-panes that correspond to different types 
of actions, events and agent lists.

• Administration – A container for the Connections, Interactive Users, Runtime Users, LDAP 
Groups, Workgroups, Security Policies and Adapters panes. These panes concern the 
administration of your TES network and TES users.

Current Pane 
The console pane that is currently active is considered the current pane.

Main Menus

File Menu

The File main menu has the following options:

• Images Repository – Displays the Images Repository tab. This tab allows for the selection of 
an alternative icon for a job or group. This image is displayed on the Jobs pane or Business 
Views window.

• Print – Displays the Reports pane to view and print the TES report that corresponds to the current 
pane. 

Note The Print option on the File menu provides the same functionality as the Print button on the TES toolbar.

• Log Out – Logs you out of the Tidal Web client.

View Menu

The View main menu has the following options:

• Show Master Feedback – Displays or hides a confirmation dialog whenever a request is sent to the 
master.

• Auto Refresh – Automatically refreshes the Tidal Web client.

• Refresh – Updates all of the information in the TES database.
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• Preferences – Displays the Preferences dialog for the current pane. The Preferences dialog is used 
to configure a pane. For more information about a Preferences dialog, see the documentation for the 
pane you wish to configure.

Activities Menu

The Activities main menu has the following options:

• Create Schedule – Displays the Create Schedule dialog to manually recreate a schedule for selected 
days.

Note After selecting Create Schedule, a dialog denotes the success or failure of the compilation.

• Insert Job Into Schedule – Inserts an unscheduled job into the schedule. (This option is only 
applicable if the job or group’s definition has the Unscheduled Allowed option set.)

• Pause Scheduler – Pauses the TES until you select the Resume Scheduler option. This is especially 
helpful when making changes or at other times when you need a temporary interruption of service.

• Resume Scheduler – Resumes TES after pausing TES.

• Pause Job Launching – Pauses job launching until you select the Resume Job Launching option. 
Jobs can be defined and scheduled but they cannot run until job launching resumes.

• Resume Job Launching – Resumes job launching after it is paused.

• Start Today’s Schedule – If the master was configured to wait until the previous schedule completes 
before starting a new schedule (on the Master tab of the System Configuration dialog), selecting 
this menu option overrides that setting and starts the new schedule whether the previous production 
schedule completed or not.

• Shutdown Scheduler – Stops the master service. Your master will be down until you restart the 
master service from either the Tidal Service Manager for a Windows master or from the command 
line for a Unix master. This option is only available to authorized users. For more information about 
the Tidal Service Manager, see <Jumps>“Tidal Service Manager” on page 44.

• System Configuration – Displays the System Configuration dialog. You can change system-wide 
parameters such as defaults, mail, logging options and master properties from this dialog.

• Register License – Displays the License Registration dialog.

• End Impersonation – Ends the impersonation of another user.

Reports Menu

See <Jumps>“Reports Pane” on page 361 for more information about the Reports main menu Job Last 
Status, Schedule Summary, Dependency Cross Reference and Event History selections.

Help Menu

The Help main menu has the following options:

• Help Topics – Displays the online help file for TES.

• About – Displays copyright information about the TES version. 
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Search Field
Enter text that you want to search for within the columns displayed.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See Searchable Columns below.

Searchable Columns

The following table contains all columns that are searchable.

Table 2-2 Searchable Columns

Pane Column Name

Job Activity Name

Event Activity Name, Agent, Owner

Alerts Job Name, Alert Message, Response

Logs Log ID, Time, Type, Message, Source, Message 
ID, Computer

Jobs Name

Calendars Name, Type, Owner

Actions Name, Owner, Description

Events Name, Owner

Job Classes Name, Description

Variables Name, Owner

Agent Lists Name, Description (on search on Agent List, not 
Agents

Queues Name

Resources Name, Owner, Description

Fiscal Calendar Name

Connections Name, Machine, Time Zone, Version

Interactive Users Full Name, Name, Domain

Runtime Users Full Name, Name, Domain

LDAP Groups Full Name, Name, Domain

Workgroups Name, Owner

Security Policy Name, Description

Adapters Name, Version, GUID
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Create Schedule Dialog
The Create Schedule dialog displays by selecting Activities>Create Schedule from the main menu bar. 
You can also right-click in the Schedules pane and select the Create Schedule option (and other options) 
from the context menu to recompile a schedule but the options in the context menu do not provide as 
much control when creating a schedule. It is recommended to use the Create Schedule dialog when 
creating a schedule.

Use the Create Schedule dialog to recreate the production schedule invoking the compilation process for 
the dates specified. Only jobs whose calendars include the date(s) specified are included in the schedule.

Caution All unscheduled jobs that were added manually will be lost if you recreate the schedule. Also, if you are 
creating today’s schedule, all jobs whose dependencies have already been satisfied will run as soon as 
resources are available.

This dialog contains the following elements:

• From – First date to include in the schedule.

• To – Last date to include in the schedule.

• Forecast Only – If selected, the master will recompile your schedule for the specified date. By 
default, the forecast date is tomorrow. A forecast is a schedule created as a model of what a potential 
production schedule may be. The forecast schedule is never used, as the master recompiles the 
production schedule at the beginning of the production day. 

A forecast schedule is not automatically updated when jobs are modified. If a job within the forecast 
schedule is modified, the job’s runs within the forecast are deleted rather than modified. The 
information contained within the forecast schedule is only relevant for the moment that it was 
created. You must recompile a new forecast schedule to account for modifications to any job 
parameters since the original forecast was created. The production schedule is recompiled at the 
beginning of each production day for this reason. 

• For today’s repeating jobs with no time window, start repeating ASAP – Normally repeating jobs 
with no time window begin at midnight. If you create the schedule after midnight, a portion or all 
of the repeating jobs may be excluded from the schedule unless you select the For today’s 
repeating Jobs with no time window, start repeating ASAP option. By choosing this option, all 
repeating occurrences are added. If you select this option, all repeating instances are added to the 
schedule and begin repeating as soon as possible.

For example: If a job repeats every five minutes, for a total of five times, and no time window is 
specified for the job, the job will normally run immediately after the automatic compilation at 
midnight. The result would run separate job occurrences at 12:00 AM, 12:05, 12:10, 12:15 and 
12:20. If you manually create the schedule after 12:20 without this setting checked, none of the 
occurrences will be added to the schedule. 

By selecting the For today’s repeating Jobs with no time window, start repeating ASAP option, all 
five occurrences will run after the schedule is re-created. For example, if you create the schedule at 
4:00 PM, separate occurrences run at 4:00 PM, 4:05, 4:10, 4:15 and 4:20.
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Job Activity Pane 
The Job Activity pane is the key to monitoring and controlling job operations. Within the bounds of your 
security policy, you can view either the jobs and job groups that are owned by you and owned by any 
workgroups to which you belong or all the jobs and job groups on the master. For detailed information 
about the Job Activity pane, see <Jumps>“Job Activity Pane Interface” on page 111.

To display the Job Activity pane, select Operations>Job Activity from the Navigator pane.

Context Menu

Right-clicking in the Job Activity pane displays a context menu providing easy access to job control 
functions. 

Display Customization

The Job Activity pane display can be customized to suit your monitoring needs. You can: 

• Sort jobs alphabetically by any column or intelligently by a status order you specify.

• Filter jobs by job status, job name, agent assignment or owner. This can be used to view only the job 
occurrences that are important to you.

• Modify column widths to accommodate long or short text.

• Modify pane sizes. You can adjust any pane to accommodate the desired information.

Job Control

From the Job Activity pane, you can perform job control functions (rerun a job, check dependencies, 
hold a job, etc.). For example, if a job requires Operator release (such as when the job must ensure that 
an external resource is free before the job starts), you (as the Operator) can manually release the job from 
the Job Activity pane using the Release control command.

Connections Pane 
After installing masters, agents and Tidal Web clients on various machines, you must still configure the 
connections properly. You configure your TES network connections through the Connections pane. You 
can also update each machine’s name, activate or deactivate agents for scheduling, change the 
communication port numbers and adjust the number of jobs that can run concurrently from an agent.

The agent architecture was overhauled to promote faster processing of jobs with a new agent. With the 
original agent, the master consistently queried the agent for its status. To reduce the workload on the 
master, the time-consuming task of communicating the status of the agent is now shifted to the agent. 
The new agent now sends status reports to the master without prompting, allowing the master to 
concentrate on other tasks and reducing network traffic. Thus new agents do not need an 
Agent-to-Master file transfer port when defining an agent connection.

Unlike other agents, the new agent has very simple configuration options. Besides the port number and 
the job limit there is not much to configure with the new agent. 
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Connections Interface
From the Navigator pane, select Administration>Connections to display the Connections pane.

The Connections pane contains the following buttons:

• Add Connection – Displays a list of connection options. Selecting which type of connection to 
define opens the appropriate Connection Definition dialog for that connection.

• Edit Connection – Displays the Connection Definition dialog to edit an existing connection.

Note You must select a connection for the Edit and Delete connection buttons to activate in the 
Connections pane. If no connection is selected, these buttons are grayed out.

• Delete Connection – Removes the selected connection definition from the TES database.

• Refresh – Updates the data in the current pane.

• Print – Displays the Reports pane to view and print the connection definitions. For more 
information, see <Jumps>“Monitoring Production” on page 361.

The Connections pane contains the following columns:

• Status Light – The status light indicates the status of the connection. 

– A green light indicates that the connection is healthy (but does not indicate whether a fault 
tolerance failover occurred).

– A yellow light in front of the backup master is normal when in fault tolerant mode and indicates 
that the backup master is in standby mode. A yellow status light also temporarily displays when 
a master first starts up but changes to green as the master comes online. 

– A red light indicates that the connection has failed.

– A gray light indicates that a connection is disabled.

• Name – The name of the agent or master connection.

• Machine – The name of the computer where the component resides.

• Type – Indicates the type of connection, whether an agent, adapter, master, backup master, remote 
master or fault monitor.

• Platform – The operating system or type of adapter of the connection.

• Enabled – Indicates if the connection is enabled.

• Modified – Indicates the last time the connection definition was modified.

• Load – Indicates the percentage of the agent machine's CPU capacity currently being used.

• Time Difference 

– If Type = Master, the number of minutes of difference between the master and the Client 
Manager. 

– If Type = Agent, the number of minutes of difference between the master and the agent from the 
point of view of the master.

– If Type = Remote Master, the number of minutes of difference between the local master and the 
remote master. 

• Floating – Indicates if the component has a floating or non-floating license.

• Active – Only applies to agents; indicates if the agent is active or not.
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• Limit – Indicates the number of jobs the component is licensed to run simultaneously.

• Version – Indicates the version number of the listed component.

• Out Until – If the connection is offline on a scheduled basis, this column displays the time when the 
outage pane will end. This column is blank if no scheduled outage is occurring.

• Time Available – If the connection is scheduled to be offline, this column displays the number of 
minutes remaining before the outage pane begins. This column is blank if there is no scheduled 
outage.

Search Field

Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See Searchable Columns, page 2-35.

Connections Preferences Dialog

From the main menu, select View>Preferences while viewing the Connections pane to display the 
Connections Preferences dialog.

From the Connections Preferences dialog, you can select which columns display in the Connections 
pane and arrange the order they appear.

• A checkmark to the left of a column title indicates that the column will be displayed in the pane. No 
checkmark indicates that column will not be displayed.

• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.

Navigator Context Menu

When you right-click in the Navigator pane while viewing the Connections pane, the Navigator context 
menu displays.

The Connections Navigator context menu contains the following options:

• Add Connection – Displays a list of the different connection types that can be defined. Has the same 
function as the Add Connection button. Selecting an option from the list displays the appropriate 
Connection Definition dialog for that connection.

• Preference – Displays the Preferences dialog for the Connections pane.

• Print – Displays the Reports pane to view and print your connection definitions. Has the same 
function as the Print button on the toolbar. For more information, see <Jumps>“Monitoring 
Production” on page 361.

• Export – Saves the data in the current pane as an HTML file.

• Refresh – Updates the data in the current pane.

• New Root Folder – Allows you to create a new root folder for the Navigator pane.
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Connections Pane Context Menu

When you right-click in the Connections pane, the Connections pane context menu displays.

Note A connection must be selected in order for the Edit and Delete options to be available in the context 
menu.

The Connections pane context menu contains the following options:

• Add Connection – Displays a list of the types of connections that can be defined. Selecting a 
connection type displays the Connection Definition dialog for that type of connection. 

• Edit Connection – Displays the Connection Definition dialog to edit a selected connection.

• Delete Connection – Deletes the selected connection’s definition.

• Refresh – Refreshes the Connections pane.

• Print – Prints a report of existing connections.

• Print Selected – Prints a report of selected connections.

• Disable – Temporarily inactivates the connection.

• Enable – Activates the connection from a disabled state (available only after having selected the 
Disable option, below). You can also enable a connection through the Enabled option in its 
definition dialog.

• Reconnect – Re-establishes a connection that failed. Reconnect is also available for an enabled 
connection that is not fully established.

• Test – Checks to see if the selected connection is working properly. 

Note This option does not apply to all connection types.

Connection Definition Dialog
The Connection Definition dialog displays by adding or editing a licensed component to your TES 
network. The type of connection being defined displays at the top of the Connection dialog.

Common To All Tabs

• Name – The name that will be used to refer to the connection throughout TES panes and dialogs. 

• Enabled Flag – Allows you to enable (activate) and disable (deactivate) agents. Jobs cannot run on 
agents that have been deactivated. If they try to run on agents that have been deactivated, they enter 
into the Agent Disabled status. Jobs already running on agents that are disabled will run to 
completion; however, their completion status will not be returned until the agent is re-enabled.

General Tab

The General tab contains the following elements:

• Job Limit – Displays the maximum number of jobs that TES can run on the agent. 
2-40
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 2      Getting Started
  Connections Pane
Windows agents have a concurrent job execution limitation based on the amount of memory the 
agent has. It is recommended that you do not set the agent job limit to a value higher than this 
limitation. In most instances, it is recommended to limit agents to running no more than 80 
concurrent jobs. In general, agents should have 5 MB of memory for each concurrent job. Some jobs 
may require additional memory to process depending upon the needs of the job.

• Default Runtime User – Specify a default runtime user for the agent being installed.

Connection Tab

On this tab, the machine name and port number are specified for the connection. The actual name of the 
fields varies according to the type of connection being defined. 

Depending on the connection type, this tab contains the following elements:

• Machine Name – The host name of the computer. This name is case-sensitive and can be found in 
the DNS section of the TCP/IP protocol of your network configuration. Consult with your System 
or Network Administrator for help with DNS and TCP/IP. 

• Master-to-Agent Port – The Master-to-Agent Port field displays when defining an agent 
connection. The port used to communicate with the cqd process of an agent machine. The default is 
5912. This number is specified during installation.

• Backup-to-Master Port – The Backup-To-Master Port field displays when defining a backup 
master connection. This port is used to communicate between the backup master and primary master 
for fault tolerance purposes. The default is 6704. This number is specified during fault tolerance 
installation.

• Fault Monitor Master Port – The Fault Monitor Master Port field displays when defining a fault 
monitor connection. This port is used to communicate between the fault monitor computer and the 
primary master and backup master for fault tolerance purposes. The default is 6703. This number is 
specified during fault tolerance installation. 

• Agent-to-Master Port – The port used when defining a master connection. The default is 5591. This 
number is specified during installation.

Note Do not use port values that are in use by other software programs. Connection performance 
will be unpredictable.

• Host Environment Log (This option only appears for a master connection if you are using an adapter 
offered by Tidal Software.) – Sets the detail level for the logging in the adapter host environment. 
Like the logging levels set on the Logging tab of the System Configuration dialog, there are seven 
progressively more detailed levels of detail available that range from None to High Debug. The 
Severe level is the default option. When the log reaches 1 MB in size, it is archived and a new log 
file is started. The log file is named AdapterHost with a date and time stamp and a .log extension. 
After 25 log files are created, the oldest log file is deleted to make room for a new log file. These 
AdapterHost files are stored in the same directory as the master's log files at Program 
Files\Tidal\Scheduler\master\log.

There is also a Service log file named Service.log for each corresponding adapter. This log is located 
inside of the corresponding adapter GUID. For example, the SAP Service Log location would be:

C:\Program 
Files\TIDAL\Scheduler\Master\services\{51C57049-3215-44b7-ABE1-C012FF786010}\log.
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Note Changing the level of the Host Environment Log will directly effect the debug level of every 
adapter.

• Remote Primary Master Machine Name – The Remote Primary Master Machine Name field 
displays when defining a remote master connection. Type the machine name of the remote master 
that is managing the intermaster dependency. 

If you are defining a remote connection, then your Connection tab is slightly different. There are 
two machine name fields and a Communication Port field. 

• Remote Backup Master Machine Name – The Remote Backup Master Machine Name field 
displays when defining a remote backup master connection. Type the name for the backup master if 
the remote master managing the intermaster dependency is in fault tolerance mode. If the remote 
master is not fault tolerant, leave this field blank.

• Communication Port – The Communication Port field displays when defining a remote master 
connection. This port is used to communicate between the local master and the remote master (and 
its backup machine if fault tolerance is being used). The default is 6215. This communication port 
should be the same number that Client Manager(s) of the remote master use.

Outages Tab

This tab only appears in the Connections Definition dialog when defining an agent or adapter connection 
and allows you to add, edit, and delete an agent or adapter outage.

This tab lists the time windows when the agent/adapter will not be available. The actual parameters of 
the outage are defined from the Outage Definition dialog. Tes will use the information entered here to 
manage jobs that may not complete before an outage window begins. From a system configuration 
viewpoint, use the Defaults tab to configure how Tes handles jobs at risk of failing due to a planned 
outage.

Resources Tab

This tab only appears in the Connections Definition dialog when defining an agent connection and 
displays all the system resources and current values collected for the connection.

Options Tab

This tab only appears in the Connections Definition dialog when defining an agent connection and 
allows you to add, edit, or delete name/value connection parameters.

Variables Tab

This tab only appears in the Connections Definition dialog when defining a remote master.

This tab lists the various names and types of variables published by the specified remote master. The 
actual value of a variables is only determined when needed as the job processes. The list of variables 
published by the remote master is regularly updated and cached by the subscribing master with the 
intermaster dependency.
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Connections and Agents Procedures

Changing the name of the computer displayed in TES 

To change the name of the computer:

Step 1 From the Connections pane, double-click the licensed computer to edit or select the computer and click 
the Edit button. The licensed computer’s Connection Definition displays.

Step 2 In the Name field, change the computer’s name. This name is used when referring to the computer on 
TES panes and dialogs.

Step 3 Click OK.

Changing the Machine Hostname of the Computer

To change the hostname of the computer:

Step 1 From the Connections pane, double-click the licensed computer to edit, or select the computer and click 
the Edit button to display the licensed computer’s Connection Definition dialog.

Step 2 Click the Connection tab.

Step 3 In the Machine Name field, update the computer’s name.

This name can be found in the DNS section of the TCP/IP protocol of your network configuration. 
See your System Administrator for more information.

Changing Connection Port Numbers 

You can update communication port numbers for licensed connections if they conflict with other 
programs that use the same numbers.

To change the connection port numbers:

Step 1 From the Connections pane, double-click the desired connection or select the connection and click the 
Edit button to display the licensed computer’s Connection Definition dialog.

Step 2 Click the Connection tab.

Step 3 Different fields are displayed, according to the type of connection selected:

– Master – The Agent-to-Master Port field is used when defining a master connection. The 
default is 5591. This number is specified during installation. Update this port if it conflicts with 
other programs.

– Agent – The Master-to-Agent Port field is used when defining an agent connection. Update this 
port number if it conflicts with other programs. The default is 5912. 

– Backup Master – The Backup-To-Master Port field is used when defining a backup master 
connection. Update this port if it conflicts with other programs. The default is 6704. 
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– Fault Monitor – The Fault Monitor Master Port field is used when defining a fault monitor 
connection. Update this port if it conflicts with other programs. The default is 6703. 

The Fault Monitor Client Port field is a JMS port used by the Client Manager to 
communicate with the Fault Monitor. The default is 6705.

– Remote Master – The Communication Port field on this tab is used for communicating between 
the local master and the remote master. There is always one remote master that will use this port 
but this port is also available to the remote backup master if the remote master is in fault tolerant 
mode. The default port for this connection is 6215, so change the value if there is a conflict. This 
same JMS Port is also used for the Client Manager to Master communication. 

Deleting an Agent Connection 

To delete an agent connection:

Step 1 From the Connections pane, select the agent to delete.

Step 2 Click the Delete button on the TES toolbar.

Starting and Stopping TES Components
To operate TES, ensure that the master, Client Manager and agent are running on their respective 
machines. Once installed, the master, its database, the Client Manager and agents should remain running. 
If any of these components stop, you can restart them on the Windows platform by using the Tidal 
Service Manager. If you are running fault tolerance, you also need to start the backup master and fault 
monitor.

The Unix platform does not use the Tidal Service Manager. Controlling the Unix master and its 
components is done from the command line of the specific machine. The commands for starting, 
stopping and checking the status of the Unix master, Client Manager and agent are noted.

Tidal Service Manager
The Tidal Service Manager is a central point of control for stopping and starting TES services on the 
Windows platform. Any Enterprise component on the Windows platform running as a service can be 
manipulated from the service manager. Through the Tidal Service Manager, you can also configure 
various aspects of how the component service runs.

Displaying the Tidal Service Manager

Click the Windows Start button, and select Programs>Tidal Software>Tidal Service Manager.

This dialog contains the following elements:

• Service – Choose the TES service you wish to start or stop.

• Start – Click to start a service.

• Stop – Click to stop a service.
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The selected service’s status displays at the bottom of the Tidal Service Manager.

Service Configuration Dialog
Clicking the Browse button while in the initial dialog of the Tidal Service Manager opens a Service 
Configuration dialog where settings for the master or other services can be adjusted.

Service Tab

The Service tab contains the following elements:

• Name – The name of the Windows system service.

• Display Name – The label for the service displayed in the main dialog of the Tidal Service Manager.

• Path – The full path to the binary file associated with the service.

• Parameters – The parameters, if any, applied to executing the binary.

• Startup – Configures how the service starts. There are three options:

– Automatic – The service starts upon every reboot.

– Manual – The service is only started when you manually start it, for example, through the Tidal 
Service Manager.

– Disabled – The service will not start as long as the Disabled option is selected.

Logon Tab

The Logon tab contains the following elements:

• System Account (LocalSystem) – The service runs under the standard system account for services.

– Allow Service to interact with Desktop – The service runs with the local desktop.

• Other Account – When the Other Account option is selected, you must type the name of the account 
under which you want the service to run. 

– Password – Type the password for the account specified in the Other Account field.

– Confirm Password – Retype the password.

Dependencies Tab

The Dependencies tab is only available when the service is stopped. You create services dependencies 
on this tab. Select a service listed in the Available Services column and click the arrow button to move 
it to the Depends On column.
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Master

Controlling the Master

Normally, after installation and after a reboot, the TES master is automatically started. On Unix, the 
master is NOT automatically started. You can check the status, start, and stop the master service 
manually from the Tidal Service Manager for a Windows master or from the command line for a Unix 
master.

Note If you are using an Oracle or MSSQL Server, ensure that your database is running prior to starting the 
master service.

Checking the Status of the Master

To check the status of the master:

Unix

The Unix master does not use the Tidal Service Manager so the command line is used to check the status 
of the master. From the command line of the master machine type:

tesm status

Windows

Step 1 On the machine with the master installation, click the Windows Start button and then select 
Programs>Tidal Software>Tidal Service Manager to display the Tidal Service Manager.

Step 2 Verify that the Scheduler Master displays in the Service field.

The master status displays at the bottom of the Tidal Service Manager. 

Starting the Master

To start the master:

Unix

The Unix master does not use the Tidal Service Manager so the command line is used to start the master. 
From the command line of the master machine type:

tesm start

Windows

Step 1 On the machine with the master installation, click the Windows Start button and then select 
Programs>Tidal Software>Tidal Service Manager to display the Tidal Service Manager.

Step 2 Verify that the Scheduler Master displays in the Service field.
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Step 3 Click Start. 

Stopping the Master

To stop the master:

Unix

The Unix master does not use the Tidal Service Manager so the command line is used to stop the master. 
From the command line of the master machine type:

tesm stop

Windows

Step 1 On the machine with the master installation, click the Windows Start menu button, then select 
Programs>Tidal Software>Tidal Service Manager to display the Tidal Service Manager.

Step 2 Verify that the Scheduler Master displays in the Service field.

Step 3 Click Stop. 

Defining a Master Timezone

You can define timezones where target application environments are based. This allows you to schedule 
a job or job group across a different timezone. For example, if the Master associated with your job is 
based in the PST timezone and you want the job to run in an alternative timezone, you can select the 
defined timezone. The Master internal process will self-adjust the scheduled time or DST (Daylight 
Savings Times) period differences.

To configure the Master timezone for a job:

Step 1 From the Activity menu, select System Configuration to display the System Configuration dialog.

Step 2 Click the Timezone tab.

Step 3 Click Add or Edit to display the Timezone for Job Definition dialog.

Step 4 In the Name field, enter a unique name to represent job timezone.

Note If the Use Agent Time Zone is selected, the following step does not apply.

Step 5 From the Timezone list, select the timezone ID.

Note As of TES 6.0.3, this option has been relocated from the Master tab to the new Timezone tab.

The following fields pre-populate depending on the Timezone list selection:

– Timezone Full Name – Java build-in timezone long name.
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– Master Timezone Offset – The time differences between Master timezone and selected Java 
timezone.

– UTC/GMT Timezone Offset – The time differences between standard 
UTC/GMT and selected Java timezone.

– Current in DST Timezone Period – Checked if current in Daylight Saving Time (DST) period 
for this selected timezone. 

– DST Time Differences – The amount of time to be added to selected timezone if it is in DST 
period.

Step 6 Click OK.

See <Jumps>“Timezone Tab” on page 59 for further instruction.

Agents
You can start and stop agents in your network at any time.

Note Before starting or stopping the agent, check the agent’s status using the Tidal Service Manager.

Changing an Agent’s Job Limit

You can change an agent’s job limit to specify the number of jobs that can run on it concurrently. You 
can also control the number of jobs running concurrently using queues. Refer to Controlling Production, 
to learn more ways of controlling job execution.

To change an agents job limit:

Step 1 From the Navigator pane, select Administration>Connections to display the Connections pane with the 
licensed computers. 

Step 2 Double-click the agent to edit or select the agent and click the Edit button on the TES toolbar to display 
the agent’s connection definition. 

Step 3 Click the General tab if it is not showing. 

Step 4 In the Job Limit field on the General tab, change the job limit to the desired value. See your 
agent-related documentation on setting the job limit.

Step 5 Click OK.

Checking Agent Status

To check the agent status:

Step 1 On the agent machine, click the Windows Start button and then select Programs>Tidal Software>Tidal 
Service Manager to display the Tidal Service Manager.

Step 2 In the Service drop-down list, select the agent you wish to check so that it displays in the Service field.
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Step 3 At the bottom of the Tidal Service Manager, the status of the selected service displays. 

Enabling/Disabling an Agent

You can disable an agent if you do not want it to run jobs submitted by TES. If a job tries to run on a 
disabled agent, its status changes to Agent Disabled.

To enable or disable an agent:

Step 1 From the Navigator pane, select Administration>Connections to display the Connections pane. 

Step 2 Double-click the agent to edit or select the agent and click the Edit button on the TES toolbar to display 
the agent’s connection definition.

Step 3 Do one of the following:

– To enable the agent, select the Enabled option.

– To disable the agent, clear the Enabled option.

Step 4 Click OK.

Starting the Agent

To start the agent:

Step 1 Click the Windows Start button and then select Programs>Tidal Software>Tidal Service Manager.

Step 2 Select the correct agent if it is not displayed in the Service field and click the Start button. The light will 
turn green when the agent starts.

Note The Agent for Unix does not use the Tidal Service Manager so the command line is used to start, 
stop and check the status of the agent. Use the following commands:
To start: ./tagent <agent name> start
To stop: ./tagent <agent name> stop
To check status: ./tagent <agent name> status

Stopping the Agent

To stop the agent:

Step 1 Click the Windows Start button and then select Programs>Tidal Software>Tidal Service Manager.

Step 2 Select the correct agent if it is not displayed in the Service field and click the Stop button. The light will 
turn red when the agent stops.
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Client Manager

Controlling the Client Manager

You can check the status, start, and stop the client manager manually from the Tidal Service Manager or 
from the command line.

Checking the Status of Client Manager

To check the status of Client Manager:

Unix

The Unix Client Manager does not use the Tidal Service Manager so the command line is used to check 
the status of Client Manager. From the command line type:

cm status

Windows

Step 1 On the machine with the master installation, click the Windows Start button and then select 
Programs>Tidal Software>Tidal Service Manager to display the Tidal Service Manager.

Step 2 Verify that the Client Manager displays in the Service field.

The Client Manager status displays at the bottom of the Tidal Service Manager. 

Starting Client Manager

To start the Client Manager:

Unix

The Unix Client Manager does not use the Tidal Service Manager so the command line is used to start 
Client Manager. From the command line of the master machine type:

cm start

Windows

Step 1 On the machine with the Client Manager installation, click the Windows Start button and then select 
Programs>Tidal Software>Tidal Service Manager to display the Tidal Service Manager.

Step 2 Verify that Client Manager displays in the Service field.

Step 3 Click Start. 
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Stopping Client Manager

To stop Client Manager:

Unix

The Unix Client Manager does not use the Tidal Service Manager so the command line is used to stop 
the master. From the command line of the Client Manager machine type:

cm stop

Windows

Step 1 On the machine with the Client Manager installation, click the Windows Start menu button, then select 
Programs>Tidal Software>Tidal Service Manager to display the Tidal Service Manager.

Step 2 Verify that Client Manager displays in the Service field.

Step 3 Click Stop. 

System Configuration 

Overview
Before using TES on a regular basis, you should spend some time in the System Configuration dialog. 
By tailoring TES’s configuration to your needs, you will receive greater benefits from using the product. 

You can configure the following options:

• Job and job group definition default field values. This lets you specify many of the default field 
values, such as the default agent, job priority, and concurrency that is automatically entered each 
time you create a new job or job group.

• Timezones where target application environments are based. You can schedule a job or job group 
across a different timezone.

• Mail parameters for email messaging services. This lets you define your email service so that TES 
can use it.

• The audits, errors and diagnostic logging messages to include and/or exclude. As you become more 
familiar with TES, you might want to filter the messages that appear in the Logs pane, but initially 
we recommend keeping all default settings.

• How job occurrences are sorted when the status sort is selected. This feature helps you to sort job 
occurrences based on the status order you choose, helping you more clearly organize jobs in the Job 
Activity pane.

System Configuration Dialog
Select Activities>System Configuration from the menu bar of the Tidal Web client to display the System 
Configuration dialog.
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Master Tab

The Master tab configures actions managed by the master. This tab contains the following elements:

• Future Days to Include in Schedule – Controls the number of future days to include in the 
production schedule when the master does its daily compilation. Larger values let you schedule jobs 
farther into the future. Lower values reduce compilation time.

Note When you change the Future Days to Include in Schedule value, the new value will not take 
effect until the production schedule is compiled. Compilation will take place at midnight, by 
default.

• Operator Alert Retention (in days) – The number of days to keep operator alert information in the 
Job Activity pane.

Note By default, alerts are kept for seven days. Alerts that are older than the Operator Alert Retention 
value are purged daily.

• Trigger History Retention (in days) – Sets the default number of days to maintain event trigger 
history on the Trigger History tab of the Event Details dialogs. The maximum length of time to keep 
trigger history information is 9,999 days but this length of time requires very large amounts of 
hardware and resources and hampers performance. The default setting is for 30 days.

• Use Passwords to Run Windows Jobs – Enables (if checked) Windows agents to use Windows 
passwords. Windows agents can be configured to use a per-job password. Each scheduled job can 
be configured to run under a specific username and password (runtime users). The job inherits the 
permissions and resources of the assigned user account. This means that all runtime users require 
valid passwords. Any jobs that log on as users with invalid or missing passwords will fail with a 
status of Error Occurred.

TES stores the passwords in encrypted form within its own database. At no time is an unencrypted 
password echoed to the screen or made otherwise accessible to any user. Passwords are also 
encrypted when passed from a master to an agent.

Caution Checking the passwords of multiple users when running jobs restricts the Windows agent to only 
processing 30 jobs concurrently. If passwords are not used when running Windows jobs, the Windows 
agent can handle up to 80 concurrent jobs.

TES stores the passwords using 64-bit block cipher encryption within its own database. At no time 
is an unencrypted password echoed to the screen or made otherwise accessible to any user. 
Passwords are also encrypted when passed from a master to an agent. 

• Automatic Daily History Cleanup – When this option is selected, TES automatically purges the 
database everyday. By default, the purge is executed at the beginning of the new production day.

Note The master will log any errors when purge is performed automatically.

When this option is not selected, TES will not automatically purge your database of old information 
history. 
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• FTP Local User Mandatory – Requires that a local (or runtime) user be selected on the Run tab of 
FTP job definitions. Using a runtime user adds additional security to FTP jobs. The default is to not 
use a runtime user (unselected). If this option is selected, any previous FTP jobs that were defined 
without assigning a local user, will error out until a local user is assigned to the job.

• None (except Launched/Active Jobs) – Do not transfer any jobs from the current production 
schedule to the next production schedule unless the jobs have already launched or are in active 
status. (On an individual basis, jobs can be prevented from carrying forward by selecting the Disable 
carryover option from the Options tab of the Job Definition dialog.)

• Successors only (unless disabled for job) – Transfers to the following production schedule any 
successor jobs from active jobs in the current production schedule unless the Disable carryover 
option was selected in a job’s definition.

• All Unfinished Jobs (unless disabled for job) – Transfers any jobs that did not run in the current 
production schedule to the following production schedule unless the Disable carryover option was 
selected in a job’s definition.

• Wait until previous schedule completes before starting new schedule – This option prevents any 
jobs from a new production schedule regardless of their priority from running until all of the jobs 
from the previous schedule are completed or canceled. If the production day rollover is held up while 
waiting for the previous day’s jobs to complete, a warning is recorded in the Audit log. To rollover 
to a new production schedule after selecting this option, you must either cancel the previous day’s 
jobs that are still running or change the jobs’ status to completed.

• Days to Carry Over – Use this option to specify the number of days to carry over unfinished jobs. 
When the number you specify is reached, TES will no longer include the unrun jobs in the next 
production schedule.

• Production Day Offset [+/– hh:mm] – The Production Day Offset value adjusts the beginning of the 
production “day” to start the specified number of hours/minutes before or after midnight of the 
“real” day. For example, if you enter a +03:00, your calendar for the day will not start until 3:00 am.

Note If the production day offset is modified, you must recompile the current and future production 
schedule for the changes to take effect. If a negative offset is specified, the master should be 
restarted and then the current and future production schedules must be recompiled.

• Compile Offset [+/– hh:mm] – This option adjusts your compile time to start the specified number 
of hours/minutes before or after the beginning of the production day. The default compile time is 
midnight, because midnight is the default time for the beginning of the production day. If you have 
set a Production Day Offset value (above) the Compile Offset value will be adjusted from the new 
beginning of the production day.

• Week Begins – This option affects the starting date of all subset calendars that use weekly 
definitions. After changing the value in this field, select Recalculate from the Calendars pane 
context menu to have the changes take effect. For more information, see Calendars Interface, 
page 10-306, in this manual.

Defaults Tab

Displays default settings for job definitions. The Defaults tab also configures whether job events, system 
events, actions, variables and calendars will default to public availability.

This tab contains the following elements:

• Agent Name – Sets the default agent for the Agent Name setting in the Job/Group Definition 
dialogs.
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• Job History Retention (in days) – Sets the default number of days of job history to keep. The Job 
History Retention setting can be individually configured for jobs on the Options tab of the 
Job/Group Definition dialogs. The maximum length of time to keep job history information is 9,999 
days but this length of time requires very large amounts of hardware and resources and hampers 
performance.

• Job Priority – Sets the default for the Job Priority setting in the Job/Group Definition dialogs.

• If job is currently running – Sets the default for the If job is currently running setting (concurrency) 
in the Job Definition dialog. There are four options:

– Run Anyway– Run another job instance even if the previous instance is still running.

– Skip – Do not run another job instance if the previous instance is running.

– Defer until Normal – Run another job instance only if the current job instance completes with 
a Normal status.

– Defer until Complete – Run another job instance only after the current job instance completes.

• Base time needed to run job on – Sets the default basis for evaluating whether jobs will complete 
before a scheduled outage. Whether jobs have adequate time to run can be based on either of the 
following factors:

– Estimated Duration – The estimated duration for the command or executable as specified in the 
job definition. If the job has run more than once with the same command or executable, the 
estimated duration is the historical average of the job's previous run times. You can also 
manually set the estimated duration time of a job in its definition. 

– Maximum Duration – The maximum duration for the command or executable as specified in 
the job definition.

• If not enough time before outage – Sets the default for the If not enough time before outage setting 
in the Job Definition dialog. There are three options:

– Run Anyway – Run the job anyway.

– Skip – Do not run the job.

– Defer – Wait and run the job after the connection outage has ended.

• Unscheduled allowed – Sets the default for the Unscheduled Allowed setting in the Job Definition 
dialog.

• Disable carryover – Prevents any jobs that did not run during the current production schedule from 
being carried over to the next production schedule. If you wish to carry over jobs to the next 
production schedule, refer to the Carryover Options for Unfinished Schedule section on the Master 
tab to configure which jobs should carry over to the next day’s production schedule.

• For Unix, source user’s profile – Allows you to execute Unix user profiles. This global option 
provides for the execution of all variables in a Unix user’s profile. This option is available in 
individual job definitions on the Options tab so that job instances do not have to default to a source 
user’s profile. Without this option, any Unix user profile variables that are referenced by scripts will 
not be executed, causing a job to fail in TES.

• Save Output Option – Sets the default handling of job output. There are three options:

– Discard – Does not save the job output. (Default)

– Append – Saves the complete output from each job instance, adding the output to the previous 
job instance’s output.

– Replace – Saves the complete output from each job instance, overwriting the previous job 
instance’s output.
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• Summary Only for ERP Jobs – This option only applies to some adapter jobs. Selecting this option 
saves the job output in a summary form. This option is useful when ERP jobs have long job output 
and you do not want the entire output file. Not available if the Discard option is selected.

• Override 'Rerun each time dependency is met' for disabled jobs – If a job is disabled, the system 
will override the option to rerun the job each time a dependency is met.

• Public – Sets the public option default where public option is used. Public items are available to all 
users of TES with an appropriate security policy.

Mail Tab

The Mail tab of the System Configuration dialog displays email settings. TES uses actions to send email 
to users about job scheduling information.

Note For more information about using email with TES, see <Jumps>Chapter , “Actions and Alerts” and your 
TES Installation & Configuration Guide.

This tab contains the following elements:

• Mail System – The email system used by your network. You can choose from the following email 
system types:

– None – No mail system is selected.

– Internet Mail SMTP – Simple Mail Transfer Protocol. 

• Address Separator – You may want to notify more than one person when an action occurs. Use the 
address separator when listing several email addresses so TES can distinguish between individual 
addresses. You may use any character that the designated mail system recognizes as a separator as 
long as the separator is a single character. Most of the time you would use a comma or a semi-colon 
as a separator.

• Timeout – If no response, enter the time (in milliseconds) you want the mail to timeout.

Logging Tab

The Logging tab configures the length of time to keep audit and error messages. You can also choose to 
suppress messages from a specific source. More information on diagnostic logging is available in 
<Jumps>“Troubleshooting” on page 407. For more information about logging and log messages, see 
<Jumps>“Monitoring Production” on page 361.

Caution Be careful using diagnostic logging as excessive diagnostic logging consumes large amounts of disk 
space and affects the timeliness of processing requests and the launching of jobs

This tab contains the following elements:

• Audits – The length of time to keep audit information. The maximum length of time to keep audit 
information is 9,999 days but this length of time requires very large amounts of hardware and 
resources and hampers performance. The default is 7 days.

• Errors – The length of time to keep error information. The maximum length of time to keep audit 
information is 9,999 days but this length of time requires very large amounts of hardware and 
resources and hampers performance. The default is 30 days.
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• Audits option – Select this option to activate audit logging. When checked, auditing information will 
be collected and can appear in the Logs pane. The following is a list of available auditing sources.

– Master – Displays audit messages that originate from the master.

– Client – Displays audit messages that originate from all Tidal Web clients connected to the 
master.

– Agent Manager – Displays audit messages that originate from licensed agents that run jobs. The 
Agent Manager: CQD category displays messages dealing with the underlying agent 
communications protocol.

– Fault Tolerance – Displays audit messages from the Fault Monitor machine.

– Dependency Manager – Displays messages about when dependencies for jobs and job groups 
are met.

– Job Manager – Displays messages about the status of jobs.

– Action Manager – Displays messages about all configured actions.

– Queue Manager – Displays messages about queue activity.

– Agent Messenger: CQD – Displays messages regarding the agent communications protocol, 
CQD. The Agent Manager category displays other messages originating from licensed agents.

Note Because of the volume of CQD diagnostic messages, you can clear the Agent Messenger: CQD 
source for messages while still gathering information regarding your agent(s) from the Agent 
Manager source.

Often the error messages displayed in the Tidal Web client that are generated by a problem, provide an 
indication of the source of the problem revealing which component should be monitored. If no source is 
indicated in the error message, check the messages in the system log for clues to the source of the 
problem. Once the source of the problem is identified, you can enable diagnostic logging for that system 
component. Be careful when using the diagnostic logging function as logging messages can consume a 
large amount of disk space very quickly. Carefully monitor the size of the log file being created as 
excessive logging consumes system resources as well as disk space. Try to repeat the scenario that 
produced the problem, so system activity can be recorded for Technical Services to interpret. Once the 
problem occurs again, contact Technical Services and send them the logging file.

If you are enabling diagnostics before contacting Technical Services, start at the Info level and Technical 
Services will provide additional instructions after receiving the diagnostic files. 

The following components are monitored:

• Scheduler Log – Records system level messages regarding the master.

• Client Manager Log – Records messages about Client Manager activity.

• Agent Manager Log – Records messages from agents running jobs.

• Compiler Log – Records messages about the status of production schedules being compiled.

• Job Manager Log – Records messages about the status of jobs.

• Event Manager Log – Records messages about events defined in TES.

• Queue Manager Log – Records messages about queue activity.

• Database Log – Records messages relating to the state of the database.

• Communications Log – Records messages concerning all defined connections and sockets. Be 
aware that setting this component to a high level of logging results in a large amount of information 
that consumes large amounts of disk space.
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Each component has a drop-down list with seven levels of progressively more detailed logging. Each 
level includes the messages of the previous levels of logging. The levels of logging are:

• None – No logging for the component.

• Severe – Logs only serious problems for that component. (default)

• Warning – Logs potential problems for the component as well as messages from the Severe logging 
level.

• Info – Logs status messages about the normal operation as well as messages from lower logging 
levels. 

• Low Debug – Logs important debugging messages as well as messages from lower logging levels.

• Medium Debug – Logs an increasing amount of debugging information as well as messages from 
lower logging levels.

• High Debug – Logs the largest amount of debugging information as well as messages from lower 
logging levels.

Caution Do not delete the current log file, which is always the log file with the latest timestamp. Even if the file 
does not exist, the master will continue to relay diagnostic information to the log file until it has relayed 
1 MB of information. At that point, the master starts a new log file but any diagnostic information from 
the time between the deletion of the current log file and the creation of a new log file is lost.

Audits Tab

Lists all the audit messages TES can issue. All audit messages can be viewed from the Logs console 
view. From this tab, you can include or exclude audit messages for TES to record. 

Job audit messages can be viewed by individual job from the Job Details dialog for that job (accessed 
from the Job Activity pane). The first audit message listed (with the 1000 ID number) is blank because 
it is available for creating a custom audit message. 

This tab contains the following elements:

• Msg ID – The ID number associated with the specific audit message.

• Exclude – Excludes the audit message from being issued by TES. 

• Message – The text of the audit message. Message strings consist of two string types–the message 
text and the substitution string placeholders. Substitution string placeholders are denoted by a 
double-percent sign and the string number. For example, the first substitution string place holder is 
%%1, and the second, %%2.

Double-click the message to display the Audit Message dialog.

• Instead of individually selecting or excluding audit messages, you can right-click the Audits field to 
display a context menu providing all or nothing options as noted below:

– Exclude Selected Messages – The selected audit messages will be issued.

– Exclude All Messages – None of the audit messages listed on this tab will be issued. 

– Include Selected Messages – The selected audit messages listed on this tab will be issued.

– Include All Messages – All of the audit messages listed on this tab will be issued.

– Log Selected As Windows Event(s) – The selected audit messages listed on this tab will be 
logged as Windows Events.
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– Log All As Windows Events – All audit messages listed on this tab will be logged as Windows 
Events.

– No Windows Event Logging For Selected – The selected audit messages listed on this tab will 
not have Windows Event logging.

– No Windows Event Logging – All audit messages will not have Windows Event logging.

For more information about audit messages, see <Jumps>“Monitoring Production” on page 361.

Errors Tab

Lists all the error messages TES can issue. Error messages can be viewed from the Logs pane. The first 
error message listed (with the 2000 ID number) is blank because it is available for creating a custom 
error message. Here you can instruct TES to exclude specific error messages. 

(For more information about error messages, see <Jumps>“Monitoring Production” on page 361.)

This tab contains the following elements:

• Msg ID – The ID number associated with the specific audit message.

• Exclude – Excludes the error message from being issued by TES. 

• Message – The text of the error message. Message strings consist of two string types–the message 
text and substitution string placeholders. Substitution string placeholders are denoted by a 
double-percent sign and the string number. For example, the first substitution string place holder is 
%%1 and the second, %%2.

Double-click the message to display the Error Message dialog.

• Instead of individually selecting or excluding error messages, you can right-click the Errors field 
to display a context menu providing all or nothing options as noted below:

– Exclude Selected Messages – The selected error messages will be issued.

– Exclude All Messages – None of the audit error listed on this tab will be issued. 

– Include Selected Messages – The selected error messages listed on this tab will be issued.

– Include All Messages – All of the error messages listed on this tab will be issued.

– Log Selected As Windows Event(s) – The selected error messages listed on this tab will be 
logged as Windows Events.

– Log All As Windows Events – All error messages listed on this tab will be logged as Windows 
Events.

– No Windows Event Logging For Selected – The selected error messages listed on this tab will 
not have Windows Event logging.

– No Windows Event Logging – All error messages will not have Windows Event logging.

Job Status Order Tab

Lists the job statuses and lets you change the job status order used for sorting jobs and job groups by 
status in the Job Activity pane.

This tab contains the following elements:

• Job Status Sort Order – To change the job status sort order, select the status you want to move up 
or down, and click the up and down arrow buttons. 
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The sort order defaults to alphabetical, but you may want to change that if there is a sort order that 
makes more sense to you. For example, jobs always enter the Launched status before they enter the 
Active status. Thus, you may want to place Active after Launched in this list. 

Fault Tolerance Tab

The Fault Tolerance tab of the System Configuration dialog allows you to turn on fault tolerance and 
configure the settings.

Note The Fault Tolerance tab is not displayed if you are not licensed for fault tolerance.

This tab contains the following elements:

• Enable Failover – Turns on fault tolerance. The default is disabled. 

The following fields do not display unless the Enable Failover option is selected.

– Machine Name (Backup Master) – The name of the machine the backup master is on.

– Backup-To-Master Port – The port number for the backup master to primary master 
connection.

– Machine Name (Fault Monitor) – The name of the machine the fault monitor is on.

– Fault Monitor Master Port – The port number for the fault monitor to master connection.

– Fault Monitor Client Port – The port number for the fault monitor to Client Manager 
connection.

Timezone Tab

The Timezone tab of the System Configuration dialog allows you to define timezones where target 
application environments are based. This allows you to schedule a job or job group across a different 
timezone. See also, <Jumps>“Working with timezones” on page 211.

This tab contains the following elements:

• Use Master Time Zone – Selecting this option indicates that TES will assume any times specified 
in job scheduling should be in accordance with the master machine’s time zone. If you want a 
job-based timezone, you must select this option.

• Use Agent Time Zone – Selecting this option indicates that TES will assume any times specified in 
job scheduling should be in accordance with the agent machine’s time zone. This means that a job 
running at the same time on all of the agents will appear from the master to run at different times 
because of the different times zones that agents may reside in.
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Note It is not recommended to use the Agent Time Zone option with the Production Day Offset 
option unless you thoroughly understand the scheduling complexities. Using the master time 
zone means that the agents reference the same time zone when launching jobs but using the 
agent’s time zone means that each agent launches jobs according to the time zone that the 
agent resides in. Due to the time zone differences, from the agents’ perspective a 11 am job 
launches correctly but from the master’s perspective the 11 am job may launch at noon, 1 
pm, 2 pm, etc.
Adding a production day offset to a system network spread over a large geographic area 
encompassing multiple time zones vastly complicates scheduling. A production day offset 
may entail that jobs will be launching on different days from the master’s perspective. Tidal 
Software’s consulting services can help resolve complicated scheduling issues.

To configure the Master timezone for a job:

Step 1 From the Activity menu, select System Configuration to display the System Configuration dialog.

Step 2 Click the Timezone tab.

Step 3 Click Add or Edit to display the Timezone for Job Definition dialog.

Step 4 In the Name field, enter a unique name to represent job timezone.

Step 5 From the Timezone list, select the timezone ID.

Step 6 The following fields pre-populate depending on the Timezone list selection:

– Timezone Full Name – Java build-in timezone long name.

– Master Timezone Offset – The time differences between Master timezone and selected Java 
timezone.

– UTC/GMT Timezone Offset – The time differences between standard 
UTC/GMT and selected Java timezone.

– Current in DST Timezone Period – Checked if current in Daylight Saving Time (DST) period 
for this selected timezone. 

– DST Time Differences – The amount of time to be added to selected timezone if it is in DST 
period.

Step 7 Click OK.

Other Tab

The Other tab controls how schedules are compiled, sets time zones, length of alert retention, offsets 
and job carryover. 

This tab contains the following elements:

• Confirm Job Enable – Displays a confirmation message whenever a job is enabled.

• Confirm Job Disable – Displays a confirmation message whenever a job is disabled.

• Allow Job Rerun on any Completed Normally and Completed Abnormally states – Allow jobs to 
be rerun on when the job state is either Completed Normally or Completed Abnormally.

• Send message text with quotes – When using HP OpenView, send all messages with quotes around 
the text.
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• Wait.... seconds for connection to recover before alerting on “Lost connection to agent/adapter” – 
Specified interval in seconds after a connection is lost to either an agent or an adapter before the 
system event Lost connection to agent/adapter is triggered. The default value is a zero delay.

• Remove the browse button for command and file monitors – If selected, the ellipsis button is 
removed from the Job Definition dialog Command and File Monitor fields.
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C H A P T E R 3

Users

Overview
You can add, edit and delete TES users from the Users interface. TES validates login names against its 
own user database. Before a person can operate TES, they must have a TES user account. Once a user 
name is registered, the user must log into Windows with that user name. Other user information includes 
their assigned security policy, their contact information and the runtime users for whom the user can run 
jobs.

User Authentication
There are three distinct entries for adding users, “Interactive Users”, “Runtime Users” and “LDAP 
Groups”. TES 6.0 allows for the setup of a user that authenticates against Active Directory/LDAP. TES 
also supports 
AD/LDAP only users.

At login, user credentials are validated against Active Directory/LDAP. Once authenticated, TES obtains 
the user’s AD/LDAP groups and other information such and phone number and email.

Once login has completed as described above, a record is established in TES to represent the Active 
Directory/LDAP only user if it is not already present and only if the user belongs to an Active 
Directory/LDAP group defined in TES. All user activity logging is then performed against this new user 
record allowing for correct auditing and reporting.

Active Directory/LDAP only users are allowed to create and own jobs and other objects if their security 
permissions permit.

User Account Concepts

Interactive User

During installation of the Windows master, you provide an existing user in the AD/LDAP User Account. 
TES creates the first TES user account for you with this information, and automatically assigns you 
Super User capability. Having the Super User option selected in a User Definition provides access to 
all TES functions, and supersedes all security policies because it encompasses all security permissions. 
From this point on, you can set up other users, and specify their user data.
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Along with specifying other user data, you need to specify a security policy for each user. TES comes 
with default security policy templates to help specify the appropriate functions available for each user 
based on a default network scheduling model. 

Note You cannot remove Super User capability from the initial TES user account until at least one more user 
has been defined and given Super User capability.

When a new user launches TES, TES checks to see if the user’s login name is listed in the TES database. 
If the user is not listed, it displays an error message, and prevents the user from entering TES.

Runtime Users

If you are going to schedule jobs for other users, you can specify those users on the Runtime Users tab 
of the User Definition dialog. This is necessary to access commands and environments created by those 
users for whom you are scheduling.

LDAP Groups

LDAP users can be imported into TES for improving user audit trails. These imported users inherit 
security from multiple LDAP groups. Imported LDAP user information is stored into a user definition 
that includes email, telephone, etc. Imported LDAP users are allowed to be owners of scheduling 
constructs such as jobs if their security permits. 

Users and Workgroups

Workgroups help organize users according to job function, security level, geographical area or any other 
category that may be helpful. TES workgroups can correspond to Windows workgroups, but they 
certainly do not have to. When you create a workgroup, you must always remember to add yourself to 
the workgroup. Creating a workgroup does not automatically make you a member of the workgroup. The 
extent of control you can wield over a workgroup is also dependent upon your individual TES security 
policy. For more information about security policies, see “Security Policies Pane” section on page 3-77.

Note When you install TES, you are automatically placed in the Schedulers workgroup. Schedulers is TES’s 
default workgroup.

Impersonating a User

Impersonating a user is one of the higher-level security permissions. When you impersonate another 
user, you have access to their TES jobs, job actions, job events, system events, user variables, calendars 
and workgroups as if you had logged on as that user.

Contact Information

You can specify and update user contact information such as phone number and email address. TES or 
another user can use this contact information to inform you of the status of a job.
3-64
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 3      Users
  Users Interface
Users Interface
From the Navigator pane, choose Administration>Runtime Users/Interactive Users or LDAP 
Groups to display the Users/LDAP Groups interface.

To change how the list of users/groups is sorted, click the head of a column to use it as a sort key.

Buttons
The Users interface contains the following buttons:

• Admd – Displays the User/LDAP Group Definition dialog to add a new user/group.

• Edit – Displays the User/LDAP Group Definition dialog to edit a user/group.

• Delete – Removes the selected user/group definition from the TES database.

• Copy – Creates a copy of the selected user/group definition from the TES database. You can rename 
the user/group definition and save time when creating several user definitions with the same security 
profile.

• Print – Displays the Reports pane to view and print your user/group definitions. For more 
information, see <Jumps>“Monitoring Production” on page 361.

• Refresh – Updates the data in the current pane.

Search Field
Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See Searchable Columns, page 2-35.

Columns

Note The Users interface contains the following columns:Depending on the selected user, some columns may 
not display.

• Full Name – The user’s full name.

• Name – The name of the user.

• Domain – The user’s domain.

• Security – The security policy assigned to the user. 

• Super User – Indicates if the user has Super User capabilities.

• Modified – The last time this user definition was modified.
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Users Preferences Dialog
If you choose View>Preferences from the main menu bar while viewing the Users/LDAP Groups 
interface, the Users Preferences dialog displays.

From the Users/Group Preferences dialog, you can select which columns are displayed in the 
Users/LDAP Groups interface and in what order the columns appear.

• A checkmark to the left of a column title indicates that it will be displayed in the pane. No 
checkmark indicates that it will not be displayed.

• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.

Navigator Context Menu
With a user/group selected, right-click in the Interactive/Runtime Users or LDAP Groups pane to 
display the context menu.

Depending on the user/group selected, the context menus contains the following elements:

• Add User/Group – Displays the User/LDAP Group Definition dialog to add a new user/group. 
Has the same function as the Add button.

• Refresh – Updates the data in the current pane.

• Print – Displays the Reports pane to view and print your user/group definitions. Has the same 
function as the Print button on the toolbar. For more information, see <Jumps>“Monitoring 
Production” on page 361.

• Note to the Writer: Unable to update the cross ref

• Export – Saves the data in the current pane as an HTML file. 

• Preferences – Displays the Preferences dialog for the User/LDAP Group pane.

• New Root Folder – Allows you to create a new root folder for the Navigator pane.

Users Context Menu
With User/Group selected, when you right-click in the Interactive/Runtime Users or LDAP Groups 
pane, the context menu displays. 

Depending on your selection, the context menus contain the following elements:

• Add Interactive/Runtime Users/Group – Displays the User/LDAP Group Definition dialog 
to add a new user/group. 

• Edit Interactive/Runtime Users/Group – Displays the User/LDAP Group Definition dialog 
to edit the selected user/group. You can double-click a user/group name as an alternative to selecting 
this menu item.

• Delete Interactive/Runtime Users/Group – Deletes the selected user/group. 

• Copy Interactive/Runtime Users/Group – Duplicates the selected user/group definition. You 
can use this option to efficiently create multiple users/groups with similar characteristics.

• Refresh – Updates the data in the current pane.

• Print – Displays a report with a list of selected users/groups with the option to print to a printer. 
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• Print Selected – Displays a report with a list of selected users/groups with the option to print 
selected users/groups only to a printer.

• Add to all super users – Adds a selected user/group record to all user records.

• Impersonate User – Impersonate another user, you have access to their Tes features as if you had 
logged on as that user. 

• End Impersonation – Ends the impersonation of another user.

User Definition Dialog for Interactive Users
The Users interface for Interactive Users displays by choosing Administration>Interactive Users. 
To view the User Definition dialog, click the Add or Edit buttons from the Interactive Users 
interface or right-click in the Navigator pane and choose Add Interactive Users or Edit Interactive 
Users from the context menu. You can also double-click an Interactive user to display that user’s 
definition. 

Common To All Tabs

• User Name – Type a logon name for the user. This field is integrated with Windows to display 
existing users defined for the selected domain.

You can use an active directory name in this field if you want but you must leave the Domain field 
blank for this to work. (An active directory name would be in this format, username@domainname, 
such as jjohn@Tidalsoft.)

• Full Name – The name of the user as displayed in TES panes consisting of up to 30 characters. This 
name must be unique.

• Domain – Specify a domain associated with this user account.

Security Tab

• Super User – Click this radio button to provide the user with access to all available TES functions.

• Other – Click this radio button to assign one of the other defined security policies from the 
drop-down menu. 

Runtime Users Tab

Typically the runtime users option is used by users with the responsibility of running jobs for others such 
as Schedulers or Operators. When you select runtime users for a user definition, the user gains the rights 
and access to all of the runtime users’ commands and environments, but only when scheduling and 
running jobs. This tab lists the defined users and user groups. The user being defined can only be a 
runtime user for a user if that user name is selected. User groups work the same way. You can either 
display the defined users or the defined user groups but not both at the same time. 

This tab contains the following elements:

• Show Users – Displays all defined users for this installation. The runtime users (users for which 
this user can schedule and run jobs) are indicated by a checkmark to the left of the listed name.

• Show Groups (Windows) – Displays all defined user groups.
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Agents Tab

This tab contains the following elements:

• Untitled Text Field – This field displays all defined TES agents for this installation. The agents 
which this user can use to run jobs are indicated by a checkmark to the left of the listed name. 

• All Agents – Select the All Agents option when you want the user to have access to all available 
agents. When the All Agents option is selected, the check boxes to the left of each listed agent 
disappear.

Note If the All Agents option is not selected, and no individual agents are selected, the user will be unable to 
run any jobs.

Notification Tab

This dialog contains the following elements:

• Phone Number – The user’s phone number.

• Pager Number – The user’s pager number.

• Email Address – The user’s email address. The email address entered here is used to receive 
notification during email actions and to log in for anonymous FTP. 

Passwords Tab

This tab contains the following elements:

• Windows/FTP Password – This field is used for running jobs on Windows/FTP machines.

• Confirm Password – Retype the password you entered in the Windows/FTP Password field to 
verify its accuracy.

• Adapter – Contains the adapter name.

• Password – Contains the password for the associated adapter.

• Add – Click to add a new record via the Change Password dialog.

• Edit – Click to edit an existing record via the Change Password dialog.

• Delete – Click to delete a selected record.

Workgroups Tab

This tab contains the following elements:

• Workgroup – The names of the workgroups under which the user is a member. To be a member of 
a workgroup, you must be added into that workgroup by the workgroup’s owner.

• Owner – The owners of the workgroups of which the user is a member.

Description Tab

A free text field for any comments regarding the user, up to 255 characters long.
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User Definition Dialog for Runtime Users
The Users interface for Runtime Users displays by selecting Administration>Runtime Users. To 
view the User Definition dialog, click the Add or Edit buttons from the Users interface or right-click 
in the Navigator pane and select Add Runtime Users or Edit Runtime Users from the context menu. 
You can also double-click a Runtime user to display that user’s definition. 

LDAP Group Definition Dialog
The LDAP Group interface displays by selecting Administration>LDAP Groups. To view the LDAP 
Group Definition dialog, click the Add or Edit buttons from the LDAP Group interface or right-click 
in the Navigator pane and select Add Group. You can also select Edit Group from the context menu 
of the LDAP Groups pane or double-click an LDAP group to display that group’s definition.

Note Features associated with LDAP Groups are common to other Users. See “Adding Interactive Users” 
section on page 3-70. 

User Configuration Procedures

Adding Runtime Users
To add a Runtime user:

Step 1 From the Navigator pane, select Administration>Runtime Users to display the Runtime Users 
pane.

Step 2 Click the Add button or right-click in the Navigator pane and select Add Runtime Users from the 
context menu to display the User Definition dialog.

Step 3 If this is a new user definition, enter the new user name in the User Name field.

Step 4 For documentation, enter the Full Name or description associated with this user.

Step 5 In the Domain field, select a Windows domain associated with the user account required for 
authentication, if necessary.

Step 6 In the Windows/FTP Password field, enter the password for the user account provided by the 
Administrator.

Step 7 In the Confirm Password field, retype the password.

Step 8 If the passwords entered in the Windows/FTP Password and Confirm Password fields do not match, 
you must re-enter the password in both fields.

Step 9 Click OK to add or save the user record in the TES database.
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Adding Interactive Users
To add an Interactive user:

Step 1 From the Navigator pane, select Administration>Interactive Users to display the Interactive 
Users pane listing all TES users. 

If the TES users do not appear, you do not have the appropriate rights to view users.

Step 2 Double-click the name of an user account that you want to be able to run jobs to display the User 
Definition dialog.

Step 3 Click the Runtime Users tab in the User Definition dialog and select the check box(es) beside the 
name(s) of the Interactive user(s) you want to include in this TES users authorized user list.

Step 4 If you wish to restrict this user’s access to specific servers, click the Agents tab and make the 
appropriate selections.

Step 5 Click OK.

Deleting a User

Note You cannot delete a user that presently owns a job, job event, system event, action, user defined variable 
or calendar. Open each item’s dialog and reassign the ownership of the items before deleting the user

To delete a user:

Step 1 From the Navigator pane, select Administration>Interactive Users or Runtime Users to display 
the Users interface.

Step 2 Select the user to delete and click the Delete button on the TES toolbar or right-click the user record 
and select Delete User from the context menu. 

Step 3 When a dialog asks you to confirm your choice, click OK.

Editing a User Definition
To edit a user definition:

Step 1 From the Navigator pane, select Administration>Interactive Users or Runtime Users to display 
the Users interface.

Step 2 Double-click the user record to edit or select the user name and click the Edit button or right-click the 
user record and select Edit User from the context menu to display the User Definition dialog.

Step 3 Edit the User Name if it does not match the Windows login name. Remember that the user name is 
case-sensitive.

Step 4 Edit the Full Name if necessary. 
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Step 5 To change the Security Policy for an Interactive user, select a new one from the drop-down menu on 
the Security tab. If you have the Superuser option set, the list is disabled. Click the Superuser option 
if you want the user to have access to all TES functions. To add or remove specific functions to a security 
policy, see “Security Policy Procedures” section on page 3-108.

Step 6 To add or remove runtime users for an Interactive user, click the Runtime Users tab.

Select the runtime users to add to the user’s definition from the Available Users list.

• To include users, select the check box next to the user you want to include. 

• To exclude users, clear the check box next to the user you want to exclude.

The user will have access to the commands and environments of the runtime users you assign.

Step 7 If you wish to change an Interactive user user’s access to specific servers, click the Agents tab and make 
the appropriate selections.

Step 8 Click the Notification tab to edit contact information for the Interactive user.

Step 9 Edit the password information, if necessary.

Note You cannot edit Workgroups information from the User Definition dialog. For more information on TES 
workgroups, see “Workgroups Pane” section on page 3‐72.

Step 10 Click the Description tab to edit the user’s description (up to 255 characters).

Step 11 Click OK. 

Step 12 Jobs in the production schedule that have not run yet will reflect the changes to the user data. Jobs that 
are running or that have completed retain the old user information.

Impersonating Another User
To impersonate a user:

Step 1 From the Navigator pane, select Administration>Interactive Users to display the Interactive 
Users pane.

Step 2 Right-click the user you want to impersonate and select Impersonate User from the context menu.

Step 3 When a dialog asks you to confirm your choice, click OK. 

Ending User Impersonation 
To end user impersonation:

Step 1 From the Navigator pane, select Administration>Interactive Users to display the Interactive 
Users pane.

Step 2 Right-click the user and select End Impersonation from the context menu 

–or–
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Select Activities>End Impersonation from the main menu bar.

Viewing Users
From the Navigator pane, select Administration>Interactive/Runtime Users or LDAP Groups to 
display the Users/Groups interface. If the users/groups do not display, you do not have the appropriate 
rights to view these items.

Workgroups Pane
A workgroup is a set of users categorized under a communal name for the purpose of sharing items (jobs, 
actions, events etc.) which are owned by the workgroup. Each user in the workgroup has access to these 
items based on their own individual security policy.

If you have appropriate rights in your security policy you can create your own workgroups from the 
Workgroup pane. This pane displays all existing workgroups (within the bounds of your security 
policy). When you create a workgroup, you become its owner, and can add users to it; however, you must 
be a Super User. To belong to a workgroup created by another user, you have to be added by that user.

Note If you own a workgroup and do not include yourself in it, the workgroup’s associated items would not 
be accessible to you.

You can change the name and the members of any workgroup that you own. You cannot edit a workgroup 
that was created by another user unless you impersonate that user. 

Workgroups help focus the information TES displays to each user. When you open the Jobs, Actions, 
Job Events, System Events, Calendars, or Variables panes, you will see only the items belonging 
to you and belonging to the workgroup(s) to which you belong.

For example, if you belong to a Payroll workgroup, you can see all the jobs, actions, etc., that are owned 
by the Payroll workgroup and were created by you or other members of the workgroup.

The following figure shows a generic workgroup structure using five users and two workgroups. Note 
that, in this figure, User 3 belongs to both workgroups, and therefore has access to all items (calendars, 
jobs, etc.) shown.

Workgroups Pane Interface
From the Navigator pane, select Administration>Workgroups to display the Workgroups pane.

Buttons

• Add Workgroup – Displays the Workgroup Definition dialog to add a new workgroup.

• Edit Workgroup – Displays the Workgroup Definition dialog to edit an existing workgroup.
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Note You can change the name and the members of any workgroup that you own. You cannot edit a workgroup 
that was created by another user unless you impersonate that user.

• Delete Workgroup – Deletes the selected workgroup as long as the workgroup does not currently 
own any TES items.

• Copy Workgroup– Creates a copy of the selected workgroup definition from the TES database. 
You can rename the workgroup definition and save time when creating several workgroup 
definitions with the same security profile.

• Print Workgroups – Displays the Reports pane to view and print your selected workgroup 
definitions. For more information, see <Jumps>“Monitoring Production” on page 361.

• Refresh – Updates the data in the current pane.

Search Field

Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See Searchable Columns, page 2-35.

Columns

• Name – The name of the workgroup.

• Users – The users that are included in the workgroup.

• Owner – The owner of the workgroup.

• Modified – The last time the workgroup definition was modified.

Workgroups Preferences Dialog

If you select View>Preferences from the main menu bar while viewing the Workgroups pane, the 
Workgroups Preferences dialog displays.

From the Workgroups Preferences dialog, you can select which columns are displayed in the 
Workgroups pane and in what order the columns appear.

• A checkmark to the left of a column title indicates that it will be displayed in the pane. No 
checkmark indicates that it will not be displayed.

• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.

Navigator Context Menu

When you right-click in the Navigator pane while viewing the Workgroups pane, the Navigator 
context menu displays. 

The following describes the items in the Workgroups Navigator context menu:

• Add Workgroup – Displays the Workgroup Definition dialog to add a new connection. 
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• Preferences – Displays the Preferences dialog for the Workgroups pane.

• Print – Displays the Reports pane to view and print your workgroup definitions. Has the same 
function as the Print button on the toolbar. For more information, see <Jumps>“Monitoring 
Production” on page 361.

• Export – Saves the data in the current pane as an HTML file. 

• Refresh – Updates the data in the current pane.

• Note to the Writer: Unable to update the cross ref

Workgroups Pane Context Menu

When you right-click in the Workgroups pane, the Workgroups context menu displays. 

The following describes the items in the Workgroups context menu.

• Add Workgroup – Displays the Workgroup Definition dialog to add a new workgroup. If you 
add a workgroup, it displays in the Jobs, Actions, Job Events, System Events, Workgroups, 
Calendars and Variables panes. 

• Edit Workgroup – Displays the Workgroup Definition dialog to edit the selected workgroup. 
You can double-click the workgroup as an alternative to selecting this menu item. Only a Super User 
or the selected workgroup’s owner can edit a workgroup.

• Delete Workgroup – Deletes the selected workgroup. 

• Print – Displays the Reports pane to view and print your workgroup definitions. For more 
information, see <Jumps>“Monitoring Production” on page 361.

• Note to the Writer: Unable to update the cross ref

Workgroup Definition Dialog
The Workgroup Definition dialog displays when adding or editing a workgroup from the 
Workgroups pane.

Common To All Tabs

• Workgroup Name – The name of the workgroup, as displayed in the Workgroup pane (up to 30 
characters). Each workgroup must have a unique name.

• Owner – The owner of the workgroup.

Users Tab

Displays a list of all defined TES users and allows you to assign security policies for each user within 
the workgroup, in addition to the user’s existing security policy.

Note Editing a user’s security policy while defining a workgroup does not remove permissions that the user 
already has. You can only assign additional security policies as part of the specific workgroup.
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Groups Tab

Displays a list of all defined TES groups. A checkmark indicates groups that are assigned to the current 
workgroup. 

Agents Tab

The Agent tab displays all the TES agents that the owner of the workgroup is authorized to use. The 
agents which the workgroup can use to run jobs are indicated by a checkmark to the left of the listed 
name.

This tab displays the following element: 

• All Agents for <workgroup owner> – Select the All Agents for <workgroup owner> option 
when you want the workgroup to have access to all the agents available to the workgroup’s owner. 
When this option is selected, the check boxes to the left of each listed agent disappear.

Note If the All Agents for <workgroup owner> option is not selected and no individual agents are 
selected, the workgroup cannot run any jobs.

Description Tab

The Description tab contains a free text field where you can enter comments about the workgroup (up 
to 255 characters).

Workgroups Procedures

Adding a Workgroup

To add a workgroup:

Step 1 From the Navigator pane, select Administration>Workgroups from the main menu bar TES to 
display the Workgroups pane.

Step 2 Click the Add button on the TES toolbar or right-click and select Add Workgroup from the context 
menu to display the Workgroup Definition dialog.

Step 3 Type a unique name for the workgroup in the Workgroup Name field (up to 30 characters).

Step 4 Click the Members tab.

Step 5 Select the users to add to the workgroup from the Available Users list.

– To include users in the workgroup, select the check box next to the user. 

– To exclude users from the workgroup, clear the check box next to the user.

Note Always include yourself in the workgroups you define; otherwise, you cannot access its definition or 
owned items.

Step 6 Click the Agents tab.
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Step 7 Select the agents to add to the workgroup.

Step 8 To enter a description for this workgroup, click the Description tab and type in the description. You can 
enter up to 255 characters.

Deleting a Workgroup

You can delete a workgroup from the Workgroups pane. Workgroups can be deleted only when they no 
longer own jobs, actions, job events, system events, calendars and/or variables. (Go to each item owned 
by the workgroup and change the ownership.)

To delete a workgroup:

Step 1 From the Navigator pane, select Administration>Workgroups from the main menu bar TES to 
display the Workgroups pane.

Step 2 Select the workgroup to delete and click the Delete button on the TES toolbar or right-click the 
workgroup and select Delete Workgroup from the context menu.

Step 3 Click Yes in the Confirm dialog.

Editing a Workgroup

You can change the name and the members of any workgroup that you own. You cannot edit a workgroup 
that was created by another user unless you impersonate that user. 

When you change the members of a workgroup, updates for affected users will occur the next time they 
reopen the Jobs, Actions, Job Events, System Events, Calendars and/or Variables panes.

To edit a workgroup:

Step 1 From the Navigator pane, select Administration>Workgroups from the main menu bar TES to 
display the Workgroups pane.

Step 2 Select the workgroup you would like to edit and click the Edit button on the TES toolbar or double-click 
the workgroup you would like to edit or right-click the workgroup you would like to edit and select Edit 
Workgroup from the context menu. 

Step 3 The Workgroup Definition dialog displays. 

Step 4 To change the name of the workgroup, edit the Workgroup Name field.

Step 5 To include users in the workgroup, select the check box next to the name of the user you want to include. 
To exclude users from the workgroup, clear the check box next to the name of the user you want to 
exclude.

Note Always include yourself in the workgroups you define; otherwise, you will not have access to its 
definition or owned items.

Step 6 To edit the agents of the workgroup, click the Agents tab. 

• To exclude agents from the workgroup, clear the check box next to the name of the agent you want 
to exclude. 
3-76
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 3      Users
  Security Policies Pane
• To include agents to the workgroup, select the check box next to the name of the agent you want to 
include.

Step 7 To edit the description of the workgroup, click the Description tab. 

Step 8 Edit the description text for the workgroup. You can use up to 255 characters.

Viewing Workgroups

In the Workgroups pane, you can view all the workgroups that you own. When in the Jobs, Actions, 
Job Events, System Events, Variables and Calendars panes, all the workgroups that you own and 
belong to can be seen. Workgroup association can also be seen in the User Definition dialog. 

From the Navigator pane, select Administration>Workgroups from the main menu bar TES to 
display the Workgroups pane.

Viewing Members of a Workgroup

To view members:

Step 1 From the Navigator pane, select Administration>Workgroups from the main menu bar TES to 
display the Workgroups pane.

Step 2 Double-click the workgroup you would like to examine to display its definition.

Viewing the Workgroups to Which You Belong

To view a workgroup to which you belong:

Step 1 From the Navigator pane, select Administration>Workgroups from the main menu bar TES to 
display the Workgroups pane. If the TES users do not appear, you do not have the appropriate rights 
to view users.

Step 2 Double-click the user name to display its User Definition dialog with the user information.

Step 3 Click the Workgroups tab. All the workgroups that the user belongs to are listed.

Security Policies Pane
Security policies restrict access to certain TES functions. The defined access rights can be saved as a 
security policy, and then assigned to one user or multiple users.

For example, there might be different sets of users who:

• Administer TES

• Create and schedule jobs for themselves and others

• Operate the job schedule
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You may have a set of users that creates jobs, a set of users that schedule jobs and another set that works 
with the job schedule. Using security policies, the users creating jobs can be restricted from inserting 
them into production and changing the schedule. The other users can be restricted from creating jobs.

TES includes default security policy templates that can be modified to create your own security policies. 
Each user within the supplied working model has a defined set of TES functions. When all the default 
security policies are in use, all aspects of scheduling are covered and available. 

The following table lists the system features available for each of the default security templates:

Each security policy has its own name, description, and set of TES functions that it comprises it. 
Functions are chosen from a list of available functions and listed in the Security Policy Definition 
dialog. Once defined, security policies can be assigned to users from the User Definition dialog.

You can override security policy restrictions for a user by selecting the Super User option in the User 
Definition dialog. Users with Super User authority have access to all TES functions.

Note If you are the only defined TES user, you will not be allowed to remove the Super User option from your 
profile until you have defined at least one other TES user with Super User capability. This is a safety 
feature to prevent inadvertent exclusion from TES, which would require you to reinstall the product.

Table 3-1 TES Security Policies

Default Security Policy Available System Features

Scheduler_Administrator The default for new installations. This includes all available functions.

Administrator Configures users.

User Creates, edits, and submits jobs. Creates workgroups and user-defined vari-
ables.

Scheduler Edits and tests job schedules.

Operator Runs and controls jobs. Responds to alerts that jobs may issue.

Inquiry Views jobs and resources. Cannot perform modification.
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Security Policy Templates
TES includes a set of default security policy templates. Inherent in these templates is the default network 
scheduling model where each user has a defined set of scheduling tasks. When all the security policies 
are assigned to users, the result is a complete enterprise network scheduling solution. Each user makes 
their contribution to the entire scheduling process. Each user can be insulated from tasks that are not 
relevant to their scheduling role.

You can modify these templates to create your own scheduling model based on the needs of your 
organization. Use caution so that vital functions are not inadvertently left out of a particular profile.

Note Selecting the Super User option in a User Definition supersedes any security policy previously assigned. 
The Superuser option provides full and unrestricted access to all TES functions. Some functions, such 
as calendars supersede even SuperUser privileges and are controlled by the function’s owner and 
available only to members of a workgroup. A SuperUser may access a function but can not modify the 
function if not a member of the workgroup.

Default Security Policies

The following table summarizes the functions that are available for each user account using the security 
policies provided with TES. If the function has been included in the security policy assigned to your user 
account then you have the capability described in that function.

TES Functions
Each security policy includes the TES functions that a user with that policy can perform. You can create 
new security policies from the Security Policy Definition dialog, or add and remove TES functions to 
an existing security policy. When you finish defining a security policy, you assign it to a user through 
the User Definition dialog.

Table 3-2 Functions available with the default security policies

Default Security Policy Available Functions

TES Admin All TES functions are available.

Administrator Functions for configuring TES including configuring users, 
security, queues, agent lists, connections, and licenses.

(Continued)

Scheduler All functions except adding users.

Operator Functions for end-user support such as schedule control and queue 
and agent list configuration. Ability to edit job information as 
necessary.

User Functions for end-user activity excluding configuration and 
schedule control, but including the tools necessary for creating, 
editing and submitting jobs.

Inquiry Functions for viewing jobs and other items, but not for creating, 
editing, or deleting.
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Note To use a job as a job dependency, you must have the ability (security policy permission) to View the job. 
However, View permission alone does not enable you to perform job control functions on the job.

Function Descriptions

The following are descriptions of each TES function, grouped by category, that can be added to or 
removed from a security policy:
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Agent Lists Category

Alerts Category

Calendar Category

Configuration and Licensing Category

Table 3-3 Agent Lists Functions

Function Description

Add Agent List Specify a group of agents for the purpose of agent fault tolerance 
(dynamic rerouting), workload balancing and job broadcasting. 
The list will be available to all users that schedule jobs.

Edit Agent List Edit the properties of an agent list. 

Delete Agent List Delete any agent list that exists in theScheduler database.

View Agent List View the properties of any agent list.

Table 3-4 Alerts Functions

Function Description

Acknowledge Alert Acknowledge a console alert generated by a job event or system 
events.

Close Alert Complete the response to a console alert.

View Alert View alert details. 

Table 3-5 Calendar Functions

Function Description

Add Calendar Create a calendar of dates that determines when to run jobs. You 
can also create calendar groups and make calendars and calendar 
groups public if you have the Add Public Data function.

Edit Calendar For calendars owned by you or your group you can change the 
dates within a calendar. You can also add and delete the calendars 
in calendar groups. 

Delete Calendar Delete your own calendars and calendar groups.

View Calendar View the dates defined for a calendar.

Table 3-6 Configuration and Licensing Functions

Function Description

Edit 
Configuration/License

Access to the System Configuration dialog. You can change 
master configuration data, update licenses, configure mail, job 
defaults, and other system-wide settings.

View 
Configuration/License

View alert details. 
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Connections Category

General Category

Job Actions Category

Table 3-7 Connections Functions

Function Description

Add Connection Add a new connection definition.

Edit Connection Edit a connection definition.

Delete Connection Delete a connection definition

View Connection View the details of connection information.

Edit Agent Job Limit Change the number of jobs that can run on an agent at the same 
time.

Edit Machine Name Edit the agent machine designation.

Table 3-8 Connections Functions

Function Description

Add Public Data Add events, actions, calendars, and variables so that they can be 
used by anyone who schedules jobs. You must have the security 
rights to add and/or edit these items to make them public.

View Logs View the audit trail of all scheduling activity, error messages, and 
diagnostics from the Logs pane. You can view all messages 
generated by the sources specified in the System Configuration 
dialog, Logging tab.

View Reports View the results of TES reports.

View History View the audit trail of TES activity.

View Master Status Access to the Master Status pane, where you can view all the 
statistics related to the TES master.

Move Jobs to Production Use Transporter to copy all jobs to other databases whether the 
user owns them or not.

Move Own Jobs to 
Production

Use Transporter to copy only the jobs that the user owns to other 
databases.

Table 3-9 Job Actions Functions

Function Description

Add Job Actions Create actions (messages, jobs, variable updates) to support 
specific job events and system events.

Edit Job Actions Edit the properties of an action that is owned by you or your 
workgroup.

Delete Job Actions Delete an action that you own.

View Job Actions View the specifics of all actions available.
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Job Classes Category

Job Console (Activity) Category

Job Control Category

Table 3-10 Job Classes Functions

Function Description

Add Job Class Create a class to which jobs can be assigned. Job classes are 
available to all schedulers.

Edit Job Class Edit a job class.

Delete Job Class Delete a job class.

View Job Class View the description of a job class.

Table 3-11 Job Console (Activity) Console Functions

Function Description

View All Jobs View the activity of all job occurrences as they are scheduled and 
run. You will also be able to view console alerts created by jobs. 
to add and/or edit these items to make them public.

View Own Jobs View the activity of your own job occurrences or those owned by 
your workgroup(s) as they are scheduled and run. You will also be 
able to view console alerts created by those jobs.

Edit All Jobs Edit the definition of any job or job group.

Edit Own Jobs Edit job and job group definitions that are owned by you or your 
workgroup(s).

Control All Jobs Apply job control to all jobs and job groups, within any limits set 
in the job control functions.

Control Own Job Apply job control to jobs and job groups owned by you or the 
workgroup(s) you belong to, within any limits set in the job 
control functions.

Table 3-12 Job Control Functions

Function Description

Ad Hoc Job Control Manually add an unscheduled job to production.

Cancel/Abort Manually cancel or abort a job occurrence from the Job Activity 
pane. Canceled and aborted jobs cannot be resumed. They must be 
rerun.

Hold/Stop Manually hold or stop a job occurrence from the Job Activity pane. 
The job can be restarted at a later time.

Override Override a job’s dependencies, allowing it to run even though its 
predefined dependencies have not been satisfied.

Release/Resume Release a job requiring operator release, and resume a job that has 
been stopped or held.
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Rerun Rerun a job.

Set Status Set a job’s completion status.

Table 3-12 Job Control Functions

Function Description
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Jobs Category

Queues Category

Table 3-13 Job Classes Functions

Function Description

Add Job Event Set up conditions to trigger job alert messages and/or recovery 
procedures (job events).

Edit Job Event Edit the properties of a job event owned by you or your 
workgroup(s).

Delete Job Event Allows a user to delete job events that the user created or are 
owned by a workgroup to which they belong.

View Job Event Allows a user to view the specifics of all job events (messaging 
service and recovery procedure constructs) available.

Allow All Jobs Enables/disables the Apply this event to all jobs check box in the Job 
Event definition. If you do not have this enabled in your security 
policy, you cannot apply a job event to all jobs.

Table 3-14 Job Functions

Function Description

Add Jobs Create new job and job group definitions. You have full control 
over what, where, and when the job or group runs. You can also 
specify dependencies for your definitions.

Assign Job Events Assign predefined job events to a job or job group from the Job or 
Job Group definition dialogs.

Edit Jobs Edit jobs for yourself or for your workgroup(s). You have full 
control over what, where, and when the job or group runs. You can 
also specify dependencies for your definition.

Delete Jobs Delete jobs belonging to you and your workgroup(s).

View Jobs View all the properties of the jobs and groups that you and your 
workgroup(s) own.

Enable Jobs Enable (activate) jobs and job groups. A job cannot run unless it is 
enabled.

Table 3-15 Queue Functions

Function Description

Add Queue Create job queues to tune the throughput and allocation of system 
resources.

Edit Queue Edit job queues to tune the throughput and allocation of system 
resources.

(Continued)

Delete Queue Delete a job queue.
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View Queue View all queues and their properties.

Edit System Queue Edit the system queue, including setting the overall limit of the 
number of jobs run on the network concurrently. With the Edit 
System Queue function, users can also edit all other queues.

Edit Native Priority Edit the CPU scheduling priority for jobs in a queue. This function 
applies to Nice values in Unix and to job classes in SAP.

Table 3-15 Queue Functions

Function Description
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Resources Category

Schedule Category

Security Category

System Events Category

Table 3-16 Resources Functions

Function Description

Add Resources Create new resources.

Edit Resources Edit resource definitions.

Delete Resources Delete existing resource definitions.

View Resources View all the properties of the resources that you and your 
workgroup(s) own.

Table 3-17 Schedule Functions

Function Description

Shutdown Scheduler Stops the master service.

Create Schedule Manually generate job occurrences for the next production 
schedule period.

Pause/Resume Schedule Prevent all jobs in the production schedule from launching. Also 
allows you to resume the schedule if it is paused.

Refresh Schedule Updates the production data.

Table 3-18 Security Functions

Function Description

Add Security Policy Allows a user to create a set of Scheduler functions that can be 
assigned to a user.

Edit Security Policy Allows a user to add and remove functions to/from a Scheduler 
functions set.

Delete Security Policy Allows a user to delete a Scheduler function set.

View Security Policy Allows a user to view the function set associated with a security 
policy.

Table 3-19 System Events Functions

Function Description

Add System Event Set up conditions to trigger actions based on events generated by 
the system (system events). 

Edit System Event Edit the properties of a system event that belongs to you or your 
workgroup(s).

(Continued)
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Delete System Event Delete system events that belong to you or your workgroup(s).

View System Event View the specifics of all system events (messages, jobs, variable 
updates) available.

Table 3-19 System Events Functions

Function Description
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Workgroups Category

Variables Category

Table 3-20 Users Functions

Function Description

Add Users Add a new user definition to the Scheduler database.

Edit Users Edit all properties of a user definition except for Assign Security 
Policy, Assign Runtime Users and Assign Agents.

Delete Users Delete any user from the Scheduler database.

View Users View all user information.

Edit Personal Data Update the personal data properties (User Definition dialog, Other 
tab) of your user definition.

Assign Security Policy Specify the functions that will be available to another user.

Assign Runtime Users Assign access to other user accounts for the purpose of running 
jobs.

Impersonate User Operate Scheduler as another user. You assume all characteristics 
of that user, including their security policy.

Assign Agents Designate the agent(s) on which a user is allowed to run jobs.

Table 3-21 Workgroups Functions

Function Description

Add Workgroup Can create a group of users to share data.

Edit Workgroup Can redefine the users who belong to a workgroup.

Delete Workgroup Can delete a workgroup, disabling the sharing of data between 
users.

View Workgroup Can view workgroup definitions.

Table 3-22 Variables Functions

Function Description

Add Variable Create variable definitions.

Edit Variable Edit variable definitions that belong to you and your 
workgroup(s).

Delete Variable Delete user-defined variables that belong to you and your 
workgroup(s).

View Variable View variables that belong to you and your workgroup(s).
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Fault Monitor Category

OracleApps Jobs Category

Variable Events Category

File Events Category

Table 3-23 Fault Monitor Functions

Function Description

Control Fault Monitor Enables a user to use the control options in the context menu in the 
Fault Monitor pane.

View Fault Monitor Enables a user to view the Fault Monitor pane

Table 3-24 OracleApps Jobs Functions

Function Description

Add OracleApps Job Create and add OracleApps jobs to the TES production schedule.

Edit OracleApps Job Edit OracleApps job definitions.

Table 3-25 Variable Events Functions

Function Description

Add Variable Events Create and add variable events to the TES production schedule.

Edit Variable Events Edit variable events that belong to you and your workgroup(s).

Delete Variable Events Delete variable events that belong to you and your workgroup(s).

View Variable Events View all the properties of the variable events that you and your 
workgroup(s) own.

Suspend Variable Events Suspends the variable events that you and your workgroup(s) own.

Resume Variable Events Resumes suspended variable events that you and your 
workgroup(s) own.

Table 3-26 File Events Functions

Function Description

Add File Events Create and add file events to the TES production schedule

Edit File Events Edit file events.

Delete File Events Delete file events that belong to you and your workgroup(s)

View File Events View all the properties of the file events that you and your 
workgroup(s) own.

Suspend File Events Suspends the file events that you and your workgroup(s) own.

Resume File Events Resumes suspended file events that you and your workgroup(s) 
own.
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Oracle DB Events Category

Oracle DB Jobs Category

SAP Jobs Category

Table 3-27 Email Events Functions

Function Description

Add Email Events Create and add Email events to the TES production schedule

Edit Email Events Edit Email events.

Delete Email Events Delete Email events that belong to you and your workgroup(s)

View Email Events View all the properties of the Email events that you and your 
workgroup(s) own.

Suspend Email Events Suspends the Email events that you and your workgroup(s) own.

Resume Email Events Resumes suspended Email events that you and your workgroup(s) 
own.

Table 3-28 Oracle DB Events Functions

Function Description

Add Oracle DB Events Create and add Oracle DB events.

Edit Oracle DB Events Edit Oracle DB events.

Delete Oracle DB Events Can delete Oracle DB event definitions.

View Oracle DB Events Can view Oracle DB event definitions.

Suspend Monitoring Can suspend the operation of the Oracle DB monitor.

Resume Monitoring Can resume the operation of the Oracle DB monitor.

Table 3-29 Oracle DB Jobs Functions

Function Description

Add Oracle DB Jobs Create and add Oracle DB jobs to the TES production schedule.

Edit Oracle DB Jobs Edit Oracle DB job definitions.

Table 3-30 SAP Jobs Functions

Function Description

Add SAP Job Create and add SAP jobs to the TES production schedule.

Edit SAP Job Edit SAP job definitions.

Delete SAP Job Delete SAP job definitions.

View SAP Job View SAP job definitions.

View Job Log View job’s job log.

View Job Spool View job’s job spool.
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SAP Variants Category

SAP Process Chains

MSSql Events

MSSql Jobs

PeopleSoft Jobs Category

Table 3-31 SAP Variants Functions

Function Description

Add/Edit Variants Create and edit SAP variants.

Delete Variants Can delete SAP variants.

Table 3-32 SAP Process Chains Functions

Function Description

Enable Planning View Can enable planning view.

Table 3-33 MSSql Events Functions

Function Description

Add MSSql Events Create and add MSSql events.

Edit MSSql Events Can edit MSSql events.

(Continued)

Delete MSSql Events Can delete MSSql event definitions.

View MSSql Events Can view MSSql event definitions.

Suspend Monitoring Can suspend the operation of the MSSql monitor.

Resume Monitoring Can resume the operation of the MSSql monitor.

Table 3-34 MSSql Jobs Functions

Function Description

Add MSSql Jobs Create and add MSSql jobs to the TES production schedule.

Edit MSSql Jobs Can edit MSSql job definitions.

Delete MSSql Jobs Can delete MSSql job definitions.

View MSSql Jobs Can view MSSql job definitions.

Table 3-35 PeopleSoft Functions

Function Description

Add PeopleSoft Job Create and add PeopleSoft jobs to the TES production schedule.

Edit PeopleSoft Job Edit PeopleSoft job definitions.
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PeopleTools Category

WebService Jobs Category

Horizon Jobs Category

Default Security Policies and Their Associated Functions

The following shows which TES functions are associated with each default security policy, grouped by 
function category

Delete Workgroup Delete a workgroup, disabling the sharing of data between users.

View Workgroup View workgroup definitions.

Table 3-36 PeopleTools Functions

Function Description

Enable PeopleTools 
Access

Can access PeopleTools.

Table 3-37 WebService Jobs Functions

Function Description

Add WebService Jobs Create and add WebService jobs to the TES production schedule.

Edit WebService Jobs Can edit WebService job definitions.

Delete WebService Jobs Can delete WebService job definitions.

View WebService Jobs Can view WebService job definitions.

Table 3-38 Horizon Jobs Functions

Function Description

Add Horizon Jobs Create and add Horizon jobs to the TES production schedule.

Edit Horizon Jobs Can edit Horizon job definitions.

Delete Horizon Jobs Can delete Horizon job definitions.

View Horizon Jobs Can view Horizon job definitions.

Table 3-35 PeopleSoft Functions

Function Description
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Agent Lists category

Add agent list    — — —

Edit agent list    — — —

Delete agent list    — — —

View agent list      
Alerts category

View alert  —    
Acknowledge alert  —  — —

(Continued)

Close alert  — —  — —

Calendars category

Add calendar  —  — — —

Edit calendar  —  — — —

Delete calendar  —  — — —

View calendar  —    
Configuration/Licensing category

Edit configuration/license   — — — —

View configuration/licensing   — — — —

Connections category

Add connection   — — — —

Edit connection    — — —

Delete connection   — — — —

View connection     — —

Edit machine name    — — —

Edit agent job limit    — — —

General category

Add public data    — — —

View logs     
View reports  —    
View history  —    —
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View master status    — —

Move jobs to production  — — — — —

Move own jobs to production  — — — — —

Job Actions category

Add job actions  —  — — —

Edit job actions  —  — — —

Delete job actions  —  — — —

(Continued)

View event actions  —    —

Job Classes category

Add job class  —  — — —

Edit job class  —  — — —

Delete job class  —  — — —

View job class  —    
Job Console (Activity) category

View all  —   
View own  —    
Edit all  — — — — —

Edit own  — — — — —

Control all  —   — —

Control own  — — —  —

Job Control category

Ad hoc job control  —    —

Cancel/abort — —    —

Hold/stop  —    —

Override  —   — —

Release/resume  —   — —

Rerun  —    —

Set status  —   — —

Job Events category

Add job events  —  — — —

Table 3-39 Default Security Policies and Associated Functions
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Edit job events  —   — —

Delete job events  —  — — —

View job events  —    
Allow all jobs  —   — —

(Continued)

Table 3-39 Default Security Policies and Associated Functions
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Jobs category

Add jobs  —  —  —

Edit jobs  —  — P —

Delete jobs  —  — — —

View jobs  —    
Assign job events  —    —

Enable jobs  — — — — —

Queues category

Add queue    — — —

Edit queue     — —

Delete queue    — — —

View queue      
Edit system queue    — — —

Edit native priority    — — —

Resources category

Add resources    — — —

Edit resource     — —

Delete resource    — — —

View resource      
Schedule category

Create schedule  —  — — —

Pause/resume schedule  —   — —

Shutdown Scheduler — — — — — —

Security category

Add security   — — — —

Edit security   — — — —

Delete security   — — — —

View security   — — — —

(Continued)
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System Events category

Add system event  —  — — —

Edit system event  —   — —

Delete system event  —  — — —

View system event  —    
Timezone category

Add Timezone — — — — — —

Edit Timezone — — — — — —

Delete Timezone — — — — — —

View Timezone — — — — — —

User Administration category

Add users   — — — —

Edit users   — — — —

Delete users   — — — —

View users  P   — —

Edit personal data      —

Assign security policy   — — — —

Assign runtime users     — —

Impersonate user    — — —

Assign agents   — — — —

Variables category

Add variables    — — —

Edit variables     — —

Delete variables    — — —

View variables      —

Workgroups category

Add workgroup    —  —

Edit workgroup    —  —

(Continued)

Delete workgroups   — — — —

View workgroups      —

Table 3-39 Default Security Policies and Associated Functions
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Fault Monitor category

Control FaultMon — — — — — —

View FaultMon — — — — — —

PeopleSoft Jobs category

Add PeopleSoft Jobs    — — —

Edit PeopleSoft Jobs     — —

Delete PeopleSoft Jobs   — — — —

View PeopleSoft Jobs      
OracleApps Jobs category

Add OracleApps Jobs    — — —

Edit OracleApps Jobs     — —

Delete OracleApps Jobs    — — —

View OracleApps Jobs      
Remote Jobs Jobs category

Add Remote Jobs Jobs    — — —

Edit Remote Jobs Jobs     — —

Delete Remote Jobs Jobs    — — —

View Remote Jobs Jobs      
SSH Jobs category

Add SSH Jobs    — — —

Edit SSH Jobs     — —

Delete SSH Jobs    — — —

(Continued)

View SSH Jobs      
JMS Jobs category

Add JMS Jobs    — — —

Edit JMS Jobs     — —

Delete JMS Jobs    — — —

View JMS Jobs      
JMS Events category

Add JMS events  —  — — —

Table 3-39 Default Security Policies and Associated Functions
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Edit JMS events  —   — —

Delete JMS events  —  — — —

View JMS events  —    
Suspend Monitorings   — — — —

Resume Monitorings   — — — —

Variable Events category

Add Variable Events    — — —

Edit Variable Events     — —

Delete Variable Events    — — —

View Variable Events      
Suspend Variable Events   — — — —

Resume Variable Events   — — — —

File Events category

Add File Events    — — —

Edit File Events     — —

Delete File Events    — — —

View File Events      
Suspend Monitorings   — — — —

Resume Monitorings   — — — —

(Continued)
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Email Events category

Add Email Events     — —

Edit Email Events     — —

Delete Email Events     — —

View Email Events      
Suspend Email Events   — — — —

Resume Email Events   — — — —

Horizon Jobs category

Add Horizon Jobs     — —

Edit Horizon Jobs     — —

Delete Horizon Jobs     — —

View Horizon Jobs      
MSSQL Events

Add MSSql Events    — — —

Edit MSSql Events     — —

Delete MSSql Events    — — —

View MSSql Events      
Suspend Monitorings   — — — —

Resume Monitorings   — — — —

MSSql Jobs category

Add MSSql Jobs     — —

Edit MSSql Jobs     — —

Delete MSSql Jobs     — —

View MSSql Jobs      
Oracle DB Events

Add Oracle DB Events    — — —

Edit Oracle DB Events     — —

Delete Oracle DB Events    — — —

(Continued)

View Oracle DB Events      
Suspend Monitorings   — — — —

Table 3-39 Default Security Policies and Associated Functions

Function Sc
he

du
le

r-
A

dm
in

A
dm

in
is

tr
at

or

Sc
he

du
le

r

O
pe

ra
to

r

U
se

r

In
qu

ir
y

3-101
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 3      Users
  Security Policies Pane
Resume Monitorings  
Oracle DB Jobs

Add Oracle DB Jobs    
Edit Oracle DB Jobs    
Delete Oracle DB Jobs    
View Oracle DB Jobs      
PeopleSoft Jobs

Add PeopleSoft Jobs    
Edit PeopleSoft Jobs    
Delete PeopleSoft Jobs    
View PeopleSoft Jobs      
People Tools

Enable People Tools Access   
SAP Events

Add SAP Events   
Edit SAP Events    
Delete SAP Events   
View SAP Events      
Suspend Monitorings  
Resume Monitorings  
SAP Jobs

Add SAP Jobs   
Edit SAP Jobs    
Delete SAP Jobs   
View SAP Jobs      
View Job Log

(Continued)

View Job Spool

SAP Variants

Add/Edit Variants   
Delete Variants   

Table 3-39 Default Security Policies and Associated Functions
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SAP Process Chains

Enable Planning View   
WebService Jobs

Add WebService Jobs   
Edit WebService Jobs    
Delete WebService Jobs   
View WebService Jobs      
Agent Lists category

Add agent list   
Edit agent list   
Delete agent list   
View agent list     v 
Alerts category

Acknowledge alert  
Close alert  
View alert     
Calendars category

Add calendar  
Edit calendar  
Delete calendar  
View calendar     
Configuration/Licensing category

Edit configuration/license  
View configuration/licensing  

(Continued)
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Connections category

Add connection  
Edit connection   
Delete connection  
View connection    
Edit machine name   
Edit agent job limit   
General category

Add public data   
View logs     
View reports     
View history    
View master status   
Move jobs to production

Job Actions category

Add job actions  
Edit job actions  
Delete job actions  
View event actions    
Job Classes category

Add job class  
Edit job class  
Delete job class  
View job class     
Job Console (Activity) category

View all    
View own     
Edit all 

Table 3-39 Default Security Policies and Associated Functions
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Security Policies Pane Interface
From the Navigator pane, select Administration>Security Policies to view the Security Policies 
pane. 

All existing security policy names are displayed. If security policies do not appear, you do not have the 
appropriate rights to view security policies.

Buttons

The Security Policies pane interface contains the following buttons:

• Add Security Policy – Displays the Security Policy Definition dialog to add a new security 
policy.

• Edit Security Policy – Displays the Security Policy Definition dialog to edit an existing security 
policy.

• Delete Security Policy – Removes the selected security policy definition from the TES database.

• Refresh – Updates the data in the current pane.

• Print – Displays the Reports pane to view and print your security policy definitions. For more 
information, see <Jumps>“Monitoring Production” on page 361.

• Note to the Writer: Unable to update these cross ref

Search Field

Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See <Jumps>“Searchable Columns” on page 35.

Columns

The Security Policies pane interface contains the following columns:

• Name – The name of the security policy.

• Description – A description of the security policy. The Description field in the Security Policy 
Definition is optional, so there may not be any data in this column.

• Modified – The last time the security policy was modified.

Security Policies Preferences 

Select View>Preferences from the main menu bar while viewing the Security Policies pane to 
display the Security Policies Preferences dialog.

From this dialog, you can select which columns are displayed in the Security Policies pane and in what 
order they appear.

• A checkmark to the left of a column title indicates that it will be displayed in the pane. No 
checkmark indicates that it will not be displayed.
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• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.

Navigator Context Menu

When you right-click in the Navigator pane while viewing the Security Policies pane, the Navigator 
context menu displays. 

This context menu contains the following options:

• Add Security Policy – Displays the Security Policy Definition to add a new security policy. Has 
the same function as the Add Security Policy button. 

• Preferences – Displays the preferences for the Security Policies pane.

• Print – Displays the Reports pane to view and print your security policy definitions. Has the same 
function as the Print button on the toolbar. For more information, see <Jumps>“Monitoring 
Production” on page 361.

• Export – Saves the data in the current pane as an HTML file. 

• Refresh – Updates the data in the current pane.

• Note to the Writer: Unable to update these cross ref

Security Policies Context Menu

When you right-click in the Security Policies pane, the Security Policies context menu displays. 

This context menu contains the following options:

• Add Security Policy – Add a new security policy definition by displaying the Security Policy 
Definition. 

• Edit Security Policy – Edit the selected security policy by displaying the Security Policy 
Definition. 

• Delete Security Policy – Deletes the selected security policy. 

• Print Security Policies – Displays the Reports pane to view and print your security policy 
definitions. For more information, see <Jumps>“Monitoring Production” on page 361.

Security Policy Definition Dialog

The Security Policy Definition displays when you edit or add a security policy from the Security 
Policies pane.

Common To All Tabs

Security Policy Name – The name of the security policy (up to 30 characters). Each security policy 
name must be unique.

Functions TabThis tab contains the following elements:

• Category – Functions are grouped into categories, as shown in the tables in “TES Functions” 
section on page 3-79. 

– No checkmark to the left of the category means that none of the functions in that category are 
assigned.
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– A gray checkmark to the left of the category means that some of the functions in that category 
are assigned. 

– A black checkmark to the left of the category means that all of the functions in that category are 
assigned.

• Functions Assigned – The list of functions assigned to the security policy. 

For more information about TES functions, see “TES Functions” section on page 3-79.

Checklist Context Menu

Double-clicking a function category displays a small checklist context menu in the Functions 
Assigned column. The checklist context menu displays all the functions that belong to that category. 
Clicking the Browse button to the far right of the category, next to the Functions Assigned column, 
will also display the checklist for that category. Click Close in the checklist to return to the Functions 
tab. A black checkmark to the left of a function signifies that the function has been selected. No 
checkmark to the left of a function signifies that the function has not been selected.

Functions Tab Context Menu

Right-clicking the Functions tab of the Security Policy definition displays the following context menu 
of options for granting and revoking basic functions in all categories simultaneously in the security 
policy:

Note The options in the Functions context menu to grant or revoke all of a type of function only apply to the 
basic functions. More advanced functions must be granted/revoked individually. For example, the Grant 
All Edit option grants the Edit Queue function but not the more advanced functions of Edit System 
Queue or Edit Nice Queue Value.

• Grant All Functions – Enables all functions in all categories, in effect, giving the user Superuser 
privileges. 

• Grant All Functions for Category – Enables all functions in a selected category. 

• Grant All Add – Enables each of the basic Add functions in each category.

• Grant All Edit – Enables each of the basic Edit functions in each category.

• Grant All Delete – Enables each of the basic Delete functions in each category.

• Grant All View – Enables each of the basic View functions in each category.

• Revoke All Functions – Cancels all functions in all categories.

• Revoke All Functions for Category – Cancels all functions in a selected category.

• Revoke All Add – Cancels each of the basic Add functions in each category.

• Revoke All Edit – Cancels each of the basic Edit functions in each category.

• Revoke All Delete – Cancels each of the basic Delete functions in each category.

• Revoke All View – Cancels each of the basic View functions in each category.

Description Tab

Description – Any user comments regarding the security policy, up to 255 characters.
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Security Policy Procedures

Adding a Security Policy

Though each user must have a security policy, not all security policies need to be assigned to users. It is 
recommended that the administrator assign functions to a security policy on a need-to-use basis. New 
user definitions are assigned the Operator security policy by default.

To add a security policy:

Step 1 From the Navigator pane, select Administration>Security Policies to display the Security 
Policies pane. 

All existing security policy names display. If security policies do not appear, you do not have the 
appropriate rights to view security policies.

Step 2 Click the Add button or right-click and select Add Security Policy from the context menu to display 
the Security Policy Definition dialog.

Step 3 In the Security Policy Name field, type the name of the security policy. 

Step 4 The name must be unique and the length must not exceed 30 characters.

Step 5 Click the Functions tab and select the functions to assign to the security policy. 

Step 6 For more information about TES functions, see “TES Functions” section on page 3-79.

Step 7 Click the Description tab and type a description for the security policy, up to 255 characters. (optional)

Step 8 Click OK to close the security policy. 

Step 9 The security policy is added to the TES database. The security policy can now be assigned to users.

Assigning Functions to a Security Policy

To assign a function:

Step 1 From the Navigator pane, select Administration>Security Policies to display the Security 
Policies pane. 

All existing security policy names display. If security policies do not appear, you do not have the 
appropriate rights to view security policies.

Step 2 Double-click the security policy, or select the security policy record and click the Edit button or 
right-click the security policy and select Edit Security Policy from the context menu to display the 
Security Policy Definition dialog. 

Step 3 All function categories appear in the Category column on the Functions tab. 

Step 4 Double-click a category to display a drop-down list of available functions. 

Step 5 Click the individual check box for each function to add or remove the function or right-click a category 
and select the Grant All Functions option from the context menu to select all functions of a category. 
(Conversely, select the Revoke All Functions option to remove the functions for a category.)

Step 6 Click Close in the checklist context to return to the Functions tab. 
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Deleting a Security Policy

Note You cannot delete a security policy that is being used by any user. You must assign a different security 
policy to each user using that security policy before you can delete it.

To delete a security policy:

Step 1 From the Navigator pane, select Administration>Security Policies to display the Security 
Policies pane. 

All existing security policy names display. If security policies do not appear, you do not have the 
appropriate rights to view security policies.

Step 2 Select the security policy you want to delete.

Step 3 Click the Delete button on the TES toolbar. 

Step 4 Click OK in the Delete Confirmation dialog. 

Editing a Security Policy

With appropriate security rights, you can change functions available to a user by editing the user's 
security policy.

To edit a security policy:

Step 1 From the Navigator pane, select Administration>Security Policies to display the Security 
Policies pane. 

All existing security policy names display. If security policies do not appear, you do not have the 
appropriate rights to view security policies.

Step 2 Double-click the security policy to edit or select the security policy and click the Edit button or 
right-click the security policy and select Edit Security Policy from the context menu. 

Step 3 The Security Policy Definition dialog displays. 

Step 4 You can change the name, description, and set of functions available to the user who has the security 
policy.

Step 5 To change the functions assigned, click the Functions tab and add or remove functions. 

Step 6 For information about how to assign functions, see “Assigning Functions to a Security Policy” section 
on page 3-108.
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Job Activity

Overview
The Job Activity pane displays information about jobs presently in the production schedule. To see jobs 
that have been defined but that are not currently scheduled, you need to open the Jobs pane. For more 
information about the Jobs pane, see <Jumps>“Jobs” on page 139. 

Note Remember that the security rights of a user will always affect what they are allowed to see in Scheduler. 
The Job Activity pane may show all jobs currently scheduled or only the jobs owned by the user and the 
user’s workgroup, depending on the user’s security policy.

The messages that display information about each job and group use different colored text to indicate 
their status, with a row background color of white. For example, carry over job rows display a 
background color of light gray. 

Job groups are presented in bold with an expand or collapse button in the first column. All jobs in a job 
group are slightly indented and can be collapsed into and expanded from the group.

Use the scroll bars to view all the columns in the Job Activity pane. The Job Activity pane makes a large 
amount of important job information easily accessible. In the case of estimated start times and durations, 
the values displayed are periodically updated as new data becomes available. You can also press the F5 
key for an instant refresh.

The Job Activity pane displays can be customized through the Preferences dialog. For more information 
on how to customize the Job Activity pane, see “Job Activity Preferences Dialog” section on page 4-114.

If the schedule in the Job Activity pane is a “forecast” for a future date (Forecast Only option selected 
when creating a schedule), then the word “Forecast” displays after the date in the pane title bar.

Job Activity Pane Interface
From the Navigator pane, select Operations > Job Activity to display the Job Activity pane.

You can double-click a job in the Job Activity pane to open its Job Details dialog.
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Note When you view a particular day in the production schedule, all jobs that have not been launched on 
previous days will also appear (unless you have filtered them out). This includes jobs in Active, Waiting 
On Resources, Waiting On Operator, Waiting On Dependencies, Stopped, Held, Agent Unavailable and 
Agent Inactive states.

Buttons
The Job Activity pane contains the following buttons:

• Refresh – Refreshes the Job Activity pane.

• Filter – Displays the Job Filter dialog to customize the data that displays in the Job Activity pane.

• View Time By – Displays the View Time By dialog. Allows you to view jobs according to the time 
zone of the master doing the scheduling, the Tidal Web client you are using or an agent that you 
select.

• Prior Day – Displays the production schedule for the day before the one currently displayed.

• Next Day – Displays the production schedule for the day after the one currently displayed.

• Select Day – Displays the production schedule for “today” or any other day.

• Print – Displays the Reports pane to view and print the contents of the Job Activity pane. For more 
information, see <Jumps>“Monitoring Production” on page 361.

• Graphical View – Displays a graphical view of the Job Activity pane.

Search Field
Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See “Searchable Columns” on page 44.

Columns
The order of the columns listed in the Job Activity pane can be rearranged from the Job Activity 
Preferences dialog.

The Job Activity pane contains the following columns:

• Job No. – The job number is the instance identification number of the job or group occurrence. Each 
occurrence or instance of a job is assigned a unique tracking number when it is added to the schedule 
to distinguish it from any other occurrences of the job. It is possible that the same job may run 
several times during a day.

• Name – The name of the job.

• Status – The present status of the job. The color of text used for each job and Job Group is based on 
its status. You can customize the status colors and sort order using the Preferences dialog.

• Current Est Start – The estimated start time as of the current moment in time. This start time value 
is updated every minute. 
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• Est Duration – The estimated duration for the command or executable as specified in the job 
definition. If the job has run more than once with the same command or executable, the estimated 
duration is the historical average of the job’s previous run times. You can also manually set the 
estimated duration time of a job in its definition.

• Reruns – Tracks the number of times that a job has run. 

• Est Start – The estimated job time calculated using the estimated launch times and estimated 
durations of preceding jobs. This value is created at the time the production schedule is compiled. 

• Time Zone – The assigned job timezone. The time value adjusts the timezone offset into Master 
time.

• Job Time Zone – The timezone the job was run in.

• Act Start – The job’s actual start time after it has launched. 

• Act End – The actual ending time and date for the job occurrence.

• Act Duration – The actual time that it took for the command or executable to run. The actual 
duration is used to calculate the historical average of the Est Duration field in the job’s definition. 
The actual duration value is 0 until after the job completes. 

Note The displayed value for the Actual Duration value of a job is updated every 90 seconds.

• Date – The production date of the job. If the job does not execute until the next day, this date stays 
the same, since it represents when the job was scheduled to run based on its calendar or when the 
job was inserted as an unscheduled job.

• Time window – The time window during which the job can run as defined in the job’s definition. 
The default, 12:00 AM to 11:59 PM, effectively means the job is eligible to run anytime during the 
day.

• Agent – The name of the agent or agent list associated with the job, as specified in the job definition. 
This field displays the agent list name prior to the job running and then displays the chosen agent 
from the list after it is launched.

• Queue – The queue that the queue manager assigns to the job. The queue to which the job is assigned 
depends upon the job’s properties, and the way that the queues are configured to assign jobs using 
queue filters. 

• Priority – The job priority as defined in the job’s definition. Job priorities are only relative to the 
job priorities of other jobs within its queue before running. 

• Runtime User – The user account that the job runs under when it executes.

• Scheduled By – How the job entered the schedule. There are three options:

– Event – The job was inserted by an action that was initiated by an event.

– Calendar – The job was compiled into the schedule according to its calendar.

– On Demand – The job was an ad hoc insertion through either operator action or the command 
line.

• Owner – The user who owns the job. If the job is owned by a workgroup, the owner of the 
workgroup. Note that this column does not display the workgroup name itself, but the owner of the 
workgroup.

• Parent Group(s) – All of the parent job groups that the job or job group belongs to. If the job or job 
group belongs to several job groups, the group path is shown.
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• Command – The command, program or script that the job will execute, as specified in the job’s 
definition. The command path is relative to the agent machine on which the job runs. The command 
data includes any command parameters. 

• Exit Code – The exit code that the command returns when the job is complete. The exit code is one 
way of determining whether the completion status of the job is Completed Normally (the exit code 
equals 0) or Completed Abnormally (the exit code does not equal 0). The exit code value can range 
from 0 to 30,000.

• Job Full Name – The full directory path to the job and its job group name.

• Job Type – The type of job.

• Parent Group – The immediate parent job group that the job or job group belongs to.

• Job Class – The job class the job is assigned to, if any.

• Alias – An alternate name for the job, as set in its job definition. The job alias is limited to eight 
characters and due to this limitation is often used in the command line mode to refer to a job.

• Predecessors – The job dependencies that have to be fulfilled before this job can run. This job will 
not run until the Predecessors have fulfilled the conditions set in this job’s definition.

• Successors – Jobs that use this job as a job dependence. This job must fulfill a certain condition 
before Successors can run.

• Group Instance – The group instance number applies only to jobs and groups with a parent group. 
As opposed to the day instance number (also known as the job ID) which is unique, the Group 
Instance is relative to other jobs in the parent group.

• Agent Instance – The agent instance number applies only to broadcast jobs. For more information 
on broadcast jobs, see Controlling Production. The Agent Instance is relative to other jobs run by 
the same agent.

• Ext ID – This number corresponds to the External ID field in a job’s Job Detail dialog. This 
number is the process ID number that the Windows operating system assigns to the highest level 
process within the job. If this is a SAP or PeopleSoft job, the Ext ID is the same as the SAP or 
PeopleSoft job ID.

• WaitOp – Indicates if a job is waiting for the operator to release it.

• Calendar – Displays the name of the calendar associated with the job instance.

Each column can be sorted in either ascending or descending order. Click any column name to change 
the column sort. For example, click Name on top of the Name column. The items in the column 
alphabetize from z to a. Click Name again and the items alphabetize from a to z. For a column that is 
numerical, the sort changes from earliest to latest time, or latest to earliest time.

Job Activity Preferences Dialog
Select View>Preferences from the main menu bar while viewing the Job Activity pane to display the Job 
Activity Preferences dialog.

Columns Tab

From the Columns tab, you can select which columns are displayed in the Job Activity pane and in what 
order they appear.

• A checkmark to the left of a column title indicates that it will be displayed in the pane. No 
checkmark indicates that it will not be displayed.
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• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.

Status Color Tab

The Status Colors tab lists every possible status a job can have. From the drop-down menu to the right 
of each field, you can select the color to represent that status in the Job Activity pane.

Grid Background Color Tab

On the Grid Background Color tab select an option from the drop-down menus to the right of each field. 
You can select the color to represent the grid background color in the Job Activity pane.

Navigator Context Menu
When you right-click in the Navigator pane while viewing the Job Activity pane, the Navigator context 
menu displays. 

This context menu contains the following options:

• Statistics – Displays the Job Statistics dialog showing the number of scheduled and unscheduled 
jobs in the present day’s production schedule.

• Filter – Displays the Job Filter dialog to filter the job occurrences that are displayed in the Jobs 
pane according to criteria you select. Has the same function as the Filter button on the toolbar. You 
can also custom-sort job occurrences. For more information about the Job Filter dialog, see 
<Jumps>“Job Filter Dialog” on page 126.

• Group Display – Selecting Group Display brings up the Group Display submenu with the 
following menu options:

– Expand Selected – Expands one level on the selected job group, displaying its child jobs. If 
multiple groups are selected, only the first group selected is expanded.

– Collapse Selected – Collapses one level on the selected job group, hiding its child jobs. If 
multiple groups are selected, only the last job group selected is collapsed.

– Expand All – Expands all levels on the currently selected group, respectively. 

– Collapse All – Collapses all levels on the currently selected job groups to hide all child jobs.

• Prior Day – Displays the production schedule for the day before the one currently displayed. Has 
the same function as the Prior Day button on the toolbar.

• Next Day – Displays the production schedule for the day after the one currently displayed. Has the 
same function as the Next Day button on the toolbar.

• Select Day – Displays a calendar from which you can select the date whose production schedule you 
want to view. Has the same function as the Select Day button on the toolbar.

• Save View As – Displays the Save View dialog to name the view that you would like to save.

• New Root Folder – Displays the New Root Folder dialog to name the new root folder that you 
would like to create in the Navigator pane.

• New Sub Folder – Displays the New Sub Folder dialog to name the new sub folder that you would 
like to create in the Navigator pane.

• Preferences – Displays the Preferences dialog for the Job Activity pane.
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• Print – Displays the Reports pane to view and print your connection definitions. Has the same 
function as the Print button on the toolbar. For more information, see <Jumps>“Monitoring 
Production” on page 361.

• Export – Saves the data in the current pane as an ASCII text file. You can then use the file data in 
other applications. 

• Refresh – Updates the data in the current pane.

Job Activity Pane Context Menu
When you right-click in the Job Activity pane, the Job Activity context menu displays. 

The Job Activity context menu contains the following options:

• Refresh – Updates the data in the Job Activity pane.

• Filter – Displays the Job Filter dialog to filter the job occurrences that are displayed in the Jobs 
pane according to criteria you select. You can also custom-sort job occurrences. For more 
information about the Job Filter dialog, see <Jumps>“Job Filter Dialog” on page 126.

• Print – Displays the Reports pane to view and print your jobs. Has the same function as the Print 
button on the toolbar. For more information, see <Jumps>“Monitoring Production” on page 361.

• Print Selected – Displays the Reports pane to view and print your job selections. 

• View Time By – Selecting View Time By displays the View Time by Agent dialog. From here, you 
can choose to view job times according to the time zone of your master, current Tidal Web client or 
an agent that you specify.

• Group Display – Selecting Group Display brings up the Group Display submenu. The menu 
options are as follows:

– Expand Selected – Expands one level on the selected job group, displaying its child jobs. If 
multiple groups are selected, only the first group selected is expanded.

– Collapse Selected – Collapses one level on the selected job group, hiding its child jobs. If 
multiple groups are selected, only the last job group selected is collapsed.

– Expand All – Expands all levels on the currently selected group, respectively. 

– Collapse All – Collapses all levels on the currently selected job groups to hide all child jobs.

• Prior Day – Displays the production schedule for the day before the one currently displayed.

• Next Day – Displays the production schedule for the day after the one currently displayed.

• Select Day – Displays a calendar to select the date whose production schedule you want to view.

• Graphical View – If you selected the Use New Graphical View Layout Manager option on the 
Other tab of the System Configuration dialog, this option displays instead of the View option. 
Select this option again to return to the original view. (Refer to <Jumps>“Business Views Pane 
Interface” on page 263 for more information.) If this option is selected (a check mark is beside the 
option), the following menu options also are available. 

• Details – When in the Jobs pane, displays the Job Detail dialog for the selected job occurrence. 
Alternately, you can display these dialogs by double-clicking the individual job record.

• Statistics – Displays the Job Statistics dialog showing the number of scheduled and unscheduled 
jobs in the present day’s production schedule.

• Goto Now – Sets the job pane’s date to the current date. 
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• Job Control – Displays a submenu with options for manipulating jobs. For more information on job 
control menu options, see <Jumps>“Job Control Submenu” on page 117.

• Insert Job into Schedule – Adds one new occurrence of the selected job into the production 
schedule regardless of the job’s (or job group’s) calendar setting or number of times the job is 
scheduled to repeat during the day. When a job or a job group is added, and the job or job group 
already resides in the production schedule, an incremented occurrence number appears next to the 
job occurrence in parentheses, i.e., Job A (2).

• Remove Job(s) from Schedule – Removes the selected job occurrence from the production 
schedule. If you wish to remove all future occurrences of the job within the schedule, select the All 
option in the Confirmation dialog. The job occurrence cannot be removed unless it has a pre-launch 
status.

• Require Operator Release – Holds the job until an operator releases it. The job will not run until 
it is released. When all the job’s dependencies are met, and it is ready to run, its status is Waiting 
On Operator. The information in the Operator Instructions field (Description tab) can inform the 
operator of any external requirements that need to be met before the job is released.

• List Instances – Lists all job instances 

• Successors – Advises which jobs, if any, are dependent on the currently selected job.

Job Control Submenu
When you select Job Control from the Job Activity context menu, a submenu displays.

Note After selecting a job control action from the menu, a context dialog confirms the success or failure of 
the action.

This submenu contains the following options:

• Override – Overrides all unmet dependencies and changes the selected job status from Waiting On 
Dependencies to Waiting on Resource or Waiting On Operator. The job must have the status of 
Waiting On Dependencies for this job control function to be available. (For information on 
overriding individual dependencies, refer to <Jumps>“Dependencies Tab” on page 121.)

• Hold/Stop – When a job is in the Held or Stopped state, the execution of the job will not begin or 
continue until it is manually released. Because Windows does not support the pausing and resuming 
of a process, the Hold/Stop option is not available for Windows jobs.

• Hold – Changes the selected job status from Waiting On Dependencies, Waiting On Resource, 
Agent Inactive, or Agent Unavailable to Held. When a job group’s occurrence is selected, places 
all waiting jobs in Held status, and all active jobs in Stopped status.

• Stop – Changes the selected job status from Active to Stopped. 

• Release/Resume – This command recommences the execution of a job at the point at which it was 
stopped (suspended). On non-Windows agents, the Release/Resume command can also take a job 
in the Held state and release it so that it will launch once all of its dependencies have been met. 
Because Windows does not support the pausing and resuming of a process, the Release/Resume 
option is not available for Windows jobs.

– Release – Changes the selected job status from Waiting On Operator or Held, to Active (with 
an intermediate Scheduled state). When a job group’s occurrence is selected, Release changes 
the job group’s status from Waiting On Operator to Active (with an intermediate Scheduled 
state), and changes all child job statuses from Waiting On Group to Scheduled.
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– Resume – Changes the selected job status from Stopped to Active. Also changes the selected 
job status from Held to Waiting On Dependencies (with an intermediate Scheduled state). 
When a job group’s occurrence is selected, changes its status from Held to Active (with an 
intermediate Scheduled state). All child jobs that were Stopped become Active, and all that 
were Held become Waiting On Dependencies.

• Cancel/Abort – Prevents or stops a job from running in the production schedule. TES agents react 
differently when a job with child jobs is aborted, depending upon the agent type and operating 
system.

– Cancel – Changes the selected job status from Agent Inactive, Agent Unavailable, Deferred, 
Held, Waiting On Dependencies, Waiting On Operator, or Waiting On Resource to 
Canceled. Canceled jobs do not run in the production schedule.

– Abort – Changes the selected job status from Active or Stopped to Aborted, and kills the active 
job process on the system.

Caution Avoid excessive aborting of job processes as this may lead to system instability. Instability may appear 
after more than 10 job aborts. Restore system stability by rebooting the agent machine.

When selecting Cancel/Abort you can choose to release the selected job’s dependents. If you 
choose to release, the dependent job will no longer be dependent on the job you are canceling or 
aborting.

• Cancel Pending – Stops or prevents a job instance from running but overrides the dependencies in 
the job stream so that children of the job will consider the parent to have completed normally. In a 
job group, all of the children also go to Cancel Pending status. Once all of the dependencies of the 
jobs in Cancel Pending status complete, the jobs end in a Cancel Normally status which is 
considered the same as Completed Normally.

• Cancel/Abort All – Prevents all occurrences of a job that are not complete from running in the 
production schedule. When you select Cancel/Abort All, you can choose whether to release the 
selected job’s dependents. If you choose to release, the dependent job will no longer be dependent 
on the jobs you are canceling or aborting.

Table 4-1 Agent Cancel/Abort Behavior

Type of Agent Abort Behavior of Jobs

Agent for Windows When TES launches a job, a Windows Job Object 
is created that spawns the actual job process. 
Aborting the job in TES, destroys the job object 
and kills the job process. If you abort a job on 
Windows, all of its child processes are aborted 
also.

Agent for Unix Aborting a job sends a SIGTERM (request to 
terminate) message to the job and its child 
processes before sending a SIGKILL message 
that actually kills all of its child processes. The 
interval between the SIGTERM and SIGKILL 
signals can be configured. More information on 
configuring agent parameters is available in 
Installing the Unix Agent chapter of the 
Installation and Configuration Guide.
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• Rerun – Changes the selected job status from Aborted, Completed Normally, Completed 
Abnormally or Error Occurred to Active (with an intermediate Scheduled state). A new instance 
ID of the job is not created. You cannot rerun a job with the status of Externally Defined, Orphaned 
or Skipped.

• Set – Changes the selected job or job group completion status. The selected status can affect all other 
jobs dependent on that job or job group. When a status is changed with this command, an asterisk 
appears after the new status. For example, Completed Normally*. You can choose from the 
following: Completed Normally, Completed Abnormally, Externally Defined, Error Occurred, 
Orphaned or Skipped. 

View Time By Dialog
The View Time by Agent dialog displays by clicking the View Time By button on the TES toolbar while 
in the Job Activity pane.

This dialog configures the times displayed in the schedule according to the time zone of one of the 
system components. TES may be managing a production schedule that includes components that are 
spread out over a wide geographic area. This geographic area may encompass several time zones. When 
you are scheduling jobs over diverse timezones you have to account for the fact that the master, agent 
and Tidal Web client may be in different time zones.

Note You can configure the jobs to run according to the timezone used by the master or by the agent from the 
Timezone tab of the System Configuration dialog. Master and Job Based Timezone offset will be applied 
into all time value for that job.

You can configure the Tidal Web client to display the estimated and actual times of jobs from the 
viewpoint of one of the following components:

• Master – The master controlling the production schedule

• Client – The Tidal Web client being used

• Job – The job being run

• Agent – The agent running the job

Job Detail Dialog
The Job Detail dialog displays when you double-click a job occurrence record in the Job Activity pane 
or right-click and select Details from the context menu.The details shown for a job differ from the details 
for a job group, thus while the Job Details dialog for a job group is very similar, it does not have the 
same tabs as a job does.

Common To All Tabs
• Job Name – The name of the job as defined in its job definition.

• Job No. – The job’s instance number.
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• Print – Clicking this button displays a report that lists the same fields of information contained 
within on the various tabs of this Job Detail dialog. This report can be saved or printed. You can 
elect to display the report with or without the job output if the job has run.

• Defaults – This button becomes available whenever you make a change to the job’s parameters from 
the Override tab. Clicking the Defaults button after a change returns all the fields on the Override 
tab to their original values. The Defaults button is then unavailable until the next override change. 
This button is unavailable from the other tabs of the dialog.

Status Tab
This tab contains the following elements:

• Status – The job’s current status. 

• Est. Start Time – Estimated job launch time based on its time dependencies and the launch times 
and estimated durations of preceding jobs. You can view all the dependent jobs on the Dependencies 
tab.

• Act. Start Time – The time the job became active. Until the job is active, this field is empty.

• Est. Duration – The estimated time it will take for the job to run. If the job has never run before, it 
contains the value in the Estimated Duration field in the job’s definition. Otherwise, it contains a 
historical average of the Actual Duration.

• Act. Duration – The actual time the job took to run. 

• Job Owner – The user that owns the job.

• Scheduled By – Indicates how the job entered the production schedule. Three possible values may 
be displayed here:

– Calendar – Compiled into the schedule based on an assigned calendar. 

– Event – Inserted by a job action based on an event trigger. 

– On Demand – Inserted by an operator via the Tidal Web client, command-line, API or Web 
Service.

• Exit Code – The exit code of the completed job (if the job has not completed, this field is blank). 
This field is not displayed for a job group. Exit code values mean:

– if the value equals 0, the job has completed normally

– if the value does not equal 0, the job has completed abnormally

• External ID – By default, this is the ID number assigned to the job process by the operating system. 
Certain job types have an External ID assigned by third party software, such as SAP or PeopleSoft.

• Reruns – The number of times the job has rerun for the day.

• Disable Carryover – Selecting this option prevents the job from being carried forward to the next 
day’s schedule if the job does not run on its scheduled day. If the Try again tomorrow option in 
the If not ready by end of day field on the Schedule tab of a job definition is selected, it will 
override the Disable Carryover option and the job will run on the next day.
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Audit Log Tab
Displays both user-initiated job interaction and production schedule audit trail messages for the job 
including job control actions, job occurrence status changes and errors. 
Double-click a record to display its details more clearly.

This tab displays the following information:

• Time – The date and time the audit was recorded.

• Description – The job audit or error message describing the change/error to the job. Audit 
information is retained according to the audit retention setting in the System Configuration dialog. 

• User – The user that submitted the job.

Output Tab
Displays the standard output of the job. TES can be configured to save or discard job output by default 
from the Defaults tab of the System Configuration dialog. Regardless of the system default, any 
individual job instance can be configured from its job definition to override the system default. 

• If the Append option in the Save Output field on the Options tab of the job definition is selected 
in the job’s definition, the job’s standard output file is transferred to the master and displayed on this 
tab. Each time a job is rerun that run’s output is separated by a block of number signs (#). 

• If the Replace option in the Save Output field is selected, then only the output from the last job 
instance that ran is saved. The output from the previous time that the job ran is overwritten. 

• If the Discard option of the Save Output field is selected than this tab will not have any job output 
displayed here. 

If a job is canceled before it can complete, any partial output that was generated during the processing 
of the job displays on the Output tab. Note that a job group does not have an Output tab in its Job Details 
dialog.

Note Scheduler’s default is to discard job output. To save or append job output or to specify that the output be 
produced in summary format, change the system default on the Defaults tab of the System Configuration 
dialog. This can be adjusted for individual jobs from the Options tab of that job’s Job Definition dialog.

You can refresh the output if parameters have been changed after runtime by clicking Refresh output.

Dependencies Tab
Shows all predecessors (job, file, time and variable dependencies) needed before a job can run. It also 
displays all successors occurring after the job runs.

From the Dependencies tab, you can override individual job dependencies for a job instance (but not for 
a job group). (To override all of a job instance’s dependencies, refer to the override section of the 
<Jumps>“Job Control Submenu” on page 117.) Other instances of the job are not affected when you 
override a dependency. 

There are three ways to override a dependency:

• Select the dependency in the Predecessors field and click the Override button.
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• Select the dependency in the Predecessors field, right-click to display the context menu and choose 
the Override option.

• Select the dependency in the Predecessors field and use the keyboard shortcut, Ctrl+O.

This tab contains the following elements:

• Include dependencies already satisfied option – When not checked, only dependencies that have 
not been met are displayed. Otherwise, met dependencies are displayed with a green box outlining 
the dependency’s icon. The default is checked to show all predecessors and successors.

• Predecessors – Displays files, times that must be met and hierarchical trees of earlier jobs that must 
reach a particular status before this job can run. Jobs on higher levels of the hierarchies depend upon 
jobs in lower levels.

• Override Button – Select a specific dependency and click the Override button to override the 
dependency for a job instance. 

• Successors – Displays a hierarchical tree of jobs that are dependent on the job in question. Jobs on 
lower levels of the hierarchies depend on the jobs above.

File Dependencies

File dependencies are defined in the job’s definition dialog, and are displayed with a file icon, the file’s 
path name and the dependency expression (Exist, Not Exist, etc…).

Job Dependencies

Job dependencies are defined in the job’s definition dialog and are displayed with a job icon, the job’s 
name, the selected logical operator (=, <>, etc…), its target status, and the present status. If the job is 
not currently in the production schedule, the icon changes to the not-in-schedule icon.

Note To have a job ignore a job dependency when the dependency is not in the schedule, select the Ignore 
dependency if job not in schedule option in the Job Dependency Definition dialog.

Time Dependencies

Time dependencies are displayed with a time icon, and indicate the time when the time dependency will 
be met.

Variable Dependencies

Variable dependencies are defined in the job’s definition dialog and are displayed with a variable icon, 
the variable’s name, its dependency expression and its present value in parentheses.

Resources Tab
The Resources tab of the Job Detail dialog displays information about any resources assigned to a job. 
The current and required system resource values, with a column showing the status of the resource, 
displays on this tab. In the case of a job that uses an agent list and has not yet been assigned an agent 
from the list, the current and status columns are grayed out.
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The possible statuses for the resource are:

• Available – The resource is available. The job cannot use the resource until all of its needed 
resources are available at the same time.

• Unavailable – The resource is unavailable. 

• Waiting – The resource is not available because another job is using the resource. 

• Locked – The job is running. All of the listed resources will display the Locked status. A job cannot 
run until all of its assigned resources are simultaneously available. When the resources do become 
available to the job, the job locks up its share of each resource until the job completes and the 
resource is released for use by other jobs.

A resource in a Locked status cannot be overridden to release it but a user could modify the 
resource's definition to temporarily increase its limit and make more of the resource available to 
other jobs. 

Note Resources cannot be assigned to a job group. If this is a job group definition, then the Resources 
tab is not displayed.

The Resources tab contains the following elements:. 

• Resource Consumption

– Type – The kind of resource that is being used, Virtual or Agent. 

– Resource Name – Displays the name of the resource associated with the job. 

– Amount Used – The amount of the resource's specified limit that the job uses. This number 
cannot exceed the number shown in the Amount Available column. 

– Amount Available – The amount of the resource that is available to be used. This number is 
derived by subtracting the amount of the resource currently in use from the limit specified in the 
resource’s definition.

– Status – Denotes the status of a resource assigned to the job. There are three possible statuses:

Available – The resource is available for the job.

Waiting – The resource is not currently available. The job is unable to run until the specified 
amount (shown in the Amount Needed column) of the resource is available.

Locked – The resource is being used by job. The amount of the resource being used by the job 
(shown in the Amount Used column) is unavailable to any other job until this job completes. If 
multiple resources are required for the job, then an all or nothing approach is used. No resource 
is locked up until all of the required resources are available and can be locked simultaneously. 

Note A resource in a locked status cannot be overridden to release it but a user could modify the 
resource's definition to temporarily increase its limit and make more of the resource 
available to other jobs.

• Resource conditions

– Type – The kind of resource that is being used, Published or Custom. 

– Resource Name – Displays the name of the resource associated with the job.

– Current – Displays the current value.

– Condition – Contains the conditional operators depending on the data type of the resource.
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– Required – Displays the amount of the resource needed by the job. This amount is defined in 
the Resource Requirement Definition dialog.

– Status – Denotes the status of a resource assigned to the job. There are three possible statuses:

Available – The resource is available for the job.

Waiting – The resource is not currently available. The job is unable to run until the specified 
amount (shown in the Amount Needed column) of the resource is available.

Locked – The resource is being used by job. The amount of the resource being used by the job 
(shown in the Amount Used column) is unavailable to any other job until this job completes. If 
multiple resources are required for the job, then an all or nothing approach is used. No resource 
is locked up until all of the required resources are available and can be locked simultaneously.

Variables Tab
Displays the variables used by the job group. These variables are isolated from any changes to their 
values that occur outside of this job group and its parent or child groups. The Job Details dialog for a 
job does not have a Variables tab.

Override Tab
Displays job properties that can be changed for this occurrence at any time while the job is waiting to 
run. After a job runs, it is only useful to change these values if you rerun the job. Changes made only 
affect the instance and not the rule as defined in the Job Definition dialog. The Job Details dialog for a 
job group does not have an Override tab.

Note After changing any of these values and clicking OK, you are prompted to confirm the changes, and you 
are given the choice to apply the changes to all occurrences of the job in today’s schedule if this is a 
repeating job. This applies to all repeating jobs that have not run yet, and all additions of this job that 
were inserted manually.

This tab contains the following elements:

• Agent – The agent that the job runs on. This is useful if the job failed on one agent and you want to 
rerun it on another. You can select from a list of active agents only. Be sure to choose an agent 
platform that will support the command in the command field.

• Agent List – The list of available agents that can run the job. The master assigns an agent to the job 
only when the job's dependencies are met and the job is ready to run. The master assigns an agent 
according to demands of the production schedule and the agent's job limit at the time that the job is 
ready to run.

Note Since the agent is not assigned to a job until the last minute, if a user looks at a Job Details dialog before 
the job runs (e.g., the job is in a Waiting on Dependencies state), the Agent field on the Override tab is 
empty. The master does not select an agent from the agent list displayed in the Agent List field until the 
job’s dependencies are met and the job is ready to run. Only then is the agent selected and the name of 
the agent displayed in the Agent field. If the job reruns, the master may assign a different agent from the 
agent list according to the demands of the production schedule.
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• Queue – Normally, jobs are automatically assigned to queues. You can use this field to override the 
automatic assignment. You may want to do this if the present queue is too full to run the job any time 
soon.

• Runtime User – The runtime user, if any, assigned to the job. If that user account is currently 
experiencing problems, you can select another runtime user in this field.

• Priority – The job priority. This value ranges from low (0) to high (100). This value is used to 
prioritize job execution by comparing with other jobs within the job’s destination queue.

• From Time – The start of a job instance’s time dependency pane. By modifying the time within this 
field, you can override the time dependency.

• Until Time – The end of a job instance’s time dependency pane. Modifying the time in this field 
overrides the jobs’s time dependency. 

• Remove Time Dependency – This button clears the values entered in the From Time and Until 
Time fields, removing the time dependency for this job instance.

• Defaults – This button becomes available whenever you make a change to the job’s parameters from 
the Override tab. Clicking the Defaults button after a change returns all the fields on the Override 
tab to their original values. The Defaults button is then unavailable until the next override change.

Runbook Tab
The Runbook tab is intended to supply any instructions for the user relative to the execution of this job. 
This field can be used effectively with the Require operator release option in the job’s definition. 

Notes Tab
Use this field to enter other notes concerning the job.

This tab contains the following elements:

• Other Notes – A free text field where you can type any instructions for the operator, up to 255 
characters long or enter a web address that provides relevant information about the job. If you 
selected the Require operator release option on the Options tab, you could use this field for 
detailed reminders about the circumstances under which to run this job with the Require operator 
release option selected.

A web address or network directory address can be entered here and if the Load URL option is 
selected, the specified directory or web page from an internet site or a company intranet site 
displays. The web page or directory pane that displays here is an active pane that can be refreshed 
and whose links and folders can be accessed by clicking. You can right-click a web page in this field 
to display a context menu of the same options available in the web browser.

• Load URL – If a web URL is entered in the text field and this option is selected then that web page 
displays in the text field. This web address can be for an internet site or a company intranet site. This 
can be very useful if information pertaining to a job is stored on a company intranet.
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History Tab
Details the job run history of every occurrence of this job in the production schedule sorted by Start 
Time and then by job number in descending order. The history includes jobs that have completed and 
jobs currently waiting to run either as repeated jobs and/or in future days of the production schedule. 
The history is retained according to the retention history setting in the job’s definition.

Note Columns in the History tab can be resized by clicking the right border bar and dragging left or right.

This tab contains the following elements:

• Job No. – The unique number assigned to the job occurrence (day instance).

• Date – The date on which the occurrence was scheduled to run.

• Status – The present or final status of the occurrence. For a description of job statuses, see 
<Jumps>“Jobs” on page 139.

• Act Start Time – For past or present jobs, the actual time the job occurrence started. For future jobs, 
this field is blank.

• Act End Time – For past jobs, the actual time the job occurrence ended. For jobs currently running 
or future jobs, this field is blank.

• Act Duration – The actual duration of the job.

• Est Start Time – For past or present jobs, the time the job was estimated to start. For future jobs, 
the estimated time the job occurrence is expected to start. The start time may vary due to system 
resource utilization, and job dependencies.

• Reruns – The number of times the job has been rerun.

• Command – The command path, name and parameters that were executed for the occurrence of the 
job.

• Priority – The priority of the job when the job ran.

Job Filter Dialog
The Job Filter dialog displays by right-clicking in the Job Activity pane and selecting the Filter option 
from the context menu.

The Job Filter dialog allows you to perform the following tasks:

• View only the jobs that have the statuses that you want to see.

• View jobs using wildcards to specify the job name.

• View jobs that are running or ran on a specific agent.

• View jobs that are owned by a specific user.

• View jobs that are run as a specific user.

• View jobs that belong to a specific job class.

• View jobs that will run in a certain queue.

• View jobs that run a certain command

• View only jobs, only job groups, or both.
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Note Filters only apply to jobs within groups, not to groups themselves. Groups are only displayed if at least 
one child within the group passes the filter criteria. If, according to the criteria, the group would be 
empty, the group is not displayed. If the Show Groups option is not selected, groups are ignored 
completely, and filters apply to the individual jobs which are now displayed outside of their group.

Status Filter
Use this filter to view only jobs with the statuses you are interested in. The default is all statuses (all 
selected). 

The Job Filter dialog contains the following status viewing options:

• Aborted – Shows all jobs that were actively running and were aborted by the operator.

• Active – Shows all jobs that are currently running in the production schedule. Jobs that run longer 
than a day are shown on the day it started.

• Agent Disabled – Shows all jobs that could not launch because their assigned agent is inactive.

• Agent Unavailable – Shows all jobs that cannot run because their assigned agent is either not online 
or not presently connected. 

• Canceled – Shows all jobs that were canceled by the operator.

• Completed Abnormally – Displays all jobs that completed with an exit code outside the designated 
normal range of values.

• Completed Normally – Displays all jobs that completed with an exit code within the designated 
normal range of values. This is configured on the Run tab of the job definition. The default exit code 
is 0 if a range of values is not specified.

• Deferred – Shows all jobs that were deferred because another occurrence of the job was running 
when the job was launched. These jobs have their concurrency option set to Deferred in their job 
definition.

• Error Occurred – Shows all jobs where an error occurred that prevented the job from running. Error 
messages can be examined in the Job Details dialog.

• Externally Defined – Shows all jobs that have a completion status defined by an external program.

• Held – Shows all jobs that were put on hold by an operator.

• Launched – Shows all jobs that are being launched by the Queue Manager.

• Orphaned – Shows all jobs where the connection between the agent and master failed while the job 
was running, and thus the job’s status is unknown.

• Scheduled – Shows all jobs that have been scheduled to run on future days, and jobs running today 
where the status has not yet been determined.

• Skipped – Shows all jobs that were skipped because another occurrence of the job was running 
when the job was launched. These jobs have the Skip option set in the If job is currently running 
field on the Options tab of their job definition.

• Stopped – Shows all active jobs that were stopped by an operator. Jobs can be resumed by using the 
Release job control menu item.

• Timed Out – Shows all jobs that could not launch during their date and time window and will never 
run because Timeout is selected in the If not ready by end of day field on the Schedule tab of the 
Job Definition dialog.
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• Timed Out for Day – Shows all jobs that missed or could not launch during their time window and 
cannot run for the rest of the day. These jobs will be carried forward to the next day because the Try 
again tomorrow option is selected in the Schedule tab of the Job Definition dialog.

• Waiting on Children – Shows all parent job groups that are waiting for their children to reach the 
necessary status. 

• Waiting on Dependencies – Shows all jobs that are waiting on time, variable, file or job 
dependencies. You can view all the job dependency information from the Job Details dialog by 
double-clicking the job in the Jobs pane. 

• Waiting On Group – Shows all jobs that are waiting on their job group’s dependencies to be 
satisfied. You can view the job group dependencies information from the Job Details dialog by 
double-clicking the group in question in the Jobs pane. 

• Waiting on Operator – Shows all jobs that have passed their dependency tests, and are waiting for 
an operator to release it. The job can be released using the Release/Resume job control command.

• Waiting on Resource – Shows all jobs that are waiting for an agent to free resources so that the job 
can run. 

Note When the Status column is sorted, the sort order is defined by the sort order listed in the System 
Configuration dialog. For more information about the System Configuration dialog, see, “System 
Configuration” on page 68.

Hours
Use this section to filter for jobs that run only during certain hours. Select the check box for each hour 
you wish to filter for. 

Other Filters
• Job – Shows all the job occurrences matching the wildcard string specified. You can use the 

following wildcard characters.

– * (Asterisk) The asterisk character masks any number of characters on and to the right of the 
location it is placed. For example, A* will match (allow in) AB, ABB, and ABBB.

– ? (Question Mark) The question mark masks one character in the location it is placed. For 
example, A?A will match ABA and ACA, but not ABB or ABBA.

– [x, y, z] The brackets with commas let you specify a set of characters to filter in to that location 
in the string. For example, A[X,Y]B accepts AXB and AYB but not AAB.

– [a-z] You can also specify ranges within brackets. For example, A[X-Z]B filters in AXB, AYB, 
and AZB but not AWB.

• Group – In this text field, type the name of a group filter. The groups configured with this filter are 
displayed as well as their children.

• Agent – Shows all job occurrences that run under the selected agent. When no agent is selected, all 
agents are assumed.

• Owner – Shows all job occurrences that belong to the selected user or workgroup.

• Runtime User – Shows jobs assigned to the selected runtime user.
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• Job Class – Shows jobs belonging to the selected job class.

• Queue – Shows all job occurrences that run in the selected queue.

• Command – Shows all jobs that execute the selected command.

• Calendar – Displays all jobs that use the selected calendar.

• Show Jobs – Displays all jobs meeting the defined filtering criteria. No jobs display if this is not 
selected, though job groups display if the Show Groups option is selected.

• Show Groups – Displays a job group if it meets the defined criteria. No job groups are displayed if 
this option is not selected. 

• Show Carryover – Displays any jobs that carried over from previous production dates.

• Show Scheduled Only – Displays jobs that were compiled as part of the original production 
schedule. The Show Ad Hoc Only option cannot be selected if this option is selected. 

• Show Ad Hoc Only – Displays jobs that were not part of the original production schedule but were 
manually inserted into the schedule by an operator.The Show Scheduled Only option cannot be 
selected if this option is selected. 

Note Jobs that did not finish on their production dates carry over only if the Carry Over Unfinished Schedule 
option was selected on the Master tab of the System Configuration dialog.

• Server Side Filter – Select this option if the job filter criteria does not change very often. This 
option improves performance by reducing network traffic. With this option selected, only jobs 
meeting the defined criteria are downloaded to the Tidal Web client when the Job Activity pane is 
selected. Once the filter criteria is changed, jobs are filtered again according to the new criteria and 
downloaded again. 

If the option is not selected, all jobs are downloaded first and then filtered by the Tidal Web client 
to meet the defined criteria. After the initial download it is quicker to refilter the jobs from the Tidal 
Web client since they do not have to be downloaded again.

• Defaults – Resets the job filter criteria to the default options. The defaults include all statuses, all 
hours, and the Show Jobs, Show Groups and Show Carryover options. The criteria in the Other 
Filters section is cleared.

Job Statistics Dialog
The Job Statistics dialog displays by right-clicking in the Job Activity pane and selecting Statistics from 
the context menu. The Job Statistics dialog shows statistics regarding job occurrences for the day 
currently displayed in the Job Activity pane. You can view statistics for All Jobs, Production jobs and 
Unscheduled jobs on the respective tab.

All Jobs, Production and Unscheduled Tabs
These tabs contain the following elements:

• Completed Normally – Shows the number of jobs that completed normally.

• Completed Abnormally – Shows the number of jobs that completed abnormally.

• Launch Errors – Shows the number of jobs that have a status of Error Occurred.
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• Total Reruns – Shows the number of jobs that have been rerun manually.

• Number of Filtered Jobs – Shows the number of jobs that have been filtered into the Job Activity 
pane using the job filter. 

Job Activity Pane Procedures

Adding or Removing Columns in the Job Activity Pane
To add or remove columns:

Step 1 From the Navigator pane, select Operations>Job Activity to display the Job Activity pane.

Step 2 Select View>Preferences from the main menu bar or right-click the Navigator pane and select 
Preferences from the context menu to display the Preferences dialog.

Step 3 Click the Columns tab. By default, all columns are used.

• To remove columns, clear the check box to the left of the column name. 

• To include columns, click the check box so that a black checkmark appears.

Adding a New Job or Group Occurrence to the Schedule
To add a new job or group occurrence:

Step 1 From the Navigator pane, select Operations>Job Activity to display the Job Activity pane.

Step 2 Right-click the job or job group occurrence to add to the production schedule and select Insert Job Into 
Schedule from the context menu or click the job or job group, and from the Activities main menu, select 
Insert Job Into Schedule. 

Step 3 Click Yes at the confirmation prompt. 

Another occurrence of the selected job or job group is added to today’s production schedule regardless 
of its calendar dates (if any). If the job is defined to repeat, only one occurrence of the job enters the 
schedule. Note that a job must have the Unscheduled Allowed option selected in its Job Definition to 
be added in this manner. 

Adjusting Column Widths in the Job Activity Pane
To adjust a column’s width:

Step 1 Place the cursor on the right vertical border of the column heading. The mouse pointer turns into the 
separator icon.
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Step 2 Hold down the left mouse button and resize the width.

Deleting Jobs or Groups from the Production Schedule
To remove jobs that have not yet launched from the production schedule:

Step 1 From the Navigator pane, select Operations>Job Activity to display the Job Activity pane.

Step 2 Right-click the job or job group occurrence to remove, and from the context menu select Remove Job(s) 
from Schedule. In the resulting confirmation dialog, select Yes if you only want to delete the selected 
job occurrence. If you wish to delete all future scheduled occurrences of the job, select the All option.

You can select multiple jobs or job groups simultaneously.

• To select more than one job or job group that are adjacent to each other, hold down the Shift key and 
select the first and last jobs.

• To select more than one job or job group that are not adjacent to each other, hold down the Control 
key while selecting the desired job occurrences.

Step 3 Click Yes at the confirmation prompt.

Remove Job(s) from Schedule will remove any pre-launch job occurrence from the schedule, for any 
date. Only the job occurrence you select is removed. If a job group occurrence is selected, all of the 
group’s child jobs are removed.

Filtering Jobs in the Job Activity Pane Based on Job Status
To filter a job:

Step 1 From the Navigator pane, select Operations>Job Activity to display the Job Activity pane.

Step 2 Click the Filter button on the TES toolbar or right-click the Navigator pane and select Filter from the 
context menu to display the Job Filter dialog.

The statuses that are presently displayed are the ones with a check mark.

Step 3 Select the agent, owner and job statuses to view.

Moving to Different Dates and Times in the Job Activity Pane
You can view job occurrences for past, present or future days. Each job’s retention history value in its 
job definition determines how far back you can see its job occurrences. The Future Days value in the 
System Configuration dialog determines how far you can see into the future.

Note When you are viewing the current day in the Job Activity pane, you may also see jobs from previous 
dates if those jobs have not yet completed.
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To move to different dates and times:

From the Navigator pane, select Operations>Job Activity to display the Job Activity pane.

• To move backward one day in the production schedule, right-click in the Job Activity pane and 
select Prior Day from the context menu.

• To move forward one day in the production schedule, right-click in the Job Activity pane and select 
Next Day from the context menu.

• To move to today’s date and time, right-click the Job Activity pane and select Goto Now from the 
context menu.

• To move to a job’s graphical start location, right-click the job’s record and select Goto Job Time 
from the context menu to display the job’s start time.

Pausing the Production Schedule
You can pause and then resume the production schedule at any time. You can also pause and resume job 
launching without having any affect on scheduling. 

When you pause a production schedule, the master service is stopped and waiting jobs are prevented 
from running, even if their dependencies are met. Jobs that are already in Active status will continue to 
run on their respective agents; however, their updated status (for example, Completed Normally) will 
not be displayed in the Job Activity pane until the master service is restarted.

When you pause job launching, jobs can still be scheduled and calendars compiled, but jobs will not 
actually launch until job launching is resumed.

To pause the production schedule or job launching:

Step 1 From the Navigator pane, select Operations>Job Activity> to display the Job Activity pane.

Step 2 From the Activities main menu, select Pause Scheduler or Pause Job Launching.

Rearranging Columns in the Job Activity Pane
To rearrange columns:

Step 1 From the Navigator pane, select Operations>Job Activity to display the Job Activity pane.

Step 2 From the View main menu, select Preferences or right-click the Navigator pane and select Preferences 
from the context menu to display the Preferences dialog. 

Step 3 Click the Columns tab. 

Step 4 Select the column and click the up or down arrows to arrange the titles into the desired order.

Recreating the Production Schedule
To recreate the production schedule:
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Step 1 From the Navigator pane, select Operations>Job Activity to display the Job Activity pane.

Step 2 From the Activities menu, select Create Schedule to display the Create Schedule dialog.

Step 3 Select the date range for which to create the schedule.

Step 4 If you want repeating jobs with no time window to start immediately, rather than after midnight, select 
the For today’s repeating jobs with no time window, start repeating ASAP option.

Step 5 TES searches for all qualified jobs to add to the production schedule for the selected dates.

Warning All job occurrences that were added manually and all records of jobs that ran will be lost. 
Furthermore, the Create Schedule recreates the schedule at the time you issue the command. This 
means that jobs whose dependencies have not been met can qualify to run immediately. Use this 
command with caution.

Refreshing the Job Activity Pane
To refresh:

Step 1 From the Navigator pane, select Operations>Job Activity to display the Job Activity pane.

Step 2 From the View main menu, select Refresh Data or Refresh All Data.

Resuming the Production Schedule or Job Launching
To resume the production schedule or job launching:

Step 1 From the Navigator pane, select Operations>Job Activity to display the Job Activity pane.

Step 2 From the Activities main menu, select Resume Scheduler or Resume Job Launching.

Saving a Job’s Output on the Master
You can view the output of a job after the job finishes running. In order to view the output of a job from 
the Job Activity pane, you must save the output for the job on the master (this is the default).

To save a job’s output on the master:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane.

Step 2 Select the job for which to save output.

Step 3 Click the Edit button to display the Job Definition dialog.

Step 4 Click the Options tab. 
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Step 5 In the Save Output option, select Append or Replace.

Step 6 Click OK. The next time the job completes, you can view its output from the Job Detail dialog.

Selecting or Removing All Job Filters in the Job Activity Pane
To select or remove all job filters:

Step 1 From the Navigator pane, select Operations>Job Activity to display the Job Activity pane.

Step 2 Click the Filter button on the TES toolbar or right-click the Navigator pane and select Filter from the 
context menu to display the Job Filter dialog.

Step 3 Right-click in the Statuses section and select Check All or Uncheck All from the context menu.

Setting the Completion Status of a Job

Note You should only set the completion status of jobs that have already finished running. Setting completion 
status of a job that is still active, may adversely affect job activity.

To set the completion status:

Step 1 From the Navigator pane, select Operations>Job Activity to display the Job Activity pane.

Step 2 Select the job on which to perform job control.

Step 3 Right-click the job to open the Job Activity context menu.

Step 4 From the Job Control submenu, select Set and from the Set submenu, select the desired job completion 
status.

Note When job completion statuses are changed in this way, an asterisk appears to the right of it, for 
example, Completed Normally*.

Sorting Jobs in the Job Activity Pane Using Column Headers
You can sort the job occurrences displayed in the Job Activity pane by two different sorting criteria. You 
can sort on a primary criteria and in turn, organize the primary sort by secondary criteria. The sorts are 
done by column header in either alphabetical or numerical order depending on the type of data contained 
in the column.

To sort a job using a column header:
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Step 1 From the Navigator pane, select Operations>Job Activity to display the Job Activity pane.

Step 2 Click the column header to select it for a primary sort. The jobs sort alphabetically (in text data) or 
numerically (if numerical data). A single arrow displays beside the column header to denote the primary 
sort.

If you click the header more than once, the sort order toggles back and forth from ascending to 
descending order.

Step 3 To perform a secondary sort, hold down the ALT key while clicking the column header. The secondary 
sort displays a double arrow in the column header.

For example, click the Name column heading. The items in the column are alphabetized from a to z 
(because the column contains alphabetical data). Clicking again reverses the order z to a. Click the Time 
column header while holding down the ALT key and the jobs remain in alphabetical order but are now 
organized also by numerical order (since this column contains numerical data). Now the jobs are 
arranged in alphabetical order and each numerical segment is organized from earliest time to latest time. 
Clicking again on the secondary sort column while holding down the ALT key reverses the secondary 
sort to latest time to earliest time.

If you click the header more than once, the sort order toggles back and forth from ascending to 
descending order.

Sorting Jobs Using the Job Filter Dialog
To sort jobs using the Job Filter dialog:

Step 1 From the Navigator pane, select Operations>Job Activity to display the Job Activity pane.

Step 2 Click the Filter button on the TES toolbar or right-click the Navigator pane and select Filter from the 
context menu to display the Job Filter dialog.

Step 3 Checking or clearing the options for status or hours enables you to sort jobs using those criteria. You can 
also sort using other criteria listed including by job name, by agent, by queue, by command, etc.

Note The Job Filter dialog includes filter options that affect sorting. For example, if you want to sort 
by the status column, and some statuses have been filtered out, those statuses will not be used 
for sorting.

Note When a Status column is clicked for sorting within the Job Activity pane, the order is defined by 
the settings on the Job Status Order tab in the System Configuration dialog.

Stopping or Starting Jobs in the Job Activity Pane
To stop or start a job:
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Step 1 From the Navigator pane, select Operations>Job Activity to display the Job Activity pane.

Step 2 Select the job on which to perform job control.

Step 3 Right-click the job to display the Job Activity context menu.

Step 4 From the Job Control submenu, select one of the following job control options:

• Select Override to override a job’s dependencies. The job enters a queue and becomes active. 
Override ignores all dependencies and launches the job immediately.

• Select Hold/Stop to stop a job from running or to keep a job from launching. The job enters the Held 
or Stopped status. If the job cannot be held or stopped, you cannot select this menu item. 

Note Windows jobs cannot be suspended, therefore this menu item is unavailable for active Windows 
jobs.

• Select Release/Resume to release a held job, or a job waiting for operator release or to start a 
stopped job. The job enters the Active or Waiting On Dependencies status. If the job can’t be 
released or resumed, you won’t be able to select this menu item.

• Select Cancel/Abort to cancel a job before running or to abort a job while running (Canceled jobs 
cannot be rerun). The job enters the Canceled or Aborted status. If the job can’t be canceled or 
aborted, you won’t be able to select this menu item.

• Select Cancel/Abort All to cancel all occurrences of a job before running or to abort all occurrences 
of a job while running. All occurrences of the same job enter the Canceled or Aborted status.

• Select Rerun to rerun a job. The job re-enters the schedule and is re-executed with the same job ID 
number. A new occurrence ID is not created. If the job can’t be rerun, you won’t be able to select 
this menu item. 

Viewing a Job’s Output
You can view the output of a job after the job finishes running. In order to view the output of a job from 
the Job Activity pane, you must first have the Save Output option selected in the job’s or job group’s 
definition.

Note Scheduler’s default is to discard job output.

To view a job’s output:

Step 1 From the Navigator pane, select Operations>Job Activity to display the Job Activity pane.

Step 2 Double-click the completed job to display the Job Detail dialog.

Step 3 Click the Output tab to view job output.
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Viewing Other Dates in the Production Schedule
To view other dates:

Step 1 From the Navigator pane, select Operations>Job Activity to display the Job Activity pane.

Step 2 Click the Select Day button or right-click in the Job Activity pane and select the Select Day option to 
display a Calendar tab. 

Step 3 Click the date to go to. You can use the arrow controls in the title bar to move to different months.
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C H A P T E R 5

Jobs

Jobs and Job Groups Panes
A TES job is a set of instructions about how, when and where to perform an automated task. In the job 
definition, you can specify a short name for the job (job alias), a command or script to run, where to run 
the job (agent), the days and times to run the job, the dependencies that need to be satisfied before it can 
run, and other runtime criteria. 

You can organize jobs into TES job groups, where each job in the group can inherit properties from its 
parent group. Job groups themselves can belong to other job groups. You can view the entire hierarchical 
structure of all defined jobs and job groups from the Jobs pane.

A job’s or job group’s definition can be added to the production schedule either manually on demand or 
automatically through a calendar. Each entry of the job into the production schedule is called a job 
instance; it is an instance of the job definition at a specific time. Job instance history can be reviewed 
for auditing purposes.

Job and Job Group Concepts

Job Hierarchy

Jobs are built on a hierarchy of job and job group ownership. A job group is a container for a set of jobs, 
usually part of a common application or department. The job group has its own name and set of runtime 
instructions. 

You can use job groups to submit jobs that either depend on each other, or should run together. For 
example, all the jobs in payroll can belong to a group called Payroll. The job group can provide default 
settings to all the child jobs that belong to it. Jobs and job groups are displayed in the Jobs pane. Job 
groups can save you the time it takes to set up job definitions because each job in the job group can 
inherit the characteristics of that job group. When you want to create several jobs with similar scheduling 
characteristics, you can define those jobs within a job group and set the scheduling characteristics in the 
job group definition. It is also possible to change scheduling characteristics at the job level even though 
the job belongs to a group. 

For example, if a job group is defined to run every Friday, then every job in that job group is 
automatically defined to run on Friday. If one job in the job group must run on Saturday, then that one 
job can be changed to the proper run day without affecting the other jobs — as long as you disinherit the 
job group calendar and change the calendar from within that job.
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The ultimate ownership of a job or job group belongs to either the user or a workgroup. A workgroup is 
a collection of users who can share access to the same jobs. Workgroups are displayed in the Workgroups 
pane. 

Job Groups and Inheritance

You can organize related jobs into groups. Using job group inheritance saves you time and reduces the 
possibility for error by having jobs automatically inherit properties from the job group to which they 
belong. You need only change the job properties that are unique to each job. For example, if a job group 
is defined to run every Friday, then each job that belongs to the job group can inherit the job group’s 
calendar to run on Fridays as well. Note that when you schedule a job group, every job in the group is 
scheduled as well, unless you choose not to inherit the calendar property.

Note If a job within a job group does not inherit the parent group’s calendar (the Inherited option on the job’s 
Schedule tab is not selected), then the calendar assigned to the job must be a subset of the dates within 
the job group’s calendar. In other words, the job’s calendar cannot contain any dates that are not part of 
the job group’s calendar.

Job Commands

Each job is assigned one command or script file. The command can be an executable file, a shell script, 
a batch file, a command file or any other executable file available to the agent that will run the job. You 
can also specify parameters to be passed to the command. This allows you to create different variations 
of a definition, based on the parameters that you pass to it. You can even use system or user variables in 
the command name or parameters. 

Agents

You can choose which agent will run your job. You can run your job on a specific agent in your network 
or you can have TES pick an agent based on a list of agents called an agent list. By running jobs using 
an agent list, you can take advantage of workload balancing, broadcasting and dynamic rerouting.

Scheduled vs. Unscheduled Jobs

Jobs and job groups can run either automatically on a regular schedule when you assign a calendar or on 
an unscheduled basis whether or not it has an associated calendar. For example, a job could run 
automatically on the 1st and 15th of every month. The job could also be inserted into the schedule as 
needed throughout the month. When a calendar is not assigned, the job will only run when you manually 
insert the job into the schedule. Calendars are created from the Calendars pane and can be applied to a 
job or job group from the Job Definition or Job Group Definition dialog.

Job, File, Variable and Time Dependencies

You can create job dependencies, file dependencies, variable dependencies and time dependencies for a 
job or job group. 

A job dependency is a dependency on another job reaching a certain status. For example, you can set a 
job to run only after a previous job has completed normally. 

A file dependency is a dependency on the existence of a file, on whether or not a file has been modified, 
or on the size of a file. This feature ensures that your jobs run when the appropriate data is available. 
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A variable dependency is a dependency on the value of a variable. You can use a preset TES variable or 
define your own. Variables can be used to track resource usage and can be updated automatically using 
variable update actions. For more information about variable update actions, see “Actions and Alerts” 
section on page 6-215.

A time dependency sets a specific time window for the job to run.

Intermaster Dependencies

You can implement intermaster dependencies by combining different TES tools and areas of 
functionality, such as job events. The methodology can be extended to apply to dependencies between 
any number of jobs on any number of masters. For more information on intermaster dependencies, see 
“Intermaster Dependencies” section on page 5-188.

Job Events 

Job and job group definitions can include exception-based actions triggered by job events. These actions 
can provide different types of notification as well as perform some additional task(s) in response to 
certain conditions. For example, a job event could be defined for a job that completes abnormally or 
when a job stops. You can associate one or more job events with a job. You can also assign multiple 
actions to each event. For more information about job events and actions, see “Actions and Alerts” 
section on page 6-215.

System Events

TES also watches for system events, such as when the master stops or when the production schedule 
finishes compiling. Job and system events can then trigger actions in response to the event condition. Job 
events can also be defined at a system level so that any job will trigger a set of actions when a particular 
job event occurs. For example, TES can email you if any job runs longer than a predefined maximum 
allowable time.

Actions

TES can respond to events using multiples and combinations of the following action types:

• Email – Notifies you and/or others of your job event via email.

• SNMP – Sends SNMP messages to SNMP managers that monitor network activity.

• Alert – Sends an alert message to the operator’s console regarding the event.

• Job Control – Performs job control, such as stopping an active job, or rerunning a job that 
completed abnormally.

• Job – Inserts a new job into the production schedule, such as a recovery task.

• Log – Posts a user-defined message to the TES log and, if desired, to the Windows application log. 
You can then view the logs through the TES Logs pane and the Event Viewer.

• Variable – Updates a user-defined variable to help you control when and how jobs run, or what 
email messages convey.

Job Scheduling Options

As part of scheduling a job, you can specify the following criteria, which further determine how your 
job will run:
5-141
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 5      Jobs
  Jobs and Job Groups Panes
• Enable or disable jobs and job groups, allowing or preventing them from being added to the 
production schedule.

• Assign job priority so that higher priority jobs run first, before lower priority jobs, in a busy 
production schedule.

• Determine how to handle a job that is ready to run when a previous instance of the job is already 
running.

• Require the operator to release a job before it can run. You can include operator instructions for the 
operator to follow prior to releasing the job.

• Automatically save and view the job’s output.

• Specify the length of time to keep job history.

• eeps internal notes and descriptions about the job.

Jobs and Job Groups Panes

TES shows all of your jobs in the Job Definition panes. A job consists of instructions that are associated 
with carrying out an automatic task such as running a script or program. Jobs and job groups can be 
owned by a user or workgroup. When you own a job, only you have access to its properties. No other 
user can edit or view your job. If a job is owned by a workgroup, anyone belonging to that workgroup 
has access to it, within the limits of their security policy. For more information about security policies, 
see “Security Policy Procedures” section on page 108.

Job History

As each job enters the production schedule, an instance of that job is created. TES allows you to view 
the history of each job instance. Job history lists the time and date when each instance ran and its 
resulting completion status. Job history can be retained for a specified length of time. For example, you 
could define your job to save the history of all its instances within the past 90 days. All instances that 
were run prior to this period are purged automatically.

Automatic Job Compilation
While jobs can be added manually to a schedule that is running at the time, in an ad-hoc fashion, the 
more common method is to use automatic compilation. Automatic compilation works by assigning a 
calendar to a job to designate on which dates a job should run. This method creates a production schedule 
for each day by adding jobs and job groups according to the calendars associated with each job's 
definition.

The production schedule contains scheduling data for a limited number of future and past days. At 
midnight every night, TES automatically compiles the next leading day (day out) of the production 
schedule and purges data for the trailing day (the oldest date in the schedule). The purging is done on a 
different thread than the production work so that production can continue throughout the purging 
process. The production schedule date range is determined based on various settings found in the System 
Configuration and Job/Job Group Definition dialogs. These settings include:

• Job Retention History – Defines how long to keep job instances for each job. There is a system 
setting on the Defaults tab of the System Configuration dialog to configure that default setting for 
retaining job history. However, the period of time to retain a job's history can also be configured on 
an individual basis for each job. This setting (History Retention) is located on the Options tab of 
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the Job Definition dialog of each job in question. You can have different settings for different jobs. 
For example, Job A could have instances kept for 30 days, while Job B could have instances kept 
for 60 days.

• Future days to include in Schedule – Defines how far in the future to schedule jobs. For example, 
if this setting is set to three days and today is June 1st, you can view jobs in the production schedule 
out to June 4th. Set the number of future days to include in the production schedule on the Master 
tab of the System Configuration dialog.

When you create a job or job group with a calendar that specifies a date within the current production 
schedule range and click OK, the Effective Date dialog displays to choose the date to begin running 
the job or job group. Each day, the automatic compilation process compiles incrementally for the 
next leading day, checking the calendar information of each job or job group to see if it should run 
on that day.

Note Because only the leading date of the production schedule (or forecasted schedule) is compiled 
automatically, if you choose not to schedule a job or job group using the Effective Date dialog, the job 
or job group will only enter the schedule on the next compile. For example, if Job D is scheduled to run 
daily, you can choose Cancel from the Effective Date dialog, and if the production schedule presently 
spans11/1/04 to 11/5/04, the job or job group will be scheduled to run starting on 11/6/04.

If you want to remove the job from the production schedule, you can disable the job from the Jobs 
pane by right-clicking it and selecting the Enable option from the context menu. You can also 
right-click it from the Job Activity pane and select the Remove Job(s) from schedule option from 
the context menu.

• Automatic Daily History Cleanup – If you are automatically creating production schedules, you 
should also automatically clean up the production history. This option ensures that the TES 
automatically purges outdated job history data from the system database. When it is time to purge 
data (by default at the beginning of the production day), TES looks for all job information that is 
older than the retention history settings. If this option is not selected, you must manually purge the 
database of outdated job information at regular intervals by scripting.

Jobs Pane Interface
A job is the set of rules that governs the running of an executable. A job group is a collection of jobs. 
The job group itself does not have an executable associated with it. 

Because of the nature of jobs and job groups, the TES console pane that displays job and group 
definitions can be correctly referred to as either the Jobs pane.

From the Navigator pane, select Definitions>Jobs to display the Jobs pane.

Note The Jobs pane displays only those jobs that are owned by you or owned by a workgroup to which you 
belong.

You can change the sort order of the jobs display by clicking the head of the column that you want to 
use as a sort key. You can also re-order and select columns from the Preferences dialog.
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The number of jobs and groups that are currently displayed (that you have access to) displays in the 
upper right corner of the Jobs pane. You can see at a glance the number of records without having to 
count each row. Note that a group will be counted as one record when it is collapsed, and as one plus 
each child within it when it is expanded. 

Buttons
The Jobs pane contains the following buttons:

• Add Job – Displays the Job Definition dialog (in insert mode) to add a job/job group.

• Edit Job – Displays the definition dialog (in edit mode) for the selected jobs.

• Copy Job – Creates a copy of the selected job definition from the Scheduler database. You can 
rename the job definition and save time when creating several job definitions with the same security 
profile.

• Delete Job – Deletes the selected jobs.

• Refresh – Updates the data in the current pane.

• Filter – Displays the Job Filter dialog to filter the jobs being displayed using multiple criteria. For 
more information, see “Defining Jobs” section on page 5-158.

• Print – Creates a report of the data for the selected jobs and/or job groups. 

• Top - Click to bring Jobs folder view to top level.

Search Field
Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See “Searchable Columns” section on page 2-35.

Columns
The Jobs pane contains the following columns:

• Expand/Collapse – The control button for expanding and collapsing the display of jobs.

• Name – The name of the job definition.

• Owner – The owner of the job definition. By default, the owner is the creator.

• Enabled – Whether or not the job definition is enabled.

• Modified – The last time the job definition was changed.

• Calendar – The calendar assigned to the job definition.

• Agent – The agent or agent list assigned to run the job definition.

• Type – Indicates if this definition is a job or job group.
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• Program/Command – If the definition is a job, this column displays the full path to the program or 
command. Note that any arguments or parameters will not be listed. If the definition is a group, this 
column is blank. 

• Job Class – The job or job group’s job class. Classifications help to further categorize the job or job 
group. For example, you can have a classification for all Payroll jobs, or all Accounting jobs. 

• Job Alias – An unique eight-digit number that serves as an alternate name for the job. The job alias 
is often used in the command line mode when referencing a job. A job that runs several times a day 
would be referenced by the alias to distinguish it from the other times it runs, since each time the 
job runs, it runs under the same name.

• Job From – The earliest date that the job should run. The job will run starting with the first date in 
the calendar that is on or after this date.

• Job Until – The last date the job can run based on the calendar. If not specified, and your calendar 
includes repetitive dates, your job will run indefinitely. 

• Job ID – Also referred to as the job number. This is the identifying number for the job definition 
and may also be called the job ID.

• Runtime User – The runtime user assigned to the job.

Jobs Preferences Dialog
If you select Preferences from the View main menu while viewing the Jobs pane, the Jobs Preferences 
dialog displays.

From the Jobs Preferences dialog, you can select which columns are displayed in the Jobs pane and in 
what order they appear.

• A checkmark to the left of a column title indicates that it will be displayed in the Jobs pane. No 
checkmark indicates that it will not be displayed.

• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.

You can specify whether the default view shows job groups expanded for easy viewing or collapsed to 
save screen space. Click the Other tab and make the appropriate selection.

Navigator Context Menu

When you right-click in the Navigator pane while viewing the Jobs pane, the Navigator context menu 
displays. 

The following describes the items in the Jobs pane Navigator context menu:

• Add Job– Displays a submenu of the licensed job options available to the user.

• Filter – Displays the Job Filter dialog to filter out by multiple criteria which jobs are displayed. 
For more information, see “Defining Jobs” section on page 5-158.

• Group Display – Displays the Group Display submenu with its four options:

– Collapse All – Closes all of the job groups.

• Preferences – Displays the Preferences dialog.

• Print – Creates a report of the data for the selected jobs and/or job groups. 

• Export – Saves the contents of the Jobs pane as a text file.
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• Refresh – Updates the data in the Jobs pane.

• New Root Folder – Allows you to create a new root folder for the Navigator pane.

• Save View As – Creates sub-folder within the Jobs folder, displaying jobs under currently selected 
folder settings.

Jobs Pane Context Menu 

The Jobs context menu displays by right-clicking a job or job group record in the Jobs pane. The menu 
options may be different according to the user’s security policy. 

This context menu contains the following options:

• Add Job – Displays a submenu of the licensed job options available to the user. TES inserts the job 
under the selected job group (if any).

Note Some job options only display in the submenu if you are licensed for that adapter.

• Edit Job – Displays the Job Definition or Job Group Definition dialog to edit an existing job or 
group. 

• Delete Job – Deletes the selected job or job group and removes all its instances from the production 
schedule. 

• Copy Job – Creates a copy of the selected job or job group with the same information as the selected 
job, except for the name.

• Refresh – Refreshes the data on the Jobs pane.

• Filter – Displays the Job Filter dialog to filter out by multiple criteria which jobs are displayed. 
For more information, see “Defining Jobs” section on page 5-158.

• Print – Creates a report of the data for the jobs and/or job groups. 

• Print Selected – Creates a report of the selected data for the selected jobs and/or job groups. 

• Group Display – Displays the Group Display submenu with its four options:

– Expand Selected – Expands the selected job groups to display the individual jobs.

– Collapse Selected – Closes the expanded job group that is selected.

– Collapse All – Closes all of the job groups.

• Disable – Temporarily disables (or makes inactive) all selected jobs and job groups. A disabled job 
cannot run. If the job being disabled is a dependency for another job, a confirmation dialog displays. 
Clicking Yes in the confirmation dialog, means that this job dependency will be overridden in all 
unrun dependent jobs. For more information, see Enable (above) and the “Job/Job Group Definition 
Dialog” section on page 5-159.

• Enable – This option enables all selected jobs and job groups. When a job or job group is defined, 
it is Enabled by default unless you clear the Enabled option. When a group is enabled, a prompt 
asks if you want to also enable the group’s children. If you click No to the prompt, the group itself 
is enabled but its children are not enabled. This menu option corresponds to the Enabled option in 
the Job and Job Group Definition dialogs. For more information, see “Job/Job Group Definition 
Dialog” section on page 5-159.

• Successors – If the selected job has successors, a report listing the successor jobs displays. If there 
are no successors, an Information dialog states that no other jobs depend on this job.
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• Create Business View From Group – Creates a Business View from a selected job group to 
graphically illustrate the dependencies and relationship between the jobs within the group.

• Insert Into Schedule – Displays the Insert Into Schedule dialog to insert the selected job (or a 
different job) into the production schedule. There is some job data that can be overridden for the 
insertion. Through the Insert Into Schedule dialog, you can insert an instance of the selected job 
or group into the production schedule on an as-needed basis for the day. This occurs regardless of 
whether the job or job group was inserted automatically via a calendar and regardless of how many 
times the job or job group is defined to repeat within the day. When a job or a job group is added, 
and the job or job group already resides in the production schedule, an incremented instance number 
appears in parentheses next to the record to indicate the exact instance number.

Note To add a job to production with the Insert Into Schedule menu option, the Unscheduled Allowed option must be set in 

the job definition.

•  Breadcrumbs (Job Groups only) – Click to bring Jobs folder view down to the child job/group 
level of the selected job group.

Life Cycle of a Job instance
Each TES job instance has its own life cycle in the production schedule. The job’s current status 
indicates where it is in its life cycle. A typical life cycle is one where the job:

• Waits in the production schedule for its dependencies to be met.

• Enters a queue and waits for an execution slot to become available.

• Launches on its designated agent.

• Starts execution successfully on its designated agent.

• Completes normally.

Each phase corresponds to the statuses Waiting On Dependencies, Waiting On Resource, Launched, 
Active and Completed Normally, respectively. Other statuses are also possible depending on certain 
conditions and exceptions. 

Note For more information on error job conditions, see “Monitoring Production” section on page 11-361.
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Job and Job Group Statuses
The following table describes the different job statuses that TES can assign to a job or job group:

Table 5-1 Job and Job Group Statuses

Status Job Description Job Group Description

Aborted The job was aborted and cannot be 
resumed. A job can be aborted if it 
is Active or Stopped status.

Not applicable.

Active The job is running. At least one job in the group is 
active. If no jobs in the group are 
active and there are still jobs in the 
group that need to run, the status 
will be Waiting on Children.

Agent Disabled The agent where the job is 
supposed to run is not enabled, and 
the job cannot run. If a job is using 
an agent list, all agents in the agent 
list have been disabled.

To allow the job to run, select an 
alternative agent override or 
enable the agent from the agent’s 
Connection Definition dialog 
(Connections pane).

Not applicable.

Agent Unavailable The agent where the job is to run is 
not connected or is not running. If 
the job is using an agent list, all 
agents in the list are unavailable. 

To get the job to run on the agent, 
determine why the agent is not 
available and correct the problem. 
For information about making an 
agent available, see “Starting and 
Stopping TES Components” section 
on page 2-44.

Not applicable.

Canceled The job was canceled by an 
operator and cannot be resumed. A 
job can be canceled while it is 
waiting in the production schedule 
(Waiting On Dependencies 
status) or in a queue (Waiting On 
Resources status).

The job group is canceled by an 
operator and cannot be resumed. 
Jobs in the group that were waiting 
were also canceled. Jobs in the 
group that were active were 
aborted, if possible.
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Canceled Pending The job is canceled but its 
dependencies are released to run to 
completion. Once the 
dependencies are satisfied, the job 
status changes to Canceled 
Normally. If any of the 
dependencies do not complete, the 
job remains in the Canceled 
Pending status. This status only 
occurs from a user-initiated job 
control action or a job action.

The job group is canceled but all of 
the dependencies placed on its child 
jobs are released. In essence, this 

status is like the Waiting on 
Dependencies status. Once the 
dependencies are satisfied, the jobs 

go to the Canceled Normally status. 
If any of the dependencies are not 
fulfilled, the job group remains in 
the Canceled Pending status.

Canceled Normally A job that was in the Canceled 
Pending status ends in the Canceled 
Normally status once the job’s 
dependencies are fulfilled. The job is 
considered to have completed 
normally.

Any job in a job group that ends 
with a Canceled Normally status is 
treated as if the job completed 
normally.

Completed 
Abnormally

The job completed with a non zero 
exit code indicating abnormal 
operation.

All jobs in the group ran and at 
least one job in the group 
completed abnormally.

Completed 
Abnormally 
(output pending)

The job has completed abnormally 
but the job output is still being 
gathered and is not yet available.

The job group remains in Active 
status until the output is posted.

Completed Normally The job completed normally with 
an exit code of 0. 

All jobs in the group completed 
normally.

Completed Normally 
(output pending)

The job has completed normally 
but the job output is still being 
gathered and is not yet available.

The job group remains in Active 
status until the output is posted.

Deferred Another instance of this job was 
running when this instance was 
ready to launch, and the 
concurrency option for the job was 
set to Defer. This job instance will 
run after the previous instance 
completes.

Not applicable.

Error Occurred An error occurred when launching 
the job and it did not run. There is 
no exit code. The specific error can 
be viewed in the TES logs and will 
show in the Job Details dialog. For 
more information about logs, see 
“Monitoring Production” section 
on page 11-361.

An error occurred for at least one 
job in the group. If another job has 
a Completed Abnormally status, 
the Error Occurred status will still 
be set at the group level.

Externally Defined The job completion status is 
defined manually, and has not been 
set yet.

Not applicable.

Table 5-1 Job and Job Group Statuses

Status Job Description Job Group Description
5-149
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 5      Jobs
  Life Cycle of a Job instance
Externally Defined 
(output pending)

The job status was determined by 
an external user or program and 
the job output is still being 
gathered and is not yet available.

Not applicable.

Held The job is restricted from running 
by an operator or an action. A job 
can be held up until the time it 
becomes active.

All active jobs in the group have 
stopped, and all waiting jobs have 
been held.

Launched A request to launch the job has 
been sent to the agent, and is 
pending notification from the 
agent that the job has started 
executing. This state is between 
Waiting On Resource and Active.

Not applicable.

Orphaned The agent on which the job was 
running is no longer in 
communication with the TES 
master. The master does not know 
its final status. The agent, network 
or master may be down.

Not applicable.

Scheduled This is the initial status of a job 
when it is added to the schedule. If 
it is scheduled to run today, the job 
will enter either the Waiting On 
Resource, Waiting On Operator, 
or Waiting On Dependencies 
status, depending on the job’s 
properties. Otherwise, it will stay 
in the Scheduled status. A job also 
temporarily enters this status when 
it is released by the operator.

This is the initial status of a group 
when it is added to the schedule. If 
it is scheduled to run today, the 
group will enter either the Waiting 
On Resource, Waiting On 
Operator, Waiting On Children or 
Waiting On Dependencies status, 
depending on the group’s 
properties. Otherwise, it will stay 
in the Scheduled status. A group 
also temporarily enters this status 
when it is released by the operator.

Skipped Another instance of this job was 
running when this instance was 
ready to launch, and the 
concurrency option for the job is 
set to Skip. This job instance will 
never run.

Not applicable.

Stopped Execution of the job has been 
suspended. A job can enter 
Stopped status only when it was 
previously Active.

See Held.

Table 5-1 Job and Job Group Statuses

Status Job Description Job Group Description
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Job Group and Child Job Statuses
The status of a job group is determined by its children. The following table demonstrates the order of 
precedence and correlation between the status of a group and the status of its children. For more 
information on a particular status, see the table “Job and Job Group Statuses” section on page 5-148.

Note The final status of a job group is determined by the statuses of all of its children, whether the child job 
ran on the current day or started on another day as a carryover job. This means if a child job that started 
on the previous day completed abnormally and other child jobs ran on the current day and completed 
normally, the job group is considered to have completed abnormally.

Timed Out For Day The job missed its time window 
today. An attempt will be made to 
run the job tomorrow. A job cannot 
time out when it is in a queue 
(Waiting On Resources) or when it 
is Active.

The group instance has timed out 
for the day.

Timed Out The job missed its date and time 
window. No attempt will be made 
to run the job tomorrow. A job 
cannot time out when it is in a 
queue (Waiting On Resources) or 
when it is Active.

The group instance has timed out.

Waiting On Children Not applicable. The group is waiting for its 
children’s dependencies to be met.

Waiting On 
Dependencies

The job is scheduled and it is 
waiting on job, file or variable 
dependencies to be met in order to 
run.

The job is scheduled and it is 
waiting on job, file or variable 
dependencies to be met in order to 
run.

Waiting On Operator All the job’s dependencies are met, 
and it is waiting for the operator to 
release it.

All the group’s dependencies are 
met, and it is waiting for the 
operator to release it before its 
children can run.

Waiting On Group The job’s parent group is waiting 
for operator release.

The group’s parent group is 
waiting on operator release.

Table 5-1 Job and Job Group Statuses

Status Job Description Job Group Description
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Job Group Inheritance
TES lets jobs inherit properties from its parent job group. When you create a job group and add a job, 
key properties of the job will default to its parent group’s properties. You can then save time by changing 
only the individual job properties needed for each job. 

Table 5-2 Job and Job Group Properties

Status Priority

Active If any child has a status of Active or Launched, the parent group 
will have Active status.

Waiting on Children If any child has a status of Held, Waiting on Dependencies, 
Canceled Pending, Waiting on Operator, Agent Unavailable or 
Agent Disabled, and no children are Active or Launched, the parent 
group will have Waiting on Children status.

Completed Abnormally If any child has a status of Completed Abnormally, and no children 
have an Active, Waiting on Children or Error Occurred status, the 
parent group will have Completed Abnormally status.

Orphaned If any child has a status of Orphaned and no children have an 
Active, Waiting on Children, Error Occurred or Completed 
Abnormally status, the parent group will have Orphaned status.

Timed Out If any child has a status of Timed Out or Timed Out for Day, and 
no children have an Active, Waiting on Children, Error Occurred, 
Completed Abnormally or Orphaned status, the parent group will 
have a Timed Out status.

Canceled If any child has a status of Canceled or Aborted, and no children have 
an Active, Waiting on Children, Error Occurred, Completed 
Abnormally, Orphaned or Timed Out status, the parent group will 
have Canceled status.

Externally Defined If any child has a status of Externally Defined, and no children have 
an Active, Waiting on Children, Error Occurred, Completed 
Abnormally, Orphaned or Timed Out or Canceled status, the parent 
group will have Externally Defined status.

Normal If no children have an Active, Waiting on Children, Error Occurred, 
Completed Abnormally, Orphaned or Timed Out or Canceled or 
Externally Defined status, the parent group will have Normal 
status. A parent group with Normal status can include children with 
statuses of Canceled Normally, Scheduled, Skipped, Deferred and 
Completed Normally.

Canceled Normally If no children have a priority an Active, Waiting on Children, Error 
Occurred, Completed Abnormally, Orphaned, Timed Out, 
Externally Defined or Normal status, the parent group will have 
Normal status. A parent group with Canceled Normally status can 
include children with statuses of Scheduled, Skipped, Deferred and 
Completed Normally.
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For example, let’s say you have a job group called Payroll Jobs containing four jobs: one job collects 
wage data, one job formats the data into a management report, one job finalizes and registers the data in 
the payroll database and one job prints payroll checks. Since these jobs are similar, they can inherit many 
properties of the parent job group, Payroll Jobs, such as on which days to run and on what machine. All 
you need to do is specify each command to run, and their dependencies on each other. For example, Job 
2 depends on the completion of Job 1, and Job 3 depends on the completion of Job 2, etc. Thus, by using 
inheritance, you save the time it takes to specify job data common between the jobs.

Note If a job is assigned a calendar that conflicts with its parent group's calendar, and the Inherited option on 
the Run tab is not selected, that job will NOT run.

Jobs can inherit a particular set of group properties. Not all properties are inherited. The following table 
shows which job properties can be inherited from the group:

Table 5-3 Job and Job Group Properties

Property Inheritable Comments

Common Properties

Job Name No Every job must have a unique name.

Job Class Yes A job will inherit the job class of its parent group.

Owner Yes A job will have the same owner as the group 
unless the Owner field in the Job Definition 
dialog is changed manually.

Parent Group N/A This is the parent group from which the job 
inherits its properties.

Enabled Yes If the group is enabled, the child jobs will be 
enabled. the parent group is disabled, the child jobs 
will also be disabled.

Program Tab Properties

Command No A group definition does not include a command.

Command Parameters No A group definition does not include parameters.

Environment File Name No A group definition does not include an 
environment file.

No Inheritance A group definition is not inherited.

Output File Name No A group does not create output

Working Directory A directory is specified for a program or script to 
run in. 

Schedule Tab Properties

Calendar settings Yes All jobs can run on the same dates.

Time Window settings Yes All jobs can run in the same range.
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Repeat settings No These values are implicitly, not directly, 
inheritable. If the group runs 5 times in one day, 
so will the job. However, the job isn’t set to run 5 
times automatically within the group. This would 
cause the job to run 25 times (5 times per each 
group run) in one day.

Run Tab Properties

Agent Information settings Yes All jobs can run on the group’s agent or agent list.

Agent Name Yes All jobs can use the group’s agent.

Agent List Yes All jobs can use the group’s agent list.

Runtime User Yes All jobs can use the group’s runtime user.

Tracking settings Yes Tracking is specific to each job.

Duration (in minutes) 
settings

No Job runtime is specific to each job. Groups can 
have their own duration which is a combination 
of all its child jobs.

Dependencies Tab Properties

Dependencies/Type No This is implicit. If a group’s dependencies are 
met, all its child jobs can start. However, the 
group holds the dependency, not the child jobs.

All must be met No This is implicit.

At least one must be met No This is implicit.

Resources Tab Properties

Resources No Resources can only be assigned to individual 
jobs.

Job Events Tab Properties

Job Events/Event Triggers No Job events are specific to each job and group, 
with exception of events applying to All Jobs.

Options Tab Properties

Job Alias No The job alias is specific to the job.

Job Priority No Job priority is specific to jobs.

If job is currently running No Concurrency is specific to jobs.

Save Output Option No Not available from group.

Allow Unscheduled No You must set this for each job (default is 
checked).

Require Operator Release No You must set this for each job (default is not 
required).

History Retention (in days) No History data is specific to each job.

Base time needed to run job 
on

No Sets the default basis for evaluating whether jobs 
will complete before a scheduled outage.

Allow operator rerun No Allows the operator to rerun a job.

Table 5-3 Job and Job Group Properties

Property Inheritable Comments
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Environment Files
TES allows you to make environment variables available to each job that you launch by entering the 
name of an environment file in the Job Definition dialog. For more information, see “Job/Job Group 
Definition Dialog” section on page 5-159. The file should be a plain text file and can have any name, as 
long as the correct path to the file is entered in the Environment File field of the Job Definition dialog. 
No commands are allowed in the file, only variable designations.

All environment variables are specified in the environment file in the following format:

VARIABLE=value

For example, 

TZ=PST8PDT 

Note Do not leave any space between the variable and its value. If you leave spaces, the variables will not be 
read correctly.

Environment Variables

The following table lists available environment variables that you can use in your environment file:

Disable Carryover No Any job from the current production schedule 
that is not in an Active or a Launched status when 
the next production day starts, will not be carried 
over to the next production day.

For UNIX, source user’s 
profile

No Provides for the execution of all variables in a 
UNIX user’s profile.

Run Book Tab Properties

Operator Instructions No Each job has its own operator instruction 
(optional).

Notes Tab Properties

Other Notes No Each job has its own description (optional).

History Tab Properties

All properties No History data is specific to each job or group.

Table 5-3 Job and Job Group Properties

Property Inheritable Comments

Table 5-4 Environment Variables

Variable Description

HOME The home directory of the runtime user.

OCS The path to TES.

OCSJNUM The job ID number.
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Adding Jobs to the Production Schedule

Adding a Job or Job Group to the Schedule

Jobs and job groups are added to the production schedule in various ways:

• Method 1 – After defining a job or job group, click OK in the definition dialog.

If you assigned a calendar, the Effective Date dialog displays, under certain conditions as explained 
below.

Note The Effective Date dialog displays when first adding a job to the schedule or when modifying certain 
job parameters that affect how the job runs. Changing a job’s command, calendar or agent parameter 
displays the Effective Date dialog while changing the owner, job class or notes of the job does not.

If you did not assign a calendar, a dialog displays a message that the job can only be added manually 
to the production schedule.

The Effective Date dialog is only displayed when accepting scheduled jobs whose next scheduled 
calendar date falls within the production schedule range and only when the master is running.

For example, if the current production date range is 12/10 to 12/20, and the next calendar date to run 
the job is 12/30, the Effective Date dialog will NOT appear. However, the job will be added to the 
schedule automatically on 12/30 through the automatic compile feature.

You can choose the day that the first instance of the job should run by selecting from the Scheduled 
Dates list when the Effective Date dialog displays. The Scheduled Dates list only includes dates 
that are currently in the production schedule and match the job’s calendar.

Note • Any changes made to a job definition do not apply to the current production schedule if the job has 
already run, even if the current date is selected in the Effective Date dialog. The following examples 
help illustrate the circumstances where modifications to a job definition do not apply to the current 
production schedule:

– If the job being saved has already started to run (any status other than Scheduled, Waiting on 
Dependencies or Waiting on Resources) or the job has completed.

– If the job being saved is a repeating job and has already run once.

OCSJNAME The name of the job.

OCSFJNAME The full name of the job.

OCSJUSER The owner of the job.

OCSJEUSER The runtime user.

OCSJHOST The host on which the job was scheduled.

OCSJEHOST The runtime host where the job is running.

OCSECODE Exit code of the job.

Table 5-4 Environment Variables

Variable Description
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– If the job being saved belongs to a job group where any of the other jobs of that job group have 
already started to run or have completed.

– If the job being saved belongs to a job group where any of the other jobs inside that job group 
are a repeating job and have already run once.
In these circumstances, to make the modified job definition run in the current day, you should 
use the Insert into Schedule option. Be aware that inserting the job manually will give the job a 
higher job instance number which may affect job dependencies within other job definitions.

If a job or job group repeats a specified number of times or if a job group contains jobs that repeat, 
the Start today’s repeating job(s) now option will appear in the Effective Date dialog. Selecting 
this option will create the first repeating instance now; otherwise, the instances will start at the 
beginning of the job’s time window. If you do not select this option, your job or group will enter the 
schedule on the date shown in the Effective Date dialog. If no time window is specified, it is 
assumed to be 12:00:00 AM to 11:59:59 PM. This may result in partial or even no scheduled 
instances of repeating jobs or groups if the current time is past the last repeat of the job.

If the master starts after the job has been created, the job will only enter the schedule on demand 
through the Effective Date dialog for the day or the next eligible day that is compiled.

If you submit a child job through the Effective Date dialog and the parent group is not in the 
production schedule, the parent group is automatically added as well.

• Method 2 – Right-click a job or job group in the Jobs pane or the Job Activity pane and select 
Insert Into Schedule from the context menu. Or, select a job or job group, then select Insert Into 
Schedule from the Activities menu. The Insert Into Schedule dialog displays.

Note The first selected job is the default for the Insert Into Schedule dialog. You can use this selection or select a 
different job using the Job Search dialog as explained in the Job Search dialog section.

Insert Into Schedule inserts one instance of the selected job or job group into the production 
schedule to run today, including its dependency criteria.

The job or job group must have the Unscheduled allowed option selected in its definition before the 
Insert Into Schedule method is available.

When a job group is selected to Insert Into Schedule, all of its members are also inserted. Only one 
instance will be added, even if the job or job group is defined to repeat during the day. 

If a child job is added using Insert Into Schedule, the job will not have a parent group in the 
production schedule. If the parent already exists in the schedule, the Insert Into Schedule method 
will not associate the child job with it and will not reflect its duration and status. If the parent does 
not already exist in the production schedule, the Insert Into Schedule method will not include it. 

If the job or job group already exists, a new instance will appear in the schedule, followed by a 
sequence number in parentheses, e.g., Job A (2).

• Method 3 – Select Create Schedule from the Activities menu.

The Create Schedule method deletes all instances in the production schedule for the dates you 
specify, and recreates the schedule with qualifying jobs as determined by the rules defined in the 
Job Definitions pane. All completed, active and previously scheduled jobs are removed. Extreme 
caution should be used with this method to prevent the inadvertent deletion of critical jobs.
5-157
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 5      Jobs
  Defining Jobs
Jobs that are not enabled, do not have associated calendars, or whose time windows have passed are 
not included in the production schedule when you use the Create Schedule method. Also, all jobs 
that were added to the production schedule manually for the selected day(s) are lost and must be 
re-inserted.

If you select the Start today’s repeating Job(s) now option with the Create Schedule method, the 
first instance of a repeating job will be the current time. Otherwise, they start according to their time 
window. If no time window is specified, it is assumed to be 12:00:00 AM to 11:59:59 PM. This may 
result in partial or no scheduled instances of repeating jobs or groups if the current time is past the 
last repeat of the job.

• Method 4 – The master compiles automatically at midnight.

At midnight, a new day is automatically added to the end of the current production schedule 
(determined by the configuration of how many future days to include). Whether the new day 
compiled is “tomorrow” depends on your configuration of Future Days to Include in Schedule. For 
more information on compilation options, see “Getting Started” on page 29. Qualifying jobs are 
added for the new day and the oldest day of history is removed.

Note The parameters for compilation are determined by your job and job group definitions and System 
Configuration settings. For more information on automatic compilation, see “Defining Jobs” section on 
page 5‐158

• Method 5 – The master automatically inserts a job into the schedule by a system or job event (new 
job action).

The new job action method is discussed in “Actions and Alerts” on page 215. The operation of this 
method is similar to using Insert Into Schedule, as described for Method 2.

Modifying a Job Occurrence in the Production Schedule

Following are the ways to modify the properties of an existing job instance:

• Change any of the original job’s properties except its name and TES will purge and replace job 
instances with the new property data.

Jobs that have not run and whose properties were changed are replaced with the new instances of 
the job when they re-enter the schedule. If the job’s Enabled option or calendar is removed, the job 
will be deleted and not replaced. Changes do not affect jobs that are rerun.

• Double-click a job in the Job Activity pane or right-click and select Details from the context menu 
to display the Job Detail dialog.

Use the Job Detail dialog to override the Agent or Agent List, Queue, Job Priority, Command, 
Environment file or Output File Name of an individual instance. This is very useful when the job 
does not run correctly using the original parameters, and you want to adjust them and rerun the job 
or job group without affecting the original job definition.

Defining Jobs
Job definition is central to job scheduling. The job definition defines:

• Which command to run

• Where the command runs
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• When to run the job

• How to handle dependencies

• Whether to issue actions based on pre-defined job events

• The job priority relative to other jobs

When you want to schedule a command to be executed, you use a job. Once a job is defined, you can 
keep the definition and run the job repetitively according to its specified calendar, or as needed.

Each job is assigned to only one command. The command can be an executable, a batch file (Windows 
only), a shell script, a command file or any other executable process. You can specify parameters to be 
passed to the command. This enables you to use one command in different ways, based upon the 
parameters that you pass to it.

For example, a job can back up files to tape, run a program to post transactions to a database or run a set 
of reports. In TES, you give each job a name, and, if the job is repetitive, a calendar by which it runs. 
You can also define dependencies that must be met before the command is executed. Using the calendar, 
TES automatically launches jobs each time they are scheduled to run, but only after all of their 
dependencies have been met.

All jobs are defined using the same basic Job Definition dialog. The standard Job Definition dialog can 
define the attributes of most scheduled jobs but some types of jobs have unique properties that require 
special fields to fully define what the job does. These jobs include FTP, MapReduce, SAP, PeopleSoft 
jobs and Oracle Application jobs. These jobs have their own page to define attributes unique to this type 
of job. 

Job/Job Group Definition Dialog 
The Job Definition and Job Group Definition dialogs appear when you add or edit a job or job group 
from the Jobs pane. These dialogs are used to define the properties of each job and group that is 
scheduled. 

Common To All Tabs

• Job Name or Job Group Name – The name you choose for your job or job group, limited to 256 
characters. The name must be unique within a group.

Note Do not use the text characters of “, / or = in the name that you assign to a job.

• Parent Group – The name of the job group to which the job or job group belongs. By default, a job 
inherits certain properties of its parent group. When a job group is added to the production schedule, 
all of its jobs are added automatically. Note that job groups are created using the Job Group 
Definition dialog.

Note You can clear the Parent Group list by right-clicking it and selecting Clear Selection from the context 
menu or by pressing the DELETE key.

• Job Class – The job’s or job group’s job class. Classes help categorize the job or job group. For 
example, you can have a classification for all Payroll jobs, or all Accounting jobs. Queues can be 
set up with queue filters to accept jobs of a particular classification or a set of classifications.
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Note You can clear the Job Class list by right-clicking it and selecting Clear Selection from the context menu 
or by pressing the DELETE key.

• Owner – The owner of the job or job group. This can be an individual user or a TES workgroup. 
Every job and job group must have an Owner.

Note If you are nesting a job group within another job group, it is recommended to use the same owner for all 
the jobs within the nested job groups. A job filter may have difficulty viewing the job groups correctly.

• Enabled – Clear the Enabled option to deactivate the job or job group definition. When a job 
definition is Enabled (active), it can be added to the production schedule. When a job is not 
Enabled (inactive), it will not be added to the production schedule during compilation. 

Note that if the job has been previously submitted to the production schedule, and if the job is 
presently in a pre-launch status, clearing this flag will remove the job from the production schedule. 
Furthermore, if the job had dependents, those dependencies are released.

• Last Modified Date – If you are editing the job or job group, on the bottom right of the Job/Group 
Definition dialog is the last modification date of the job. This date and time reflects the last time 
you saved the Job/Group Definition dialog data by clicking OK.

Program Tab

The Program tab displays in the Job Definition dialog. On this tab you specify the parameters and 
directories to be used as the command designated in the job runs.

This tab contains the following elements:

• Command/Parameters – The absolute path and filename of the command, script, batch file or 
executable that you want the job to run, from the perspective of the agent that it runs on. Do not use 
a mapped drive in the pathname. Follow UNC conventions when entering the pathname. Notice that 
there is a separate field for command parameters that is below the Command field. Do not add 
parameters to your command in the Command field.

Note You can view and edit the contents of command files by right-clicking the file from the Select Program 
dialog, then selecting Edit from the context menu.

You should specify the full path to the file you want to run. The format is \\<computer 
name>\<folder name>\<file name> or <drive>:\<folder name>\<file name>. You will only need 
the computer name if the job is running on a different computer from the Tidal Web client. To insert 
a variable into your path specification, click Variables and then select the variable you want to use. 

Another way to specify this command would be to define a variable called paydir whose value is 
the Payroll Executables directory. Then, you could specify your command line like this: 
<paydir>\payrolldat.exe. If the location of the payroll executables ever changes, you would 
need only to update the definition of the paydir variable for all the jobs using the paydir variable 
(rather than the literal location of the directory) to be updated.

Note You can view and edit the contents of command files by right-clicking the file from 
the Select Program dialog, then selecting Edit from the context menu.
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TES runs any command that is an executable such as files with the extensions .exe, .bat and .cmd or 
script files on the Unix platform.

• Command Parameters – Command parameters supply essential information that the command 
requires to run, and are passed to it when it is executed. Command parameters are appended to the 
command exactly as entered. This field will accept up to 1,024 characters.

Command parameters allow a single command file to be used for multiple purposes. For example, 
a command that processes data from a certain file could be given the file’s name as a command 
parameter. You can type all your parameters on a single line. TES will wrap the text display so that 
it is easier to read. 

TES uses the standard MS-DOS command syntax for command parameters. The command 
parameters are substituted into a command file containing the variable names %1, %2, etc. When 
the command is issued, command parameters are passed exactly as you specify them. You should 
separate each parameter value with a space so that the first value replaces %1, the second value 
replaces %2 when the batch file is executed.

Note Any argument that either explicitly has a space in it or could have a space in the argument should be 
enclosed in quotation marks; otherwise, the argument is returned as separate arguments wherever the 
spaces occur. For example, a job called Section 59 Tally would be returned as separate arguments, 
“Section,” “59” and “Tally.” Similarly, if a variable like <jobname> could return an argument containing 
a space, it also should be enclosed in quotation marks.

The following batch file is an example of how Windows accepts and handles command parameters. 
Listed below are the contents of the Argdemo batch file, found in the TES Agent Tutorial directory.

@ECHO OFF
title ArgDemo.bat
ECHO This job will run the sleep program for 60 seconds
ECHO then echo back the first three job parameters
%Tidal%\agent\tutorial\SLEEP.EXE 60
echo Program Parameter 1 = %1
echo Program Parameter 2 = %2
echo Program Parameter 3 = %3
ECHO done
ocsexit 0

Note Variables will be replaced by actual values when the command runs. If the variable is used with a 
repeating job, the value of the variable assigned the first time that the job runs remains the value each 
time the job runs. 
Since the variable values are determined as when the command runs, do not use job runtime variables in 
the command parameters. The true value for variables like Start Time and Finish Time cannot be 
determined until after the job completes.

You can type in command parameters or specify Job, System, Public or user-defined variables. For 
convenience, you can right-click inside the Command Parameters field to display a context menu. 
This menu offers the following options to manipulate text: Undo, Cut, Copy, Paste, Delete and 
Copy All.

• Environment File Name – In this field, type the directory path to a file containing a list of 
environment variables and their values for the job. The format of the file must be specified in 
name=value pairs. For example, variable1=<its value>, variable2=<its value>. This field is optional. 
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For more information about environment files, see “Environment Files” section on page 5-155. 

• Working Dir – In this field, a directory can be specified for a program or script to run in. Type the 
pathname for the directory that the program or script specified in the Command field should execute 
in. If this field is left blank, the default is for the script or program to run in the same directory that 
it is located in (unless the script or program automatically changes to a different directory).

• Capture Alternate Output File – If a file is specified in this field, the agent looks for the output 
file in the location specified and reads it as text, returning that text as the output of the job instead 
of gathering the job process’s standard output. A job process’s “standard output” is the text that 
would be returned to the screen if you were to run the process manually via a command line 
interface. However, some applications do not return any “standard output,” resulting in a blank 
Output tab in the Job Detail dialog if run by TES. 

For example, if your job produces a small report in plain text format, you can specify that file’s 
pathname here. (Refer to the Load URL feature on the Runbook or Notes tab for details on 
presenting a non-text file for viewing via TES. If this field is not used, TES provides the default 
standard output file produced by the process launched on the agent.

• Variables – Click this button to display a context menu of variables categorized according to Job, 
System, Public or specific to a remote master that can be used with the command. There may be 
several remote masters with their own variables. You can use these variables in the Command, 
Command Parameters, Environment File Name and Output File Name fields.

Schedule Tab

This tab of the job definition determines when and how often a scheduled job will run by controlling its 
calendar and time window.

Calendar Section

You can specify the days and times when the job will run and any calendar offset. 

• Inherited – When selected, all properties on this tab, except those in the Repeats section, are 
inherited. If you want to explicitly set these properties, clear the Inherited option (which only 
appears when there is a Parent Group specified in the definition).

• Calendar Name – The calendar or calendar group indicating which days the job should run. You 
must select a calendar for the job to be scheduled automatically. Select the Calendar Name from 
the drop-down menu. A calendar can encompass one or more days. You do not need to select a 
calendar if you plan to use this as an unscheduled job.

Note You can clear a calendar by right-clicking the Calendar field and selecting Clear from the context menu, 
or by pressing the DELETE key.

• From – The earliest date that the job should run. The job will run starting with the first date in the 
calendar that is on or after this date. You can choose a date using the built-in calendar dialog by 
clicking the drop-down button next to the field.

• To – The last date the job can run based on the calendar. If not specified, and your calendar includes 
repetitive dates, your job will run indefinitely. You can choose a date using the built-in calendar 
dialog by clicking the drop-down button next to the field.

• Timezone – The timezone for the job or job group. 
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You can configure timezones where target application environments are based. This allows you to 
schedule a job or job group across multiple timezones. If a timezone value is not specified in a job 
or job group definition, the master will default to the master timezone.

• Offset – The job will run a given number of days before or after every day in the calendar. Each day 
in the calendar is adjusted by the offset you provide. For example, if the job is using the Fiscal 
Month End calendar with an offset of 2, the job will be inserted into the schedule 2 days after Fiscal 
Month End date. If you use an offset of –2, the job will be inserted 2 days before the Fiscal Month 
End date.

• Forecast – Click this button to display the Calendar Forecast dialog for the selected calendar 
(adjusted by offset, if provided) showing all the dates for which the job will be scheduled. For more 
information, see “Calendar Forecast Dialog” section on page 5-185.

Time Window Section

• Only start the job between the hours X and Y – Start the job on or after time X, but no later than 
time Y. If you do not type a value in either field, the time defaults to the start of the production day 
or the end of the production day, as the case may be: 

– If only X (the first time value) is specified, for example 5:00 PM, the job can launch between 
5:00 PM and 11:59 PM of the same day. 

– If only Y (the second time value) is specified, for example 3:00 PM, the job can launch between 
12:00 AM (midnight) and 3:00 PM of the same day.

The time window function is a little more complicated with job groups. The time window of any 
child job of a job group, must be confined within the time window of its parent job. By selecting the 
Inherited option in the Time Window section of a job within a job group, a child job would inherit 
the same time window as its parent job. Even if the child job does not inherit the time window of its 
parent than its default time window remains the time window of its parent job. The time window of 
a child job can be within than the time window of its parent but it cannot be larger than the time 
window of its parent job. 

The time format that appears in these fields is determined by the settings in the Windows Control 
Panel, Regional Settings.

• If not ready by end of time window – These options are not available until time values are entered 
in the fields above.

– Do not timeout – Select this option if you want to carry the job forward to the next day if it fails 
to start by the end of the time window specified. 

– Run again tomorrow – Select this option if the job has not run by the end of the time window 
specified, and you want to carry it forward to the next day. After the time window has passed, 
the job has the status Timed Out For Day. With this option selected, the job is eligible to run 
on each subsequent day, until it does run. You can set up a job action to notify you if your job 
does not run on the originally scheduled day. 

If Do not timeout and Run Again Tomorrow are both unchecked, the job will timeout at the end 
of the time window.

If Do not timeout is checked, but Run Again Tomorrow is unchecked, the status of the job will not 
be set to Timeout. However, any job events running that are based on the end of the time window 
are triggered at the end of the time window.

If Do not timeout and Run Again Tomorrow are both checked, the status is set to Timed Out For 
Day and the job carries over to the next day and run then.
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Note Each instance of the job that is scheduled through the Repeats section will recheck the dependencies of 
the original job. For more information, see “Dependencies Tab” on page 168.

Repeats Section 

• After job execution

– Do not repeat – Only one instance of the job will be compiled for each production day that the 
job is scheduled to run.

– Run new occurrence every X minutes up to Y times – 

 X – The interval between consecutive job start times in minutes relative to the 
beginning of the time window. 

 Y – The number of instances to create for the job. A job will not launch after the end 
of its time window. If this field is left blank, the job continually repeats until the end 
of the time range specified above, or if the time window is omitted, until 11:59 PM 
of that day.

The following rules govern this function:

 If the job is defined to run at specific intervals relative to a time window, the 
resultant run times are fixed.

For example, if a job’s time window begins at 12:00 PM, and the job is defined to 
run every hour up to 4 times, the job will run 12:00 PM, 1:00PM, 2:00PM and 
3:00PM. If the Create Schedule command occurs at 1:30PM, this job will run twice, 
once at 2:00 PM and once at 3:00 PM (unless the Start today’s repeating jobs now 
option is selected in the Effective Date dialog).

 If no time window is supplied, the job will begin at 12:00 AM and will repeat the 
number of times specified.

 If you change the job definition while one of the repeat jobs is running, and the 
repeat count is changed, all job instances in pre‐launch statuses will be removed 
from the Production Schedule, and the number of job instances added will equal 
the total number of instances specified minus the number of job instances that have 
already launched.

For example, if you specify that Job A runs 4 times, and the 2nd instance has 
started, then you change the repeat count to 5, the 2 instances that already ran will 
remain in the schedule, the 2 jobs that have not run yet will be removed, and 3 jobs 
will be added to run in sequence after the 2nd instance finishes.

 The Run new occurrence every... minutes up to... times option is ignored for jobs 
manually added to the schedule. Only one instance of the job will be scheduled.

 If the job is manually added to the schedule, and other jobs depend on the last 
instance of this job, the dependencies will be updated to reflect the new instance.

– Rerun same occurrence after... minutes up to... times– This option is similar to the one above 
with a few exceptions. Only one instance of the job is created. Rather than creating a new job 
instance, the same job instance will rerun after x number of minutes up to the prescribed y 
number of times. x is the interval between completion of the previous run and the beginning of 
the next one. This means that the actual rerun frequency is x plus the actual job runtime interval. 
The Rerun same occurrence after... minutes up to... times option also applies to repeating 
jobs that are manually added to the schedule (from the Insert Job into Schedule context menu 
option).
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Note Jobs dependent on a job using the Rerun same occurrence after... minutes up to... times option may 
or may not have their dependency satisfied, even if it should be, yielding potentially inconsistent results. 
Setting job dependency this way is not recommended. 
Instead:

• Put both jobs under the same group.

• For the group, select the Rerun same occurrence after... minutes up to... times option on the 
Schedule tab of the Job Group Definition dialog.

• For each job, select the No repeat option on the Schedule tab of the Job Definition dialog.

If you do not specify how many times a job should repeat, it will repeat throughout the day at the 
designated interval. The option to begin today’s repeating jobs when the job is submitted is not 
offered in the Effective Date dialog.

Note If a job group configured with the rerun same occurrence option has already completed some jobs, do 
not modify its definition. Modifying the parameters of the job group after some of its jobs complete will 
result in some jobs not rerunning as they should.

Run Tab

The Run tab of the Job Definition dialog manages where the job will run, the duration of the job and 
how to determine if the job completes successfully. The Run tab for a job group definition does not have 
a Tracking section to determine a job’s successful completion.

Note If the job exists under a parent group, by default, all properties in the Agent Information section are 
inherited from its parent job group. If you want to override any one of these properties, clear the 
Inheritance option.

Agent/Adapter Information Section

• Agent/Adapter Name – The agent machine on which the program or script runs. You must use an 
agent that corresponds to the platform where your program or script can run. This value defaults to 
the agent name specified in the System Configuration dialog, Defaults tab. Note that if you select 
an agent name, the Agent List Name field is reset.

Note The Tidal Agent for Unix runs as the agent owner with the same security rights as its owner. By default, 
the agent does not have access to all of the dependent files, scripts and environment variables it may 
need. A Unix job cannot complete successfully unless you ensure that the agent has the proper access 
rights to all of the files needed during the processing of a job.

• Agent List Name – An agent list is a set of agents that can run the program or script, or the agent 
machines on which you want the program or script to run. Agent lists allow for workload balancing, 
broadcasting, and dynamic rerouting. You must select an agent list for the platform on which your 
program or script can run. Note that if you select an agent list, the Agent Name field is reset.
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• Runtime User – The logon name of the user under whose account the program or script needs to 
run. If you are creating the job for another user and you are authorized to do so, you can select the 
user for this field from the drop-down. If the user does not appear on the drop-down menu, the user 
needs to be added to your list of Runtime Users in your User Definition. See the following section 
for information on creating a special type of runtime user account called local system.

Note If you are selecting a runtime user for an agent list, the user must exist on all agents in the agent list. The job 
will fail if it runs on an agent where the user is not defined.

Note You can clear the above fields by right-clicking them, and selecting Clear from the context menu or by 
pressing the DELETE key.

Tracking Section (job only, does not apply to job group)

• Exit Code – The job completion status is determined by the job’s exit code. An exit code of 0 sets 
the job status to Completed Normally. Any other exit code sets the job status to Completed 
Abnormally.

The exit code of a job is set depending on the type of agent and script you are using. The exit code 
is determined by using the ocsexit command at the end of the batch or command file run by a job. 
The exit code value can range from 0 to 30,000.

• External – Selecting this option means that the status of a completed job is determined externally 
by a user or program. TES will set the job status to Externally Defined when the job completes. 
You can then have the active job completion status set through an action, or use the Set command 
from the Job Activity pane context menu. For more information, see “Actions and Alerts” section 
on page 6-215.

• Exit code of cmd pipe – Select this option if you want to pipe the output of your job as input to a 
command and use the exit code of the last command in the pipe to determine the success of the job. 
This scanning of output is case-sensitive unless the Master.Props file is modified to make scanning 
insensitive to case. Refer to Appendix C: Parameter Values for more information.

Note You cannot reference the output from the command pipe in the same job that creates it. Only a different 
job can use the current job’s output.

This allows you to use output analysis tools to determine the job status. If you use this option, type 
the command pipe in the associated field.

Note A maximum of 1024 characters of output can be piped to another command.

• Scan Output: Normal String – Select this option if you want a particular text string in the output 
from a job to determine that a job completed normally. In the associated field, type the text string 
that will signify “normal.” To use the text string as a whole, enclose the text in quotation marks; 
otherwise, TES treats the text string as a list of random words and any single word of the text signals 
“normal.” 
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• Scan Output: Abnormal String – Select this option if you want a particular text string in the output 
from a job to determine that a job completed abnormally. In the associated field, type the text string 
that will signify “abnormal.” To use the text string as a whole, enclose the text in quotation marks; 
otherwise, TES treats the text string as a list of random words and any single word of the text signals 
“abnormal.”

Note You can scan job output for multiple strings. Listing multiple text strings separated by commas means 
any one of the listed text strings can signal that the job completed normally or abnormally. Listing text 
strings separated by plus signs means all of the text strings must appear in the job output to determine if 
the job completed normally or not. If the text strings contain commas or pluses, enclose the text string 
in quotation marks. You cannot mix commas and pluses together as separators.

Duration (in minutes) Section

• Estimated – The estimated duration for the job specified in minutes, or a fraction thereof. The 
estimated run time is used to create the forecast shown in the Job Activity pane. It is also referenced 
by the Job finished later than expected job event trigger. You can use the Estimated Duration 
field to monitor jobs that run for a shorter or longer time than expected. For example, you could set 
up a job event triggered by Job finished later than expected, with an associated email action that 
will notify you when a certain job that normally runs for 5 minutes, runs for more than one hour. 
For more information about job events, job event triggers and actions, see“Actions and Alerts” 
section on page 6-215

• Minimum – The minimum duration that you expect your job to run. You can create a job event to 
monitor and perform an action if the job completes in less than the minimum time. For example, you 
could set up a job event and job action that would run a diagnostic tool if it completes in less than 
the Minimum time.

• Maximum – The maximum duration that you expect your job to run. You can create a job event to 
monitor and perform an action if the job runs over the maximum time. For example, you could setup 
a job event and job action to stop the job if it runs past the Maximum time.

• Exclude Completed Abnormally when calculating Estimated Duration – Prior to TES 6.0, the 
calculation of the Estimated Duration of time that a Job should run includes the previous execution 
time for both Jobs that completed normally and abnormally. Selecting this option allows you to 
control which Jobs are included in that calculation.

Using Local System Accounts for Windows Jobs

Usually, jobs running on a Windows agent use the user account configured for that agent. Jobs can also 
be run under specific runtime user accounts using Windows passwords if configured on the Master tab 
of the System Configuration dialog. An alternate method is to use runtime Local System accounts for 
some or all Windows jobs that are generic by nature and do not require a password. Using the Domain 
field, you can make Local System available globally or restrict its use to specific machines or some 
combination of both. 

To use a local system account:

Step 1 From the Navigator pane, select Administration>Users to display the Users pane.

Step 2 Click the Add button or right-click and select Add User from the context menu to display the User 
Definition dialog.

Step 3 Type LocalSystem in the User Name field. 
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Step 4 Type LocalSystem in the Full Name field. This name is used in TES reports and some dialogs.

Step 5 If you wish the Local System account to be available to all machines, leave the Domain field blank; 
otherwise, type the name of the machine.

Step 6 Select the Runtime User Only option. 

The Runtime Users, Workgroups and Other tabs of the User Definition dialog disappear when 
the Runtime User Only option is selected, since this user is only launching jobs, not logging in to 
use TES.

Step 7 After creating the Local System account, you need to grant or deny each user the right to use the Local 
System runtime user account.

a. From the Navigator pane, select Administration>Users to display the Users pane.

b. Double-click each user account to open the User Definition dialog and click the Runtime 
Users tab. 

c. Select the Local System option and click OK.

Now authorized users can run jobs without passwords using the local system account if the user has that 
runtime user right.

Dependencies Tab

The Dependencies tab of a job definition manages a job’s interaction between the various job, file and 
variable dependencies that a job may require to run to completion.

Note Each instance of the job will include the dependencies you define on the Dependencies tab.

This tab contains the following elements:

• Dependency Name Column – The name of the job, group, file or variable dependency.An 
intermaster variable displays in the following format, variable name@master. If the connection to 
the remote master is lost then the variable shows a current value of Unavailable though the value is 
updated as soon as the connection is restored. An intermaster variable deleted from the remote 
master or no longer published has a value of Not Published.

• Type Column – The type of dependency.

• All must be met – When selected, all the dependencies in the above list must be met before the job 
can run. This option does not include time dependencies. All must be met means that each 
dependency condition must be met at the same time for the job’s dependencies to be satisfied.

If a dependency’s state changes from met to not met while other dependencies are still not met, and 
the other dependencies subsequently change state from not met to met, the All must be met 
condition option is still not satisfied. All dependencies must be in the met state simultaneously.

• At least one must be met – If selected, when any one of the dependencies in the above list is met, 
the job can run. This option doesn’t include time dependencies. Time dependencies are set using the 
time window section on the Schedule tab.

• Rerun each time dependencies are met – The job will run every time that all its dependencies are 
met, with these exceptions:

– The Rerun each time dependencies are met option cannot be used in conjunction with the 
Rerun same occurrence... option on the Schedule tab, Job Definition dialog.
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– If your job is dependent on a job with multiple instances, the dependency is set only to the first 
instance. The Rerun each time dependencies are met option will only be triggered if the first 
instance of the dependency is rerun. 

If the master goes down (or fails over if running in a fault tolerance configuration) while a job with 
this option runs, the job will run again when the master restarts if all of the job’s dependencies are 
still met. To prevent the job from rerunning when the master restarts, modify one of the 
dependencies to keep it from being met. For example, delete a file if the job has a job dependency 
so that only a new file will meet the job’s dependency.

Note Jobs dependent on a job using the Rerun same occurrence after... minutes up to... times option will 
never be satisfied. 

Instead: 

Step 1 Put both jobs under the same group.

Step 2 For the group, select the Rerun same occurrence after... minutes up tINTERNET.. times option on 
the Schedule tab of the Job Group Definition dialog. 

Step 3 For each job, select the No repeat option on the Schedule tab of the Job Definition dialog.

• Add – Click this button to display a drop-down menu for you to add a job, file, variable or z/OS JES 
dependency.

• Edit – Click this button to edit the selected job, file, variable or z/OS JES dependency.

• Delete – Click this button to delete the selected job, file, variable or z/OS JES dependency.

• Clear – Click this button to delete all of the listed dependencies regardless of type.

Setting Dependencies on a Job

The Tidal Agent for Unix runs as the agent owner with the same security rights as its owner. By default, 
the agent does not have access to all of the dependent files, scripts and environment variables it may 
need. A Unix job cannot complete successfully unless you ensure that the agent has the proper access 
rights to all of the files needed during the processing of a job.

Each type of dependency (Job, File, Variable, and z/OS) being set on a job has its own definition dialog. 

Note Jobs dependent on a job using the Rerun same occurrence after... minutes 
up to... times option will never be satisfied. 

Instead: 

Step 1 Put both jobs under the same group.

Step 2 For the group, select the Rerun same occurrence after... 
minutes up to... times option on the Schedule tab of the Job 
Group Definition dialog. 

Step 3 For each job, select the No repeat option on the Schedule tab 
of the Job Definition dialog.
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Resources Tab

The Resources tab appears in the Job Definition dialog but not in the Job Group Definition dialog since 
resources cannot be assigned to a job group. Resources for a job, Virtual or System, are added and edited 
from this tab. 

Virtual resources are resources that already exist. By adding an existing resource to the Resources tab, 
you are able to manage the use of the resource by TES users. 

System resources are either Published or Custom. Agents that support published system resources provide 
information about those resources when a connection is established. You can create custom system 
resource definitions by specifying commands that will periodically run on an agent machine to obtain 
the resource values. 

System resource definitions are automatically created for published resources if they do not already exist 
for that connection type and the Published command displays.

A resource can be quantified and the sharing of the resource can be limited to a designated number of 
shares. A resource can be either a software resource such as a database or network or it can be a hardware 
resource like a machine. The job will not run until all of the resources listed on this tab are available for 
the job when it runs. A job can still use a resource that is not listed on this tab, but if a resource is listed 
on this tab of a job's definition, it creates a “reservation” for the job to use a set amount of the resource.

This tab contains the following elements:

• Virtual Resources – You can add, edit, and delete virtual resources from this tab.

– Resource – Displays the name of the virtual resources associated with the job. 

– Amount Required – Displays the amount of the resource needed by the job. This amount is 
defined in the Resource Requirement Definition dialog.

– Add – Click this button to display a Resource Requirement Definition dialog to associate an 
existing resource to this job.

– Edit – Click this button to display the Resource Requirement Definition dialog of the selected 
resource to edit it.

– Delete – Click this button to delete the selected resource.

– Clear – Click this button to delete every resource listed for the job definition.

• System Resources – You can add, edit, and delete system resources from this tab.

– Resource – Displays the name of the system resources associated with the job. 

– Condition – Contains the conditional operators depending on the data type of the resource.   

For Integers, the conditions supported are:

• Equals (=)

• Does Not Equal (<>)

• Greater Than (>)

• Greater Than Or Equal To (>=)

• Less Than (<)

• Less Than Or Equal To (<=)

Strings support all of the conditions above and the following:

• Contains

• Does Not Contain
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• Matches Pattern

• Does Not Match Pattern

• Matches Regular Expression

• Does Not Match Regular Expression

– Value – Contains the value for the condition.

– Add – Click this button to display a System Resource Requirement Definition dialog to 
associate an existing system resource to this job.

– Edit – Click this button to display the System Resource Requirement Definition dialog of the 
selected system resource to edit it.

– Delete – Click this button to delete the selected system resource.

– Clear – Click this button to delete every system resource listed for the job definition.

Published Resource Definition Dialog (read-only)

System resources are either Published or Custom. This dialog displays the name, data type and operating 
system of a Published resource and is read-only. Agents that support published system resources provide 
information about those resources when a connection is established. 

Resource Requirement Definition Dialog

When you click Add on the Resources tab of the Job Definition dialogs, the Resource Requirement 
Definition dialog displays.

The Resource Requirement Definition dialog is used to add or edit an existing resource to a job from the 
Resources tab. From this dialog, you specify which resource and how much of the resource is needed by 
a job. If the Enabled option is not selected in the resource's definition, then the resource does not display 
in the drop-down list.

This dialog contains the following fields:

• Resource – The name of the defined resource. Only resources that are enabled are available from 
this field. Once the resource is selected, its maximum limit displays beside the Amount Needed 
field.

• Amount Required – The amount of the resource's specified limit that the job requires. This number 
cannot exceed the limit of the resource noted as (Max) beside the field.

System Resource Requirement Definition Dialog

When you click Add on the Resources tab’s System Resources section of the Job Definition dialogs, the 
System Resource Requirement Definition dialog displays.

The System Resource Requirement Definition dialog is used to add or edit an existing system, resource 
to a job from the Resources tab. From this dialog, you specify which resource and how much of the 
resource is needed by a job. If the Enabled option is not selected in the resource's definition, then the 
resource does not display in the drop-down list.

This dialog contains the following fields:

• System Resource – The name of the defined resource. Only resources that are enabled are available 
from this field. Once the resource is selected, its maximum limit displays beside the Amount 
Needed field.

• Operator – Select the conditional operator depending on the data type of the resource.
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• Value – Enter the value for the selected resource.

For more information about defining a resource, refer to Resources Pane, page 10-330.

Variables Tab

The Variables tab appears in the Job Group Definition dialog but not in the Job Definition dialog. This 
tab is used for specifying that a job group use certain variables instead of global variables. When 
multiple instances of a job group using global variables run concurrently, data values cannot be 
preserved since the variable value changes as each job group instance runs. By assigning variables to the 
Variables tab, the variable becomes “localized” or isolated from the changes that occur outside of the 
job group. These variables can be either variables hard-coded to specific values or global variables 
available from the Variables button menu. Child groups have access to parent group variables through 
the Variables button menu.

A job that is a regularly scheduled production job uses the default values for its variables. However, a 
job group inserted into the schedule manually can specify values to be used only by that run of the job 
group.

The ad hoc job group instance and any child job groups associated with it will use the variable values 
specified at insertion regardless of other occurrences of the same job group that may be running and 
using a different set of variable values.

Job Events Tab

This tab is used to assign predefined job events to a job and to arrange the job events into a desired 
sequence. You can only associate predefined job events to a job from this tab. To create or modify a job 
event, you need to open the job event’s definition in the Job Events pane. 

This tab contains the following elements:

• Event Name column – The name assigned to the job event.

• Event Trigger column – The condition that triggers the associated job event. 

• Insert – Click this button to display the Select Job Event dialog where you can select one or more 
predefined job events to assign to your job. Job events are created from the Job Events pane. 

• Edit – Click this button to display the Job Event Definition dialog of the job event that was selected 
to modify the event.

Note Any changes you make to a job event from the Job Events tab of the Job or Job Group Definition 
dialogs affect all jobs to which the event is assigned, not just the current job or group.

• Delete – Click this button to remove the selected job event from the list. 

Note When you assign a job event to your job, the job event no longer appears in the Select Job Event dialog. 
When you delete a job event from the Job Events tab, the job event returns to the Select Job Event 
dialog.

• Clear – Click this button to delete all of the defined job events clearing the tab.

• Move Up – Click this button to move the selected job event up in the sequence of job events.

• Move Down – Click this button to move the selected job event down in the sequence of job events.
5-172
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 5      Jobs
  Defining Jobs
Job Events That Apply To All Jobs Section

This section is read-only. These are job events that apply to all jobs. They are not individually assigned. 
You can only change a system-wide job event from the Job Event Definition dialog. 

• Event Name column – The name assigned to the job event.

• Event Trigger column – The condition that triggers the associated job event. 

Select Job Event Dialog

When you click Insert from the Job Events tab of the Job or Job Group Definition dialogs, the Select 
Job Event dialog displays.

This dialog shows the available job events you can assign to your job. Visible are all the job events you 
own, and the ones owned by workgroups of which you are a member. 

The Select Job Event dialog contains the following columns:

• Event Name – The name(s) of the job events you can associate to the job.

• Event Trigger – The job event triggers that issue the job events. You can select more than one event. 
After you click OK, each selected event is added to the job event list.

When you click Edit from the Job Events tab of the Job or Job Group Definition dialogs, the Job Event 
Definition dialog displays.

Group’s Events Tab

The Group’s Events tab is only displayed in the Job Group Definition dialog. This tab lists job events 
that are designated to be inherited by the children of the job group. The job events that are associated 
with the job group can be configured to occur either before or after the job events assigned to each 
individual child job occur. 

This tab contains the following elements:

• Before tab – Lists the job events that must occur before the job instance’s own job events. You 
arrange the order of the job events listed here to specify the sequence that the job events should 
follow.

• After tab – Lists the job events that must occur after the job instance’s own job events. You arrange 
the order of the job events listed here to specify the sequence that the job events should follow.

• Event Name column – The name assigned to the job event.

• Event Trigger column – The condition that triggers the associated job event. 

• Level column – The generations of job children that will inherit the listed job event. This is 
specified by clicking in the field and entering the number of the child generation. Level 1 events are 
only triggered for up to the child job/group. Level 2 events are triggered for grandchild job/group as 
well as child job/group.

Example

If a Job Group is set up this way:

A1: Parent

               A2: Job whose parent is A1.

               B1: Subgroup whose parent is A1.

                               B2: Job whose parent is B1.
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In this scenario, Level 1 would be B2, and Level 2 would be A2/B1.

If B2 fails with the Event on Level 1, there will be 1 event triggered on B2.

If B2 fails with the Event on Level 2, there will be 2 events triggered - one on B1, and B2.

• Insert button – Displays the Select Job Event dialog where you can select one or more predefined 
job events to assign to the job class. Job events are created from the Job Events pane. 

• Edit button – Displays the Job Event Definition dialog to modify the selected job event.

• Delete button – Removes the selected job event from the list.

• Clear button – Deletes all of the defined job events clearing the field.

• Move Up button – Moves the selected job event up in the sequence of job events.

• Move Down button – Moves the selected job event down in the sequence of job events.

Options Tab

The Options tab provides fields that enable individual job instances to override various global settings 
that control a job's properties such as output handling, history retention, carryover, priority and operator 
control. The Options tab for a job group does not have all of the fields that are available for a job 
definition.

This tab contains the following elements:

• Job Alias – A short one- to eight-character identifier for this job or job group. For convenience, 
many of the commands in the command-line interface refer to the job or job group using its alias 
name. 

• Job Priority (Job Definition dialog only) – The priority of the job within its assigned queue. The 
job priority determines which job runs first within a queue, when the queue limit only permits 
launching of one additional job. Queue priorities determine which queues get preference. The larger 
the priority number, the higher the actual priority (i.e., all other things being equal, a job with a 
priority of 75 would run before a job with a priority of 50). For example, a job with a priority of 75 
in a queue with a priority of 50 will generally run after a job with a priority 50 in a queue with a 
priority of 75, even through the job priority is greater. 

• If Job is currently running (Job Definition dialog only) – Determines what to do to if a job is ready 
to launch and an instance of the same job is already running:

– Run Anyway – Runs a new instance of the job even though a previous instance is already 
running.

– Skip – Skips the job if a previous instance of the job is already running. This setting will not 
run the job when the prior instance finishes. A skipped job cannot be rerun.

– Defer until Normal – Runs the job only after the previous instance of the job completes with 
a Completed Normally status. If the previous instance does not complete normally, this job will 
not run.

– Defer until Complete – Runs the job only after the previous instance completes regardless of 
the final status of the previous job.

• Base time needed to run job on – Sets the default basis for evaluating whether jobs will complete 
before a scheduled outage. Whether jobs have adequate time to run can be based on either of the 
following factors:
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– Estimated Duration – The estimated duration for the command or executable as specified in 
the job definition. If the job has run more than once with the same command or executable, the 
estimated duration is the historical average of the job’s previous run times. You can also 
manually set the estimated duration time of a job in its definition. 

– Maximum Duration – The maximum duration for the command or executable as specified in 
the job definition. If the job has run more than once with the same command or executable, the 
estimated duration is the historical average of the job’s previous run times. You can also 
manually set the estimated duration time of a job in its definition. 

• If not enough time before outage – Sets the default action for occasions when a job may run into 
an outage window as based on the evaluation option set in the Base time needed to run jobs on text 
field. There are three options:

– Run Anyway – Run the job instance even at the risk that the job may not complete before the 
outage window.

– Skip – Do not run the job instance if it may run into an outage window.

– Defer – Wait to run the job until after the outage window has ended.

• Save Output Option (Job Definition dialog only) – Specifies what will happen to the job’s output. 
If you save the output, you can view it by double-clicking the completed job in the Job Activity 
pane. The Job Detail dialog appears, displaying the output text.

– Discard – To Discard is the TES default setting for job output. Output is not saved for viewing 
after the job runs. 

– Append – Saves the output of the job in the master database, adding to the first output file every 
time the job runs.

– Replace – Saves the output of the job in the master database, overwriting the existing output 
file with a current one every time the job runs. 

Note Standard output and standard error output are combined in TES job output files. You cannot separate 
stdout and stderr.

• Allow Unscheduled – Enables the job to be inserted into the production schedule on an as-needed 
basis. The default is that unscheduled instances are allowed. If you do not want the job to run on an 
ad hoc basis, you can clear this option to prevent non-scheduled submissions.

• Require Operator Release – Holds the job until an operator releases it. The job will not run until 
it is released. When all the job’s dependencies are met, and it is ready to run, its status is Waiting 
On Operator. The information in the Operator Instructions field (Description tab) can inform the 
operator of any external requirements that need to be met before the job is released.

• Allow operator rerun – Allows the operator to rerun a job. The default is allow operator reruns (box 
checked).

• Disable carryover – Disables the job carry forward feature that appends the jobs that did not run in 
the current production schedule to the next day's production schedule. Any job from the current 
production schedule that is not in an Active or a Launched status when the next production day 
starts, will not be carried over to the next production day. The default is to enable job carry forward 
(unchecked).

• For Unix, source user’s profile – Allows you to execute Unix user profiles. This option provides 
for the execution of all variables in a Unix user’s profile. Without this option, Unix user profile 
variables that are referenced by scripts are not being executed, causing errors in TES.
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• History Retention (in days) – The retention of the job history data, including job output. Use this 
field to adjust the job history data displayed on the History tab of the definition dialog. TES will 
automatically purge all job instance history older than this retention history setting if the Automatic 
Daily History Cleanup option is enabled on the Master tab of the System Configuration dialog.

Run Book Tab

The Run Book tab provides a place in the job definition to display operator instructions pertaining to 
running the job. provides a place for instructions or information pertaining to the job. Text instructions 
can be provided but a Web page can also be loaded and displayed. A page on your company's intranet 
with relevant information or a PeopleSoft login page could be displayed.You can also enter a pathname 
to a directory on the network to display the directory’s contents to verify that a file exists in the directory.

This tab contains the following elements:

• Operator Instructions – A free text field where you can type any instructions for the operator, up 
to 255 characters long or type a web address that provides relevant information about the job. If you 
choose the Require operator release option on the Options tab, you could use this field for detailed 
reminders about the circumstances under which to run this job with the Require operator release 
option selected. While text instructions can be provided, a web page can also be loaded and 
displayed.

• Load URL – First, type a web URL in the Operator Instructions field and then select this option. 
This Web address can be for an internet/intranet site or a directory on the network. This can be very 
useful if information pertaining to a job is stored on a company intranet or a login page must be 
accessed. 

Note • In order to use Load URL feature to load contents of files, located on the network Windows shares, 
following rules should be utilized:

– You will need to supply file:// as the protocol indicator. 
For example, 
file:///\\<yourcomputer>/Share_here/<JobID>.txt

– Loading the content through file:// protocol works without any intervention from Internet 
Explorer. However, Firefox, by default, does not allow the browser to load content from local 
system for security reasons. Modify the Firefox browser setting to allow it.

• Variables – The drop-down list available from this button provides access to the following three job 
variables for customizing TES to your application:

– Job Name – The name of the job. 

– Job Alias – The alias of the job.

– Job Run ID – The job run ID of the job.

If your application uses other files with its jobs, using one of these variables in the file name can provide 
access to the file from the Job Activity pane. Enter the network pathname of the file on this tab and select 
the Load URL option. For example, entering file://\<JobID>.txt on this tab will display the 
contents of this file on the Runbook tab of the Job Details dialog.
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Notes Tab

The Notes tab is very similar to the Run Book tab. This tab provides a space to display additional 
information about a job, either as written text or as a Web page.

This tab contains the following elements:

• Other Notes – A free text field where you can type any instructions for the operator, up to 255 
characters long or type a web address that provides relevant information about the job. While text 
instructions can be provided, a web page can also be loaded and displayed. A page on your 
company's intranet with relevant information or a PeopleSoft login page could be displayed. You 
can also enter a pathname to a directory on the network to display the directory's contents to verify 
that a file exists in the directory.

• Load URL – First, type an internet or network directory URL in the Other Notes field and then 
select this option. This Web address can be for an internet/intranet site or a directory on the network. 
This can be very useful if information pertaining to a job is stored on a company intranet or a login 
page must be accessed

Note • In order to use Load URL feature to load contents of files, located on the network Windows shares, 
following rules should be utilized:

– You will need to supply file:// as the protocol indicator. 
For example, 
file:///\\<yourcomputer>/Share_here/<JobID>.txt

– Loading the content through file:// protocol works without any intervention from Internet 
Explorer. However, Firefox, by default, does not allow the browser to load content from local 
system for security reasons. Modify the Firefox browser setting to allow it.

• Variables – The drop-down list available from this button provides access to the following three job 
variables for customizing TES to your application:

– Job Name – The name of the job. 

– Job Alias – The alias of the job.

– Job Run ID – The job run ID of the job.

If your application uses other files with its jobs, using one of these variables in the file name can 
provide access to the file from the Job Activity pane. Enter the network pathname of the file on this 
tab and select the Load URL option. For example, entering file://\<JobID>.txt on this tab 
will display the contents of this file on the Run Book tab of the Job Details dialog.

History Tab

The History tab displays status changes using history data for the job as far back as the retention period 
allows, sorted by job start time with the most recent first. It also shows scheduled jobs that have not run 
yet. If the job definition is new and the job has not ever run, then there is no History tab because there 
is no job history yet.

This tab contains the following elements:

• Date – The production date of the job instance.

• Status – The status of the job instance.
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• Actual Start Time – For job instances that have already run, or are running, the time the job or job 
group became active. For jobs that have not yet run, this field is empty.

• Estimated Start Time – For job instances that have already run or are running, the estimated start 
time that was predicted before the job or job group became active. For jobs that have not yet run, the 
estimated time that the job will become active.

• Duration – The runtime duration of the job in minutes. For job groups, the duration reflects the 
duration from the time the first job started to the time the last job ended.

• Rerun – The number of times that the job has run.

• Command – The command, program or script that was run.

• Priority – The priority assigned to the job.

Images Tab

The Images tab of the Job Definition dialog allows for the selection of an alternative icon for a job or 
group. This image is displayed on the Jobs pane or Business Views window.

FTP Job Definition Dialog
For a remote FTP (File Transfer Protocol) to work, the following limitations apply:

• FTP server must exist 

• FTP server on the local and remote side must be configured

Note Some FTP jobs may require that the domain name be part of the user name. If a FTP job requires the 
domain be part of the user name, before you can run the job you must modify the user name by adding 
the domain to the User field in the following format, domain\user.

When you select the Add FTP Job option, you will find that the FTP Job Definition dialog differs from 
the standard Job Definition dialog in two ways:

• Instead of a Program tab, there is an FTP tab

• Some of the fields on the Run tab are different to accommodate FTP requirements

These two tabs with their differences are described below. The other tab and fields in the FTP Job 
Definition dialog are the same as the normal Job Definition dialog. For information on the other tabs and 
fields refer to the section on “Defining Jobs” section on page 5-158.

FTP Tab

The FTP tab contains the following fields:

• Protocol – Select one of the following FTP protocols to use in this job:

– FTP – The job will use the normal FTP protocol. No file encryption is used with this option.

– FTPS – The job will use FTPS or FTP Secure and FTP-SSL.
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– SFTP – The job will use SFTP or Secure File Transfer Protocol. The file is encrypted when 
transferred between hosts using SSH2. SFTP can only use the binary format so the ASCII 
format is unavailable if this option is selected. The FTP Quote feature that assigns file 
formatting to a file being transferred between a mainframe and non-mainframe platform is 
unavailable with SFTP.

• FTP Operation – Define what the FTP job will do by selecting an option from the FTP Operation 
drop-down list. Select from the following options:

– PUT File – Copies the designated file from the agent to the FTP server.

– GET File – Copies the designated file from the FTP server to the agent.

– MPUT File – Copies multiple files using wildcards from the agent to the FTP server. (For more 
information on wildcards, refer to “Wildcards in File Dependencies” section on page 5-192.)

– MGET File – Copies multiple files using wildcards from the FTP server to the agent. (For more 
information on wildcards, refer to “Wildcards in File Dependencies” section on page 5-192.)

– RENAME File – Changes the name of the file on the FTP server.

– DELETE File – Removes the designated file from the FTP server.

– MDELETE File – Deletes files on remote computers.

– LIST Directory – Lists the files within a designated directory on the FTP server.

– MAKE Directory – Creates a designated directory on the FTP server.

– DELETE Directory – Deletes a designated directory on the FTP server.

The remaining fields on the FTP tab vary according to which FTP Operation option was selected.

• Format – There are two file formats available to use with FTP

– ASCII – This format maintains the line returns within a file but loses most other formatting. 
This format option is not available if the SFTP protocol option is selected.

– Binary – This format saves formatting within the file.

• Filename – Type the name of the file for the FTP operation.

• Replace Files – Select this option if you wish to overwrite existing files when using the MPUT or 
MGET options; otherwise, existing files are skipped.

• Local Path – This is the pathname to a directory on the local or agent machine. 

• Remote Path – This is the pathname to a directory on the FTP server.

• Quote – Type the formatting attributes for a file being transferred between a main frame platform 
and another platform, e.g., Windows to z/OS. The field is limited to 255 characters. This option is 
not available if the SFTP protocol option is selected.

• New Filename (Only used with the Rename File option.) – Designate the new name to be used 
when renaming the remote file.

• SFTP Options – The only secure shell option currently supported is SSH2 only.

• Advanced – Clicking this button displays the SFTP Advanced Settings dialog with the standard 
encryption options. Use this feature to configure the order to be used when cycling through the 
encryption protocols as the agent searches for the protocol used by the remote machine. The 
Encryption Cypher Selection Policy field displays the four most commonly used encryption 
methods:

– AES

– Blowfish
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– 3DES 

– DES

Any of these encryption methods may be used during the file transferal between two machines with the 
secure FTP procedure. 

Like strangers traveling in a foreign land attempting to communicate with one another, server machines 
do not know which encryption “language” is being used by the other. TES will try each of the listed 
encryption protocols to establish a common encryption protocol. A user can configure the order that TES 
tries when it attempts to find the encryption protocol recognized by the other machine. If the user knows 
which encryption protocol is used by the other system, the user can select that protocol and click the up 
and down arrows to move it to the top of the list where it will be the first protocol attempted during file 
transferal. Moving the correct protocol to the top of the list will eliminate guesswork and save time 
during the FTP process.

• User/Password – The user account and password used to logon to the FTP server. This could be a 
Windows or Unix account. If this option is selected then the Pass Phrase and Private Keyfile 
Location fields are not displayed.

• Private Key File – Indicates that a private key file is being used with this job instead of system login 
by the user. The key file must be generated by an SSH open system. To use a private key file, you 
must supply the password and directory location of the private key file.

• Pass Phrase – The password needed to access the private key file. 

• Private Keyfile Location – The directory pathname to the private key file for the agent. This should 
be a local directory rather than a network directory. 

• Variables – If you create an action that is tied to an FTP job, you can click the Variables button to 
use a variable listed under Job Variables in the FTP Statistics submenu. There are four FTP job 
variable options available:

– # of Files – Details the number of files transferred.

– # of Bytes – Details the size of the file (in bytes) that was transferred. 

– # Skipped – Details the number of files within a designated directory that were not FTP’ed.

– Duration (Seconds) – Details how long (in seconds) that it took to perform the FTP operation.

Run Tab

Agent Information

In the Agent Information section you define the agent, the user account to be used and the FTP server 
information.

• Agent (Local Host) – The agent machine that will act as an FTP Tidal Web client. You must select 
an agent from the drop-down list. 

• Agent List – An agent list is a set of agents that can run the FTP job. Agent lists allow for workload 
balancing, broadcasting, and dynamic rerouting. If you select the Agent List option, the Agent 
Name drop-down list displays agent lists instead of agents. Be sure to select an agent list for the 
platform on which the FTP job can run.

• Local User – A runtime user account that the job runs under. Provides an additional layer of security 
since the user must be added to the runtime user’s list. If the FTP Local User Mandatory option 
on the Master tab of the System Configuration dialog is selected, an FTP job cannot run without 
an authorized local user. 
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• FTP Host – The name of the machine that hosts an FTP server. If the FTP server uses a port that is 
not the default port, 21, you may also specify the port number immediately after the host machine 
name, separated by a colon, such as sputnik:5621. 

• FTP User – Specify a user from those defined to TES that has an associated password to log on to 
the FTP server. A user account may not be necessary if the FTP server offers Anonymous login.

• Anonymous – Select this option if you know that the remote FTP server has been configured to 
accept this option. Using anonymous as a FTP login does not normally require a user account and 
password. You must supply a TES user with an email account before using this option. 

Tracking Section

In the Tracking section, select a method to determine that a job has completed. Four options are 
available:

• External – This option requires an external application or user to signal that the FTP task 
completed.

• Exit code – This option bases the status of the job on the success or failure of the FTP operation.

• Scan Output: Normal String – If you select this option, type a text string in the field below that 
signals a job completed normally if the text string appears in the job’s output.

• Scan Output: Abnormal String – If you select this option, type a text string in the field below that 
signals a job completed abnormally if the text string appears in the job’s output.

Duration Section

In the Duration section, specify the time parameters for job completion. These parameters are used to 
send an alert to the console if a job is not completing as expected. 

• Estimated – This value configures the forecast next to the Job Activity pane.

• Minimum – If the job completes before the specified number of minutes, an alert can be created to 
notify the operator.

• Maximum – If the job completes after the specified number of minutes, an alert can be created to 
notify the operator.

DataMover Job Definition Dialog

DataMover Tab

The fields displayed on this tab depend on the Protocol selected, Hadoop or Amazon S3.

Hadoop protocol 

The Data Mover tab contains the following fields:

• Protocol – select the Hadoop DFS protocol from this list.

• Operation – choose the operation within the protocol.  

– Copy To Local File – select to copy a Hadoop Source file to a local destination file.

– Copy From Local File – select to copy a local source file to a Hadoop Source destination file.
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• File Details – define the files for the operation. This section changes depending on which Hadoop 
DFS Operation is selected. 

– Local Source Files – the Local file(s) to be copied to the Hadoop file system. When copying 
multiple Local Source files, the failure of any file to be copied does NOT cause the entire copy 
to fail; an attempt is made to copy every file. When specifying multiple Local Source Files, use 
a comma separated list of file 

– Hadoop Destination File – where the Local Source File(s) are copied. The Hadoop 
Destination File can specify a Hadoop directory. When multiple Local Source files are 
specified, the Hadoop Destination File must specify a Hadoop directory. 

• Delete Source File After Copy – When this checkbox is checked, the source file will be 
deleted after being copied.

• Overwrite Destination – When this checkbox is not checked, the copy fails if the file already exists 
in the Hadoop file system.

• Connection Details – 

– Use Connection Details From – Select the predefined connection you want to use to pull 
connection details from. 

– Name Node – Enter the HDFS node name.

• Use Kerberos Authentication – The Adapter supports both Simple and Kerberos 
authentication. Click this option to use Kerberos authentication.

• Variables – Click this button to insert predefined TES variables into fields.

Amazon S3 Protocol (Get Object, Put Object and Put Multiple Parts)

The Data Mover tab contains the following fields:

• Protocol – select the Hadoop DFS protocol from this list.

• Operation – choose the operation within the protocol.  

– GET OBJECT – retrieves objects from Amazon S3

– PUT OBJECT – adds an object to a bucket

– PUT MULTIPLE PARTS – adds multiple parts of an object to a bucket

• Amazon S3 Host Name – enter the Amazon S3 connection server name. Currently, the only 
connection supported is s3.amazonws.com.

• File Details – enter the following information regarding the file you want to move.

Note The fields in this section change depending on which Amazon S3 Operation is selected.

For the GET and PUT operations:

– Bucket Name – Enter the name of an already existing bucket on Amazon S3 owned by the user 
identified by the Access Key and Secret Key provided on the Run page.

– Object Name – Enter the name of the object in the bucket that you want to retrieve/add.

– Local File – Enter the location and file name where you want to store the retrieved/added object.

Note When defining a DataMover Job using MapR Hadoop, set the Name Node field to 
“maprfs:///”.
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For the PUT MULTIPLE PARTS operation:

– Bucket Name – Name of an already existing bucket on Amazon S3 owned by the user identified 
by the Access Key and Secret Key provided on the Run page.

– Object Name – Name of the Object in the Bucket that you wish to store the file as.

– Local File(s) – A comma separated list of the locations and file names that you would like to 
upload to the specified bucket and object. All of the files must be at least 5MB in size except 
for the last one.

• Options section – Click the Options button to add additional job options via the Amazon S3 
Objects dialog.

Depending upon the selected AS3 operation selected on the Data Mover page, this dialog contains 
the following elements:

– AS3 Protocol – Select the protocol you want to use to communicate with Amazon server.

The default is HTTPS, but HTTP can be used.

– Maximum Connections – Enter the maximum number of allowed open HTTP connections.

– Maximum Retries – Enter the maximum number of retry attempts for failed retry-able 
requests.

– Maximum Timeout – Enter the amount of time to wait (in milliseconds) for data to be 
transferred over an established, open connection before the connection is timed out and closed.

– GET OBJECT –

Object Version – Enter the specific version of an object to be the target of the get operation.

Matching ETag(s) – Enter the MD5 hash of the object. It can be used to select a specific 
version of an object to be the target of the get operation.

Non Matching ETag(s) – Enter the MD5 hash of the object. It can be used to non-select or 
preclude a specific version of an object as the target of the get operation.

– PUT OBJECT & PUT MULTIPLE PARTS –

Target File Name – This is a way to set a ‘suggested’ filename for the contents of the 
transfer. There is no guarantee that the ‘request’ will be honored.

Expiration Rule Id – Enter the Bucket Configuration rule ID for this object's expiration.

Encoding – Select the content type from the drop down list if you desire to specify the content 
type.

Content Type – When uploading files, Amazon S3 will attempt to determine the correct content 
type if one hasn't been set yet. If no content type is provided and cannot be determined by the 
filename, the default content type “application/octet-stream” will be used.

Server Encryption – Select from the drop down list whether you want no Server Side 
Encryption or the object to be encrypted using AES-256 (the only encryption algorithm 
currently available from Amazon S3).

Expiration Time – If you want the object that is being uploaded to expire after a set time, 
provide the time delta here in milliseconds.

MD5 – Select whether you want an MD5 hash to be generated for the transfer for validation of 
the contents when received by the Server.

Custom Metadata – Specify name=value pairs that you want to attach to the object as 
metadata when it is uploaded. Click Add to add metadata via the Add Metadata dialog or edit 
to edit existing metadata via the Edit Metadata dialog.
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– (Optional) Variables – Click to insert a predefined TES variable into a selected field.

Run Page

Agent Information

In the Agent Information section you define the agent, the user account to be used and the FTP server 
information.

• Agent (Local Host) – The agent machine that will act as a DataMover Tidal Web client. You must 
select an agent from the drop-down list. 

• Agent List – An agent list is a set of agents that can run the DataMover job. Agent lists allow for 
workload balancing, broadcasting, and dynamic rerouting. If you select the Agent List option, the 
Agent Name drop-down list displays agent lists instead of agents. Be sure to select an agent list for 
the platform on which the DataMover job can run.

• Local User – A runtime user account that the job runs under. Provides an additional layer of security 
since the user must be added to the runtime user’s list. If the FTP Local User Mandatory option 
on the Master tab of the System Configuration dialog is selected, a DataMover job cannot run 
without an authorized local user. 

• FTP Host – The name of the machine that hosts a DataMover server. If the DataMover server uses 
a port that is not the default port, 21, you may also specify the port number immediately after the 
host machine name, separated by a colon, such as sputnik:5621. 

• FTP User – Specify a user from those defined to TES that has an associated password to log on to 
the DataMover server. A user account may not be necessary if the DataMover server offers 
Anonymous login.

• Anonymous – Select this option if you know that the remote DataMover server has been configured 
to accept this option. Using anonymous as a DataMover login does not normally require a user 
account and password. You must supply a TES user with an email account before using this option. 

Tracking Section

In the Tracking section, select a method to determine that a job has completed. Four options are 
available:

• External – This option requires an external application or user to signal that the DataMover task 
completed.

• Exit code – This option bases the status of the job on the success or failure of the DataMover 
operation.

• Scan Output: Normal String – If you select this option, type a text string in the field below that 
signals a job completed normally if the text string appears in the job’s output.

• Scan Output: Abnormal String – If you select this option, type a text string in the field below that 
signals a job completed abnormally if the text string appears in the job’s output.

Duration Section

In the Duration section, specify the time parameters for job completion. These parameters are used to 
send an alert to the console if a job is not completing as expected. 

• Estimated – This value configures the forecast next to the Job Activity pane.
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• Minimum – If the job completes before the specified number of minutes, an alert can be created to 
notify the operator.

Maximum – If the job completes after the specified number of minutes, an alert can be created to notify 
the operator.

Effective Date Dialog
The Effective Date dialog appears after either modifying the parameters of a job or job group contained 
in one of the compiled schedules or modifying a calendar used by one of the jobs contained in the 
compiled schedules. From this dialog, you specify the date when the changes should apply. The Effective 
Date dialog only appears if you are connected to the master.

This dialog contains the following elements:

• Scheduled Dates – Displays all dates in the compiled production schedule. Those dates in the 
compiled schedule that coincide with the dates associated with the modified job or calendar are 
displayed in bold type. If there are no bolded dates than the job or calendar is not used on any of the 
dates that have already been compiled. Select one of the listed dates to enter that date in the 
Effective Date field. 

• Effective Date – Displays the selected date from the Scheduled Dates list. If the job is already in 
the schedule and has just been modified, all instances of the job that have not yet run before this date 
will not reflect the change. All existing schedules going forward from the selected effective date, 
will be recompiled to account for the modifications to the job or calendar. The default effective date 
is the first date listed in the Scheduled Dates list that the job will run on.

• Start today’s repeating job(s) now – Displayed when the job or group has a designated number of 
times to repeat. Normally, a job or group will begin repeating at midnight if no time window is 
specified. By selecting this option, you can start the first repeating instance as soon as the job or 
group is added to the production schedule; otherwise, it is possible that no instances of the repeating 
job will be added for today if the number of repeats completed between midnight and the current 
time configured. 

Note Any instances of a job that has not yet run will be replaced.

If you create a repeating job without specifying how often the job should repeat, the Start today's 
repeating job(s) now option is not displayed in the Effective Date dialog. The job will be 
continually repeated at the designated intervals all day; thus, the job automatically starts at the 
beginning of the production day.

Click Cancel in the Effective Date dialog if you want your changes to take effect as of the next 
automatic or manual compile.configured.

Note The default beginning of the production day is midnight. This default can be changed in the System 
Configuration dialog. For more information, see “Getting Started” on page 29.

Calendar Forecast Dialog
The Calendar Forecast dialog displays by clicking the Forecast button on the Schedule tab of the Job 
Definition or Job Group Definition dialog.
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This dialog displays the dates the job will be scheduled to run based on the selected calendar, adjusted 
by the offset (if any).

Insert Into Schedule Dialog
The Insert Into Schedule dialog displays whenever you select the Insert Into Schedule option from the 
Jobs pane context menu or by selecting the Insert Into Schedule option from the Activities main menu. 

The fields in this dialog vary slightly depending upon what is highlighted in the Jobs pane. The dialog 
for inserting individual jobs into the schedule has a Parameters field for modifying parameters of the 
job instance being inserted. 

This dialog contains the following elements:

• Job/Group – The name of the job or group to insert into the production schedule. If the job or job 
group being inserted is a child job/job group, then the pathname to the parent is provided in brackets 
[ ]. For example, Scheduler2 [\WinTest\Grp1\Grp2]. 

• Date – The date on which you want the job or group inserted.

• From ___ Until___ – The time window in which you want the job or group inserted.

• Parameters – The parameters to add to the job’s execution.

• Override job’s dependencies – Select this option to have the job or group run whether or not its 
dependencies have been met. Selecting this option when inserting a job group, overrides job 
dependencies on all jobs within the job group. Note that if any of the child jobs are dependent upon 
one another, then all of these jobs would begin running once inserted.

Inserting Job Groups Into the Schedule

The dialog for inserting a job group has the same fields as the dialog for inserting individual jobs except 
the Parameter field is replaced with a Variables field that lists the name of the group variable listed on 
the Variables tab of the job group definition and its default value. The default values can be modified as 
needed when inserting the job group into the schedule.

Inserting Multiple Jobs Into the Schedule

The dialog for inserting multiple job/job group selections has the same basic fields as the other dialogs. 
However, instead of a Parameter or Variables field, the selections are listed. When inserting a multiple 
selection of jobs and/or job groups, the dialog displays the name and pathname of each selection to 
illustrate the parent-child nesting level. The selections cannot be modified from this dialog.

Job Rule Filter Dialog
You can filter the jobs that appear in the Jobs pane to screen out the jobs that you do not want to see. The 
Job Rule Filter dialog provides various fields to filter out undesired jobs. The more fields used to filter 
the jobs displayed in the Jobs pane, the more specific the results. 

The Job Rule Filter dialog displays in the Jobs pane when the Filter option is selected in that pane's 
context menu or the Filter button is clicked.

This dialog contains the following elements:

• Job – Shows all the job instances that match the text string specified. You can use the following 
wildcard characters in all fields that use text strings:
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* (Asterisk) – The asterisk character masks any number of characters on and to the right of the 
location it is placed. For example, A* will match (allow in) AB, ABB, and ABBB.

? (Question Mark) – The question mark masks one character in the location it is placed. For 
example, A?A will match ABA and ACA, but not ABB or ABBA.

[x, y, z] – The brackets with commas let you specify a set of characters to filter in to that location 
in the string. For example, A[X,Y]B accepts AXB and AYB but not AAB.

[a–z] – You can also specify ranges within brackets. For example, A[X–Z]B filters in AXB, AYB, 
and AZB but not AWB.

• Group – Filters for all job groups and their child jobs matching the criteria specified in this field. 

Note The Show Groups option must be selected before you can use this field.

• Command – Filters for jobs using the specified command.

• Agent – Filters for all job instances that run under the agent selected from the drop-down list. When 
no agent is selected, all agents are assumed. The default is to show all agents.

• Owner – Filters for all job instances that belong to the user or workgroup selected from the 
drop-down list. If left blank, jobs belonging to all of the various owners are displayed.

• Calendar – Filters for all jobs using the calendar selected from the drop-down list. If left blank, jobs 
using any calendars are displayed.

• Job Class – Filters for all jobs belonging to the job class selected from the drop-down list. If left 
blank, jobs belonging to all job classes are displayed.

• Enabled – Selecting Yes option filters for all jobs that are enabled. Selecting the No option filters 
for all jobs that are disabled. Leaving this field blank includes all jobs, whether enabled or not.

• Show Groups – Filters for job groups. Leaving this option unchecked, means that the job groups 
will not be displayed (though the child jobs are displayed) and you cannot filter by group.

• Defaults – Clicking this button resets the job filter criteria to the default options. This clears all 
fields of their criteria though the Show Groups option is selected by default.

Job Search Dialog
The Job Search dialog is accessed from various dialogs by clicking the Browse button. Use the Job 
Search dialog to set the criteria used to find jobs.

Common To All Tabs

• Find – Click this button to search through all jobs for jobs matching the search criteria.

• All – Click this button to display all jobs regardless of the search criteria.

• Clear – Click this button to clear all of the previous search criteria.

• Job Search Results – Displays the jobs that match the search criteria.

Job Search Criteria Tab

This tab contains the following elements:
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• Name – Search for a job by the name of the job.

• Owner – Search for jobs owned by a particular user.

• User – Search for jobs that run as a particular user.

• Agent – Search for jobs that run on a particular agent.

• Class – Search for jobs that belong to a particular job class.

You must select at least one of the check boxes in the following categories. You may also select both 
check boxes to search in both categories.

• Group(s) – Search by job group.

• Job(s) – Search by jobs.

You must select at least one of the check boxes in the following categories. You may also select both 
check boxes to search in both categories.

• Enabled – Search for jobs that are enabled.

• Disabled – Search for jobs that are disabled.

Advanced Criteria Tab

This tab contains the following elements:

• Command – Use this field to search for a job that uses a particular script or executable.

• Agent List – Use this field to search by the list of agents that can run the job.

• Parent group – Use this field to search for jobs that are children to a particular group.

• Requires operator release – Select this option to search for jobs requiring operator release.

• Does not require operator release – Select this option to search for jobs that do not require operator 
release.

• Unscheduled allowed – Select this option to search for jobs that can be inserted into a schedule on 
an ad hoc basis.

• Unscheduled not allowed – Select this option to search for jobs that can only be run on a scheduled 
basis.

Intermaster Dependencies
You can create jobs with variable dependencies that are determined by jobs processed on another master. 
A job with an intermaster dependency resides on a local master subscribing to a remote master that 
publishes the value of a variable. 

For the purpose of an intermaster dependency, the local master becomes a type of client to the remote 
master. The variable is defined on the remote master and made available to other masters. The local 
master subscribes to a variable managed by another master by creating a special remote master 
connection. Because the local master is a client to the remote master, the communication port is the same 
one used by the client of the remote master. If the remote master is using fault tolerance than the 
connection is configured to automatically switch to the backup machine of the remote master if a failure 
occurs. This connection displays in the Connections pane as a Remote Master connection. The 
Connection Definition dialog also displays the variables that the remote master is publishing. These 
variables are regularly updated and cached on the local master and the actual variable values are 
published at the time required by the specific job.
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When defining a variable dependency, you specify which master manages the variable. If no remote 
connections have been set up, then the local master is the default. If you selected a remote master, you 
can select a published variable from a drop-down list of variable names.

You control which variables are available for remote master use through the Variable Definition dialog. 
You can keep a variable for use only on the local master or publish the variable for use by remote masters. 
You can also elect to either publish the variable in unalterable form or allow others to modify the 
variable.

A system event can be created to notify a user if connection between the remote and local master is lost. 
A lost connection prevents a job from completing since the variable value cannot be determined. A user 
can also check on the status of an intermaster variable by studying the Dependencies tab of the Job Detail 
dialog. An intermaster variable will show a value of Unavailable if the connection to the remote master 
is lost.

Note It requires a separate license to use intermaster dependencies. You cannot define a remote master or 
publish intermaster variables without a license for intermaster dependencies.

The methodology described here can be extended to apply to dependencies between any number of jobs 
on any number of masters. In brief, the technique to implement intermaster dependencies uses a job event 
on one master to set a variable value on another master whose job(s) will depend on that variable.

For example: Master2:JobB depends on Master1:JobA

Step 1 Install an agent on the same machine as Master2 or one of its clients. This agent will service Master1. 
(If there are cross-dependencies such that Master1:JobC depended on Master2:JobB, you would 
install an agent on the same machine as Master1 or one of its clients to service Master2). An agent is 
required for each unique intermaster relationship. Remember, more than one agent can be installed on a 
single machine to service multiple masters.

Step 2 On Master1 create a linking job that runs on the agent installed on Master2 (or one of its Tidal Web 
clients). This job will run the varset command from the client's command line interface to set the value 
of a variable on Master2 to indicate that the dependency has been met; for example, the job definition 
for the linking job would contain the following:

– In the Command field, type

C:\Program Files\Tidal\TESCmdLine\bin\sacmd.bat 

– In the Command Parameters field, type

varset –n master1_joba –v “normal”

– In the Agent Name field, type

Master2

Step 3 On Master2, create a string variable called master1_joba and create a variable action to initialize it to 
blank whenever JobB is added to the schedule.

Step 4 On Master1, associate the job created in step 2 with a job action, and associate that action with a job 
event triggered by JobA completing normally. To make it easier to work with multiple jobs, create one 
linking job as in step 2 and override the command parameters here.

Step 5 On Master2, add a variable dependency to JobB so that JobB depends on master1_joba = “normal”.

When JobA completes normally, it triggers the linking job that sets the master1_joba variable value 
on the other master to satisfy JobB's dependency.
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The actions and events used in this scenario can be defined generically for reuse in working with any 
number of jobs that have inter-master dependencies. The TES API can also be used to set TES variables 
on any master programmatically. For more information on the TES API, see the TES API Guide. 

Setting Dependencies on Jobs

Job Dependency Definition Dialog
The Job Dependency Definition dialog displays when you add or edit a job dependency from the 
Dependencies tab of the Job or Job Group Definition dialogs.

Note For instructions on how to implement inter-master dependencies, see “Intermaster Dependencies” on 
page 188.

This dialog contains the following elements:

• Job/Group – The job(s) or job group(s) that the current job depends on. You can search for jobs or 
job groups by clicking the Browse button, which opens the Job Search dialog. You can also view a 
job/group drop-down list by clicking the down-arrow button. If you narrowed your search for jobs 
using the Job Search dialog, the list displays the subset of jobs found. Otherwise it displays all jobs 
you or your workgroups own. 

If you choose more than one job or job group, dependencies will be created for each one selected, 
and when you click OK, they appear on the Dependencies tab. You can then update individual job 
dependency criteria by double-clicking them from the Dependencies tab. 

Note You cannot type a job or job group name in this field directly.

• Operator – Defines whether the dependency should be satisfied when the preceding job equals or 
does not equal the specified status.

• Status – The status of the job dependency. Select Launched, Active, Completed Normally, 
Completed Normally (Output Pending), Completed Abnormally, Completed Abnormally 
(Output Pending), Error Occurred, Externally Defined, Externally Defined (Output Pending) 
or Completed as the condition for which the job dependency is satisfied.

• Occurrence – Used if the job dependency is a job that repeats within a production day. 

– Select First Occurrence when the first instance of the job should be used to satisfy the 
dependency. 

– Select Last Occurrence when the last instance of the job should be used to satisfy the 
dependency.If the job does not repeat, the last instance of the job dependency is used. If the 
dependent job has more repeating instances, the last instance of the job dependency is used to 
satisfy the dependency for the trailing instances of the dependent job.

– Select Match Occurrence when both jobs (predecessor and successor) repeat within a day, and 
the instance of the job dependency should match the instance of the job that depends on it. 
5-190
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 5      Jobs
  Setting Dependencies on Jobs
• Offset – The number of instances to offset from either the First or Last instance. When set from the 
First Occurrence setting, the dependency is met using the offset+1 job instance. For example, if 
the offset is set to 1, the dependency is met using the second instance.

When set from the Last Occurrence setting, the dependency is met using the Last Occurrence – 
offset job instance. For example, if a job is repeated 10 times, and the offset is 1, then the 
dependency is met using the ninth instance. 

Note The Offset option does not apply to Match Occurrence.

• Relative to group (otherwise for day) – Indicates whether this dependency refers to a group 
instance or a day instance. Use this option to establish job dependencies within separate instances 
of a repeating group. Job dependency is then defined by a group instance number. If this option is 
not selected, job dependency is defined by the day instance, using the total number of jobs that run 
that day.

Note With repeating groups, this option should be selected most of the time.

• Date Offset – The number of days in the past to find the job dependency. For example, if Job A runs 
daily, and you want the job to depend on the instance finishing three days ago, specify 3. This value 
should not exceed the retention history for the job. If it does, the job dependency is never met. 

• Ignore this dependency if job not in schedule – If the job dependency is not in the schedule, the 
job dependency is automatically satisfied. If this is not checked and the job dependency is not in the 
schedule, the dependency will not be met until the job dependency is added to the schedule.

File Dependency Definition Dialog
The File Dependency Definition dialog displays when adding or editing a file dependency from the 
Dependencies tab of the Job or Job Group Definition dialogs.

This dialog contains the following elements:

• File Name – The file that the underlying job depends on. The filename should be an UNC (Universal 
Naming Convention) pathname from the agent running the job. (Do not use a mapped drive in the 
file name.) For more information on file dependencies, see “Wildcards in File Dependencies” on 
page 192.

• Agent Name – The agent on which the file is located. The agent doesn’t have to be the same agent 
on which the job runs.

Note If the job being defined uses an agent list, then the Inherit Agent from Job option is automatically 
selected and the agent list name displays in the Agent Name field.

• Inherit Agent from Job – Select this option if you want the dependent file to use the same agent as 
the job or job group you are adding or editing. The default for this option is unchecked.

If the job uses an agent list instead of a specified agent, the dependent file uses the first agent in the 
agent list unless the agent list is the broadcast type. (The order of the agents on the selected list is 
determined by the sequence they were added to the agent list.) If the agent list is a broadcast type, 
then the dependent file uses the same agent the job runs on.
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• Exists – The file dependency is satisfied when the file exists at the specified path on the specified 
agent.

• Does Not Exist – The file dependency is satisfied when the file does not exist at the specified path 
on the specified agent.

• Has Changed In DD:HH:MM – The file dependency is satisfied when the file has changed within 
the specified time in days, hours, and minutes prior to when the job entered the production schedule. 
For example, if the job entered the schedule at 1:00 PM, the period specified is 6 hours, and the file 
changed after 7:00 AM (or later), the dependency is met.

• Stable For DD:HH:MM – The file dependency is satisfied when the file contents have not changed 
for the specified time in days, hours and minutes from the present time. For example, if the file’s 
modified time is 1:00 PM, the period specified is six hours and the job enters the schedule at 3:00 
PM, the dependency is satisfied in four hours, i.e., 7:00 PM.

• Size >= – The file dependency is satisfied when the file size increases to or exceeds the value 
specified in bytes. The maximum file size is 4,294,967,296 bytes.

• Size <= – The file dependency is satisfied when the file size decreases to or drops below the value 
specified in bytes. 

Wildcards in File Dependencies

The question mark (?) and the asterisk (*) are supported as wildcards in the filenames of file 
dependencies. 

Wildcard Usage Summary

• The question mark (?) wildcard represents any single character in a string 

• The asterisk (*) wildcard represents any character or group of characters in that position in the string

• You may combine the wildcards (for example, T?dal.*)

• UNC paths must be used if the user account under which the agent runs has the required access to 
the network share

• Wildcards are accepted in filenames only, not elsewhere in the path specification

Note that if the Has Not Changed For or Stable For option is selected with a wildcard file dependency, 
a large match set may result, delaying the check for file dependencies for other jobs. 

FAQs on Wildcard Functionality

What are the benefits of using wildcards in file dependencies?

There are programs, applications, scripts and batch files that need to depend on the existence of a file. 
In some situations, the exact name of the file that the program depends is unknown. The filename may 
include a date or time stamp, or a sequence number may be appended to the filename at the time of 
creation of the file. For example, an order file might be named ORD<sequence_number>.RDY.

The wildcard enhancement makes it quick, easy and efficient to set up and manage file dependencies 
where the filename is not constant. 

How are the wildcards structured?

Usage of wildcards in TES is consistent with the standard wildcard practice. A combination of the 
question mark (?) and asterisk (*) can be used. For example, a file dependency can be set on any files 
meeting the following wildcard criteria, L??d?n*.dat. The file, London101.dat, would make this 
dependency true.
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Can you use wildcards in the path as well as in the filename?

No. The path to the file must be known. The wildcard functionality does not support wildcards in the 
path to a file. 

You should enter file dependencies in UNC format:

\\servername\directoryname\filename 

i.e.

\\bpssch2\bpapps\files\ord????.dat 

as well as in the format of a mapped drive if on the same machine:

driveletter:\directoryname\filename 

i.e. 

c:\files\ord*.dat 

This gives you the flexibility to detect the existence of files on any shared server in the domain. 

What is the logic applied in fulfillment of wildcard file dependencies? 

Once a file arrives whose name qualifies based on the wildcards, the dependency is marked true and the 
job with the dependency is released. Wildcards are cleanly implemented with the Exists and Does Not 
Exist options as well as TES’s advanced file dependency features. 

What if more than one file fulfills the dependency?

Multiple files may qualify for a wildcard file dependency. For example, the query ORD*.RDY may result 
in three files: ORD100.RDY, ORD105.RDY and ORD200.RDY. A dependency could be set on files that 
have changed in the last 30 minutes. ORD105.RDY might have changed in the last 30 minutes while the 
other two files did not. In this type of situation, if one file meets the condition, then the dependency has 
been met. 

What happens when dependencies cross day boundaries?

A job can be scheduled to run daily depending on a file. You can use a wildcard in the file dependency 
to look for the file. For example, the job may need ORD9T.RDY on Tuesday and ORD10W.RDY on 
Wednesday. You can define this job to have a dependency on file ORD*.RDY. ORD*.RDY matches both 
ORD9T.RDY and ORD10W.RDY. 

What if ORD9T.RDY arrives late, after the end of the day? 

If Tuesday's job is set to carry over to the next day, both Tuesday’s and Wednesday's jobs will be looking 
for the existence of a file that matches ORD*.RDY. If ORD019.RDY arrives before ORD024.RDY, both jobs 
will launch on its arrival. To avoid this, you can set the job to reschedule itself when another file is found.

Can you have a dependency on a file that exists on a non-agent machine?

Yes. You are not limited to files on servers with active TES agents. If the agent machine can see and 
connect to another machine (the machine has a share), it can determine if a file exists on it.

Can we use the wildcard characters as literal characters?

No. TES will interpret the? and * characters as wildcards.

Are wildcard file dependencies supported on all platforms?

No, currently this enhancement applies to Microsoft Windows and Unix systems only. 

Are the wildcards supported from the TES command line and API?

Yes. The wildcard functionality is the same for the Tidal Web client, command line and the TES API. 
The? and * characters can be typed at the command line or API and will be treated as wildcards. 
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Variable Dependency Definition Dialog
The Variable Dependency Definition dialog displays when adding or editing a variable dependency from 
the Dependencies tab of the Job or Job Group Definition dialogs.

This dialog contains the following elements:

• Master – The master that manages the variable dependency being created. If creating an intermaster 
dependency, select the appropriate remote master from the drop-down list; otherwise, leave the 
default.

• Variable Name – The variable that the current job depends on. You select the variable from a list of 
user-defined variables that you or your workgroup own. If the master is a remote master, these 
variables are a list of published variables cached within the local master.

• Operator – The relative operator used to determine whether the variable’s value satisfies the 
dependency. 

– Equals (=)

– Does not equal (<>)

– Less than (<)

– Less than or equal to (<=)

– Greater than (>)

– Greater than or equal to (>=)

When text strings are used in comparison, higher letters of the alphabet are greater than lower letters. 
For example, A < Z. If the first letters of the string match, succeeding letters are used for 
comparison. For example, AA < AZ. The operation works similar to sorting strings. 

• Variable Value – The value of the variable that satisfies the dependency. Using the drop-down 
menu, you can also select from a list of System and User-defined variables that should be used for 
comparison. 

z/OS JES Job Dependency Definition Dialog
The z/OS JES Dependency Definition dialog displays when adding or editing a z/OS JES dependency 
from the Dependencies tab of a job’s definition.

This dialog contains the following elements:

• z/OS Gateway Adapter – Select the appropriate Gateway adapter that is connected to the z/OS 
mainframe machine that is running the z/OS job you are interested in. Each z/OS machine requires 
its own Gateway adapter so you must select the machine you are interested in. 

• JES Job Name – The name of the job running on the selected z/OS machine that you wish to use as 
a dependency.

Job Occurrence Section

Since the TES job you select could run multiple times during the day, you must specify which job 
occurrence you are interested in. 

• First – Select this option if the first instance of the job in the production day should be used to 
satisfy the job dependency.
5-194
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 5      Jobs
  Setting Dependencies on Jobs
• Latest – Select this option if the most recent occurrence of the job should be used to satisfy the job 
dependency.

• Match – Select this option if both jobs (predecessor and successor) repeat within a day, and the 
instance of the job dependency should match the instance of the job depending on it. If the job does 
not repeat, the first instance of the job dependency is used. 

• Specific – Select this option to use a specific job instance. Type a number or use the arrow buttons 
to denote which instance of the repeating job instances should be used.

• Offset – Select this option to specify the number of job instances to offset from the instance of the 
dependent job. Type a number or use the arrow buttons to enter how many job instances to offset. A 
positive number adds the specified number from the dependent jobs’ instance number. A negative 
number subtracts the specified number of job occurrences from the dependent jobs’ instance 
number. 

• Ignore if questionable – Any instance number of a job that the Gateway did not track from the start 
of the production day is considered questionable because the Gateway cannot verify that the job did 
not run before the Gateway started tracking it. This might occur if the Gateway is not running at 
some point during the production day or if the job is not registered with the Gateway at the start of 
the production day. 

Select this option if the dependency is critical to a specific instance of the job and there is any 
uncertainty about the exact instance number. The dependency cannot be met during the day if the 
z/OS job instance number is questionable. 

Dependency Condition Section

In the Dependency Condition field, you specify the condition of the TES job or one of the job steps that 
comprise the job that will signal that the dependency is satisfied. The condition is based on the state or 
status of the TES job or job step. A variety of conditions can denote a satisfied dependency. 

• Job (or Step) Completed – The dependency is satisfied when the job completes or a specified job 
step has completed with the a condition code within the range of condition codes specified in the 
Condition Code Range field.

• Highest Condition Code – The dependency is satisfied only when the job completes with the 
highest code within the range of condition codes specified in the Condition Code Range field.

• Any Step Condition Code – This dependency is satisfied whenever any job step within the z/OS 
job completes with a condition code within the specified range in the Condition Code Range field.

• Job Started – The dependency is satisfied if the job or job step starts.

• Job (or Step) Abended – The dependency is satisfied if the job or job step results in a system or 
user abend.

• Job Flushed (JCL/Alloc Errors) – The dependency is satisfied whenever the job fails to start.

• Job (or Step) Canceled (by SMF Exit) – The dependency is satisfied whenever a job or job step is 
canceled. 

• Job Abended due to Condition Code – The dependency is satisfied whenever the job completes 
with an abend condition based on condition code handling.

• Optional (PROC.) Step – This field is optional, but if you wish to specify a particular step within 
the job, type the name of the job step. The dependency that was specified in the Dependency 
Condition field will apply only to the job step you specify here. The condition of any other job steps 
or the overall job is irrelevant once this field is used. (You can include a PROC prefix, if necessary.)
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• Condition Code Range – Use this section to set the condition code that signals that the dependency 
is true. You can use a specific number or type a range of numbers so that anything within the given 
range means that the dependency is satisfied. The condition code can range from 0 to 4095. This 
field only applies if you selected the following dependency condition options:

– Job (or step completed)

– Highest Condition Code

– Any Step Condition Code

– Job Abended due to Condition Code

• Include Abend – Selecting this option, adds the Abend status to the specified condition code 
options. If a job or job step either completes inside the specified range of condition codes or 
completes with an Abend status then the job dependency is satisfied.

Job Procedures

Adding a Job or Job Group

You can add a job or group rule and have it added to the production schedule simultaneously. Adding a 
job to the production schedule is optional. When jobs are added to groups, many properties can be 
inherited from the parent group.

To add a job or job group:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

a. To add a job or job group under a job group, right-click the job group under which you want to 
add your job or job group.

b. To add a job or job group at the root level of the hierarchy, right-click a root-level job or on a 
white section of the pane.

Step 2 Select Add Job or Add Job Group from the context menu or click the Add Job on the TES toolbar.

Step 3 Depending on your selection, the Job Definition or the Job Group Definition dialog appears. For more 
information on the definition dialogs, see “Jobs Pane Interface” section on page 5-143.

Adding Jobs Automatically to the Production Schedule

Jobs with associated calendars are automatically added to the production schedule through the TES 
automatic compilation process. Jobs with calendars are only added to the schedule for days that are in 
the set of days defined for the calendar. No intervention is necessary, but you can customize its operation 
to tailor compilation to your needs. For more information, see “Defining Jobs” section on page 5-158). 
Another way of automatically adding jobs to the production schedule is through new job actions. For 
more information about new job actions, see “Actions and Alerts” on page 215.

Adding Jobs Manually

To add a job manually:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 
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Step 2 Right-click the job or job group to add to the production schedule and select Insert Into Schedule from 
the context menu. 

Or, select the job or job group to add to the production schedule, and from the Activities main menu 
select Insert Into Schedule.

The Insert Job Into Schedule dialog displays. The Job/Group field should contain the name of the 
job or group you right-clicked, and the Date field should contain the current date. If the job or group 
you selected has a time window, this will be displayed in the From and Until fields. Any parameters 
that were set in the job’s or group’s definition will be listed in the Parameters field. If the job or 
group has dependencies, you may want to select the Override job’s dependencies option so that 
your job or group will enter the schedule without checking for its dependencies.

Step 3 Click Yes at the confirmation dialog.

The job is added to today’s production schedule regardless of its calendar dates (if any). If the job 
is defined to repeat, only one instance of the job will be added to the schedule. Only jobs with the 
Unscheduled Allowed option selected (definition dialog, Options tab) can be added in this manner. 

Adding a Job or Job Group Dependency

Jobs can depend on the status of other jobs and job groups. For example, you can set Job B to run when 
Job A completes normally using a job dependency for Job B.

To add a job or job group dependency:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group that you want to edit. 

Step 3 Click the Dependencies tab.

Step 4 Click Add and select Add Job Dependency from the drop-down menu.

Step 5 In the Job/Group field, click the Browse button to open the Search dialog to search for the job that this 
job will depend on. You can also view a drop-down list of jobs by clicking the down-arrow button. If you 
used the Browse button to narrow your search for jobs, the drop-down list will be that job subset. 

Step 6 In the Operator field, select whether the file dependency Equals or Does not equal the following status 
to satisfy the dependency. For example, you can set the job dependency to Equal the Completed 
Normally status.

Step 7 In the Status field, select the status to use to satisfy the dependency. You can choose between Active, 
Completed Abnormally, Completed Normally, Error Occurred, Externally Defined and Completed.

Note A job group becomes active when any of its associated jobs become active. If all jobs in a job group 
depend on the job group becoming active, no jobs will launch.

Step 8 If the job repeats during the day, select which instance of the job will trigger the dependency from the 
Occurrence drop-down menu. 

a. Select First Occurrence if you want the first instance of the preceding job to match the status 
criterion.

b. Select Last Occurrence if you want the last instance of the preceding job to match the status 
criterion.

c. Select Match Occurrence when both jobs repeat during the day, and the dependency should 
match instance numbers.
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There are two ways to apply the First/Last/Match dependency logic: by day instance or group instance. 

Step 9 To specify an instance offset, you can do so in the Offset field. This field only applies to First 
Occurrence and Last Occurrence. When applied to First Occurrence, specifies which instance after 
the first to use in satisfying the dependency. When applied to Last Occurrence, specifies which instance 
from the last.

Step 10 If you want to specify an instance of a job that occurred a certain number of days in the past, go to the 
Date Offset field, and type the number of days in the past for the required job dependency. For example, 
if Job A repeats daily, but you want your job to be dependent on Job A’s instance 3 days ago, specify 3 
in this field.

Step 11 Select Ignore this dependency if Job not in schedule if the dependency only applies when the job is 
part of the production schedule.

Step 12 Click OK to add the job dependency.

Note If your job has more than one dependency (file, job, variable or time), all dependencies must be satisfied 
for the job to run. It is possible for a dependency’s state to change from satisfied to unsatisfied. If this 
occurs, the job will only run when all dependencies have been satisfied at the same time.

Adding a File Dependency

You can have a job that depends on the status of a file on any system in your network. For example, Job 
A can be defined to run only when file data.txt exists in the c:\data directory.

To add a file dependency to a job:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group that you want to edit to display the Job or Job Group Definition 
dialog. 

Step 3 Click the Dependencies tab.

Step 4 Click Add and select Add File Dependency from the dependency context menu to display the File 
Dependency Definition dialog.

Step 5 Type the path and filename for the required file or click the Browse button to select a file on the local 
Tidal Web client. 

–or–

Click the Variables button to add System or Job variables as a file name.

Step 6 Select the agent where the file needs to exist.

Step 7 Select the dependency type for the file from the following options:

– Exists – The file exists at the path and on the agent specified.

– Does Not Exist – The file no longer exists, or is not found at the path or on the agent specified.

– Has Changed In DD:HH:MM – The file dependency is satisfied when the file changed within 
the specified time in days, hours, and minutes after the job entered the production schedule. For 
example, if the job entered the schedule at 1:00 PM, the period specified is 6 hours, and the file 
changed after 7:00 PM (or later), the dependency is met.
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– Stable For DD:HH:MM – The file dependency is satisfied when the file size has not changed 
for the specified time in days, hours, and minutes from the present time. For example, if the 
file’s modified time is 1:00 PM, the period specified is 6 hours, and the job enters the schedule 
at 3:00 PM, the dependency is satisfied in 4 hours, i.e., 7:00 PM.

– Size >= – The size of the file is greater than or equal to the specified amount in bytes.

– Size <= – The size of the file is less than or equal to the specified amount in bytes.

Step 8 Click OK.

Note If your job has more than one dependency (file, job, variable or time), all dependencies must be satisfied 
for the job to run. It is possible for a dependency’s state to change from satisfied to unsatisfied. If this 
occurs, the job will only run when all dependencies have been satisfied at the same time.

Adding a Variable Dependency

You can make a job depend on the value of a user-defined variable. For example, Job A should only run 
when the variable RunVar is equal to ten. For more information on variables, see “Variables” on 
page 277.

To add a variable dependency to a job:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group that you want to edit. 

Step 3 Click the Dependencies tab from the Job Definition dialog.

Step 4 Click Add and select Add Variable Dependency from the drop-down menu to display the Variable 
Dependency Definition dialog.

Step 5 If you are creating an intermaster dependency, select from the Master drop-down list a master to manage 
the variable dependency. Leave the default field selection, if you are not creating an intermaster 
dependency.

Step 6 In the Variable Name field, choose a variable from the drop-down menu that the job or job group will 
depend on.

Step 7 In the Operator field, select from the drop-down list an operator to make the appropriate comparison to 
the value of the variable.

Step 8 When text strings are used in comparison, “lower” letters of the alphabet are of greater value than 
“higher” letters. For example, Z > A. If the first letters of the string match, succeeding letters are used 
for comparison. For example, AZ > AA. The operation works similar to sorting strings in ascending 
order. Upper versus lower case is not considered (i.e., a=A, b=B, etc.).

Step 9 In the Variable Value field, enter the value of the variable required for the dependency to be met. You 
can also select from a list of system, job, user-defined and public variables to which the variable should 
be compared. For example, suppose you are using a variable dependency to repeat a job a specific 
number of times, and this amount changes periodically. You can define how many times to repeat the job 
by changing its variable value instead of changing its job definition.
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Adding Parameters to a Command 

You can specify command parameters that are appended to the command when the command is run. 
Consult the author of the script or program or refer to documentation about the command you are running 
for specific information on the type of command parameters you can pass to it.

You can enter fixed parameters, or you can use system, job, public, and user variables using the Variables 
button. At runtime, the current variable values will be used.

Note Command parameters must be added to a job definition through the Command Parameters field on the 
of the Job Definition dialog. TES will not recognize any parameters appended to a command in the 
Command field. For more information about the Command Parameters field or the Command field, 
see “Program Tab” on page 160.

To add a parameter to a command:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job you want to edit to open its Job Definition dialog. 

Step 3 Click the Program tab.

Step 4 In the Command Parameters field, type the parameter text as it should appear in the command.

Adding Notes or Operator Instructions to a Job

For every job or job group that you create, you can add notes on the Notes tab to describe the job or 
group. You can also add instructions intended for the operator during the execution of the job on the 
Runbook tab. This information has no direct effect on how the job or job group runs, but is for 
informational purposes only. The notes or instructions can be written text or can be a web page of 
information displayed from the internet or a company intranet.

To add a note or operator instruction to a job:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group that you want to edit. 

Step 3 Click either the Runbook or the Notes tab.

a. To add text, type the information in the text field. The text can contain up to 255 characters.

b. To display a web page from the internet or a company intranet with information relevant to the 
job, type a web URL in the text field and select the Load URL option.

Assigning an Agent or Agent List to a Job

You can select an agent or an agent list to run your jobs but be sure to choose an agent or an agent list 
for a platform on which your command or batch file can run. 

To assign an agent or agent list to a job:
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Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group you want to edit to open its definition. Selecting an agent or agent list 
for a group results in assignment of the agent to the children that inherit this property.

Step 3 Click the Run tab.

Step 4 The default agent is the agent specified in the System Configuration dialog, Defaults tab. To change 
this agent, select either:

a. An agent from the Agent Name drop-down menu to run your job on a specific agent.

b. An agent list from the Agent List Name drop-down menu to run your job on one or more agents 
in the agent list, depending on the type of list. Note that agent lists allow you to do workload 
balancing, broadcasting, and dynamic rerouting. 

Note If you select an agent list, make sure that the user has logon access to each agent in the agent list. If the 
job tries to run on an agent that the user cannot access the job will fail with an Error Occurred status.

Assigning Job Event(s) to a Job

You can assign predefined job events to jobs to notify the operator or take actions based on exception 
conditions. You can issue email, console alerts, SNMP traps, ITO messages, job control commands, or 
even run a new job through the job event’s associated actions. 

To assign a job event to a job:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group that you want to edit. 

Step 3 Click the Job Events tab.

Step 4 Click Insert and the Select Job Event dialog appears.

Step 5 Select the job event(s).

Step 6 Click OK to add the job event to the job or job group definition.

Copying Jobs or Job Groups

To create a job or job group that has many of the same properties as an existing job or job group, you 
can save time by copying the job or job group first, and then editing its properties.

Note Copying a job group will copy all the jobs and job groups belonging to that job group.

To copy a job or job group:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Right-click the job or job group to copy and select Copy Job/Group from the context menu. 
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Step 3 A copy of the definition of the job or job group you selected will appear. The properties will be the same 
except for the name, which will be prefaced with “Copy of”. Note that you should give each copy a new 
name.

Creating a Public Job

To allow all users access to a job or job group, make the Owner field a public workgroup. A public 
workgroup is a workgroup that contains all TES users.

To create a public job:

Step 1 Create a TES workgroup and add all users:

a. From the Navigator pane, select Administration>Workgroups to display the Workgroups 
pane.

b. Click the Add button on the TES toolbar to display the Workgroup Definition dialog.

c. In the Workgroup Name field, type Public (or whatever name you choose to use).

d. Click the Members tab and select all TES users to join the workgroup.

e. Click OK.

Step 2 To add a job or job group to the public workgroup:

a. From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

b. Double-click the job or job group that you want to edit. 

c. In the Owner field, select the public workgroup from the drop-down menu.

Job and job groups owned by the public workgroup will be available to all users of TES. 

Note The members of the public workgroup should be kept updated as TES users are added or deleted.

Deleting Jobs or Job Groups

To delete a job or job group:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Note If you delete a job group, all child jobs and job groups that are under that job group are also deleted.

Step 2 Select the job or job group to delete and click the Delete button on the TES toolbar. You could also 
right-click the job or job group and select Delete Job/Group from the context men or select the job or 
job group to delete and press the DELETE key on your keyboard.

To select multiple jobs or job groups, hold down either the SHIFT or the CTRL key on your keyboard 
while you click your selections.
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Step 3 Click Yes in the Confirmation dialog to delete the job or job group. 

Deleting a Dependency

To delete a dependency:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group that you want to edit. 

Step 3 Click the Dependencies tab.

Step 4 Select the dependency and click Delete.

If you click the Delete button without selecting a dependency, then the last listed dependency is 
deleted. 

Note Deleting a dependency from a job or job group definition does not delete the actual job, file or variable 
the dependency refers to. It only removes that dependency from the definition you are editing.

Deleting a Job Event From a Job

To delete a job event from a job:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group that you want to edit. 

Step 3 Click the Job Events tab.

Step 4 Select the job event to remove.

Step 5 Click Delete. The job event is removed from the job or job group definition.

Determining the Result From the Exit Code Automatically

To determine the result from the exit code automatically:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job you want to edit. 

Step 3 Click the Run tab.

Step 4 In the Tracking section, select the Exit Code option.

The Job Activity pane displays the job’s completion status based on the job’s exit code.
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Determining the Completion Status Manually

To determine the completion status manually:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job you want to edit. 

Step 3 Click the Run tab.

Step 4 In the Tracking section, select the External option.

The Job Activity pane displays the job’s completion status as Externally Defined. Note that you 
will need to set the job’s status manually using the set status option, or the TES command line 
program jobset. For more information about jobset, see the TES Command Line Reference 
Guide.

Disabling Automatic Job Insertion 

To disable automatic job insertion:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Right-click the job and select Disable from the context menu or double-click the job that you want to 
edit, and remove its calendar or clear the Enabled option.

If the job is already in the schedule, but has not run yet, the job will be removed. If the job had 
dependents, the dependencies on the job are released. Jobs that are active or are completed cannot 
be removed in this fashion, and can only be removed using the normal purging process.

Editing a Job Event Assigned to a Job

To edit a job event assigned to a job:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group that you want to edit. 

Step 3 Click the Job Events tab.

Step 4 Double-click the job event that you want to edit.

Editing a Dependency

Note When you edit a job event definition, all jobs that have been assigned to the job event are affected by the 
change.
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You can edit any existing dependencies associated with jobs or job groups. Editing dependencies is 
similar to adding dependencies.

To edit a dependency:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group that you want to edit. 

Step 3 Click the Dependencies tab. 

Step 4 Select the dependency and click Edit.

a. If you selected a job dependency, the Job Dependency Definition dialog appears. 

b. If you selected a file dependency, the File Dependency Definition dialog appears. 

c. If you selected a variable dependency, the Variable Dependency Definition dialog appears. 

Step 5 Edit the values of the selected Dependency Definition dialog as described previously.

Step 6 Click OK to save the changes.

Managing Simultaneous Occurrences of the Same Job

You can control how your job runs if a previous instance of it is already running. You can skip the job, 
defer it until after the other instance completes, or run it anyway. 

Note The concurrency setting does not apply to job groups.

To manage simultaneous occurrences of the same job:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job you want to edit. 

Step 3 Click the Options tab.

Step 4 In the If Job is currently running section, select one of the following:

a. Run anyway – If a previous instance of the same job is already running, the job tries to launch 
and run it anyway. You may have two or more instances of the same job running at the same 
time.

b. Skip – If a previous instance of the same job is already running, the job is assigned the Skipped 
status and will not run.

c. Defer until Normal – If a previous instance of the same job is already running, the job is 
assigned the Deferred status until the previous instance completes with a Completed Normally 
status, at which time TES launches the job. The job will not run if the previous job instance does 
not complete normally.

d. Defer until Complete – If a previous instance of the same job is already running, the job is 
assigned a Deferred status until the previous instance completes, at which time TES launches 
the job.
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Overriding a Dependency

You can override one or more dependencies when running a job instance. This is useful if you need to 
modify the parameters of a job for just one instance. Instead of creating a new job, you can select a job 
that closely matches the job required and override the dependencies until the job meets your 
requirements. The overridden job dependency only applies to that particular job instance. The job returns 
to its original dependencies after the modified job instance runs.

To override a dependency:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group that you want to edit. 

Step 3 Click the Dependencies tab.

Step 4 Select each dependency you wish to override and right-click to display the context menu. There is only 
one context menu selection called Override.

As an alternative, you can use the shortcut, Ctl+O, to override the dependencies you selected.

Preventing a Job From Being Submitted Manually

You can prevent a job from being added manually into the production schedule.

To prevent a job from being submitted manually:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job you want to edit. 

Step 3 Click the Options tab.

Step 4 Clear the Unscheduled Allowed option.

Removing Jobs from the Production Schedule

There are several ways to remove a job and job group instances from the production schedule:

• Select Create Schedule from the Activities menu.

The Create Schedule option recreates the existing production schedule for the date(s) specified and 
creates new instances based on qualifying jobs. All jobs that were added manually are removed as 
well.

• If the Automatic Daily History Cleanup option on the Master tab of the System Configuration 
dialog is selected, the master automatically purges history during daily maintenance at midnight. 
(Otherwise, the operator must manually purge the job history at regular intervals.)

Each job and job group has a retention period, after which its job instances are automatically purged 
from history. The default retention period is set on the Defaults tab of the System Configuration 
dialog, but individual jobs can customize their retention period on the Options tab of the Job 
Definition dialog.

• Disable the job by deselecting the Enabled option in the job’s or job group’s definition or by using 
the Disable option from the context menu.
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If the job (or job group) has a pre-launch status, disabling the job removes the job from the schedule. 
Job instances that are active or have completed already are not removed. If any jobs depend on the 
removed job, that dependency is no longer required.

• Right-click a job or job group in the Job Activity pane and select Remove Job(s) from Schedule 
from the context menu, or, select a job or job group, then select Remove Job(s) from Schedule from 
the Activities menu. 

If the job (or job group) has a pre-launch status, selecting Remove Job(s) from Schedule will 
remove the job from the schedule. You are prompted for whether you want to release the dependency 
from dependent jobs or job groups.

• Delete the job or job group from the Jobs pane.

Select the job or job group, then click the Delete button on the TES toolbar or the DELETE key on 
your keyboard. When the job or job group definition is deleted, all instances (past, present and 
future) of the job or job group are removed from the production schedule. 

Requiring Manual Release Before a Job Can Run

You can set a job so that an operator must release it before it runs. All dependencies must be satisfied 
before the job is made available for release. Before releasing the job, the operator can view instructions 
regarding it.

To set a job so that an operator must release it before it runs:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job you want to edit. 

Step 3 Click the Options tab.

Step 4 Select the Require operator release option.

Step 5 Click the Notes tab. Type any information and instructions the operator might need to see before 
releasing the job.

Running a Job for Another User

You can run a job using a specific user logon account by selecting the Runtime User in the Job or Job 
Group Definition dialog. When you specify a Runtime User, you must be authorized to do so. Your job 
has access to that user’s environment on the agent. This may be required for your job to run successfully.

To run a job for another user:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group you want to edit. 

Step 3 Click the Run tab.

Step 4 In the Agent Information section, select the user name from the Runtime User drop-down menu. If the 
user name you need doesn’t appear, it must be added to your list of Runtime Users. For more 
information, see “Users” on page 63.. 
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Note If you select an agent list and a runtime user, make sure that the runtime user has logon access to each 
agent in the agent list. Otherwise, the job might fail with an Error Occurred status.

You also need to select the Use Passwords to Run Windows Jobs option on the Master tab of the 
System Configuration dialog. For more information, see “System Configuration” on page 51.

Scheduling Jobs According to a Calendar

To schedule a job according to a calendar:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group you want to edit.

Step 3 Click the Schedule tab.

Step 4 If the job or job group has a parent job group:

a. To use a calendar other than the parent’s calendar, clear the Inherited option in the Calendar 
section.

b. From the Calendar Name drop-down menu, select the Calendar for the job. 

c. To use the calendar assigned to the parent job group, select the Inherited option in the 
Calendar section.

Note A child job must use a calendar that is a subset of the parent job’s calendar. Any job assigned a run date 
that is outside of the date range of the parent job’s calendar cannot be scheduled.

Step 5 You can view the specific dates of the selected calendar by clicking the Forecast button.

Step 6 If you want to offset the dates specified in the calendar, you can type the offset in days next to the 
Calendar drop-down menu. For example, if the job is using the Fiscal Month End calendar with an 
offset of 2, the job will be inserted into the schedule 2 days from every date in the Fiscal Month End 
calendar.

Step 7 To specify the date pane during which the job should run, type dates in the from and to fields. You can 
leave either field blank. If you leave the from field blank, the Calendar takes effect immediately. When 
you leave the to field blank, the Calendar is effective indefinitely.

Step 8 You can use the built-in calendar context dialog to help you select dates. To use the calendar function, 
click the down-arrow button next to the from and to fields.

For more information about TES Calendars, see Controlling Production.

Scheduling Jobs To Repeat Within a Day

You can repeat your job or job group as many times as you like within the day that it is scheduled.

To schedule a job to repeat within a day:
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Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group you want to edit.

Step 3 Click the Schedule tab.

Step 4 In the Repeats section, there are three options to choose from:

– Do not Repeat – Only one instance of the job will be compiled for each production day that the 
job is scheduled to run.

– Run new occurrence – Runs a new occurrence of the job after the number of minutes specified 
in the minutes field passes. In the up to field, specify the number of times to repeat the job. If 
this field is left blank, the job repeats until the end of the time window or until the end of the 
day, whichever occurs first.

– Rerun same occurrence – Run the same job instance after the number of minutes specified in 
the Repeat every field elapses. In the up to field, select the number of times to repeat this job 
instance. If this field is left blank, the job repeats until the end of the time window or until the 
end of the day, whichever occurs first.

The following rules govern this function:

– The interval always begins at the start of the time window (12:00 AM if blank).

For example, if a job’s time window begins at 12:00 PM, and the job is defined to run every hour up 
to four times, the job will run 12:00 PM, 1:00PM, 2:00PM and 3:00PM. If the create schedule 
command occurs at 1:30PM, this job will run twice, once at 2:00 PM and once at 3:00 PM, unless 
you choose to start repeating the jobs ASAP within the Create Schedule dialog, in which case the 
job would run at 1:30, 2:30, 3:30 and 4:30.

– If you change the job definition while one of the repeat jobs is running, and the repeat count is 
changed, all job instances that have not run yet will be removed from the Production Schedule. 
The number of job instances added will equal the total number of instances specified minus the 
number of job instances that have already run.

For example, if you define job A to run 4 times, and the 2nd instance has started, and then you 
change the definition so the repeat count is 5, the 2 jobs already launched will remain in the 
schedule, the 2 other jobs will be removed, and 3 jobs will be added to run in sequence after the 2nd 
instance finishes.

– When you manually insert a repeating job into the schedule (via the Insert Into Schedule menu 
item), only one instance of the job will run as soon as possible after insertion.

– If the job is manually added to the schedule (via the Insert Into Schedule menu item), and other 
jobs depend on the last instance of this job, the dependency will then reflect the added job.

– You can create a perpetual job by using the Rerun same occurrence, Repeat every... minutes 
up to... times option. The same job instance will be rerun after each interval, rather than a new 
instance of the job being run. Only one instance of the job will be displayed in the Job Activity 
pane, but the instance number will increment every time the job is run. The History console 
pane will also show every instance of the job and every status changes. For more information 
about the History pane, see “Diagnostic Messages” on page 376.
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Setting a Job or Job Group’s Priority

You can specify a job’s priority in the Job Definition dialog. The job’s priority value is relative to other 
jobs in the same queue, and not with all other scheduled jobs. When TES looks for the next job to run, 
it searches first for the queue with the highest priority, and then for the job with the highest priority in 
the queue. For more information, see Queues Pane, page 10-338. 

To set a job or job group’s priority:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job you want to edit. 

Step 3 Click the Options tab.

Step 4 In the Job Priority field, enter the job priority, from 0 for lowest priority to 100 for highest priority.

Specifying a time window For Jobs

You can specify the time window during which your job or group is allowed to run. For example, you 
can specify that your job will run after regular business hours, an ideal time to run processor-intensive 
commands because it frees up system resources during the day.

To specify a time window for a job:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group you want to edit.

Step 3 Click the Schedule tab.

Step 4 Use the arrow buttons on each field in the Time window section to type the time window, or type the 
time in each field. If the job or job group has a parent job group, clear the Inherited option in the Time 
window section to use a different time window.

Note If you leave the To and From fields blank, TES assumes 12:00 AM. You can use the From field alone 
to have your job run at the time specified. The time format can be changed in the Windows Regional 
Settings Control Panel.

Step 5 Click the option that indicates what to do if the job cannot run within the time window specified.

– Do not timeout – Select this option if you want to carry the job forward to the next day if it fails 
to start by the end of the time window specified.

– Run again tomorrow – Select this option if the job has not run by the end of the time window 
specified, and you want to carry it forward to the next day. With this option selected, the job is 
eligible to run on each subsequent day, until it does run. You can set up a job action to notify 
you if your job does not run on the originally scheduled day.

Note Using job events, you can be notified if your job does not run within the time window or if the duration 
exceeds its time window. For more information on job events, see “Actions and Alerts” on page 215.
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Working with timezones

You can configure timezones where target application environments are based. This allows you to 
schedule a job or job group across multiple timezones. For example, if the Master associated with your 
job is based in the PST timezone and you want the job to run in an alternative timezone, you can set the 
time differences between the timezones and the amount of time to be added to selected timezone if it is 
in DST (Daylight Savings Time) period. 

To specify a timezone for a job:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group you want to specify the timezone for.

Step 3 Click the Schedule tab.

Step 4 From the Timezone list, select the appropriate timezone you defined in the System Configuration 
dialog.

Step 5 Save the job.

See also, “Timezone Tab” on page 59

Specifying a Command or Batch File

Each TES job runs a single executable, such as files with .exe, .cmd, and .bat extensions. You can also 
specify run parameters.

To specify a command or batch file:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job you want to edit to open its Job Definition. 

Step 3 Click the Program tab.

Step 4 In the Command field, type the path to the executable file.

– To specify a file on a remote agent:

If your job runs on a remote agent, you must specify the command from the perspective of the agent. 
You can use the following naming convention to specify the file you want to run:

\\<computername>\<shared-directory-name>\<filename>. 

For example, if you want to run a command named payrolldat.exe that is located on the computer 
named accounting, in the shared directory Payroll, specify the command as follows:

\\accounting\Payroll\payrolldat.exe

You can also use the Variables button to insert a user-defined path variable.

Note Remote Windows agents must run under a user account and not as a system account. More information 
is available in the installation prerequisites for the Windows agent in the Installation and Configuration 
Guide.

Step 5 In the Command Parameters section, type the parameters to be used in running the command file. Note 
that TES appends command parameters, in the order that they appear on this list, separated by a space. 
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Step 6 In the Environment File section, specify the file containing environment variables for your job. Note 
that this option only applies to jobs run on Unix agents. For more information about environment files, 
see “Environment Files” section on page 5-155. 

Specifying How a Job Determines Its Completion Status

You can determine how to set the completion status of a job in one of the following ways:

• HaveTESset the status automatically based on the exit code of the command or batch file. If the 
exit code is 0, the job’s status is Completed Normally; if the exit code is not 0, the status is 
Completed Abnormally. (The exit code value must range between 0 and 30,000.)

• If the job’s completion status is more difficult to determine than a simple exit code, you can 
determine the status yourself, and then manually set it.

• Use an external output analysis program to determine the job’s status upon completion.

Specifying Durations For a Job

You can specify minimum, maximum, and estimated durations for a job. You can also create job events 
to notify you if the job’s duration exceeds the maximum value, or if the job completes before its 
minimum value. Once the job has run, the estimated duration value reflects the average duration value 
based on the number of times the job has run. For more information, see “Actions and Alerts” on page 215.

To specify duration for a job:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job you want to edit. 

Step 3 Click the Run tab.

Step 4 Go to the Duration (in minutes) section and type the values for the Estimated, Minimum, and 
Maximum run times.

Using TES Variables

To use a TES variable:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job you want to edit to open its Job Definition. 

Step 3 Click the Program tab.

Step 4 While in the field and at the point where you want to insert a TES variable, click Variables. From the 
drop-down menu, select the variable you want to use. 

Using an External Program to Determine Completion Status

To use an external program to determine completion status:
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Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job you want to edit. 

Step 3 Click the Run tab.

Step 4 In the Tracking section, select the Exit code of cmd pipe option.

Step 5 In the Scan Output section, select the option for a particular text string in the output from a job to 
determine that a job completed normally or abnormally.

Step 6 Specify the external command in the adjacent field. The final results are determined by the success of 
that command, and the exit code from the command displays in the Job Activity pane. For more 
information refer to the “Tracking Section (job only, does not apply to job group)” on page 166.

For example, if you type Find Passed in the Exit code of cmd pipe field for an Windows job, the 
output is passed to the Find command. If the text Passed is found in the output, Find returns an exit 
code of 0, and the job’s completion status will be Completed Normally. If Passed is not found, Find 
returns 1, and the job’s completion status is Completed Abnormally.

Viewing Job/Job Group Properties

To view the properties of a job or job group:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane.

Step 2 Double-click a job or job group to view the Job Definition or Job Group Definition dialog.

Viewing Job/Job Group History

To view the history of a job or job group:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the job or job group to view to display the Job Definition or Job Group Definition dialog.

Step 3 Click the History tab. The job’s or job group’s history displays. 

Note For jobs only, you can change the number of days of history to retain using the Retention (in days) field 
on the Options tab when the definition dialog is in Edit mode.
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C H A P T E R 6

Actions and Alerts

Actions Pane 
TES can respond automatically to unusual situations that may arise while running a production schedule. 
Users can create predefined responses called actions. There are various types of actions ranging from 
sending an alert to the Tidal Web client to running a specific job when a designated condition occurs. 

Certain job or system conditions have been designated by TES as “event triggers.” The occurrence of 
these conditions can be used to initiate or trigger a job and/or an action a user has defined. 

By linking an event trigger to an action or a job, an automatic response called an event is created. When 
this event is associated with a condition that affects an individual job or all jobs in general, this defined 
response is known as a job event. If the event is associated with a condition that affects the entire system 
and not just jobs, this defined response is known as a system event. 

Job and/or Action + Event Trigger =   Event

Jobs, job events and actions are constructed in dialogs using a three-tier hierarchy. Each job can have 
any number of job events associated with it, and in turn, each job event can have any number of actions 
associated with it. A job triggers a job event only when its exception condition becomes true, which then 
triggers all of its associated actions. 

Jobs, job events and actions can all be created separately and linked at any time. The 
job-job event-action hierarchy can be linked from the Job Event Definition dialog and from the Job 
Definition or Job Group Definition dialog. In the Job Event Definition dialog, you can assign 
multiple jobs and actions to a single job event. In the Job Definition or Job Group Definition dialog, 
you can assign multiple job events to the job or job group, but you cannot assign actions to job events.

Action Concepts

Actions

An action is a task or notification that is automatically performed by TES in response to a job event 
trigger that occurs for a specific job or job group or system event trigger. Actions are customized tasks 
and messages linked to a job or system event through the Job Event Definition and System Events 
dialogs. The job or system event is then associated with a job or job group. For example, an action to 
send email to the owner of a job that failed can be tied to a Job Completed Abnormally job event 
trigger. Another action that sends an alert message to the console can also be linked to the same job event 
so that two actions occur simultaneously when the job fails. 
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Note When multiple actions are defined for a single event, the actions are completed as the conditions to 
satisfy the event trigger are fulfilled.

Action Types

From the Actions pane, you can view the actions that belong to you or your workgroups. 

The types of actions you can choose from are:

• Email – Use an email message action to notify users via email that an event occurred.

• Log – Use a log message action to post a message to the TES and system logs to record that a 
specified condition occurred. Each TES log message has a unique numerical identifier. You can view 
TES logs from the Logs pane and view Windows event logs using the Windows Event Viewer.

• Job – Use a new job action to add special recovery, pager activation or ad hoc jobs to the production 
schedule when a job event or system event occurs. For example, you can add a recovery job into the 
schedule if the underlying job fails.

• Alert – Use an alert action to send an alert message to the Alerts pane of the Tidal Web client. These 
alerts generated by the action can be assigned varying levels of severity. Once these alert messages 
are sent to the Tidal Web client, the Alerts status light turns yellow to notify a user that a condition 
in the system has generated an alert. The alert must be acknowledged and eventually closed, forcing 
the TES operator to respond to them. The Alerts pane is discussed in more detail later in this chapter 
at “Alerts Pane” section on page 6-234 

• SNMP – Use an SNMP message action to send an SNMP message (trap) to an SNMP manager such 
as Hewlett Packard’s OpenView application.

• HP OV Message – Use a HP OpenView message action to send a message to HP OpenView 
Operations software application.

• Variable – Use a variable action to change a user-defined variable. This action will not affect 
system, job or job event variables.

Variables

TES lets you use system, job, job event and user-defined variables in action messages, making them 
applicable to many jobs. For instance, you could create an action called Job Stopped Email 
Notification, with variables in the message text that will be replaced at runtime with the job name and 
runtime. When you create a job and want to be notified if it stops during execution, you can associate 
the action with the job from the Job Event Definition dialog. If the job stops during execution, you 
receive an email referring to the job that triggered the event. You could even include in the message a 
variable representing the exit code at the time of completion.

Actions Pane Interface 
From the Navigator pane, select Definitions>Actions to display the Actions pane. You must select 
one of the types of actions to display its pane to create or modify an existing action. 

The Actions pane contains the following actions:

• Email – Create an email message action by displaying the Action Definition: Email dialog. For 
more information about email actions, see “Action Definition: Email Message Dialog” section on 
page 6-219
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• Alert – Create a console alert action by displaying the Action Definition: Alert dialog. For more 
information about alert actions, see “Action Definition: Alert Dialog” section on page 6-220. 

• Job – Create a new job action by displaying the Action Definition: Job dialog. For more 
information about new job actions, see “Action Definition: Job Dialog” section on page 6-225.

• SNMP – Create an SNMP message (also known as an SNMP trap) action by displaying the Action 
Definition: SNMP dialog. For more information about SNMP message actions, see “Action 
Definition: SNMP Dialog” section on page 6-221.

• SAP Event – Create an action that sends a notification to an SAP instance when a designated event 
occurs in TES by displaying the Action Definition: SAP Event dialog. For more information about 
SAP Event message actions, see “Action Definition: SAP Dialog” section on page 6-226.

• Log – Create a log message action by displaying the Action Definition: Log dialog For more 
information about log message actions, see “Action Definition: Log Message Dialog” section on 
page 6-226. 

• Variable – Create a variable update action by displaying the Action Definition: Variable dialog. 
For more information about variable update actions, see “Action Definition: Variable Dialog” section 
on page 6-227.

Buttons

Note Buttons are only enabled after a type of action has been selected from the Actions pane.

This pane contains the following buttons:

• Add Action – Displays the Action Definition dialog for the selected type of action to create a new 
action.

• Edit Action – Displays the Action Definition dialog for the selected type of action to edit an 
action.

• Copy Action – Creates a copy of the selected action with the same information as the selected 
action, except for the name.

• Delete Action – Removes the selected action definition from the TES database.

• Refresh – Updates the data in the actions pane.

• Print – Displays the Reports pane to view and print your action definitions. For more information, 
see Monitoring Production.

Search Field

Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out. 

Columns

This pane contains the following columns:

• Name – The name of the action.
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• Owner – The owner of the action.

• Public – Whether or not the action is public, that is, available to all TES users.

• Description – A description of the action. The Description field in the Action Definition dialogs 
is optional, so there may not be any data in this column.

• Modified – The last time the action was modified.

Actions Preferences Dialog 
Select Preferences from the View main menu while viewing an Actions pane to display the Actions 
Preferences dialog for actions.

From an Actions Preferences dialog, you can select which columns are displayed in the pane for the 
selected type of action and in what order the columns appear.

• A checkmark to the left of a column title indicates that it will be displayed in the pane. No 
checkmark indicates that it will not be displayed.

• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.

Navigator Context Menu

When you right-click in the Navigator pane while viewing an Actions pane, the Navigator context 
menu displays. 

The Navigator context menu contains the following options:

• Add Action – Displays the Action Definition dialog for the selected type of action to create a new 
action. Has the same function as the Add Action button. 

• Refresh – Updates the data in the current pane.

• Print – Displays the Reports pane to view and print your connection definitions. Has the same 
function as the Print button on the toolbar. For more information, see Monitoring Production.

• Export – Saves the data in the current pane as an ASCII text file. You can then use the file data in 
other applications. 

• Preferences – Displays the Preferences dialog for the selected type of action.

• New Root Folder – Allows you to create a new root folder for the Navigator pane.

Actions Pane Context Menu

After selecting a folder associated with one of the six action types, if you right-click in the Actions pane, 
the Actions context menu displays. 

The following describes the items in the Action Types pane context menu. The same menu appears for 
each type of action.

• Add Action – Creates a new action definition.

• Edit Action – Edits the selected action by displaying the its Action Definition dialog. 

• Delete Action – Deletes the selected action definition. The action is removed from any instance 
where it has been used.
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• Copy Action – Creates a copy of the selected action with the same information as the selected 
action, except for the name.

• Refresh – Updates the data in the actions pane.

• Print – Prints a list of the available actions. 

• Print Selected – Prints the selected action(s). 

Action Definition: Email Message Dialog
The Action Definition: Email Message dialog displays when you add or edit an email message action. 
An email action sends an email message in response to a job event or system event. You can send email 
to any individual or group with a valid email address in the mail system you have chosen. A user without 
a valid email address (provided on the Other tab in the User Definition dialog) cannot receive 
notification from an Email action. The individual receiving the email does not have to be a user of TES. 
For more information about setting up TES for email, see Getting Started, page 2-29, and the Installation 
and Configuration Guide.

Note To send email to a TES workgroup, that workgroup (not just the individual members) must have a 
mailbox, or be defined as a mailing list, in your email system. For help setting up a mailbox or mailing 
list, see your System or Mail Administrator.

Common To All Tabs

• Action Name – The name of the action (up to 30 characters). The name must be unique.

• Owner – The owner of the action. The default owner is the creator.

• Public flag – When selected, this option ensures that the action is available to all TES users (within 
the constraints of their security policy). You can select the default condition for this option from the 
System Configuration dialog. 

• Variable – When you are in the Subject or Message fields, this button inserts one or more 
variables. Appropriate values replace these variables when the action is triggered.

Note When creating an email message for a system event about losing your database connection, do not use 
variables that will not work without a connection to the database, i.e., <JobName> or <JobStatus>.

Details Tab

• From: – The From: field cannot be edited from this dialog.

• To: – The recipient(s) of the email. To add and remove recipients in this field, you must use the 
Mailing List dialog, displayed by clicking the Browse button. For more information about the 
Mailing List dialog, see “Mailing List Dialog” section on page 6-220. 

Note The To: field can accommodate no more than 1024 characters. If you attempt to enter one or more email 
addresses whose total characters exceed this limit, your address(es) will be truncated automatically. Your 
email action will then fail to reach all its intended recipients. The solution is to create a mailing list 
through the TES Mailing List dialog.
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• Subject – The subject of the email. You can type a combination of text and/or variables in your 
subject. Use the Variables button to select variables from the Variables context menu. 

• Message – The message to send to the recipient. You can type a combination of text and/or 
variables in your message. Use the Variables button to choose variables from the Variables 
context menu.

• Attachment – Type a pathname to locate a file on the network to attach to your email. You must 
type the pathname from the perspective of the master, not from the perspective of the Tidal Web 
client.

Description Tab

The Description field is a free text field for up to 255 characters.

Mailing List Dialog

The Mailing List dialog displays by clicking the Browse button in the To: field in the Action 
Definition: Email dialog. You can select one or more addresses for email actions from this dialog. Each 
recipient of the email action that is selected will be highlighted in the list of available email addresses 
in each field. 

Note To select multiple consecutive addresses, click the first email address and while holding down the SHIFT 
key, click the last consecutive address. 
To select multiple non-consecutive email addresses in each field, click individual desired addresses 
while simultaneously holding down the CTRL key. 
Remove existing recipients in the same way by also clicking their individual addresses while 
simultaneously holding down the CTRL key.

TES Email Addresses Use this field to select the email addresses of TES users. In the case that no email 
address is assigned to a user, their TES user ID appears in the list and is used as a local email address. 
Email addresses are defined in the Other tab of the User Definition dialog. 

You can also use the following variables in this field:

• <JobOwner> – Use the email address of the owner of the job that triggers the job or system event.

• <JobRunUser> – Use the email address of the user whose login was used to run the job.

• <ActionOwner> – Use email address of the owner of the action. For example, if you are a member 
of a workgroup that owns a job, you can associate a specific action to the job’s event so that email 
is sent only to you, the owner of the action.

• <EventOwner> – Use the email address of the owner of the event. For example, if you are a 
member of a workgroup that owns a job, you could associate a specific event that sends an email 
only to you when its event condition occurs.

• Other Email Addresses – Use this field to specify the email address(es) of people outside of the 
TES network.

Action Definition: Alert Dialog
The Action Definition: Alert dialog displays when you add or edit an alert action. An alert action can 
be assigned one of four severity levels: Critical, Error, Warning and Information.
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Common To All Tabs

• Action Name – The name of the action (up to 30 characters). The name must be unique.

• Owner – The owner of the action. The default owner is the creator.

• Public – When selected, the action is available to all TES users (within the constraints of their 
security policy). You can select the default condition for this option from the System 
Configuration dialog. 

• Variable – When you are in the Alert Message field, this button inserts one or more variables. The 
values of the variables are substituted when the action is triggered by the job event or system event. 

Details Tab

• Severity Level – The severity level of the alert. You can select from four different severity 
levels–Critical, Error, Warning and Information. Console alert colors are configurable from the 
Colors tab of the Alerts Preferences dialog. 

Note Critical level and Error level alerts can be associated with an alert sound. However, the computer that 
receives the alert must have a sound card and speakers for the alert sound to be effective. Alert sounds 
are configured from the Sound tab of the Alerts Preferences dialog.

– Critical – Sends the highest priority alert to the Job Activity pane when the action is triggered.

– Error – Sends a high priority alert to the Job Activity pane when the action is triggered.

– Warning – Sends a medium priority alert to the Job Activity pane when the action is triggered.

– Information – Sends the lowest priority alert to the Job Activity pane when the action is 
triggered.

• Alert Message – The message the operator receives when viewing the alert message from the Alert 
Details dialog in the Alerts pane. You can type a combination of text and/or variables in your 
message. Use the Variables button to choose variables from the Variables context menu. 

Description Tab

The Description field is a free text field for up to 255 characters.

Action Definition: SNMP Dialog
The Action Definition: SNMP dialog displays when adding or editing an SNMP Message action. An 
SNMP action sends a message (also known as a trap) to an SNMP manager when the associated job or 
system event occurs. The computer which hosts the SNMP manager does not need to have TES installed.

Common To All Tabs

• Action Name – The name of the action (up to 30 characters). The name must be unique.

• Owner – The owner of the action. The default owner is the creator.
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• Public flag – When selected, this option ensures that the action is available to all TES users (within 
the constraints of their security policy). You can select the default condition for this option from the 
System Configuration dialog. 

• Variables – When you are in the Message field, this button inserts one or more variables. The 
values of the variables are substituted at the time that the action is executed.

Details Tab

TES uses the SNMP community, port, and host/IP address as set in the Windows SNMP Properties 
dialog. 

• Severity Level – The severity level of the SNMP message. You can choose Critical, Major, Minor, 
Warning or Normal. Severity levels can be used by an SNMP manager to alter the representation 
color of the alert.

• Community – The SNMP community that you want to send the SNMP trap to. This value is 
case-sensitive so type the name exactly as it is defined. 

• Message – The message for the SNMP trap. You can type a combination of text and/or variables in 
your message. Use the Variables button to choose a variable from the Variables context menu. TES 
is limited to messages of 255 characters or less. Any message text that extends beyond 255 
characters is not sent. 

Description Tab

The Description field is a free text field for up to 255 characters.

Configuring SNMP on the Master

By default, the SNMP action sends the trap to just the “public” community but TES can be configured 
to send SNMP traps to multiple communities and hosts. Older versions of TES used the Master.Props file 
to configuration the use of SNMP traps. The designated recipients of the SNMP traps are now specified 
in an XML file called snmpconfig.xml. 

To create the configuration file, the following information must be gathered beforehand:

• A list of the communities that will receive traps from TES

• A list of the hostnames of the machines in each community 

• The port number, if a host machine is not using the standard port number (162) for receiving the 
traps

From the information that you have gathered, you must designate a default community, host machine and 
port number, in that order. 

• The default community is the community that the trap will be sent to when the action definition of 
the trap is not filled in. 

• The default host is the hostname that the trap will be sent to if the default community contains no 
hosts. The hostname is only used if the default community is unavailable or incorrectly defined.

• The default port is the port number that the trap will use unless the host is specifically configured 
for a different port. The default port number used in SNMP trapping is 162, though this could have 
been configured differently in your system.

The information in the snmpconfig.xml configuration file is organized as follows, first the default 
properties and then a listing of the communities and their host members, if any.
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The following rules must be followed when creating the snmpconfig.xml file:

• The default attributes for community, hostname and port number must be defined. 

• There can only be one default designated for each attribute and the defaults must be listed in the 
correct order.

• The default community and its attributes must be listed first.

• The community name is case-sensitive. Type the community name in the configuration file exactly 
as it is defined.

• No other community besides the default is necessary in the configuration file but as many 
communities as needed can be defined after the default. 

• Communities cannot nest inside each other. Instead each community should be listed in individual 
blocks of its attributes.

• Hostnames are optional in the other communities listed, but if used, they must be placed in the 
community they belong. Note that a host machine can belong to multiple communities. 
If the same host machine is named twice in a community block, then that host machine will receive 
two copies of every trap sent to that community.

• Define a port number attribute if the designated host machine is using a port number for its traps 
that differs from the default port number. Any host machine without a port attribute will receive traps 
via the designated default port.

An example of an snmpconfig.xml file illustrating the proper file formatting and using the rules stipulated 
above is shown below. In this example, the default community=public, the default hostname=localhost 
and the default port number=162.

<?xml version=”1.0” encoding=”UTF–8”?>

<snmp_config>

<default_community value=”public”/>

<default_host value=”localhost”/>

<default_port value=”162”/>

<community id=”public”>

<host hostname=”localhost”/>

<host hostname=”trapreceiver.mycompany.com” port=”362”/>

<host hostname=”networkaudit.mycompany.com”/>

</community>

<community id=”support”>

<host hostname=”offsite.techsupport.com”/>

</community>

</snmp_config>

Installing the snmpconfig.xml File

Once the configuration file is created, it needs to be placed onto the master. 

To install the file:

Step 1 Save the configuration file as snmpconfig.xml.

Step 2 Stop the master.
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Place the snmpconfig.xml file into the TES master’s config directory. 
If you installed the Windows master in the default location, this directory is at C:\Program 
Files\Tidal\Scheduler\master\config.
If the Unix master was installed in the default location, this directory is at 
/opt/Tidal/master/config.

Step 3 Restart the master. 

After the TES master restarts, it will reconfigure the SNMP settings according to the information in the 
snmpconfig.xml file. If you previously used the Master.Props file to configure SNMP, that configuration 
information is overridden. Examine the log file on the master to verify that the configuration was 
successful. If the snmpconfig.xml file cannot be used, the master will use the configuration specified in 
the Master.Props file.

Action Definition: HP OpenView Operations Dialog
The Action Definition: HP OpenView dialog displays when adding or editing an HP OpenView 
message action. An HP OpenView message action sends an HP OpenView message to an HP OpenView 
Operations software management node.

Common To All Tabs

• Action Name – The name of the action (up to 30 characters). The name must be unique.

• Owner – The owner of the action. The default owner is the creator.

• Public flag – When selected, this option ensures that the action is available to all TES users (within 
the constraints of their security policy). You can select the default condition for this option from the 
System Configuration dialog. 

• Variables – When you are in the Message field, this button inserts one or more variables. The 
values of the variables are substituted at the time that the action is executed.

Details Tab

• Severity Level – The severity level of the message. You can choose Critical, Major, Minor, 
Warning or Normal. Severity levels alter the representation color of the icons and message 
indicators in the HP OpenView software.

• Message – The text for the HP OpenView message. You can type a combination of text and/or 
variables in your message. Use the Variables button to choose a variable from the Variables 
context menu. 

Note If you do not type a message here, there will be no content for the HP OpenView message when viewed 
from the HP OpenView Message Browser.

Description Tab

The Description field is a free text field for up to 255 characters.
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Action Definition: Job Dialog
The Action Definition: Job dialog displays when adding or editing a job action. A job action adds a 
new job or job group to the production schedule when the associated job or system event occurs.

Common To All Tabs

• Action Name – The name of the action (up to 30 characters). The name must be unique.

• Owner – The owner of the action. The default owner is the creator.

• Public flag – When selected, this option ensures that the action is available to all TES users (within 
the constraints of their security policy). You can select the default condition for this option from the 
System Configuration dialog. 

• Variables – When you are in the Override field of the Parameters section, click this button to 
select a defined variable. The values of the variables are substituted when the action is executed. 

Details Tab

• Job Name – The name of the job or job group to add to the production schedule. Click the Browse 
button to select a job or job group using the Job Search dialog. You cannot type directly into this 
field, which prevents the typing of non-existent jobs and job groups.

• Agent – The agent on which to run the job. If this field is left blank, the agent or agent list specified 
in the job’s definition is used. You can clear an agent you selected by right-clicking the Agent field 
and selecting Clear Agent from the context menu or by selecting the agent and using the DELETE 
key on your keyboard.

• Runtime User – The user account under which the job runs. If this field is left blank, the runtime 
user specified in the job’s definition is used. If the runtime user is not defined in the job definition, 
then the job runs under the account of its Owner. You can clear the Runtime User by right-clicking 
the Runtime User field and selecting Clear User from the context menu or by selecting the text 
and pressing the DELETE key on your keyboard.

• Parameters – If the job has command parameters assigned to it from the Job Definition dialog, 
the parameters are displayed here. Command parameters are text strings placed after the command 
when it runs to modify how the command is executed.

• Default – Displays the default command parameter(s) from the original job definition.

• Override – The command parameter(s) to be passed to the job’s command when the job is inserted 
into the schedule by the action. You can use this column to add or to override the existing values 
shown in the Default field by typing in the new values or variables. 

Description Tab

The Description field is a free text field for up to 255 characters.
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Action Definition: Log Message Dialog
The Action Definition: Log dialog displays when you add or edit a log message action. A log action 
posts a message of your choice to the TES log when a job or system event occurs. Optionally, the same 
message can be recorded to the Unix console if on the Unix platform. The message can be defined as 
Error, Audit or Diagnostic.

Common To All Tabs

• Action Name – The name of the action (up to 30 characters). The name must be unique.

• Owner – The owner of the action. The default owner is the creator.

• Public flag – When selected, this option ensures that the action is available to all TES users (within 
the constraints of their security policy). You can select the default condition for this option from the 
System Configuration dialog. 

• Variables – When you are in the Log Message field, clicking this button accesses predefined 
variables to incorporate into your message. The values of the variables are determined at the time 
that the action is executed. 

Details Tab

• Log Level – The type of log message. You can filter messages based on their Log Level setting: 
Error, Audit or Diagnostic.

• Window – Specifies that instead of just logging the message from the action to the log in TES, that 
the log message should also be written to the console in Windows. All TES messages are logged 
under the application, TES. This section contains the following fields:

– Log as Windows Event – Enable this option to log events to the console in Windows.

– Event ID – Assign an event number in Scheduler for the logging of the message to the Windows 
console.

• Log Message – The message you want entered in the TES log. Error and audit level messages are 
accessible through the TES Logs pane. Diagnostic level messages are recorded into the master’s 
sadiagsall.txt file, if diagnostics logging for the Action Manager has been enabled. For more 
information, see Monitoring Production)

Description Tab

The Description field is a free text field for up to 255 characters.

Action Definition: SAP Dialog
The Action Definition: SAP dialog displays when adding or editing an SAP action. An SAP action 
sends a notification to the CCMS of a designated SAP instance that a specified event has occurred in 
TES.

Common To All Tabs

• Action Name – The name of the action (up to 30 characters). The name must be unique.
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• Owner – The owner of the action. The default owner is the creator.

• Public flag – When selected, this option ensures that the action is available to all TES users (within 
the constraints of their security policy). You can select the default condition for this option from the 
System Configuration dialog. 

• Variables – When you are in the Event Parameters field, click this button to enter a system, job 
or job event variable. You can use this function to set the value of the variable to the value of another 
variable. You can also set the variable to a string based on the values of other variables. The values 
of the variables are substituted at the time that the action is executed. 

Details Tab

• SAP Instance – Specifies which SAP instance will receive the event notification. 

• SAP Event ID – Specifies the name of the event that will initiate this action.

• Event Parameters – If necessary, you can define the parameters of the event that triggers this 
action. You can use defined variables by selecting them from the Variables drop-down list.

Description Tab

The Description field is a free text field for up to 255 characters.

Action Definition: Variable Dialog
The Action Definition: Variable dialog displays when adding or editing an update variable action. A 
variable action updates a user-defined variable when the job or system event occurs. 

Note Only user-defined variables can be used for variable actions. Therefore, if you have not yet created your 
own variables, this action will not be available.

Common To All Tabs

• Action Name – The name of the action (up to 30 characters). The name must be unique.

• Owner – The owner of the action. The default owner is the creator.

• Public flag – When selected, this option ensures that the action is available to all TES users (within 
the constraints of their security policy). You can select the default condition for this option from the 
System Configuration dialog. 

• Variables – When you are in the Value field, click this button to enter a system, job or job event 
variable. You can use this function to set the value of the variable to the value of another variable. 
You can also set the variable to a string based on the values of other variables. The values of the 
variables are substituted at the time that the action is executed. 

Details Tab

• Master – The master that the variable is related to. This is used mostly with intermaster 
dependencies.
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• Variable Name – The name of the variable to update. The displayed variable name includes the 
type of variable it is, i.e., string, number or date. Choose from the drop-down list of user-defined 
variables.

• Type of Update – Use this drop-down menu to choose the type of update for the variable:

– Set Variable Value – Sets the variable’s value to the value given in the Value field. The value 
can be either a number, date or string.

– Increment Variable Value – If the variable is a number or date, increments the variable’s 
value. If the variable is a string, appends the new string value to the present string.

– Decrement Variable Value – If the variable is a number or date, decrements the variable’s 
value. If the variable is a string, then this option is unavailable.

• Value – The value used for the update. When updating a number type, you can use any real number 
(including negative numbers). When updating a string type, any set of characters (including 
numbers) are treated as a string. When updating a date type, the format will conform to the same 
format as set in the operating system of the master.

For example, a variable can refer to the name of the primary printer being used. If the printer goes 
down, a job can track it and issue a job event that sends an email message to users explaining that 
the primary printer has gone down. The variable update can then be issued to change the default 
printer name.

Description Tab

The Description field is a free text field for up to 255 characters.

Action Procedures

Adding an Email Message Action

You can send an email message to anyone with a valid email address in response to a job event or system 
event by creating an email action. You cannot send email to a workgroup unless that workgroup (not just 
the individual members) has a mailbox, or is defined as a mailing list, in your email system.

Note When creating an email message for a system event about losing your database connection, do not use 
variables that will not work without a connection to the database, i.e., <JobName> or <JobStatus>.

To add an Email Message action:

Step 1 From the Navigator pane, select Definitions>Actions to display the Actions pane.

Step 2 Select the Email folder.

Step 3 Click the Add button or right-click and select Add Action from the context menu to display the Action 
Definition: Email dialog.

Step 4 In the Action Name field, type a name for this action (up to 30 characters). The name must be unique.

Step 5 To make the action public, select the Public option. When an action is public, the action is available to 
all TES users, within the bounds of their security policy.

Step 6 Select the desired Owner from the drop-down menu in the Owner field.
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Step 7 Click the Details tab.

Step 8 In the To field, click the Browse button to display the Mailing List dialog and select the recipients of 
this email action when it is triggered.

Note The From: field will be the name specified in the Mail tab of the System Configuration dialog.

Step 9 In the Subject field, type a subject title for your email message. In this field you have the option of 
inserting one or more TES variables.

To insert a variable, click where you want to insert the variable, and then click the Variables button 
and select a variable from the variables context menu.

Step 10 In the Message field, type the message to send when this email action is triggered. In this field you have 
the option of inserting one or more TES variables.

To insert a variable, click where you want the variable, and then click the Variables button and select a 
variable from the variables context menu.

Step 11 To enter a description for your email action, click the Description tab, and type your description in the 
Description field.

Step 12 Click OK to accept the action. 

The action displays in the Actions pane and is available from the Job Event Definition and System 
Events dialogs.

Adding a Console Alert Action

You can send an alert to the Job Activity pane in response to a job event by creating an console alert 
action. 

To add a Console Alert action:

Step 1 From the Navigator pane, select Definitions>Actions to display the Actions pane.

Step 2 Select the Alert folder.

Step 3 Click the Add button or right-click and select Add Action from the context menu to display the Action 
Definition: Alert dialog.

Step 4 In the Action Name field, type a name for this action (up to 30 characters). The name must be unique.

Step 5 If you wish to make the action public, select the Public option. When an action is public, the action will 
be available to all TES users, within the bounds of their security policy.

Step 6 Select the desired Owner from the drop-down menu in the Owner field.

Step 7 Click the Details tab.

Step 8 In the Severity Level section, select the severity level for the alert you are defining. Different severity 
levels can be represented in different ways. For example, Critical and Error level alerts can be made 
audible. Alerts of different severity levels appear in different colors on the Job Activity pane by default.

Step 9 In the Alert Message section, type the message to send. 

Step 10 In this text field, you have the option of inserting one or more TES variables. Click where you want to 
insert the variable, and then click Variables to choose a variable from the variables menu.
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Step 11 To enter a description for your alert, click the Description tab, and type your description in the 
Description field.

Step 12 Click OK and the action appears in the Actions pane and is available from the Job Event Definition 
and System Events dialogs.

Adding an SNMP Action

You can send an SNMP message (trap) to an SNMP manager in response to a job event or system event 
by creating an SNMP action.

To add an SNMP action:

Step 1 From the Navigator pane, select Definitions>Actions to display the Actions pane.

Step 2 Select the SNMP option.

Step 3 Click the Add button or right-click and select Add Action from the context menu to display the Action 
Definition: SNMP dialog.

Step 4 In the Action Name field, type a name for this action (up to 30 characters). The name must be unique.

Step 5 If you wish to make the action public, select the Public option. When an action is public, the action will 
be available to all TES users, within the bounds of their security policy.

Step 6 Select the desired Owner from the drop-down menu in the Owner field.

Step 7 Click the Details tab.

Step 8 In the Severity Level field, select the severity level for the SNMP message from the drop-down menu. 
(Refer to your SNMP manager software documentation for an explanation of how the severity level is 
interpreted.)

Step 9 In the Message field, type the SNMP message. In this field you have the option of inserting one or more 
TES system variables. Click where you want to insert the variable, and then click Variables to choose 
a variable from the Variables menu. 

Step 10 To enter a description for your SNMP action, click the Description tab, and type your description in the 
Description field.

Step 11 Click OK and the action appears in the Actions pane and is available from the Job Event Definition 
and System Events dialogs.

Adding a New Job Action

You can submit a new job or job group to the production schedule in response to a job event or system 
event by creating a new job action. You can specify on which agent it will run, the runtime user, and 
override the default command parameters in the job or job group that is submitted.

To add a new job action:

Step 1 From the Navigator pane, select Definitions>Actions to display the Actions pane.

Step 2 Select the Job option.
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Step 3 Click the Add button or right-click and select Add Action from the context menu to display the Action 
Definition: Job dialog.

Step 4 In the Action Name field, type a name for this action (up to 30 characters). The name must be unique.

Step 5 If you wish to make the action public, select the Public option. When an action is public, the action will 
be available to all TES users, within the bounds of their security policy.

Step 6 Select the desired Owner from the drop-down menu in the Owner field.

Step 7 Click the Details tab.

Step 8 In the Job Name field, click the Browse button to display the Job Search dialog.

Step 9 Select the job or job group to add and click OK. 

Step 10 Adding a job group submits all the child jobs with one action. To achieve a similar result, you can assign 
multiple actions, each adding a separate job, to the same job event or system event.

Step 11 From the Agent drop-down menu, select the agent on which to run the added job or job group. If no 
agent is selected, the job or job group runs on the agent that is defined in the job or job group definition. 
To clear an agent, right-click the Agent field, and select Clear Agent from the context menu, or use the 
DELETE key on your keyboard.

Step 12 From the Runtime User drop-down menu, select the runtime user.

a. If no user is defined, the runtime user in the job or job group definition is used. If the runtime 
user is not defined in the job or job group definition, the owner of the job or job group is used.

b. To clear the runtime user, right-click the Runtime User field and select Clear User from the 
context menu or use the DELETE key on your keyboard.

Step 13 To override the default values (if any) in the Default field, you can enter your own values or assign 
variables. If an added job contains command parameters, the Override field will display them.

a. Select the parameter to override from the Override field.

b. Type the new value. You can choose from a menu of TES variables using the Variables button. 

Note To override the agent used by a job, create a job action for the same job and assign a different agent. You 
can also use an ordered agent list, which will cause the job to use the next agent in the list if one fails.

Step 14 To enter a description for your job action, click the Description tab, and type your description in the 
Description field.

Step 15 Click OK and the action appears in the Actions pane and is available from the Job Event Definition 
and System Events dialogs.

Adding a Log Message Action

You can post a log message of your choice to the TES log based on a job or system event. You can 
configure the log message’s text, log level and whether or not it should also be logged in the Windows 
Event Log.

To add a Log Message action:

Step 1 From the Navigator pane, select Definitions>Actions to display the Actions pane.

Step 2 Select the Log folder.
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Step 3 Click the Add button or right-click and select Add Action from the context menu to display the Action 
Definition: Log dialog.

Step 4 In the Action Name field, type a name for this action (up to 30 characters). The name must be unique.

Step 5 If you wish to make the action public, select the Public option. When an action is public, the action is 
available to all TES users, within the bounds of their security policy.

Step 6 Select the desired Owner from the drop-down menu in the Owner field.

Step 7 Click the Details tab.

Step 8 In the Log Level section, select the log level.

– Error – Places the log into the error message class. Use this log level when your message 
explains an error that occurred.

– Audit – Places the log into the audit message class. Use this log level when your message 
explains normal activity.

– Diagnostic – Places the log into the diagnostic message class. Use this log level when your 
message contains detailed information, useful for diagnostic purposes.

Step 9 In the Windows Event Log section, select whether you want the message to be logged to the Windows 
Event Log and assign an event number as an ID for the logging action. You can view these messages 
using the Windows Event Viewer application log. 
(If using an Unix master, this section is called the Unix Console and if the Log to Unix Console option 
is selected than events are recorded to a log file using the ID number assigned.)

Step 10 In the Log Message field type the message. In this text field you can insert one or more TES variables. 
Click in the location where you want to insert the variable and then click the Variables button to choose 
a variable from the variables menu. 

Step 11 To enter a description for your log action, click the Description tab and type your description in the 
Description field.

Step 12 Click OK and the action appears in the Actions pane and is available from the Job Event Definition 
and System Events dialogs.

Adding a Variable Update Action

You can update a user-defined variable using an action. If the variable is a string, you can update its 
string value. If it is a number or date variable, you can increment, decrement, or simply change its 
numerical value. When editing a variable update action, you define which variable to update, the update 
value, and when to update the variable. 

To add a Variable Update action:

Step 1 From the Navigator pane, select Definitions>Actions to display the Actions pane.

Step 2 Select the Variable folder.

Step 3 Click the Add button or right-click and select Add Action from the context menu to display the Action 
Definition: Variable dialog.

Step 4 In the Action Name field, type a name for this action (up to 30 characters). The name must be unique.

Step 5 If you wish to make the action public, select the Public option. When an action is public, the action is 
available to all TES users, within the bounds of their security policy.

Step 6 Select the desired owner from the drop-down menu in the Owner field.
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Step 7 Click the Details tab.

Step 8 In the Variable Name field, select the name of the variable to affect with the action. (The variable must 
have been previously defined.)

Step 9 In the Type of Update field, select how to update the variable:

– Set variable value to – Replaces the existing variable’s value to the value specified in the 
Value field.

– Increment variable value by – If the variable is of the number or date type, increments the 
variable by the number in the Value field. If the variable is a string type, appends the string in 
the Value field to the variable.

– Decrement variable value by – If the variable is of the number or date type, decrements the 
variable by the number in the Value field. If the variable is a string type, replaces the variable 
by the string in the Value field. (For string variables only, the Set variable to option and the 
Decrement variable value by option have the same result.)

Step 10 In the Value field, type either a numeric value or a string to use for the update. 

* The date format corresponds to the format configured in the operating system of the master.

Step 11 In the When to Update field, select when the variable should update, before or after all other actions. 
If you want to use the variable’s updated value in other actions that are triggered by the same event, select 
the before other actions option. For example, if you wanted to track how many times a job completes 
normally, you could create a variable called Comp_Norm. Then, you would have a variable update action 
increment Comp_Norm before other actions. You could then notify users how many times the job 
completed successfully with an email action that includes the Comp_Norm variable. 

Changing an Action's Ownership

To change an action’s ownership:

Step 1 From the Navigator pane, select Definitions>Actions to display the Actions pane.

Step 2 Select the folder for the type of action you want to see: Email, Alert, SNMP, Job, Log or Variable.

Step 3 Double-click the action whose properties you want to change, or right-click the action and select Edit 
Action from the context menu or select the action and click the Edit button on the TES toolbar.

Step 4 In the Owner drop-down list, select a different owner.

Table 6-1 Variable Update Table

Type of 
Update

Set Variable Value to Increment Variable 
Value by

Decrement Variable 
Value by

Number Any real number Any real number Any real number

Date Date string* Any integer Any integer

String Any string Any string Any string
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Deleting an Action

You can delete an action that you no longer need. When you delete an action, it is removed from all 
associated job events and system events.

To delete an action:

Step 1 From the Navigator pane, select Definitions>Actions to display the Actions pane.

Step 2 Select the folder for the type of action you want to delete: Email, Alert, SNMP, Job, Log or Variable.

Step 3 Right-click the action and select Delete Action from the context menu or select the action and click the 
Delete button on the TES toolbar.

Step 4 Click OK in the confirmation dialog to delete the action.

Viewing an Action’s Properties

To view an action’s properties:

Step 1 From the Navigator pane, select Definitions>Actions to display the Actions pane.

Step 2 Select the folder for the type of action you want to see: Email, Alert, SNMP, Job, Log or Variable.

Step 3 Double-click the action whose properties you want to view, or right-click the action and select Edit 
Action from the context menu or select the action and click the Edit button on the TES toolbar.

Alerts Pane 
The Alerts pane lists the console alerts that were generated by alert actions. Alerts are a special type of 
action to bring specific conditions to the attention of the TES operator. Alerts can also be used as a 
diagnostic tool to decipher the cause of the abnormal condition. For more information about alert 
actions, see “Action Definition: Alert Dialog” section on page 6-220. More information on an alert is 
available by double-clicking it to display its Alert Detail dialog.

The Alerts pane displays all console alerts that are present on the system, up to the alert retention history 
as defined on the Master tab in the System Configuration dialog. 

Alerts Interface

Note From the Navigator pane, select Operations>Alerts to display the Alerts pane.There cannot be any 
data in this pane until at least one alert action has been defined and triggered.

• Alerts status light – This light displays in different colors based on the status of the alerts in the 
Alerts pane. 

– Red status light – One or more Critical or Error alerts have not yet been acknowledged.
6-234
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 6      Actions and Alerts
  Alerts Pane
– Yellow status light – One or more Warning alerts have not yet been acknowledged, or one 
or more Critical, Error or Warning alerts have not yet been closed.

– Green status light – There are alerts present, but none need to be closed or there are no alerts 
present; alert actions may have been defined, but none have been triggered. 

Buttons

• Filter – Displays the Alert Filter dialog to customize the data that displays in the Alerts pane.

• Prior Day – Displays the alerts for the day before the one currently displayed.

• Select Day – Displays the alerts for “today” or any other day.

• Next Day – Displays the alerts for the day after the one currently displayed.

• Print – Displays the Reports pane to view and print the contents of the Alerts pane. For more 
information, see Monitoring Production.

Columns

Note Time – The date and time that the job event occurred triggering the alert. Alerts do not display for jobs 
that have been purged from history.

• Status – The status of the alert. A console alert can have a status of the following:

– Open – The alert is new or has not yet been acknowledged or the status of the alert has been 
reset to open from an acknowledged or closed state. To reset the status of an alert to open, 
double-click the alert record to open the Alert Detail dialog, then select Open from the Status 
field drop-down menu.

– Acknowledged – The alert has been acknowledged. To acknowledge an alert, right-click the 
alert and select Acknowledge from the context menu or double-click the alert record to open 
the Alert Detail dialog, then select Acknowledge from the Status field drop-down menu. To 
acknowledge multiple alerts at the same time, hold down the SHIFT key or the CTRL key on your 
keyboard while clicking your selections.

– Closed – The alert has been closed. To close an alert, right-click the alert and select Close from 
the context menu or double-click the alert record to open the Alert Detail dialog and then select 
Closed from the Status field drop-down menu.

• Job No. – The job number of the job that issued the alert.

• Job Name – The name of the job that issued the alert.

• Alert Message – The alert message as defined in the alert action definition.

• Level – The severity level of the alert. Possible severity levels are critical, error, warning and 
information. Severity levels can be used to filter and sort the data in the Alerts pane. 

• Response – The response entered by the operator in the Alert Detail dialog. The Alert Detail 
dialog is available by double-clicking the alert in the Alerts pane.

• Response Time – Displays the time the alert was acknowledged or closed. If the alert is in the open 
state, this field is blank.
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Alerts Preferences Dialog

If you select Preferences from the View main menu while viewing the Alerts pane, the Alerts 
Preferences dialog displays.

From the Columns tab of the Alerts Preferences dialog, you can select which columns are displayed 
in the Alerts pane and in what order they appear.

• A checkmark to the left of a column title indicates that it will be displayed in the pane. No 
checkmark indicates that it will not be displayed.

• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.

On the Colors tab of the Alerts Preferences dialog, select the color to be used for alerts of that type 
from the drop-down menu in the Critical Alert, Error Alert, Warning Alert and Information Alert 
fields. 

On the Sound tab of the Alerts Preferences dialog, specify the following:

Note Audible Critical/Error Alerts – Specify if Critical and Error level alerts should be audible. If several 
alerts occur in less than 30 seconds apart, the alert will sound only once.You must specify a .wav file in 
the Wave File field for the Audible Critical/Error Alerts option to take affect. Most Windows 
installations will include some .wav files.

• Wave file – Select the .wav sound file to play when the Critical or Error alert occurs. You can 
click the Browse button to select a file using the Open dialog.

• Duration ... (in seconds) – Specifies how long the alert sound will play.

• Test – Click to play the sound specified in the Wave file field.

Navigator Context Menu

When you right-click in the Navigator pane while viewing the Alerts pane, the Navigator context 
menu displays. 

The Alerts Navigator context menu contains the following options:

• Filter – Displays the Alert Filter dialog to filter the job occurrences whose alerts are displayed. Has 
the same function as the Filter button on the toolbar. You can also custom-sort the alerts. For more 
information on the alert filter, see “Alert Filter Dialog” section on page 6-238.

• Prior Day – Displays the alerts for the day before the one currently displayed. Has the same 
function as the Prior Day button on the toolbar.

• Next Day – Displays the alerts for the day after the one currently displayed. Has the same function 
as the Next Day button on the toolbar.

• Select Day – Displays a calendar to select the date whose alerts you want to view. Has the same 
function as the Select Day button on the toolbar. 

• Preferences – Displays the Preferences dialog for the Alerts pane.

• Print – Displays the Reports pane to view and print your alerts display. Has the same function as 
the Print button on the toolbar. For more information, see Monitoring Production.

• Export – Saves the data in the current pane as an ASCII text file. You can then use the file data in 
other applications. 

• Refresh – Updates the data in the current pane.
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Alerts Context Menu

When you right-click in the Alerts pane, the Alerts context menu displays. 

The Alerts pane context menu contains the following options:

• Details – Displays the Alert Detail dialog. This menu option is available only when an alert has 
been selected.

• Filter – Displays the Alert Filter dialog. The Alert Filter dialog allows you to manipulate the 
Alerts pane display. For more information on the Alert Filter dialog, see “Alert Filter Dialog” 
section on page 6-238.

• Prior Day – View the alerts generated the day before the one you are currently viewing.

• Next Day – View the alerts generated for the day after the one you are currently viewing.

• Select Day – Select a specific date for which to view the generated alerts.

• Acknowledge – Sets the status of an alert to Acknowledged. This menu option is available only 
when an alert has been selected.

• Close – Sets the status of an alert to Closed. This menu option is available only when an alert has 
been selected.

• Job Details (available only for alerts generated by a job or job group) – Displays the details about 
the job that generated the alert.

• Insert New Job Instance (available only for alerts generated by a job or job group) – Inserts a 
new instance into the schedule of the job or job group that generated the alert.

• Job Control (available only for alerts generated by a job or job group) – Displays the same job 
control context menu available in the Job Activity pane for user convenience to perform job control 
functions on the job or job group that generated the alert. This allows you to override dependencies, 
release or rerun a job, cancel a job or set the status of a job that generated the alert.

• Print – Prints a report of all current alerts to the screen in a TES Report window. You can then 
print this report to a printer, or just close the pane.

Alert Detail Dialog
The Alert Detail dialog displays when you double-click an alert record in the Alerts pane. Alerts are 
generated by alert actions that are associated with job or system events. 

This dialog contains the following elements:

• Time – The date and time the alert action issued the alert.

• Level – The alert’s severity level, as defined in the alert action’s definition.

• Description – The text of the alert, as specified in the alert action definition’s Alert Message field. 
(Any variables used in the Alert message have been replaced with their values.)

• Job No. – The job occurrence number associated with the alert.

• Job Name – The name of the job that issued the alert.

• Status – The status of the alert: Open, Acknowledged or Closed.

• Response – This field, if the alert was generated by a job or job group, displays audit information 
about any job control actions taken in response to this alert. Any messages, if any, entered at the time 
of acknowledgement or closure of an alert are also displayed. 
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Alert Filter Dialog
The Alert Filter dialog displays when you select Filter from the Alerts pane context menu. Use the 
Alert Filter dialog to limit the alerts that you see according to different parameters.

This dialog contains the following elements:

• Open – Shows all alerts that have just been generated or have not yet been acknowledged or closed.

• Acknowledged – Shows all alerts that have been acknowledged. 

• Closed – Shows all alerts that have been responded to and closed. 

• Critical – Shows all alerts with a severity level set to critical, indicating that the console alert should 
be responded to immediately.

• Error – Shows all alerts with a severity level set to error, indicating that an error occurred on the 
associated job.

• Warning – Shows all alerts with a severity level set to warning, warning the operator of a potentially 
damaging situation regarding the associated job.

• Information – Shows all alerts with a severity level set to information, indicating that the operator 
should take notice of the information given regarding the job.

Note If Critical and Error alerts are filtered out, any associated audible alert will not sound.

• Current Day – Shows all the alerts that have been generated on the current day.

• Date Range from ... to ... – Shows all alerts generated during the time period specified.

• Last ... Day(s) ...Hour(s) ...Minute(s) – Displays all alerts generated during the specified time 
period.

Alerts Procedures

Acknowledging an Alert

To acknowledge an alert:

Step 1 From the Navigator pane, select Operations>Alerts to display the Alerts pane.

Step 2 Right-click the alert that you want to acknowledge and select Acknowledge from the context menu. To 
acknowledge more than one alert at the same time, hold down the SHIFT or the CTRL key on your 
keyboard while clicking your selections.

–or–

Double-click the alert to acknowledge to display its Alert Detail dialog.

Step 3 From the Status drop-down menu, select Acknowledged. You may also want to type notes in the 
Response field. TES’s auditing mechanism will log the change in status of the alert.

Step 4 Click OK to close the dialog and save the changes.
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Closing an Alert

To close an alert:

Step 1 From the Navigator pane, select Operations>Alerts to display the Alerts pane.

Step 2 You can right-click the alert and select Close from the context menu or double-click the alert to display 
the Alert Detail dialog and select the Closed option. 

Filtering Console Alerts

You can define which alerts the Alerts pane displays by using the Alerts Filter dialog. You can filter 
alerts by status and severity level, or include alerts generated on the current day only or from a specified 
range of days.

To filter console alerts:

Step 1 From the Navigator pane, select Operations>Alerts to display the Alerts pane.

Step 2 Click the Filter button on the TES toolbar or right-click and select Filter from the context menu to 
display the Alerts Filter dialog with all the available alert types.

a. To filter alerts based on status, select Open, Acknowledged and/or Closed.

b. To filter alerts based on severity level, select from the following: Critical, Error, Warning or 
Information

c. To filter alerts based on date, select from Current Day or Date range from... to...

Step 3 Click OK. The Alerts pane displays only alerts that fall within the parameters set in the Alert Filter 
dialog. 

Note For more information about the Alert Filter dialog, see “Alert Filter Dialog” section on page 6-238.

Rearranging Columns in the Alerts Pane

To rearrange columns:

Step 1 From the Navigator pane, select Operations>Alerts to display the Alerts pane.

Step 2 From the View main menu, select Preferences or right-click the Alerts pane and select Preferences 
from the context menu to display the Alerts Preferences dialog. 

Step 3 Click the Columns tab. 

Step 4 Select the column and click the up or down arrows to arrange the titles into the desired order.
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Selecting/Deselecting All Alert Filters

To select/deselect all alert filters:

Step 1 Right-click in the Statuses or Levels section of the Alert Filter dialog.

Note Select Check All or Uncheck All from the context menu.Selecting Check All or Uncheck All does not 
affect the Days section.

Sorting Console Alerts

You can sort the alerts displayed in the Alerts pane to change the order in which they are listed.

From the Navigator pane, select Operations>Alerts to display the Alerts pane.

• To sort alerts by status, click the Status column heading. The alerts are primarily sorted 
alphabetically by status, and secondarily by time.

• To sort console alerts by severity level, click the Level column heading. The alerts are primarily 
sorted alphabetically by severity level, and secondarily by time.

Note To sort console alerts by job number, click the Job column heading. The alerts are sorted numerically in 
descending order by job occurrence number. Clicking column headings more than once toggles the sort 
order between ascending and descending.
6-240
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



OL-32248-01
C H A P T E R 7

Events

Overview
When a job enters the production schedule, it begins a life cycle consisting of five general phases:

Step 1 The job waits in the schedule for its dependencies to be met.

Step 2 The job enters a queue and waits for an execution slot to be available.

Step 3 The job is launched on an agent.

Step 4 The job runs.

Step 5 The job completes and enters history.

Throughout the life cycle of a job, it goes through a variety of conditions that affect it. Some of these 
conditions arise from factors that occur within the job process and other conditions arise from factors 
outside of the job’s life cycle. Some conditions are recognized as key occurrences within the process of 
job scheduling by designating them as event triggers. 

Once the event condition is defined, a predefined action must be associated with it. In effect, an event 
defines a cause and effect–when this condition occurs, do this. Defining events allows you to create 
automatic responses to conditions within your system.

Some of these event triggers are predefined by TES as internal events and some events are defined 
externally by users as conditions to be monitored by event monitors during designated times periods.

These event triggers are grouped into different categories according to the type of conditions that create 
the events.

Events Pane Interface
From the Navigator pane, select Definitions>Events to display the Events pane.

Buttons
• Add Event – Displays the Event Definition dialog to define a new event.

• Edit Event – Displays the Event Definition dialog to edit an existing event.

• Copy Event – Creates a copy of the selected event with the same information as the selected event, 
except for the name.
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• Delete Event – Removes the selected event definition from the TES database.

• Refresh – Updates the data in the current pane.

• Print – Displays the Reports pane to view and print your event definitions. For more information, 
see Monitoring Production.

Search Field
Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See <Jumps>“Searchable Columns” on page 35.

Columns
• Name – The name of the event.

• Owner – The owner of the event.

• Enabled – Whether or not the event is enabled for use.

• Public – Whether or not the event is public, that is, available to all TES users.

• Trigger – The event condition that triggers the job event.

• Modified – The last time the event definition was modified. 

• Agent (Available only with variable, file and email events) – Denotes the connection that is being 
monitored for the defined event conditions.

Event Types
• Job Events – Job events are caused by conditions that affect specific jobs. These conditions are 

often associated with the various statuses and changes that jobs go through during their life cycle.

• System Events – System events are caused by conditions that affect multiple jobs. Unlike job 
events that are limited in their influence to specific jobs, system events have more global 
ramifications throughout your system. Examples are connection failures and problems with masters, 
queues and schedule compilations.

• Variable Events – Variable events are user-defined variable conditions. A defined event condition 
will monitor a designated master during certain time periods for a predefined variable to match a 
specified value. 

• File Events – File events are user-defined conditions that affect specified files during designated 
time periods. 

Job and system events are defined as conditions that occur within TES while variable, file and email 
are defined as conditions that occur outside of the system that TES will monitor for.

• MSSql Events – MSSql events are defined as events that are triggered on Windows SQL 
Server for table, index, and row creation, modification and deletion.
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• OracleDB Events – OracleDB events are defined as the detection of a change within a 
monitored Oracle datatable. This change can be the addition, modification or deletion of 
rows, indexes and tables.

• Sap – An SAP monitor is defined from the SAP Event Definition dialog. This dialog displays 
whenever you add or edit an SAP event.

• Email Events – Email events are user-defined conditions for monitoring for defined conditions 
within email. The condition is a specified text string in an email originating from a designated email 
server.

• JMS Events – You can define events acting as a “consumer” that can be used for monitoring 
selected topics or queues in the JMS systems.

Windows Event Log IDs
Every job or system event log action generates a entry to the TES log. If you are running TES on 
Windows, you can also choose to write to the Windows application log. Each Windows log message 
generated by a TES event has a unique event ID number. The unique IDs make it possible to interact with 
other third party software. (These event IDs do not apply to the Unix platform.)

A complete list of both job and system event triggers and their event ID numbers is provided in 
Chapter 12, “Event ID Tables”.

Events Preferences Dialog
If you select Preferences from the View main menu while viewing the Events pane, the Events 
Preferences dialog displays.

From the Events Preferences dialog, you can select which columns are displayed in the Events pane 
and in what order they appear.

• A checkmark to the left of a column title indicates that it will be displayed in the pane. No 
checkmark indicates that it will not be displayed.

• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.

Navigator Context Menu 

When you right-click in the Navigator pane while viewing the Events pane, the Navigator context 
menu displays. 

The Events Navigator context menu contains the following elements:

• Add Event – Displays the Event Definition dialog for the selected type of event to add a new 
event. Has the same function as the Add Event button on the TES toolbar.

• Refresh – Updates the data in the current pane.

• Print – Displays the Reports pane to view and print the selected type of event definitions. Has the 
same function as the Print button on the TES toolbar. For more information, see Chapter 11, 
“Monitoring Production”.

• Export – Saves the data in the current pane in HTML format. 

• Preferences – Displays the Preferences dialog for the Events pane.
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• New Root Folder – Allows you to create a new root folder for the Navigator pane.

Events Context Menu

When you right-click in the Events pane, a context menu displays.  

The Events pane context menu contains the following elements:

• Add Event – Adds a new event by displaying the Event Definition dialog for the type of event 
selected. 

• Edit Event – Edits the selected event by displaying its Event Definition dialog. 

• Delete Event – Deletes the selected event. 

• Copy – Creates a copy of the selected event with the same information as the selected event, except 
for the name.

• Refresh – Updates the data in the current pane.

• Print – Prints the event data. 

• Print Selected – Prints the selected event’s data.

• Disable – Deactivates the selected event making it unavailable for use.

• Enable – Activates the selected event making it available for use.

Job Events
A job event connects job event triggers to actions. For example, you can create a job event that sends you 
an email message (an email action) if any of your jobs complete with a Completed Abnormally status. 
Each job event that you create is associated with a particular event trigger, and can result in one or more 
actions that you select. You can make job events generic for assignment to multiple jobs. Job events can 
also be made public for all users of TES to use. You can only view job events that belong to you and any 
workgroups you belong to.

The job event is created in the Job Event Definition dialog by linking predefined actions to the job 
event triggers that TES provides.

TES monitors every point of a job’s life cycle to trigger job events. These job event triggers are 
associated with a job event from the Job Event Definition dialog. 

The three general categories of job event triggers are:

• Status Change – The status of a job changes as it is processed.

• Schedule Irregularity – A job runs outside of its expected runtime, possibly affecting the 
schedule of other jobs

• Job Control – An operator performs manual control of a job, such as starting or stopping the job.

Job Event Definition Dialog

The Job Event Definition dialog displays when you add or edit a job event.

Common To All Tabs

• Event Name – The name of the job event (up to 30 characters).

• Event Trigger – The condition that triggers the associated action(s).
7-244
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 7      Events
  Event Types
• Owner – The user with full control over the event. By default, the owner is the creator of the event.

• Apply this event to all jobs – When this option is selected, the Associated Job(s) tab disappears 
and the actions are associated with all jobs. For example, if you want to always notify users if their 
agent is not available for their job, you can set up a job event with the Agent for Job Unavailable 
event trigger, an email action and then enable the Apply this event to all jobs option. If the agent 
goes down, all users with jobs scheduled to run on that agent will be notified.

• Public – Makes the event available to all users of TES.

• Enabled – Makes the event active and available for use. When this option is disabled, you can still 
assign the event but it will not be triggered when the job runs.

Associated Action(s) Tab

This tab associates action(s) to the job event. An event must have at least one associated action before it 
can be enabled. The actions that are available are the actions that are predefined in the Actions pane. If 
you are defining a job event, then job control actions are also available. The associated actions will occur 
in sequence that they are listed. 

• Selected Action(s) – The action(s) to issue when the event occurs. You can specify one or more 
actions for each event. The actions will occur in the order they are listed. You can rearrange the 
sequence of multiple actions by selecting an action and clicking the up or down arrow.

• Available Action(s) – The actions that you can assign to the job event. To assign an action, select 
the action and click the right arrow button. To select more than one action at the same time, hold 
down the SHIFT key or the CTRL key on your keyboard while clicking your selections.

You cannot add the same action more than once. Although you can assign multiple actions to a job 
event, you can apply only one job control action to an event. Adding a second job control action will 
replace the original job control action displayed in the Selected Actions field. The actions 
available to use may be limited by your security policy. 

You can choose from the following types of job control actions that TES provides (for Job event 
only):

– Cancel/Abort

Abort – Terminates the job if it is active, resulting in the job completing abnormally.

Cancel – Cancels the job occurrence if it has not started yet.

– Cancel Pending – Cancels the job occurrence but passes the job’s dependencies to any 
successor jobs. In essence, the job goes into a Waiting on Dependencies state as the 
dependencies run. Once all of the job’s dependencies are satisfied, the job ends with a 
Cancelled Normally status that is equivalent to a Completed Normally status.

– Hold/Stop

Hold – Prevents your job from running when its dependencies are met. The job changes its 
status to Held. You can release the job at a future time. (Not available for jobs running on 
Windows agents).

Stop – Stops the execution of an active job. You can restart the job at a future time using the 
Resume job control. (Not available for jobs running on Windows agents).

– Override – Overrides any dependencies for which your job is waiting. It is recommended to 
use this option only with the Job not ready by end of its time window and Job might not 
be ready by end of time window event triggers.

– Release/Resume

Release – Releases a job that has the Waiting On Operator status.
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Resume – Resumes a job that has either a Held or Stopped status.

– Rerun – Sets the maximum number of job reruns. To set the number of reruns, double-click 
Rerun in the Available Action(s) pane in the Job Event Definition dialog to display the 
Event Parameter dialog. See the following figure.

Maximum Reruns – Use to set the number of reruns. The default is 0. The maximum number the 
field can accommodate is 9999.

– Set To Completed Abnormally – Sets the job’s completion status to Completed 
Abnormally.

– Completed Normally – Sets the job’s completion status to Completed Normally. For 
example, when your process completes with a non-zero exit code, TES assumes the job has 
completed abnormally. Using this action, with a Job Completed Abnormally job event 
trigger, the job will be reset with a final status of Completed Normally.

Note Although job status can be changed using the Set Status action, the actual exit code of a job (0 for 
Completed Normally, non-zero for Completed Abnormally) is not changed.

– Set To Error Status – Sets the job’s completion status to Error Occurred.

– Set To External Status – Sets the job’s completion status to Externally Defined.

– Set To Orphaned Status – Sets the job’s completion status to Orphaned.

– Set To Skipped Status – Sets the job’s completion status to Skipped.

Available Actions Context Menu

When you right-click in the Available Action(s) field on the Associated Action(s) tab of the Job 
Event Definition dialog, the Available Actions context menu displays.  

The Available Action(s) context menu contains the following elements:

• Add Mail Action – Displays the Action Definition: Email Message dialog to send email to 
specified users when the event occurs. The action will be added to the Actions pane and to the 
Available Action(s) field. For more information about email actions, see “Action Definition: 
SNMP Dialog” section on page 6-221.

Note When creating an email message for a system event about losing your database connection, do not use 
variables that will not work without a connection to the database, i.e., <JobName> or <JobStatus>.

• Add Console Alert – Displays the Action Definition: Alert dialog to send an alert to the Job 
Activity pane. The action will be added to the Actions pane and to the Available Action (s) field. 
For more information about console alert actions, see “Action Definition: Alert Dialog” section on 
page 6-220. 

Note Fundamental master and agent connection information is automatically logged by TES, so you do not 
have to create a separate alert action for master or agent start or stop.

• Add SNMP Action – Displays the Action Definition: SNMP dialog to send an SNMP trap (or 
message) to an SNMP manager such as HP OpenView NNM. The action will be added to the 
Actions pane and to the Available Action (s) field. For more information about SNMP trap 
actions, see “Action Definition: SNMP Dialog” section on page 6-221.
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Note Add Job Action – Displays the Action Definition: Job dialog to submit unscheduled jobs in response 
to the event. The action will be added to the Actions pane and to the Available Action(s) field. For 
more information about job actions, see “Action Definition: SNMP Dialog” section on page 6-221.It is 
possible to create an infinite loop that continually submits jobs if a job inserted with a new job action is 
also listed in the Associated job(s) tab.

• Add Log Action – Displays the Action Definition: Log dialog to post user defined log messages 
to the TES log or the Windows Event Viewer. The action will be added to the Actions pane and to 
the Available Action (s) field. For more information about log actions, see “Action Definition: 
SNMP Dialog” section on page 6-221.

• Add Variable Action – Displays the Action Definition: Variable dialog to update a variable 
whenever a designated job action occurs. The action will be added to the Actions pane and to the 
Available Action(s) field. For more information about variable actions, see “Action Definition: 
Variable Dialog” section on page 6-227.

• Add SAP Event Action – Displays the Action Definition: SAP Event dialog to send an SAP 
Event notification to a designated SAP instance when the action occurs in TES. The action is added 
to the Actions pane and to the Available Action(s) field. For more information about SAP event 
notification actions, see “Action Definition: Variable Dialog” section on page 6-227.

• Edit/View Action – Displays the Action Definition dialog for a user-defined action. This option 
is available from the context menu only if the action was selected as you right-click to open the 
context menu.

Associated Job(s) Tab

This tab is used to link the job event to any number of jobs. This tab does not appear if you selected the 
Apply this event to all jobs option. You can also assign job events in the Job and Job Group 
Definition dialogs. The specified event trigger is monitored for all jobs that are listed in this tab.

This tab contains the following elements:

• Browse – Displays the Job Search dialog where you can find and select a collection of jobs or job 
groups. You can also use the Job Search dialog to create a filter to restrict which jobs are listed in 
the drop-down menu. 

• Down-arrow – Displays all jobs and job groups belonging to you and your workgroups in a 
drop-down menu. To narrow the number of jobs displayed, use the Browse button to display the 
Job Search dialog. When the Job Search dialog is closed, whatever jobs were found in the Job 
Search Results list are displayed in the drop-down menu. To select a job, you can select it and click 
Add.

• Add – Links a job(s) or job group(s) to the event trigger. The job(s) and/or group(s) that are linked 
are the ones you select from the drop-down menu, or Job Search dialog.

The jobs that are added are displayed in the field below but they are not added (or associated with 
the job event) until the Add button is clicked.

• Remove – Removes a job or job group from the Associated Job(s) field when the job or job group 
is selected.

Description Tab

This is a free text field where you can provide a description and notes about this particular event, up to 
255 characters.
7-247
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 7      Events
  Event Types
Trigger History Tab

The Trigger History tab lists all of the instances when the event was triggered during the trigger history 
retention period. This retention period is configured on the Default tab of the System Configuration 
dialog. 

There are usually only four columns of basic information about each time that the event occurred but a 
job event has two additional columns to identify the job that was triggered by the event. 

This tab contains the following elements:

• Trigger Time – The date and time (in 24 hour format) when the event occurred.

• Run Date – The date and time (in 24 hour format) when the triggered action actually occurs. 
Normally this time will be the same as the Trigger Time but if there is some lag time built into the 
associated action, the Run Date will be later.

• Job No. – The instance number of the job that was triggered by the event. (job event only)

• Job Name – The name of the job triggered by the event. (job event only)

• Connection – The connection that the event monitor is watching. This could be the connection to 
a master, to a database or to an agent.

• Status – The current status of the event trigger. There are several statuses used.

– Scheduled – The event trigger is scheduled for the current day 

– Suspended – The event trigger is scheduled for the current day but has been suspended using 
the Suspend Monitoring option in the Monitor Control context menu in the Event Activity 
pane.

– Outside time window – The event trigger is scheduled for the current day but is currently 
outside of the event monitor’s specified time windows and is thus inactive.

You can drill down to get additional information about each event instance listed in this Trigger History 
tab. Right-click any of the listed event triggers to either update the information with the Refresh option 
or you can display details about the trigger with the Trigger Details option.

Trigger Details Dialog

The Trigger Details dialog displays more information about an event instance that occurred. The 
Trigger Details dialog displays by selecting an event trigger listed in an Event Details dialog and 
right-clicking and selecting the Trigger Details option. 

Details Tab

The Details tab displays basic run information about the event trigger. 

This tab contains the following elements:

• Trigger Date – The date and time when the conditions that triggered the event occurred. 

• Run Date – The date and time that the event actually occurred. Most of the time this date and time 
will match the information in the Trigger Date field. Sometimes though there is a lag time between 
when the conditions defined as the event occur and when the actual event occurs. An example would 
be an event such as compiling a production day schedule. The event condition might be the start of 
a new production day at the designated time yet there might still be some period of time pass before 
the actual compilation of a new schedule occurs as the master takes care of prerequisite maintenance 
tasks. 

• Status – The current status of the event.
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Triggered Actions Tab 

The Triggered Actions tab () provides information about the action(s) that the event initiated. 

The Triggered Actions tab displays the following columns of information about its associated actions:

• Trigger Time – The date and time when the action was triggered.

• Run Date – The date and time that the action actually ran. Most of the time this date and time will 
match the information in the Trigger Time field. Sometimes though there is a lag time between 
when the action is triggered and when the action actual runs.

• Action Type – The type of action that ran.

• Action Name – The name of the action. 

If an action triggered is a job action, you can display additional details about the job that was triggered. 

Right-click the job to display a context menu. You can update the details about the job by clicking the 
Refresh option.

Exit Codes Tab

This tab displays in the Job Event Definition dialog only if the Job completed with specified exit 
code(s) option is selected in the Event Trigger field. If you are creating a job event that is triggered 
by a specific exit code or a range of exit codes, type the exit code(s) on this tab. You can create several 
actions using different job event triggers keyed to different exit code ranges to denote various job 
statuses. The exit code you use is determined by the script you are using. The exit code value can range 
from 0 to 30,000.

Use the operator field to select an operator for comparing the exit code(s) specified in the adjacent fields. 

• = – The exit code must match the specified value or within the range of values. This operator enables 
both value fields and is the only operator that can specify a range of values.

• < > – The exit code must be anything but the specified value. Essentially greater than or less than 
the specified value.

• < – The exit code must be less than the specified value.

• <= – The exit code must be less than or equal to the specified value.

• > – The exit code must be greater than the specified value.

• >= – The exit code must be greater than or equal to the specified value.

System Events
System events assign actions to events generated by the TES master. For example, if the master is 
shutdown, you can notify users via email that jobs will not run until the master has started again. System 
events are useful for notifying interested users of conditions with system-wide effects. 

You create system events much like job events, except that they are not associated with particular jobs, 
since they are applicable to all jobs. Each includes a system event trigger, and one or more actions to 
take when the event occurs. The system event is created in the System Event dialog by linking 
predefined actions to the system event triggers that TES provides.

The TES master is constantly monitoring for the conditions that trigger system events. The four 
categories of system event triggers monitored by TES are:

• Agent – Agent connection and job execution information
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• Queue – System and individual queue limit adjustments and job execution information

• Production Schedule – Compiling start and finish times and new production day information

• Master – Master start, stop, pause, resume and information

System Events Dialog

The System Events dialog displays when you add or edit a system event.

Common To All Tabs

• Event Name – The name of the system event (up to 30 characters).

• Event Trigger – The condition that causes TES to trigger the assigned (associated) action(s).

• Owner – The owner of the system event. By default, the creator is the owner.

• Public – Makes this event available to all users of TES as allowed by their security policy. You can 
create a default for this option on the Defaults tab in the System Configuration dialog.

• Enabled flag – Makes the system event available for use. When this option is cleared, the event 
cannot be triggered by the master. If the system event is inactive, the system event cannot be 
monitored by the master. Note that there are some major events that are always reported, with or 
without specifically defined system events.

Associated Action(s) Tab

This tab associates action(s) with the system event. An event must have an associated action before it 
can be enabled. For information about the fields on this tab, refer to “Associated Action(s) Tab” section 
on page 7-245

Description Tab

This is a free text field where you can provide a description and notes about the system event (up to 255 
characters).

Trigger History Tab

The Trigger History tab lists all of the instances when the event was triggered during the trigger history 
retention period. This retention period is configured on the Default tab of the System Configuration 
dialog. For information about the fields and options on this tab, refer to the “Trigger History Tab” section 
on page 7-248.

Variable Events
An event monitor can be defined to watch a designated variable on a master. Whenever the variable 
matches a specified value it becomes an event that triggers an assigned action.

Variable Event Definition Dialog

A variable monitor is defined from the Variable Event Definition dialog. The Variable Event 
Definition dialog displays whenever you add or edit a variable event. 
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In the Navigator pane, select Definitions>Events>Variable Events to display the Variable Events 
pane. To display the Variable Event Definition dialog, either right-click in the pane in the Variable 
Events pane and select Add Event from the context menu or click the Add Event  button.

Common To All Tabs

• Event Name – The name of the system event (up to 30 characters).

• Owner – The owner of the system event. By default, the creator is the owner.

• Public – Makes this event available to all users of TES as allowed by their security policy. You can 
create a default for this option on the Defaults tab in the System Configuration dialog.

• Enabled – Makes the event available for use. When this option is cleared, the event cannot be 
triggered by the master. If the event is inactive, the event cannot be monitored by the master. 

Variable Tab

The Variable tab () designates a variable to be monitored and defines the characteristics of the variable 
that will trigger an action. 

Monitor Section

In this section, designate a variable, a master associated with the variable and a value to be monitored for.

• Master – The local master where the variable resides. 

• Variable Name – The name of the variable to update. The displayed variable name includes the 
type of variable it is, i.e., string, number or date. Choose from the drop-down list of user-defined 
variables.

• Operator – The relative operator used to determine whether the variable’s value satisfies the 
dependency. 

– Equal (=)

– Not Equal (<>)

– Less Than (<)

– Less Than or Equal To (<=)

– Greater Than (>)

– Greater Than or Equal To (>=)

When text strings are used in comparison, higher letters of the alphabet are greater than lower letters. 
For example, A < Z. If the first letters of the string match, succeeding letters are used for comparison. 
For example, AA < AZ. The operation works similar to sorting strings. 

• Value – The value used for the update. When updating a number type, you can use any real number 
(including negative numbers). When updating a string type, any set of characters (including 
numbers) are treated as a string. When updating a date type, the format will conform to the same 
format as set in the operating system of the master.

• Variable – Select this option to compare the value of the Variable Name to the value of another 
variable.

• Master – Select the remote master that this variable event will monitor.

• Variable Name – Select the variable associated with the remote master to be monitored.
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Schedule Tab

The Schedule tab displays when the event monitor is scheduled to monitor for the defined event 
conditions. The fields on these tabs are the same fields that are on their respective tabs in their Event 
Definition dialogs. Refer to the “Configuring the Schedule Tab on an Event Monitor” section on 
page 7-260 for more information about the fields on this tab.

Associated Action(s) Tab

This tab associates action(s) with the variable event. An event must have an associated action before it 
can be enabled. For information about the fields on this tab, refer to “Associated Action(s) Tab” section 
on page 7-245.

Description Tab

This is a free text field where you can provide a description and notes about this particular event, up to 
255 characters.

Trigger History Tab

The Trigger History tab lists all of the instances when the event was triggered during the trigger history 
retention period. This retention period is configured on the Default tab of the System Configuration 
dialog. For information about the fields and options on this tab, refer to the “Trigger History Tab” section 
on page 7-248.

File Events
An event monitor can be defined to monitor for a designated file and trigger an associated action 
whenever that file meets the defined conditions. 

File Event Definition Dialog

A file event monitor is defined from the File Event Definition dialog. The File Event Definition 
dialog displays whenever you add or edit a file event. 

In the Navigator pane, select Definitions>Events>File Events to display the File Events pane. To 
display the File Event Definition dialog, either right-click in the File Events pane and select Add 
Event from the context menu or click the Add Action button.

Common To All Tabs

• Event Name – The name of the system event (up to 30 characters).

• Owner – The owner of the system event. By default, the creator is the owner.

• Public – Makes this event available to all users of TES as allowed by their security policy. You can 
create a default for this option on the Defaults tab in the System Configuration dialog.

• Enabled – Makes the event available for use. When this option is cleared, the event cannot be 
triggered by the master. If the event is inactive, the event cannot be monitored by the master. 

File Monitor Tab

The File Monitor tab defines the file and the event characteristics that a file monitor will watch for. 
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This tab contains the following elements:

• Agent Name – Enter or select the name of the agent that will process the file.

• Source – Designates the directory where the file being monitored is located.

• File Mask – A specific file name can be entered or a mask using the asterisk (*) and question mark 
(?) characters can be created to filter for certain files to be monitored.

Any combination of the following criteria options can be selected to apply to the file.

• Wait until file is at least this size (bytes): – The file must reach the size (in bytes) that is 
specified here.

• Milliseconds delay before processing: – The event monitor must wait the number of 
milliseconds specified here before it can react to the defined event.

• File size stable for (milliseconds): – The file size must remain unchanged for the specified 
number of milliseconds before the event conditions are met. 

• Operation – There are two options that can be done to the file being monitored when the specified 
conditions are met:

– Move file to target directory – Moves the monitored file to the directory that is specified in 
the Target field. This does not replace any of the existing files in the target directory.

– Delete file from source directory – Deletes the monitored file from the directory designated 
in the Source field once the specified conditions are met.

• Target – Designates the directory location where the monitored file should be moved once the 
specified conditions are met.

• Return file contents to master as output – The contents of the file being monitored will be 
returned to the master as job output.

Schedule Tab

The Schedule tab displays when the event monitor is scheduled to monitor for the defined event 
conditions. The fields on these tabs are the same fields that are on their respective tabs in their Event 
Definition dialogs. Refer to the “Configuring the Schedule Tab on an Event Monitor” section on 
page 7-260 for more information about the fields on this tab.

Associated Action(s) Tab

This tab associates action(s) with the file event. An event must have an associated action before it can 
be enabled. For information about the fields on this tab, refer to “Associated Action(s) Tab” section on 
page 7-245.

Description Tab

This is a free text field where you can provide a description and notes about this particular event, up to 
255 characters.

Trigger History Tab

The Trigger History tab lists all of the instances when the event was triggered during the trigger history 
retention period. This retention period is configured on the Default tab of the System Configuration 
dialog. For information about the fields and options on this tab, refer to the “Trigger History Tab” section 
on page 7-248.
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Event Activity Pane
The Event Activity pane displays information about the status and activity of each event that has been 
defined. A user can only view events in this pane that are made public to all users or that belong to that 
user or the workgroups that the user is a member of. A user can drill down through each event record for 
more details about the circumstances of each event.

Event Activity Pane Interface
From the Navigator pane, select Operations>Event Activity to display the Event Activity pane. You 
can double-click any of the listed events to display its details.

Search Field

Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See Searchable Columns, page 2-35.

Columns

• Status Light – The status light provides an at-a-glance graphic indicator of the current status of the 
event monitor. There are three colors used to indicate status:

– Green – Scheduled status

– Yellow – Outside time window status

– Red – Suspended status

• Times Triggered – The number of times that the event monitor has been triggered during the 
current day.

• Status – The current status of the event monitor. There are three possible statuses:

– Scheduled – The event trigger is scheduled for the current day 

– Suspended – The event trigger is scheduled for the current day but has been suspended using 
the Suspend Monitoring option in the Event Control context menu in the Event Activity 
pane.

– Outside Time window – The event trigger is scheduled for the current day but is currently 
outside of the event monitor’s specified time windows and is thus inactive.

• Name – The name of the defined event monitor.

• Owner – The user account that owns the event. By default, the user that defined the event is the 
owner. 

• Public – Indicates if the event monitor is available to other users.

• Trigger – Displays the trigger assigned to the event monitor.

• Modified – Displays the last date and time that the parameters of the event monitor were changed.

• Type – Displays the type of event monitor.

• Agent – Displays the name of the connection that is being monitored.
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Event Activity Preferences Dialog

Select Preferences from the View main menu while viewing the Events Activity pane to display the 
Event Activity Preferences dialog.

This dialog contains the following elements:

• Columns – From the Columns tab, you can select which columns are displayed in the Job Activity 
pane and in what order they appear.

– A checkmark to the left of a column title indicates that it will be displayed in the pane. No 
checkmark indicates that it will not be displayed.

– To rearrange the order in which the columns are displayed, select the column and click the up 
or down arrow.

Navigator Context Menu

When you right-click in the Navigator pane while viewing the Event Activity pane, the Navigator 
context menu displays.  

The Navigator context menu for the Event Activity pane contains the following options:

• Preferences – Displays the Preferences dialog for the Job Activity pane.

• Print – Displays the Reports pane to view and print your connection definitions. Has the same 
function as the Print button on the toolbar. For more information, see Chapter 11, “Monitoring 
Production”.

• Export – Saves the data in the current pane as an HTML file. 

• Refresh – Updates the data in the current pane.

• New Root Folder – Adds a new root folder to the Navigator pane.

• New Sub Folder – Adds a new sub folder to the Navigator pane.

Event Activity Pane Context Menu

When you right-click in the Event Activity pane, the Event Activity context menu displays. The 
Monitor Control options only apply to external events such as file, email or variable events that have 
defined a monitor. The Event Activity context menu has the following options:

• Monitor Control – The Monitor Control submenu has the following control options:

– Suspend Monitoring – Suspends the monitoring activity of the selected event monitor.

– Resume Monitoring – Resumes the monitoring activity of the event monitor that was 
suspended.

• Details – Displays the Event Details dialog for the selected type of event occurrence. Alternately, 
you can display these dialogs by double-clicking the individual event monitor record.

• Print – Displays the Reports pane to view and print your connection definitions. Has the same 
function as the Print button on the toolbar. For more information, see Chapter 11, “Monitoring 
Production”.

• New Root Folder – Adds a new root folder to the Navigator pane.

• New Sub Folder – Adds a new sub folder to the Navigator pane.
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Event Details Dialog
The details for any event listed in the Event Activity pane can be displayed by either double-clicking it 
or by right-clicking it and selecting Details from the context menu. Those events that define monitors 
have additional tabs to provide details specific to that type of event.The fields on the tabs of the Event 
Details dialog are read-only though a user can update the information in the fields at any time by 
selecting the Refresh option from the context menu.

Common To All Tabs

• Event Name – The name of the event (up to 30 characters).

• Event Trigger – The condition that causes TES to trigger the assigned (associated) action(s).

• Owner – The user account that owns the event. By default, the user that defined the event is the 
owner. 

Status Tab

The Status tab provides details on the current status of the event trigger.

• Current Status – The event’s current status. 

• Times Triggered – The number of times that this event has been triggered.

• Last trigger condition time – The date and time of the last time the event was triggered. 

Variable, File and Email Monitor Tabs

These tabs appear depending upon the type of event selected. Job and system events do not have these 
tabs because they do not require a monitor. The fields on these tabs are the same fields that are on their 
respective tabs in their Event Definition dialogs.

Schedule Tab 

These tabs only appear for variable, file and email events. The Schedule tab displays when the event 
monitor is scheduled to monitor for the defined event conditions. The fields on these tabs are the same 
fields that are on their respective tabs in their Event Definition dialogs. Refer to the “Configuring the 
Schedule Tab on an Event Monitor” section on page 7-260 for more information about the fields on this tab.

Description Tab

Displays any description about the use and purpose of the event.

Triggered Today Tab

The Triggered Today tab lists all of the instances when the event was triggered during the current 
production day. The columns of information on this tab is the same as the ones on the Trigger History 
tab. Once the current production day ends, the information on this tab is moved to the Trigger History 
tab. Like the Trigger History tab, you can also drill down to get more information about the event 
trigger, and, if a job event, more information about the job that the event was associated with. Refer to 
the “Trigger History Tab” section on page 7-248 for more information about the fields on this tab.
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Trigger History Tab

The Trigger History tab lists all of the instances when the event was triggered during the trigger history 
retention period configured in the System Configuration dialog. The fields on this tab are the same 
fields as on the Triggered History tab of the Event Definition dialog. Refer to the “Trigger History 
Tab” section on page 7-248 for more information about the fields on this tab.

Event Procedures

Adding Jobs and Job Groups to Job Events

You can link any number of jobs or job groups to a job event. 

To add a job/job group to a job event:

Step 1 Select one of the defined job events in the Job Events pane. 

Step 2 Double-click the job event to edit from the Job Events pane, or right-click the job event and select Edit 
Event from the context menu, or select the job event and click the Edit button on the TES toolbar to 
display the Job Event Definition dialog. 

Step 3 Click the Associated Job(s) tab.

Step 4 The drop-down arrow button lists all the jobs you own and that are owned by workgroup to which you 
belong.

Step 5 Select the job(s) and/or job group(s) you want to associate to this job event and click the Add button.

Associating Actions to Events

You can associate any number of actions to an event. However, if you are using a job control action type 
(Job events only), then only one job control can be associated (or combined with the other action types) 
at any time. When the event trigger occurs, all the actions that are associated with the event will occur.

To associate actions to events:

Step 1 From the Navigator pane, select Definitions>Events to display the Events pane. 

Step 2 Double-click the event or right-click the event and select Edit Event from the context menu, or select 
the event and click the Edit button on the TES toolbar to display the Event Definition dialog. 

Step 3 Click the Associated Action(s) tab.

Step 4 In the Available Action(s) field, select the action(s) to associate with the event. 

You can select the actions and then use the left arrow button (<). To select more than one action at the 
same time, hold down the SHIFT key or the CTRL key on your keyboard while clicking your selections, 
then click the left arrow button. 

Job control actions are displayed in the Available Actions field if you are working on a Job event.
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Note It is possible to create an infinite loop that continually submits jobs if you assign a new job action that 
inserts a job that is also listed in the Associated job(s) tab.

Changing the Ownership of Events

To change the ownership of an event:

Step 1 From the Navigator pane, select Definitions>Events to display the Events pane. 

Step 2 Double-click the event to edit from the Events pane or right-click the event and select Edit Event from 
the context menu, or select the event and click the Edit button on the TES toolbar to display its Event 
Definition dialog.

Step 3 From the drop-down menu in the Owner field, select a new owner of the event.

Creating a Job Event

You can create a job event that connects an event trigger to one or more actions. You can link jobs or job 
groups to job events at any time either from the Job Event Definition dialog or the Job Definition or 
Job Group Definition dialogs. Actions are associated with a job event only from the Job Event 
Definition dialog. 

To create a job event:

Step 1 From the Navigator pane, select Definitions>Events>Job Events to display the Job Events pane. 

Step 2 Click the Add button or right-click and select Add Event from the context menu to display the Job 
Event Definition dialog.

Step 3 In the Event Name field, type a name for the job event (up to 30 characters).

Step 4 If you do not want to own this job event, select another user or workgroup from the drop-down menu in 
the Owner field.

Step 5 If you want this job event to be associated with all jobs, select the Apply this event to all jobs option; 
otherwise, you must click the Associated Jobs tab to select a job(s) to associated with the event.

Step 6 If you want the event to be public, select the Public option. Note that if an event is public, all users of 
TES with the appropriate security policy have access to that job event.

Step 7 If you want to define the event now, but you are not ready to have it triggered, clear the Enabled option

. 

Defining an Email Monitor

To define an email monitor:

Step 1 From the Navigator pane, select Definitions>Events>Email Events to display the Email Events 
pane. 
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Step 2 From the Email Events pane, right-click and select the Add Event option from the context menu, to 
display the Email Event Definition dialog.

Step 3 In the Event Name field, enter a name for the email event.

Step 4 By default, the user defining the event is the owner but you can select one of the other listed users from 
the drop-down menu as the owner. 

Step 5 In the Email Connection field, select a connection to an Exchange server. The connection must be 
already defined before it will appear in the drop-down list.

Step 6 In the Folder field, enter the name of the mail account to be monitored.

Step 7 In the Conditions section, designate what text is to be considered an event when it is detected. 

Step 8 Click the adjacent Insert button to add a line to the Conditions section.

a. In the Scan for Text column, enter a text string that the monitor will scan for in the email going 
to the designated mail account.

b. In the In column, select from the drop-down list where in the email that the monitor should look 
for the text.

c. In the Case Sensitive column, designate whether the text match is dependent upon case. 

d. In the Disposition section, select what will occur once the monitor detects the specified text. 
From the drop-down list in the Operation field, select an option. If you select the Move 
message to folder option, in the Target field, enter the pathname to the folder where you 
want the message stored.

e. If you want to access the message text from within TES, select the Return message body to 
Scheduler option.

Defining a Variable Monitor

To define a variable monitor:

Step 1 From the Navigator pane, select Definitions>Events>Email Events to display the Email Events 
pane. 

Step 2 From the Email Events pane, right-click and select the Add Event option from the context menu, to 
display the Email Event Definition dialog.

Step 3 In the Event Name field, enter a name for the email event.

Step 4 By default, the user defining the event is the Owner but you can select one of the other listed users from 
the drop-down menu as the owner. 

Step 5 In the Master field, select the master that owns the variable.

Step 6 In the Variable Name field, select the variable to be monitored.

Step 7 In the Operator field, select the operator to be used with the specified value.

Step 8 In the Value field, specify the value that the variable needs. 

Step 9 If defining an intermaster variable so that the monitor will watch for a variable published from another 
master, select the Variable option and specify the Master and the Variable Name.
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Defining a File Monitor

To define a file monitor:

Step 1 From the Navigator pane, select Definitions>Events>Email Events to display the Email Events 
pane. 

Step 2 From the Email Events pane, right-click and select the Add Event option from the context menu, to 
display the Email Event Definition dialog.

Step 3 In the Event Name field, enter a name for the email event.

Step 4 By default, the user defining the event is the Owner but you can select one of the other listed users from 
the drop-down menu as the owner. 

Step 5 In the Agent Name field, enter the 

Step 6 In the Directory field, enter the path to the directory to be monitored for the file’s appearance.

Step 7 In the File Mask field, you can enter a file mask using wild card characters.

Step 8 If needed, you can configure the monitor to delay its response or to only respond after the designated 
file is stable for a stated interval of time or reaches a certain size. 

Step 9 In the Disposition section, specify what should be done with the file when it meets the monitor’s 
criteria. 

Step 10 In the Operation field, you can either delete the file or move it to another directory that is designated 
in the Target field.

Step 11 If needed, you can select the Return file contents as output option include the file’s contents as part 
of the job output.

Configuring the Schedule Tab on an Event Monitor

Whenever an event monitor is defined, it must be configured to watch for the defined event criteria at 
the crucial times. This is done by scheduling when the monitor should be active. 

To configure the Schedule tab:

Step 1 Select the Schedule tab in the event being defined.

Step 2 In the Calendar section, select and configure a calendar as needed.

Step 3 If you want to restrict how often the event can be triggered, select the Trigger Constraints option and 
configure how often the event can be triggered within a designated interval. Select the Ignore 
occurrences that exceed the limit option 

Step 4 If you want the event monitor to operate all of the time, do not select the Time window option; however, 
if you want the event monitor to operate only during certain periods of the day, select this option. Click 
Insert to create a row in the Time window field and enter a starting time in the From Time column 
and an ending time in the Until Time column. Create as many time windows as needed.
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Deleting an Event

You can delete an event that is no longer in use. When you delete an event, the job event is removed from 
the jobs and job groups associated with it.

To delete an event:

Step 1 From the Navigator pane, select Definitions>Events>Job Events to display the Job Events pane. 

Step 2 Select the job event to delete and press the DELETE key on your keyboard or click the Delete button on 
the TES toolbar or right-click the job event and select Delete Event from the context menu.

Step 3 Click OK in the confirmation dialog to delete the job event.

Removing Actions from Events

To remove an action from an event:

Step 1 Select an event in the Events pane. 

Step 2 Open the event definition by double-clicking the event or right-click the event and select Edit Event 
from the context menu, or select the event and click the Edit button on the TES toolbar to display the its 
Event Definition dialog. 

Step 3 Click the Associated Action(s) tab.

Step 4 In the Selected Actions(s) field, select the action(s) to remove from the job event, and click the right 
arrow button (>).

Removing Jobs/Job Groups from Job Events

To remove a job or job group from a job event:

Step 1 From the Navigator pane, select Definitions>Events>Job Events to display the Job Events pane. 

Step 2 Double-click the job event to edit from the Job Events pane or right-click the job event and select Edit 
Event from the context menu, or select the job event and click the Edit button on the TES toolbar to 
display the Job Event Definition dialog. 

Step 3 Click the Associated Job(s) tab.

Step 4 From the Associate Job(s) field, select the job(s)/job group(s) to disassociate from the job event.

Step 5 Click Remove

.

Viewing Events

You can view all the events available to you according to your security policy and all public events in 
the Events pane. You can also view the job events for a job from the Job Events tab of the Job 
Definition and Job Group Definition dialogs. 
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From the Navigator pane, select Definitions>Events>Job Events to display the Job Events pane. 

Viewing Jobs and Groups Associated With a Job Event

To view a job or job group associated with a job event:

Step 1 From the Navigator pane, select Definitions>Events>Job Events to display the Job Events pane. 

Step 2 Double-click the desired job event from the Job Events pane, or click the Edit button on the TES 
toolbar to display the Job Event Definition dialog.

Step 3 Click the Associated Job(s) tab to display the jobs and job groups associated with the job event.

Viewing Job Events Associated With a Job or Job Group

To view a job event associated with a job or job group:

Step 1 From the Navigator pane, select Definitions>Jobs to display the Jobs pane. 

Step 2 Double-click the desired job or job group or right-click and select Edit Job/Group from the context 
menu to display its Job Definition (or Job Group Definition) dialog.

Step 3 Click the Job Events tab to display all job events associated with the job or job group.
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Business Views

The Business Views pane is a subset of the Jobs pane. It provides an alternate method of defining jobs. 
The Business Views pane offers a graphical way to create and modify jobs and their dependencies by 
clicking function buttons and dragging-and-dropping object icons from a toolbar. Using the mouse 
cursor, you can create workflows, rearrange the sequence of jobs and link dependencies to jobs as 
required. 

Business Views Pane Interface
From the Navigator pane, select Definitions > Jobs > Business Views to display the Business View 
window. The window is blank if you have not saved any Business Views. 

If you have created and saved Business Views, they are listed in the window. 

The Business View window contains the following columns of information about each listed View:

• Name – The name of the View.

• Owner – The user that owns (or created) the View.

• Public – Indicates if the View is available to other users.

• Groups – Indicates if the View depicts a job group and its children.

• Jobs – The number of jobs depicted in the Business View.

• Modified – The date and time that the View was last modified.

Views Preferences Dialog
While viewing the Business View window, select View > Preferences or right-click Business Views in 
the Navigator pane and select Preferences from the context menu to display the Business Views 
Preferences dialog.

General Tab

The General tab manages the recursive behavior of jobs in the Business Views screen. 

This tab contains the following elements:

• Default View – Specifies that the selected Business View is the default View. This option assigns 
the properties of the default View to new Business Views.
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• Add Children – Automatically includes the immediate child jobs of any existing job group that is 
added to a View.

• Add Children Recursively – Automatically adds successive generations of the children of all child 
job groups. If this option is selected, the Add Children option is automatically selected also.

• Add Predecessors – Automatically includes the immediate predecessor jobs of any existing job or 
job group that is added to a View.

• Add Predecessors Recursively – Automatically includes the immediate predecessors of a job and 
includes all other ancestors of those predecessors. If this option is selected, the Add Predecessors 
option is automatically selected also.

• Add Successors – Automatically includes the immediate successor jobs of any existing job or job 
group that is added to a Business View.

• Add Successors Recursively – Automatically includes the immediate successors of a job and 
includes all other descendants of those successors. If this option is selected, the Add Successors 
option is automatically selected also.

Columns Tab

The Columns tab specifies which columns are displayed in the Business Views window and in what order 
the columns are arranged.

This tab contains the following elements:

• A check mark to the left of a column title indicates that it will be displayed in the window. No check 
mark indicates that the column will not be displayed.

• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.

Navigator Context Menu

When you right-click in the Navigator pane while Business Views is selected, the Navigator context 
menu displays. 

This context menu contains the following options:

• Add Business View – Displays a new Business View screen.

• Preferences – Displays the Preferences dialog for the Business View window.

• Print – Displays a print preview screen of the information listed in the columns shown in the View 
window. From this screen, you can print a report of the information in the columns.

• Export – Saves the data in the current window as an ASCII text file. You can then use the file data 
in other applications.

• Refresh – Updates the data in the current window.

Business View Window Context Menu

You create, modify and delete Views from the context menu that displays by right-clicking the mouse 
from inside the Business View window or by clicking the Add Business View button on the toolbar of 
the Business View window. 

This context menu contains the following options:

• Add View – Displays a new Business View screen.
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• Modify View – Displays the selected View.

• Delete View – Deletes the selected View.

• Print – Displays a print preview screen of the information listed in the columns shown in the View 
window. From this screen, you can print a report of the information in the columns.

Business View Canvas
Clicking an existing View listed in the Business View window or selecting the Add View option displays 
the Business View canvas.

Figure 8-1 Business View Canvas

View Properties Dialog
The basic properties governing the appearance and operation of the View canvas are controlled from the 
View Properties dialog. The View Properties dialog displays when right-clicking on the Business View 
canvas and selecting the View Properties option in the context menu. 

General Tab
The General tab controls the general properties of the Business View. 

This tab contains the following elements: 
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• Owner – The user that owns (or created) the current View. If the owner is a workgroup, any member 
of the workgroup can work with this View.

• Zoom Scale – Select the zoom percentage of the View screen.

• Height – The total height (in pixels) of the View screen.

• Width – The total width (in pixels) of the View screen.

• Calculate Size to Fit – Configures the current View size to fit all graphical objects within the View.

• Show Captions – Selecting this option will display the full job name underneath the job bars. 

• Public – Selecting this option makes the View available to all users of TES when viewing the Jobs 
pane. If this option is not selected, only the owner (whether an individual user or workgroup) can 
use the Business View.

Auto Arrange Tab
The Auto Arrange tab controls the behavior of the Automatic Arrangement feature applied to the 
Business View layout. Selected objects that are scattered randomly in the View are rearranged according 
to the properties specified on this tab.

The options in the Advanced Options section are used to configure the arrangement logic used in the 
most complicated Business View that contain many defined objects. Unless you thoroughly understand 
these options, it is recommended to use the defaults.

Depending upon the number and relationship of objects in a View, use of the advanced arrangement 
configuration options can slow down the display performance when using the Auto Arrange feature. The 
arrangement properties specified on this tab are applied to the selected objects in the View by clicking 
the Auto Arrange button .

This tab contains the following elements: 

• Column Spacing – Specifies the horizontal distance (in pixels) between objects that are arranged 
in a column in the View.

• Direction Option – Specifies the directional orientation of the workflow displayed in the View. The 
linking arrows will point in the designated direction, e.g., the Up option flows from bottom to top. 

Callouts Tab 
The Callouts tab controls the default properties for the text callouts. Callouts are used to display 
additional information about an object. 

This tab contains the following elements: 

• Width – Specifies a default width (in pixels) for the callout. This width can be adjusted from the 
individual callout as necessary.

• Row Height – Specifies a default size (in pixels) for each line of text. This text size can be adjusted 
from the individual callout as necessary by dragging the green squares of the selected callout.

• Background Color – Clicking this button displays a Color dialog where the a background color for 
the callout can be selected from predefined colors or a new color can be created.

• Text Color – Clicking this button displays a Color dialog where a color for the callout text can be 
selected from predefined colors or a new color can be created.

• Font – Select the font to be used for the callout text from the list.
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• Italic – Selecting this option displays the callout text in italic type. 

• Underline – Selecting this option displays the callout text in underlined type. 

• Bold – Selecting this option displays the callout text in bold type. 

• Custom Text – Selecting this option displays any text that is typed in the box below.

• Job Runbook – Selecting this option displays any operator instructions that are entered on the 
Runbook tab of the job definition. If the Load URL option is selected on the Runbook tab after 
typing an URL for an internet or intranet site (or even a directory path on your system's network) 
then that Web page (or directory) displays. If you click the URL displayed in the caption, a separate 
window displays to show the Web page or directory contents of that URL. 

• Job Notes – Selecting this option displays any notes about the job that are typed on the Notes tab 
of the job definition. If the Load URL option is selected on the Notes tab then the URL of the tab 
displays.

• Sample of Chosen Font – Displays the selected font as its appearance is currently configured. 

• Hide All Callouts – Hides all callouts. You can also use the Hide All Callouts option from the 
context menu to hide the callouts.

To display a specific callout that is hidden: 

a. Select the bar icon and right-click to display the context menu. 

b. From the Add/Edit Extras submenu, select the Callout option to display the Callout 
Properties dialog.

c. Clear the Hidden option.

Canvas Interface
The View’s Canvas functions are controlled from the icons that run in a toolbar along the top of the 
screen. The creation and linking of job and dependency objects is controlled from a column of icons that 
run down the left side of the Canvas. 

Many of the toolbar options are available from a context menu. 

Layout Toolbar

The buttons in the toolbar that runs along the top of the Canvas have the following functions:

• Align Left – Aligns selected objects by their left side boundary. All objects will align with the left 
side of the leftmost selected object. To align other objects with another designated object, click the 
anchor object (a green boundary box will surround the object) and while holding down the CTRL 
key, select the other objects by either clicking them individually.

• Align Right – Aligns selected objects by their right side boundary. All objects will align with the 
right side of the rightmost selected object. Refer to the Align Left button section for details on 
aligning objects.

• Align Top – Aligns selected objects by their top boundary. All objects will align with the top of the 
highest selected object. Refer to the Align Left button section for details on aligning objects.

• Align Bottom – Aligns selected objects by their bottom boundary. All objects will align with the 
bottom of the lowest selected object. Refer to the Align Left button section for details on aligning 
objects.

• Equal Vertical Spacing – Spaces selected objects an equal distance apart in a column format. 
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• Equal Horizontal Spacing – Spaces selected objects an equal distance apart in a row format.

• Auto Arrange – Automatically arranges selected objects according to the properties configured on 
the Auto Arrange tab of the View Properties dialog.

Objects Toolbar

Along the left side of the View window are a column of buttons with various icons. 
Dragging-and-dropping these buttons onto the View canvas creates objects. 

This toolbar contains the following buttons:

• Job Group – Clicking this button and dragging to the View canvas creates a job group bar. 
Double-click the job group bar to display a dialog to define the job group parameters.

• Job – Clicking this button and dragging to the View canvas creates a job bar. Double-click the job 
bar to display a dialog to define the job parameters.

• OS/400 Job – Clicking this button and dragging to the View canvas creates an OS/400 job bar. 
Double-click the OS/400 job bar to display a dialog to define the job parameters.

• Horizon Job – Clicking this button and dragging to the View canvas creates a Horizon job bar. 
Double-click the Horizon job bar to display a dialog to define the job parameters.

• BusinessObjects Job – Clicking this button and dragging to the View canvas creates a 
BusinessObjects job bar. Double-click the BusinessObjects job bar to display a dialog to define the 
job parameters.

• Informatica Job – Clicking this button and dragging to the View canvas creates a Informatica job 
bar. Double-click the Informatica job bar to display a dialog to define the job parameters.

• JD Edwards Job – Clicking this button and dragging to the View canvas creates a JDE job bar. 
Double-click the JDE job bar to display a dialog to define the job parameters.

• JDBC Job – Clicking this button and dragging to the View canvas creates a JDBC job bar. 
Double-click the JDBC job bar to display a dialog to define the job parameters.

• SSH Job – Clicking this button and dragging to the View canvas creates a SSH job bar. Double-click 
the SSH job bar to display a dialog to define the job parameters.

• Cognos Job – Clicking this button and dragging to the View canvas creates a Cognos job bar. 
Double-click the Cognos job bar to display a dialog to define the job parameters.

• JMS Job – Clicking this button and dragging to the View canvas creates a JMS job bar. Double-click 
the JMS job bar to display a dialog to define the job parameters.

• Remote Job Job – Clicking this button and dragging to the View canvas creates a Remote Job job 
bar. Double-click the Remote Job job bar to display a dialog to define the job parameters.

• Oracle Applications Job – Clicking this button and dragging to the View canvas creates an Oracle 
Applications job bar. Double-click the Oracle Applications job bar to display a dialog to define the 
job parameters.

• VMWare Job – Clicking this button and dragging to the View canvas creates an VMWare job bar. 
Double-click the VMWare job bar to display a dialog to define the job parameters.

• MSSql Adapter Job – Clicking this button and dragging to the View canvas creates a MSSql job 
bar. Double-click the MSSql job bar to display a dialog to define the job parameters. 

• SAP Adapter Job – Clicking this button and dragging to the View canvas creates a SAP job bar. 
Double-click the SAP job bar to display a dialog to define the job parameters.
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• PeopleSoft Adapter Job – Clicking this button and dragging to the View canvas creates a 
PeopleSoft job bar. Double-click the PeopleSoft job bar to display a dialog to define the job 
parameters. 

• WebService Job – Clicking this button and dragging to the View canvas creates a WebService job 
bar. Double-click the WebService job bar to display a dialog to define the job parameters.

• Oracle Database Adapter Job – Clicking this button and dragging to the View canvas creates an 
Oracle Database job bar. Double-click the Oracle Database job bar to display a dialog to define the 
job parameters.

• FTP Job – Clicking this button and dragging to the View canvas creates a file dependency job bar. 
Double-click the FTP job bar to display a dialog to define the job parameters.

• File Dependency – Clicking this button and dragging to the View canvas creates a file dependency 
job bar. 

• Variable Dependency – Clicking this button and dragging to the View canvas creates a variable 
dependency bar. 

• z/OS Dependency – Clicking this button and dragging to the View canvas creates a z/OS 
dependency bar. 

• Get Jobs – Clicking this button and double-clicking in the View window displays the Job Search 
dialog to enter search criteria to locate existing jobs to add to the View. (Refer to the “Views 
Preferences Dialog” section on page 8-263 for information about recursive options for parent-child 
jobs.)

• Create View from Group – Select a group and then click this button to create a new View that 
displays only the selected job group and its children jobs with their respective dependencies. The 
selected group job bar receives a link icon  to link to the new View and the parent group job bar in 
the new View also receives a link icon. By clicking the link icon , you can jump back and forth 
between the two Business Views. This option is only available if a job group bar is selected. (Refer 
to the “Views Preferences Dialog” section on page 8-263 for more information about recursive options 
for parent-child jobs.)

• Callout – If a job or job group is selected when clicking this button, a text balloon that points to the 
selected job displays. By clicking anywhere on the text balloon you can move it around to reposition 
the callout text. The text balloon is bounded by little boxes. 

The callout can be repositioned around an object by clicking it and dragging the callout to the 
desired location. 

Double-clicking the callout displays the Callout Properties dialog. 

The Callout Properties dialog largely duplicates the Callout tab of the View Properties dialog. 
The difference is that the Callout tab of the View Properties dialog sets the universal properties for 
all callouts while the Callout Properties dialog configures the properties for the individual callout 
that was selected. Refer to the <Jumps>“Callouts Tab” on page 266 for more information on the 
options in this dialog.

Notice that there is an option to hide the callout text. The showing and hiding of an individual callout 
is controlled from either the Hidden option in this dialog or one of options in the Hide/Show 
submenu in the View context menu. 

• Flag Job – If a job or job group is selected when clicking this button, the Flag Properties dialog 
displays. You can then assign a colored flag to the selected job as a marker. 

You can designate a red, green, blue, yellow or black flag. If a flag is already assigned you can also 
delete it from this dialog. You can also type up to 4,000 characters of text about the flag to explain 
or describe it. These remarks are displayed by pausing the cursor on the flag.
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• Create Hyperlink – Creates a Link bar icon and displays the Choose a View for Link dialog to 
create a link from the current View to another existing View. You click the link icon to display the 
linked View. To add the hyperlink to an existing job or dependency bar icon, select the bar icon and 
click this button (or use the Hyperlink option in the Add/Edit Extras submenu). To close the 
displayed dialog without creating a hyperlink, click Cancel.

Context Menu Options

Right-clicking the mouse anywhere on a View canvas displays a context menu of options. Many of these 
menu options replicate the functions of the various buttons on the toolbars along the Canvas edge. Some 
of the options are not available until a job or job group is selected. The options in the context menu are:

• Add – Selecting this option displays a submenu of the following options:

– Job – This option displays a submenu of the following options:

Select from Existing Jobs – Displays the Job Search dialog to enter search criteria to locate a 
defined job.

Group – Creates a job group bar. Double-click the bar icon to define the parameters of the job 
group.

Job – Creates a job bar. Double-click the bar icon to define the parameters of the job.

– Dependency – Selecting this option displays a submenu of the following options:

File – Creates a file dependency bar. Click the dependency icon and drag the cursor to a job bar 
to associate the dependency to that job. Once the dependency is associated to a job, a dialog 
displays to define the parameters of the file dependency. 

Variable – Creates a variable dependency bar. click the dependency icon and drag the cursor to 
a job bar to associate the dependency to that job. Once the dependency is associated to a job, a 
dialog displays to define the parameters of the variable dependency. 

– Link Node – Displays the Link bar icon and the Choose a View for Link dialog to create a link 
from the current View to another existing View. Click the link icon  to display the linked View. 
To add the hyperlink to an existing job or dependency bar icon, select the bar icon and use the 
Hyperlink option in the Add/Edit Extras submenu. To close the displayed dialog without 
creating a hyperlink, right-click in the list and select the Delete option.

– View from Group – Creates a separate View of a selected group bar and its children jobs. The 
selected group job bar receives a link icon  to link to the new View and the parent group job bar 
in the new View also receives a link icon. By clicking the link icon , you can jump back and 
forth between the two Business Views. This option is only available if a job group bar is 
selected. 

• Add/Edit Extras – Selecting this option displays a submenu of the following options:

– Callout – Displays the Callout Properties dialog to add or modify the callout associated with 
a selected object.

– Flag – Displays the Flag Properties dialog for the object you selected. 

– Hyperlink – Displays the Choose a View for Link dialog to add or change which defined View 
is linked.

• Edit – Displays the definition dialog for the selected object to modify its parameters.

• Delete – Deletes the selected object after you confirm that it should be deleted. If you wish to just 
remove the object from the View but not delete the actual job or dependency, select the Remove 
from View option.
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• Copy – Copies the selected job or job group. 

• Rename Alias – Changes the eight character name that appears inside the job object bar and updates 
the job alias in the job’s definition.

• Save – Saves any changes to the current View. 

• Print – Displays a Print dialog to configure the printing parameters.

• Index – Displays a list of the objects in the View with their names and the appropriate icons. 
Double-click a listed item to display it (with a green selection box).

• Select All – Selects all objects in the current View.

• Show Missing – Displays a list of children or dependencies that exist but are not displayed in the 
current View. Children and/or dependencies may not be displayed in the View because they were 
deleted from a View (but not from the database), they were added to a job or group that co-exists in 
another View or they were created in the TES console instead of the View.

– Children – Displays a list of child jobs that belong to the groups in the current View but are 
missing from the View. You can add missing children by dragging-and-dropping any of the 
listed items into the current View.

– Dependencies – Displays a list of dependencies that are missing from the current View. 

• Remove from View – Deletes the selected object from the View though the object remains in the 
database and can be seen in the Jobs window or on the Dependencies tab of the associated job 
definition.

• Hide/Show – Selecting this option displays a submenu of the following options:

– Hide Selected Objects – Grays out the selected objects so they are only faintly visible. The 
objects will not show in the Job Activity pane.

– Hide All Callouts – Hides all callouts to reveal more of the View canvas.

– Show Selected – Shows the hidden objects that were selected, restoring them to the normal bold 
lines instead of the grayed out format. 

– Show All – Displays all jobs and dependency objects that have been hidden.

– Show All Callouts – Displays all callouts that have been hidden.

– Show Unhidden Callouts – Displays only those callouts that are not hidden individually.

• View – Selecting this option displays a submenu of the following options: 

– Align – Selecting this option displays a submenu of the following alignment options:

Left – Aligns selected objects by their left side boundary.

Right – Aligns selected objects by their right side boundary.

Top – Aligns selected objects by their top boundary.

Bottom – Aligns selected objects by their bottom boundary.

• Refresh – Updates the screen with recent changes to display the most current status of the View 
Canvas.

• Properties – Displays the View Properties dialog to configure the basic properties of the View 
window.
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View Procedures

Create Jobs/Job Groups in the View
To create a job or job group in the View:

Step 1 From the Object toolbar, select the appropriate job/job group icon and drag it onto the Business Views 
Canvas.

Step 2 Double-click on the job/job group object to display its definition dialog and define its parameters.

Step 3 Save the definition dialog.

Add a Child Job to an Existing Group
If a defined job in the View does not already belong to a job group, it can be added to any defined job 
group in the View.

To add a child job to an existing group:

Step 1 From the Object toolbar, select the appropriate job icon or the Get Job icon and drag it onto the Business 
Views Canvas.

Step 2 From the canvas, double-click the job object to display its definition dialog.

Step 3 From the Parent Group list, select the job group you want the job assigned to.

Step 4 If defining a new job, define the remaining parameters.

Step 5 Save the definition dialog.

Create Dependencies in the View
To create a dependency in the View:

Step 1 From the Object toolbar, select the appropriate job icon and drag it onto the Business Views Canvas.

Step 2 Double-click on the job object to display its definition dialog and define its parameters.

Step 3 Save the definition dialog.

Step 4 From the Object toolbar, select the appropriate dependency icon and drag it onto the Business Views 
Canvas.

Note You cannot define a dependency until you have associated or linked it to an existing job object, 
so the object displays grayed out.

Step 5 Select the job object, then press CTRL+ALT simultaneously.
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While continuing to press CTRL + ALT simultaneously, click the dependency object.

A red arrow displays between the objects when they are linked successfully. Once linked, you can 
double-click the dependency to define it. Once defined, a green arrow displays between the objects.

Create/Modify a Callout
To create or modify a callout:

Step 1 Click an object to select it. (A green border will appear around the object.)

Step 2 Click the Callout button in the object toolbar to attach a caption to the object. 

Step 3 Double-click the callout to display its Callout Properties dialog.

Step 4 Type the text you wish to appear in the callout and format it as needed.

Hide/Show All Callouts 
To hide or show all callouts:

Step 1 Right-click in the Canvas screen to display the context menu.

Step 2 Select the Show/Hide menu option.

• To hide all callouts, select the Hide All Callouts option.

• To show all callouts, select the Show All Callouts option.

Hide Individual Callouts
To hide an individual callout:

Step 1 Double-click a callout to display its Callout Properties dialog.

Step 2 Select the Hidden option.

Show Individual Callouts
To show an individual callout:

Step 1 Click an object to select it.

Step 2 On the object toolbar, click the Callout button to display the Callout Properties dialog for the object’s 
callout.
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Step 3 Clear the Hidden option.

Create/Modify a Flag
To create or modify a flag:

Step 1 Click an object to select it.

Step 2 Click the Flag Job button in the object toolbar to display its Flag Properties dialog.

Step 3 Select a color for the flag and type any text you wish to appear when the mouse cursor pauses over the 
flag.

Create/Modify a Hyperlink
To create or modify a hyperlink:

Step 1 Click an object to select it.

Step 2 Click the Create Hyperlink button in the object toolbar to display the Choose a View for Link dialog.

Step 3 Link the selected object to a View by selecting a View from the list.

A link icon will be placed on the object that when clicked displays the specified View.

You can change the linked View at anytime by selecting the object, clicking the Create Hyperlink 
button and choosing a different View from the Choose a View for Link dialog.

Change the View Properties
To change a View’s properties:

Step 1 Display the View Properties dialog by selecting the Properties option in the Canvas context menu. 

Step 2 Modify the parameters in the dialog as needed. Click the Defaults button to return to the original default 
values after changing the values.

Delete Objects
There are two degrees of object deletion. With one type of deletion, you may wish to just delete an object 
from the View Canvas yet leave the object still available in the database. With the other form of deletion, 
an object is not only removed from the View but is permanently removed from the database.
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To delete an object from the View Canvas and the database, select the object and press the DELETE 
button on your keyboard. A confirmation message displays.

Deselecting Currently Selected Objects
You can click on a empty spot of canvas to deselect all currently selected objects in the canvas. This is 
helpful if you want to recover or reset from previous selection mistakes during a job dependency or 
parent job relationship procedure.

Find Jobs
There are two different types of job searches available. All of the existing jobs that are defined in the 
database and just the jobs that are included in the current View, which can be difficult to find as the 
workflow in a View becomes more complicated and populated with objects.

• To find a particular object within the current View, right-click on the canvas and select Index from 
the context menu to display the Job Index dialog that lists the various objects contained in the 
current View. Double-click one of the listed objects to close the dialog and to display the selected 
object, highlighted in a green bounding box.

• To find an existing job (or job group) in the database that is not in the current View, click the Get 
Jobs button in the object toolbar to select it and double-click anywhere in the Canvas to display the 
Job Search dialog. Enter criteria in the various fields to find the desired job. For more information 
on the Job Search dialog, refer to “Job Search Dialog” section on page 5-187.
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C H A P T E R 9

Variables

Overview
TES provides a rich set of variables representing system, job and job event data points. In addition, users 
can define their own variables to represent dynamic information. You can use variables for command 
parameters, in various action messages and in job and job group dependencies. You can update 
user-defined variables through variable actions. For more information about jobs and job groups, see 
Chapter 5, “Jobs”.

Variables are useful for specifying information that continually changes or is only available at certain 
times. For example, if you want to know which queue your job enters when it runs, you can use the 
Queue Name variable to specify that information. Using the Queue Name variable in a mail action 
message, you can email yourself the name of the queue your job enters at every runtime.

TES’s variables function is a blend of power and flexibility that you expect in a world-class application.

Note Any argument that either explicitly has a space in it or could have a space in the argument should be 
enclosed in quotation marks; otherwise, the argument is returned as separate arguments wherever the 
spaces occur. For example, a job called Section 59 Tally would be returned as separate arguments, 
“Section,” “59” and “Tally.” Similarly, if a variable like <jobname> could return an argument 
containing a space, it also should be enclosed in quotation marks.

Types of Variables

System Variables
System variables cover general information such as:

• Current date

• Current time

• System name

Job Variables

You can use job variables to use the information that pertains to a specific job in its definition. Job 
property information is represented by many variables. Some of these variables are:
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• Job ID – The identification number of the job occurrence. Each job ID is unique.

• Job Name – The name of the job or job group.

• Job Owner – The owner (workgroup or user) of the job or job group.

• Job Occurrence – Information such as job status, exit code, and start time

• Job Parent – The parent job group that the job belongs to (if any).

• External ID – The job’s ID number on the agent platform. For example, the External ID for a 
job run on a Unix agent would be the Unix process ID. The External ID for an SAP job would be 
the job’s unique SAP instance number.

In addition, to the variables for the job being defined, if a job is dependent on another job, then the 
variables for job “A” also show under the job variables for job “B.” That is, the same variables defined 
for Job “A” become available for use in the dependent job “B.”

Parent-Child Variables

In the same way, child jobs can access the job variables of their parent. The job variables of the parent 
and higher-level job groups appear as a submenu of the Job Variables menu under the name of the job 
group. 

When the parent variable is selected, the level within the parent-child hierarchy is denoted by a suffix of 
a period and the letter p (.p). (Some variables without a time or date format may have two periods.) When 
the child job uses the parent variable, it is distinguished as a parent variable by a .p suffix. A grandparent 
variable would be .p2, a great-grandparent variable would be .p3, and so on. 

Job variables can also be used to help communicate and/or diagnose the condition under which a job’s 
action was triggered.

Event Variables

Event variables include event and action information such as:

• Event Name 

• Event Owner

• Action Name 

• Action Owner

User-Defined Variables

You can define your own variables to use as command parameters or in action message text. 

By using the same user-defined variable in multiple job and action definitions, you can update all the 
jobs and actions by just updating the variable you created.

Public Variables

You can declare any user-defined variable as public. Any TES user can refer to a public variable. For 
example, you could use public variables to refer to key employees by their title. For example, if you had 
a public variable named Payroll Manager which refers to the name of the Payroll Manager, you would 
update the variable definition when a new employee takes that position, and all instances of Payroll 
Manager would be updated.
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Dependencies Variables

You can use variables as dependencies to prevent jobs from running until their value qualifies. Variable 
dependencies are defined as a part of a job or job group definition. In the definition, you specify the value 
a variable must have before the job or job group can run. You can change variables manually to satisfy 
dependencies or they can change automatically when a job event or system event triggers a variable 
action. Thus, you can use variables to trigger the start of a job based on any system or job event.

For example, assume Job A needs to run 100 times, and when it runs, it saves a file. Job A also 
increments a variable from 1 to 10. When the variable reaches 10, Job B starts, resets the variable to 1, 
and transfers the files created by Job A to another location, freeing up disk space. TES repeats this 
process 10 times until Job A has run 100 times.

Variables Interface
From the Navigator pane, select Definitions>Variables to display the Variables pane. 

Buttons
The Variables interface contains the following buttons:

• Add Variable – Displays the Variable Definition dialog to add a variable.

• Edit Variable – Displays the Variable Definition dialog to edit a variable.

• Copy Variable – Creates a copy of the selected action with the same information as the selected 
variable, except for the name.

• Delete Variable – Removes the variable definition from the TES database.

• Refresh – Updates the data in the current pane.

• Print – Displays the Reports pane to view and print your variable definitions. For more 
information, see Chapter 11, “Monitoring Production”.

Search Field
Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See Searchable Columns, page 2-35.

Columns
The Variables interface contains the following buttons:

• Name – The name of the variable.

• Owner – The owner of the variable.

• Public – Specifies that the variable is public, that is, available to all TES users.

• Type – The type of variable; whether String, Date, Number or Boolean.
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• Value – The value of the variable.

• Published – Shows whether the variable is available for use with remote masters.

• Modified – The last time the variable definition was modified.

Variables Preferences Dialog
If you select Preferences from the View main menu while viewing the Variables pane, the Variables 
Preferences dialog displays. 

From the Variables Preferences dialog, you can select which columns are displayed in the Variables 
pane and in what order they appear.

• A checkmark to the left of a column title indicates that it displays in the pane. No checkmark 
indicates that it is not displayed.

• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.

Navigator Context Menu
When you right-click in the Navigator pane while viewing the Variables pane, the Navigator context 
menu displays. 

The following describes the items in the Variables Navigator context menu:

• Add Variable – Displays the Variable Definition dialog to add a new connection. Has the same 
function as the Add Variable button. 

• Preferences – Displays the Preferences dialog for the Variables pane.

• Print – Displays the Reports pane to view and print your variables definitions. Has the same 
function as the Print button on the TES toolbar. For more information, see Chapter 11, “Monitoring 
Production”.

• Export – Saves the data in the current pane as an ASCII text file. You can then use the file data in 
other applications. 

• Refresh – Updates the data in the current pane.

Variables Pane Context Menu
When you right-click in the Variables pane, the Variables pane context menu displays.

The Variables pane context menu contains the following options:

• Add Variable – Displays the Variable Definition dialog to add a new variable. 

• Edit Variable – Displays the Variable Definition dialog to edit an existing variable. 

• Delete Variable – Deletes the selected variable. 

• Print – Displays the Reports pane to view and print your variables definitions. Has the same 
function as the Print button on the TES toolbar. For more information, see Chapter 11, “Monitoring 
Production”.
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Variable Definition Dialog
The Variable Definition dialog displays when adding or editing a variable.

This dialog contains the following elements:

Note Name – The name of the variable that displays in the variable pane and in the variable selection context 
menus. The name of a variable cannot include the following five characters: <, >, :, . or @.

• Owner – The owner of the variable. By default, the creator of the variable is the owner.

• ID – The variable’s identification number. The ID number is automatically appended to the variable 
name so that variables with the same name can be created between users and workgroups. You 
cannot edit the ID.

• Type – The data type of the variable. You can choose from the following types of data:

– String – The value of the variable will be a text string consisting of no more than 255 
characters. Note that if you type a number when the STRING type is selected, the result will 
still be a string, not a numerical value.

– Number – The value of the variable must be a number (base 10).

– Date – The value of the variable will be a date string and must conform to the same format as 
set in the operating system that the master is running.

– Boolean – The variable uses Boolean logical operators to determine a true or false value.

• Value – The value of the variable. Do not use quotation marks unless you want them to be a part of 
your text string (when the STRING type variable is selected). If Boolean was selected in the Type 
field, True or False are presented as the options in this field.

• Calculated – This check box appears only if the Date option is selected in the Type field. Select 
this option to make the variable calculate a date based on a formula. Selecting this check box, makes 
the Value field unavailable since the value will be calculated and displays a Browse button at the 
end of the field. Clicking this Browse button displays the Date Calculation dialog.

• Description – This is an empty text field for typing a description or notes about the variable.

• Public – When selected, this option makes the variable available to all TES users on the master. You 
can make this option default to either selected or cleared from the System Configuration dialog, 
Defaults tab. 

• Publish this variable to remote masters – The variable is available for use by other masters. 

• Read only – The defined variable is available to other masters but the variable can not be modified. 
(This option is only available if the Publish this variable to remote masters option was 
selected.)

Date Calculation Variable Dialog
If you wish to use a specific calendar date for the date value then simply enter the date in a specified 
format. The date format is defined on the Date tab of your computer’s Regional Options setting 
(Start>Settings>Control Panel>Regional Options).

If you wish to calculate a date, then you must configure the formula to be used in creating the date 
variable. You associate a date calculation with a variable from the Date Calculation dialog. 

To display the Date Calculation dialog:
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Step 1 Select the Date option in the Type field of the Variable Definition dialog.

Step 2 Select the Calculated option. 

Step 3 Click the drill-down button in the Value field to display the Date Calculation dialog.

This dialog contains the following elements:

– Calendar Start Section – The fields that are available in the Date Calculation dialog vary 
according to the option selected in the Starting with field in the Calendar Start section. 
Some fields are unavailable with certain options while other options display new fields.

Starting with – The starting point of the date calculation. All defined offsets are offset from 
this date. As soon as an option is selected from the drop-down list, the resulting date displays 
in parentheses to the right of the field. 

The possible starting points of the date calculation and their definition are listed in the following table:

Table 9-1 Date Calculation Options

Date Calculation Starting Points Definition

System Date The date displayed in the computer system. 
Usually this is the same as the current date.

Production Date The date used when scheduling production 
schedules. This may differ from the current date if 
a production offset has been configured.

Job’s Actual Run Date The date that the job actually runs. This may be 
different than the scheduled date due to 
production carryover.

Job’s Scheduled Date The date assigned to a job to run.

Last Sunday The Sunday that occurred before the current date.

Last Monday The Monday that occurred before the current date.

Last Tuesday The Tuesday that occurred before the current date.

Last Wednesday The Wednesday that occurred before the current 
date.

Last Thursday The Thursday that occurred before the current 
date.

Last Friday The Friday that occurred before the current date.

Last Saturday The Saturday that occurred before the current 
date.

Specific Date (m/d/yy) A date is specified within a designated year.

Specific Date (m/d) A date is specified within the current year.

Fiscal Month The current month within a selected fiscal year.

Fiscal Week The current week within a selected fiscal year.

Fiscal Quarter The current quarter within a selected fiscal year.

Fiscal Year The current year within a selected fiscal year.

Calendar Month The current calendar month.
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n Using – This field displays only when the Specific Date options and the Fiscal 
period options are selected in the Starting with field. This field varies according to 
the option selected in the Starting with field.
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n Specific Date (m/d/yy) – Click the drop‐down arrow to display the current 
monthly calendar tab. Click the desired date to select it. You can advance or roll 
back the calendar month by clicking the side arrows in the header bar. Alternately, 
you can click the month to display a list of the months to select from. You can also 
click the year and click the up or down arrow to advance or roll back the year.

n Specific Date (m/d) – The Using field is split into two fields. The first field is a 
drop‐down list of months. Once a month is selected, click the second field to select 
a day of the month. The current year is assumed. 

n Fiscal periods – click the drop‐down arrow in the Using field, to display a list of 
predefined fiscal calendars. This field displays only if one of the following options 
is selected in the Starting with field: Fiscal Month, Fiscal Week, Fiscal Quarter 
and Fiscal Year. 

– Offset section – Date offsets are optional but you may require one or more offsets from the 
starting date to calculate the desired date. The offset units used when calculating dates in a 
variable vary from a specific number of days to fiscal periods and calendar periods. You select 
a unit of offset from the drop-down list of unit options, select how many units to use and whether 
the offset is positive or negative.

n Positive/Negative Offset – Select whether the offset is positive (+) or negative (–).

n Number of Offset Units – The number of the selected offset units to use. Type a 
number or use the arrow keys to increase or decrease the value. A zero offset value 
whether positive or negative has special significance in date calculations. 

n + 0 (Positive zero offset) – If the start date is the same as the selected offset unit 
then use that unit’s date/day. If the start date and the selected offset unit do not 
coincide than use the next occurrence of that unit. 

For example, if the date offset is + 0 Sunday, and the start date falls on a Sunday 
then use that Sunday, but if the start date falls on a day other than Sunday use the 
next occurrence of Sunday. If the start date is March 10th, then because the start 
date falls on the same date as the date unit (Sunday), the calculated date is March 
10th. If the start date was on a different day within the week, say on the 12th, then 
the calculated date would be March 17th.

n – 0 (Negative zero offset) – If the start date is the same as the selected offset unit 
then use that unit’s date/day. If the start date and selected offset unit do not coincide 
than use the previous occurrence of that unit.

For example, if the date offset is – 0 Sunday, and the start date falls on a Sunday 
then use that Sunday, but if the start date falls on a day other than Sunday use the 
previous occurrence of Sunday. If the start date is March 10th, then because the 
start date falls on the same date as the date unit (Sunday), the calculated date is 
March 10th. If the start date was on a previous day within the week, say on the 9th, 
then the calculated date would be March 3th.

– Offset Units – Select from the drop-down list of unit options. These options range from 
specific days of the week to fiscal and calendar periods of time.

n Calendar (Custom Calendar unit only) – This field only appears if the Custom 
Calendar option was selected in the Offset Units field. The field has a drop‐down 
list of calendars that are available from your defined Calendars. 

n Fiscal (Fiscal periods only) – This field only appears if one of the fiscal units is 
selected (Fiscal Quarter, Fiscal Month, Fiscal Week and Fiscal Year). This field 
has a drop‐down list of predefined fiscal calendars.

– Calendar Offset – This column lists the defined calendar offset parameters.
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– Offset End – This column lists the calendar date derived from the defined calendar offset 
relative to the starting date if the variable were to be calculated now.

– Add – Click this button to add the calendar offset parameters that are displayed to the list of 
calendar offsets.

– Edit – Click a listed calendar offset to select it. Click the Edit button to display and, if desired, 
to modify the existing parameters. 

– Delete – Click this button to remove the selected calendar offset.

– Test – Click this button to test the specified date offset. Clicking this button displays a calendar 
tab dialog. Click a date in the calendar month to apply the offset to that date and display the 
resulting calculated date. The Test button is unavailable if an offset date is not selected.

Examples of Calendar Offsets

A few examples may illustrate some important points about how calendar offsets work.

Fiscal calendar offsets key off both the quarter breakdown and the starting date of the fiscal calendar 
used in the date calculation variable. A fiscal period is often independent of a calendar period. For 
example, assume that the fiscal calendar being used for a fiscal quarter offset is defined to start on a 
Monday, January 1st with a 4-4-5 quarter breakdown. If the starting date is February 2, 2001 and the 
calendar offset is “+ 1 Fiscal Quarter” then the calculated offset date is April 2, 2001. This is calculated 
from the starting point of January 1st and counting 13 weeks (4-4-5).

Using the same fiscal calendar parameters as the preceding example, for a fiscal month with a starting 
date of February 2, 2002 and a “+ 1 Fiscal Month” offset calculates an offset date of February 26, 2002. 
It seems odd that the next fiscal month begins in the same month but the fiscal calendar is counting 
months according to the designated quarter breakdown and not according to the calendar month. 
Counting from the start of the fiscal quarter (January 1, 2002), a 4-4-5 quarter breakdown means that the 
months of the first fiscal quarter start on 1/1, 1/29 and 2/26 respectively. The fourth fiscal month (and 
second fiscal quarter) begins on 4/2.

You can also use multiple offsets. Each listed calendar offset uses the date calculated from the preceding 
offset to build upon when calculating its result. 

In the multiple calendar offsets in the example, there are three calendar offsets used to arrive at the date 
offset. 

• The first offset, + 1 “full month,” adds a calendar month to the current date (4/30/02) giving a date 
of 5/30/02.

• The second offset, – 0 “Monday,” moves the calculated date to the previous Monday unless the 
calculated date already falls on a Monday, giving a date of 5/27/02.

• The third offset, + 0 “Custom Calendar–Workdays,” advances the calculated date by one day by 
using a custom calendar that defines the workdays for a company. The calculated date from the 
previous offset, 5/27/02, does not fall on a workday according to the custom calendar because 
5/27/02 is Memorial Day, a holiday. This offset ensures that the calculated date is a workday.

A table of more calendar offset examples is provided for the user to study how calendar offsets work. 

Table 9-2 Date Calculation Options

Calendar Offset Definition

Add 0 “Monday” The next Monday following the Starting with date. If today is a 
Monday, then today’s date is returned.

Add 1 “Monday” Always the next Monday following the Starting with date.
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Variables Button Context Menu

The Variables button context menu displays when you click the Variables button in the Job, Job 
Group or Action Definition dialogs. 

When selecting a variable for a command parameter, the Variable Search dialog displays when there 
are too many variables to list in a context menu.

You can scroll down the list of variables and make a selection or you can start typing in the name of the 
variable to display the variables that match your entry.

Click OK.

System Variables

The following describes the System Variables available from the Variables button context menu.

This context menu contains the following options:

• System Date – The date on the TES master. You can select from a list of predefined date formats, 
or construct your own format using the Date Format Selection dialog. For more information about 
using the Date Format Selection dialog, see “Date Format Selection Dialog” section on page 9-289.

• System Time – The time according to the TES master when the variable is replaced with a value. 
You can select from a list of predefined system time formats. For more information about time 
formats, see “Time Format Submenu” section on page 9-290. 

• System Name – The name of the TES master.

• User Name – The account under which the TES master is running. If it is not running under a 
specific account, but as part of the system, the value of this variable will be SYSTEM.

Subtract 1 “Monday” Go back to the Monday previous to the Starting with date.

Add 2 “Monday” Move ahead two Mondays from the Starting with date.

Add 2 “Days” Move ahead two days from the Starting with date.

Add 1 “Week” Move ahead one week following the Starting with date.

Add 1 “Month” One month following the Starting with date.

Subtract 2 “Month” Go back two months previous to the Starting with date.

Add 1 “Calendar Week” A calendar week begins on Sunday so this offset goes to the 
next Sunday from the Starting with date.

Add 1 “Fiscal Quarter” 
Fiscal

The beginning of the next fiscal quarter following the Starting 
with date. This varies according to the way the fiscal calendar 
being used is defined. The quarters are calculated according to 
when the fiscal year starts.

Add 1 “Fiscal Week” The beginning of the next fiscal week following the Starting 
with date. This varies according to the way the fiscal calendar 
being used is defined. The weeks are calculated according to 
when the fiscal year started.

Add 1 “Calendar Month” The beginning of the next calendar month following the 
Starting with date.

Table 9-2 Date Calculation Options

Calendar Offset Definition
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• Production Date – The current production date for the master. This is the same as the System 
Date, unless you are running a schedule from a day other than the current day. You can select from 
a list of predefined date formats, or construct your own format using the Date Format Selection 
dialog. For more information about using the Date Format Selection dialog, see “Date Format 
Selection Dialog” section on page 9-289.

• Queue Name – The name of the queue that triggered the system event.

• Queue Limit – The job limit of the queue that triggered the system event.

• Connection Name – The name of the connection relevant to the variable. If you are defining a job, 
the connection name variable relates to the agent that will run the job. If you are defining an 
intermaster dependency, the connection name variable refers to the connection to the remote master.

• Agent Limit – The job limit on the agent that triggered the system event.

• Remote Master Name – The name of the remote master that triggered the system event.

Job Variables

The Variables button context menu contains the following Job variables: 

• Job Rule ID – The identification number for the job. The job rule ID may be shared by numerous 
job instances that were created from the same job. Compare to Job Instance ID.

• Job Name – The name of the job as defined in the Job Definition dialog.

• Job Parent – The parent job group that the job belongs to (if any).

• Job Owner – The owner of the job. The owner can be a user name or a workgroup name.

• Job Command – The command that the job executes.

• Agent Name – The name of the agent that the job runs on. If the job has an agent list, it is the name 
of the agent in the agent list to which the job was assigned.

• Estimated Runtime – The estimated time that it takes for the command executable to run. If the 
job has run more than once, this value is a historical average of its actual duration. The time is 
expressed in minutes in decimal format. This means that a job that runs for one minute and 15 
seconds is shown as 1.25.

• Earliest Start Time – The beginning of the job’s time window. You can select from a list of 
predefined system time formats. For more information about time formats, see “Time Format 
Submenu” section on page 9-290.

• Latest Finish Time – The end of the job’s time window added to its estimated duration. You can 
select from a list of predefined system time formats. For more information about time formats, see 
“Time Format Submenu” section on page 9-290.

• Owner’s Phone Number – The job owner’s phone number, as defined in the owner’s user 
definition.

• Owner’s Pager Number – The job owner’s pager number, as defined in the owner’s user 
definition.

• Job Alias – The alias of the job.

• Job Run ID – The number that identifies the individual job instance. A job may run numerous times 
and each time the job runs it has a different job instance ID. Compare to Job Rule ID.

• Job Status – The status of the job. 

• Exit Code – The exit code of the job when it completed.
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• External ID – The job’s ID number on the agent platform. For example, the external ID for a job 
run on a Unix agent would be the Unix process ID. The external ID for an SAP job would be the 
job’s unique SAP instance number.

• Runtime User – The user name under which the job is running. 

• Job Output – The output from the job that triggered the job event, up to 1024 characters. If this 
variable is used in a Windows log message, it is limited to 255 characters. This variable does not 
apply to system events. 

• Scheduled Date – The date on which the job is scheduled to run. You can select from a list of 
predefined date formats, or construct your own format using the Date Format Selection dialog. 
For more information about using the Date Format Selection dialog, see “Date Format Selection 
Dialog” section on page 9-289.

• Actual Runtime – The length of time that the job ran or has been (if still active) running. The time 
is expressed in minutes in decimal format. This means that a job that runs for one minute and 15 
seconds is shown as 1.25.

• Start Time – The time that the job entered Active status. You can select from a list of predefined 
system time formats. For more information about time formats, see “Time Format Submenu” section 
on page 9-290.

• Finish Time – The time that the job completed. You can select from a list of predefined system time 
formats. For more information about time formats, see “Time Format Submenu” section on 
page 9-290.

• Error Message – For jobs that complete abnormally, the error message currently associated with 
the job.

• Queue Name – The queue in which the job ran. 

• FTP Statistics – Select from four options that offer details about the FTP operation.

– # of Files – Details the number of files FTP’ed.

– # of Bytes – Details the size of the file (in bytes) that was FTP’ed. 

– # Skipped – Details the number of files within a designated directory that were not FTP’ed.

– Duration (Seconds) – Details how long (in seconds) that it took to perform the FTP operation.

Event Variables

Job event variables are only available when you are composing a message in the message field of an 
action.

The Variables button context menu contains the following Event variables: 

• Event Name – The name of the job event that triggered the action.

• Event Owner – The owner of the job event that triggered the action.

• Action Name – The name of the action triggered by the job event.

• Action Owner – The owner of the action triggered by the job event.

User Variables

If you are the owner (by default, the creator) of any variables, this menu selection (replaced with your 
user name) appears. The submenu lists all your user variables. 
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Workgroup Variables 

If you or the workgroup to which you belong own any variables, this menu selection will appear. The 
submenu lists all the variables owned by that workgroup.

Public Variables

This menu item appears if there are any public variables. Any variable can be made a public variable by 
selecting the Public option in its definition.

Date Format Selection Dialog
The Date Format Selection dialog displays when you choose to change the format of a date variable 
that was selected from a Variables button context menu. You could be in a Job, Job Group or Action 
Definition dialog.

This dialog contains the following elements:

• Date Format – The date format to be applied to a date variable. The drop-down menu shows a list 
of predefined date formats. You can choose from this list or create a custom format. The drop-down 
menu offers six common date formats:

– ddd (Abbreviated day of the week) – Use this date format for abbreviated days only. The 
first letter (of three) is capitalized. For example: Mon, Tue, Wed, etc.

– dddd (Day of week) – Use this date format for days only. The first letter is capitalized. For 
example: Monday, Tuesday, etc.

– dddd, mmmm dd, yyyy – The long date format. Use this format to exclude any abbreviations. 
For example: Friday, October 6, 2006.

– mmmm dd, yyyy – Letterhead date format. For example: October 6, 2006.

– dddd, dd mmmm, yyyy – An alternative long date format. Use this format to exclude any 
abbreviations. For example: Friday, 6 October, 2006.

– dd mmmm, yyyy – An alternative letterhead date format. For example: 06 October, 2006.

• Sample – An example of the format you selected, using the current date.

• Custom Format section – Use this section to define your own date format:

– Order – Arranges the order of the day, month, and year in the date format as follows:

Month, Day, Year – For example: October 6, 2006

Day, Month, Year – For example: 6 October 2006

Year, Month, Day – For example: 2006 October 6

Year, Day, Month – For example: 2006 6 October

– Separator – The character to use to separate your format into year, month and day. You can 
have only one separator character. The default is a forward slash /.

– Month/Qtr – Select this option to include the month or quarter in your custom date format. The 
default is selected.

– Day – Select this option to include the day in your custom date format. The default is selected.

– Year – Select this option to include the year in your custom date format. The default is selected.

– Month, Day and Year drop-down menus – Selects the format for each of the date elements.
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– Fiscal Calendar (For Fiscal Month, Quarter or Year) – If a fiscal format was selected in 
either the Month/Qtr or Year fields then select a predefined fiscal calendar from this 
drop-down list.

– Apply – Click this button to display the custom date format in the Date Format field, and show 
an example using the current date in the Sample field.

Time Format Submenu

The time formats available from the time format submenu use the following conventions: 

Note By default the characters that comprise the time format are separated by colons but you may replace the 
colon with a period or manually delete the separator if desired.

Date Format Conventions

Date formats use the following conventions:

Table 9-3 Time Format Conventions

Format Description Example

h:mm AM/PM Standard time without preceding '0' showing hours and 
minutes using ante meridiem (AM) or post meridiem 
(PM)

7:12 PM

hh:mm AM/PM Standard time with preceding '0' showing hours and 
minutes using ante meridiem (AM) or post meridiem 
(PM)’

07:12 PM

H:mm Military time without preceding ‘0’ showing hours and 
minutes

7:12

HH:mm Military time with preceding ‘0’ showing hours and 
minutes

07:12

h:mm:ss Standard time without preceding ‘0’ showing hours, 
minutes and seconds

7:12:31

hh:mm:ss Standard time with preceding ‘0’ showing hours, 
minutes and seconds’

11:32:44

H:mm:ss Military time without preceding ‘0’ showing hours, 
minutes and seconds

15:16:59

HH:mm:ss Military time with preceding ‘0’ showing hours, 
minutes and seconds

06:54:07

Table 9-4 Date Format Conventions

Format Description Example

d Date 1, 2, ..., 31

dd Date with leading ‘0’, if applicable 01, 02, …, 31

ddd Abbreviated day Mon, Tue, …, Sun

dddd Long day Monday, Tuesday, …, Sunday
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Variables Procedures

Adding Variables
When you create a variable definition, you can use it as a command parameter or as part of the message 
text in an action. 

To add a variable:

Step 1 From the Navigator pane, select Definitions>Variables to display the Variables pane.

Step 2 Right-click and select Add Variable from the context menu or click the Add  button on the TES toolbar 
to display the Variable Definition dialog.

Step 3 In the Name field, type a name for the variable you are defining.

Step 4 In the Owner field, if you want to change the ownership of the variable, select a new Owner from the 
drop-down menu.

Step 5 In the Type field, from the drop-down menu, select the type of variable you are defining:

– String – This setting accepts any string up to 255 characters, including numerical strings. Note 
that STRING types cannot be incremented with a variable update action. 

– Number – This setting accepts only values in numerical format, including those in exponential 
format (i.e., 1E5). It does not accept algebraic formats such as 1+2.

– Date – This setting accepts only date values. You can only enter dates in the format defined in 
your Windows control panel. For example, if you have selected the short date style m/d/yy in 
the Regional Settings control panel, you cannot enter the date here as 10-6-07.

j Julian date 9, 41, 121, ..., 365

jjj Julian date with leading ’0,’ if applicable 009, 041, 121, ..., 365

m Numerical month 1, 2, …, 12

mm Numerical month w\ leading ‘0’, if app. 01, 02, …, 12

mmm Abbreviated month Jan, Feb, …, De

mmmm Long month January, February, …, December

yy Abbreviated year 99, 00, …, 02

yyyy Full year 1999, 2000, …, 2006

fm Fiscal Month 1, 2, ..., 12

fmm Fiscal month w/leading ’0,’ if app. 01, 02, ..., 12

q Calendar quarter 1, 2, 3, 4

fq Fiscal Quarter 1, 2, 3, 4

fyy Abbreviated fiscal year 99, 00, ..., 02

fyyy Full fiscal year 1999, 2000, ..., 2006

Table 9-4 Date Format Conventions

Format Description Example
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– Boolean – The variable uses Boolean logical operators to determine a true or false value.

Step 6 In the Value field type a starting value for the variable. You do not have to use quotation marks. You can 
type up to 255 characters.

Step 7 In the Description field, type a description for the variable (optional).

Step 8 If you want the variable to be public, select the Public option. This makes the variable accessible to all 
TES users, within the limits of their security policy.

You can edit a variable when you want to change its current value. The new value will be used 
everywhere that the variable is referred to, such as in the job definition, or an action definition.

Deleting Variables

Note By default the characters that comprise the time format are separated by colons but you may replace the 
colon with a period or manually delete the separator if desired.

You can delete variables that are no longer used. If there are references to the variables in jobs and 
actions, they will be replaced with an empty string.

Note If the variable to be deleted is already in use, you will lose that variable’s value in all those instances. 
You can disturb your production schedule, depending on how the variable was used. Once a variable 
definition is deleted, it will not be automatically replaced in any instances where it has been used, even 
if the new variable is given exactly the same name.

To delete a variable:

Step 1 From the Navigator pane, select Definitions>Variables to display the Variables pane.

Step 2 Right-click the variable and select Delete Variable from the context menu or select the variable and 
click the Delete button on the TES toolbar or the DELETE key on your keyboard.

Step 3 When the Confirmation dialog displays, click Yes to delete the variable.

Editing Variables
To edit a variable:

Step 1 From the Navigator pane, select Definitions>Variables to display the Variables pane.

Step 2 Double-click the variable or right-click the variable and select Edit Variable from the context men, or 
select the variable and click the Edit button on the TES toolbar.

Step 3 In the Name field, edit the name of the variable.
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Note If you change the name of the variable, the new variable name does not automatically get updated in all 
job and action definitions where it was previously used. However, the correct substitution will still occur.

Step 4 In the Type field, edit the type of variable:

– STRING – This setting accepts any string up to 255 characters, including numerical string 
types. Note that STRING types cannot be incremented with a variable update action. 

– NUMBER – This setting accepts only values in numerical format, including those in exponential 
format (e.g., 1E5). It does not accept algebraic formats such as 1+2.

– DATE – This setting accepts only date values. You can only enter dates in the format defined in 
your Windows control panel. For example, if you have selected the short date style m/d/yy in 
the Regional Settings control panel, you cannot type the date here as 10-6-06.

– Boolean – The variable uses Boolean logical operators to determine a true or false value.

Step 5 In the Value field, edit the variable’s value. You do not have to use quotation marks. You can type up to 
255 characters.

Step 6 In the Description field, type a description for the variable (optional).

Step 7 If you want the variable to be public, select the Public option. This makes the variable accessible to all 
TES users, within the limits of their security policy. To limit use of the variable to yourself and your 
Workgroup, clear the Public option.

Viewing Variables
You can view all the user-defined variables available to you from the Variables pane.

From the Navigator pane, select Definitions>Variables to display the Variables pane.

Viewing the Value of Variables

To view the value of a variable:

Step 1 From the Navigator pane, select Definitions>Variables to display the Variables pane.

Step 2 The Variables pane includes a Value column. If the Value column is not visible in the Variables pane, 
select Preferences from the View main menu to display the Variables Preferences dialog.

Step 3 On the Columns tab, select the Value option. 

Step 4 For more information about the Variables Preferences dialog, see “Variables Preferences Dialog” 
section on page 9-280.

Step 5 You can also double-click the variable, or right-click and select Edit Variable from the context menu, 
or select the variable and click the Edit button on the TES toolbar to open the Variable Definition 
dialog and view its value.
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C H A P T E R 10

Controlling Production

Enterprise Scheduler follows certain concepts when it compiles a production schedule. The concepts 
are basic but can result in complicated timing scenarios with date shifts that cause confusion among 
users when put into practice. The most complex timing issues arise from the shifting of the start of the 
production day through a series of time offsets as scheduled jobs run. 

Enterprise Scheduler compiles a production schedule from your job rules for each master. This 
production schedule covers at least the current day but may extend to multiple days. You determine the 
duration of each schedule by specifying the number of days to include. Each master in your network 
has its own production schedule, so schedule durations can vary. The active production schedule for a 
master includes history data (for dates past), the current date and any remaining days in the schedule 
(future).

Figure 10-1 Example of a Normal Schedule Length

The production day contains all of the job rules that are scheduled to run during the production day. A 
production day always contains 24 hours and by default starts at midnight and ends at 23:59:59 PM. 
(For simplicity’s sake, we will use the 24-hour time format in this discussion so 11:59 PM is 2359.) To 
accommodate all of the processing needs of a business, a production day often differs from the calendar 
day. You can designate that the production day start at any time. For instance, you might specify that 
the production day starts at 0500 instead of starting at midnight to allow for the completion of the 
previous day's jobs. This is called a production day offset.

If the offset is positive, the fiscal day begins at some time after midnight and continues into the next 
calendar day. If the offset is negative, the fiscal day begins at some time before midnight. The 
maximum offset that you can define is 23 hours and 55 minutes. Scheduler uses the designated start of 
the production day to determine when the production day starts, and to select and launch jobs 
accordingly.
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Defining a Production Day 

Positive Offset (Late Start)

If you want your production day to begin at 1200 noon and continue until 1200 noon the following day, 
you define the start of the production day as 1200 (+1200). When offsetting the start time, it is 
important to remember that no time is lost, the hours between the start of the calendar day and the start 
of the production day are merely shifted from the beginning of the production day to its end. There are 
still 24 hours in the day.

The following figure compares the calendar day to a production day with an offset of +1200. Using this 
production offset, a job scheduled to launch at 0800 (8:00 A.M.) on June 10th (production date) will not 
actually launch until 0800 on June 11th (calendar date).

Figure 10-2 Production Offset Defined As +1200 (Master/Agent in Same Time Zone)

Negative Offset (Early Start)

If you want your production day to begin at 2045 (8:45 P.M.), and continue until 2045 the following 
day, define the production day offset as -0315.

The following figure illustrates the calendar and production days with an offset of -0315. Using this 
production day offset, a job scheduled to launch at 2115 on June 12th (production date) launches at 
2115 on June 11th (calendar date).
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Figure 10-3 Production Offset Defined As -0315 (Master and Agent in Same Time Zone)

Scheduling Based on Agent Time Zone 
While jobs normally run from the master’s time reference, you can launch jobs according to what time 
it is in the agent’s time zone. Selecting the Use Agent Time Zone option on the Master tab of the 
System Configuration dialog will launch jobs according to the time where the agent resides. This 
change will take effect the next time any schedule is compiled. While the jobs will launch at the 
intended times in the agent’s time zone, the master’s viewpoint will be compiled in for the job time 
windows and start time. Since the master will compensate for the offset, users should not think about 
the difference between the different master and agent time zones when defining jobs rules. In a 
nutshell, using the master time zone imposes an absolute time reference while using the individual 
agent time zones imposes a relative time reference.

Caution The master will be unable to predict shifts in times when compiling future schedules. Times will be 
calculated as an offset to the master time based on the timezone of the agent. If the agent shifts times, 
the master will not be able to predict this shift, as international daylight savings time laws constantly 
change, country to country. The schedule must be compiled under the influence of the new agent times.

The following example illustrates the differences to be accounted for when the master and the agent 
reside in different time zones. The master in this example is three time zones ahead of the agent. A job 
defined to run at 2300 on the production day of August 10th will actually be launched by the master at 
0200 on the production day of August 11th to account for the difference in time zones.
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Figure 10-4 Agent Residing Three Time Zones Behind Master (No Production Date Offset)

Figure 10-5 is another example of the master and agent in different time zones without a production 
offset. This example shows a master that is seven hours behind the agent. A job defined to run at 0500 
on the production day of August 11th is actually launched by the master at 2200 on the production day 
of August 10th to account for the difference in time zones.

Figure 10-5 Agent Residing Seven Time Zones Ahead of Master (No Production Date Offset)

Using a Positive Production Day Offset 

Agent Running Ahead of the Master

Setting a positive production day offset moves the start of the production day forward. In the example 
below, the difference between time zones is shown in a solid line and the production day offset is shown 
in a dotted line.
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Figure 10-6 Positive Production Day Offset With the Agent Running Ahead of the Master

This example shows an agent that is five hours ahead of the master. A production day offset of positive 
three (+3) shifts the start of the production day (0000) three hours ahead in calendar time for both 
master and agent. A job defined to run at 0500 on the production day of August 11th launches at 0000 
on August 10th on the master’s production day. 
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Agent Running Behind the Master

Setting a positive production day offset moves the start of the production day forward. In the example 
below, the difference between time zones is shown with a solid arrow and the production day offset is 
shown with a dotted arrow. This example has a positive production day offset of two hours ahead with 
the agent running eight hours behind the master. Thus a job defined to run at 2200 on the production 
day of August 10th is launched at 0600 on August 11th due to the difference in time zones.

Figure 10-7 Positive Production Day Offset With Agent Running Behind Master

Using a Negative Production Day Offset 

Agent Running Ahead of the Master

Setting a negative production day offset moves the start of the production day back from midnight. In 
the example below, the difference between time zones is shown with a solid arrow and the production 
day offset is shown in a dotted arrow. The example shown below has a negative 4 offset so the start of 
the production day is moved back four hours behind the start of the calendar day. A job defined to run 
at 2200 on the production day of August 11th is launched at 1600 on August 10th on the master due to 
the time difference.
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Figure 10-8 Negative Production Day Offset With Agent Running Ahead of Master

Agent Running Behind the Master

Setting a negative production day offset moves the start of the production day back from midnight. In 
the following example, there is a negative four hour production offset moving the start of the 
production day four hours behind the start of the calendar day. In the example below, the difference 
between time zones is shown with a solid arrow and the production day offset is shown with a dotted 
arrow.

Figure 10-9 Negative Production Day Offset With Agent Running Behind Master

This configuration has an agent that is running five hours behind the master. A job defined to run at 
2300 on the production day of August 10th is launched by the master at 0300 on August 11th. 

Defining a Compile Offset
Compiling the production schedule may consume enough CPU resources to seriously affect your 
system’s performance and hinder other work that may be going on concurrently. It may be better to 
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schedule such a resource-intensive operation like compiling your schedule, at a more convenient time 
when your system has a lighter workload. Once the schedule is compiled, it is saved until needed when 
the new production day starts. You can manually compile a new schedule at any time by selecting the 
Create Schedule option in the Activities main menu.

Figure 10-10 Create Schedule Dialog

The compile offset is calculated from the start of the production day. The schedule will be compiled for 
the current day and all days that belong to the future days to include in the schedule. Any future day 
that was already scheduled (not forecast) will not get recompiled to reflect any job modifications or 
additions that were not committed to the schedule after the operation. To include any modifications that 
were not committed to the schedule, we must either recompile the already scheduled days or revert 
these schedules to a forecast type to force a compile before the day rolls into production.

Calendars Pane
Cisco Tidal Enterprise Scheduler’s Calendars function enables you to specify dates on which to run jobs 
on a regular basis. Calendars are the backbone of an automated production schedule. You can create a 
calendar that holds specific dates of your choice, or a relative calendar that repeats on a daily, weekly, 
or monthly basis. You can also combine calendars into calendar groups where logic is used to include or 
exclude the dates of the calendars in the group. You can then use the calendar group as a whole to 
schedule jobs.

TES provides many pre-defined calendars and calendar groups. Most are Public and belong to the default 
workgroup Schedulers so that anyone can use them. You can customize these examples or create your 
own entirely new calendar. Once you select a calendar, TES calculates the matching dates for the 
remainder of the current year, plus three more years.

All calendars are fully configurable. For example, after specifying the repetitive rules for the calendar, 
you can forecast the results to ensure that the rules are correct. You can then add or delete special days 
to the resulting set, giving you full control over the scheduling process.

List Calendars
You can select unique days to run jobs with a list calendar. List calendars are useful when you do not 
want your job to repeat continually. Once defined, the calendar can then be assigned to a job definition 
from the Job Definition or Job Group Definition dialogs.
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Daily Calendars
With a daily calendar, you can specify your job to run based on an interval of days. Once defined, the 
calendar can then be assigned to a job definition from the Job Definition or Job Group Definition dialog. 

Weekly Calendars
With a weekly calendar, you can specify your job to run based on an interval of weeks. Once defined, 
the calendar can then be assigned to a job definition from the Job Definition or Job Group Definition 
dialog. 

Monthly Calendars with Days
With a monthly calendar with days, you can specify common days of the week in various months to run 
your job; for example, the 1st and 15th of January, February and April. You can also add and remove 
unique days and weeks from the calendar. 

Monthly Calendars with Weeks
With a monthly calendar, you can specify common days in various months to run your job. For example, 
the first and third Wednesday of October and November. You can also add and remove unique days and 
weeks from the calendar. 

Subset Calendar
You can use subset calendars to extract exactly the dates that you need from an existing calendar, 
“borrowing” the calendar logic already in place.

Fiscal Calendars
TES gives special attention to fiscal calendars, acknowledging their vital role in production in business 
environments. They are treated in a slightly different way than other types of TES calendars and have a 
section devoted to them in this chapter.
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Calendar Types
The following table lists the types of calendars (other than fiscal calendars) available in TES.. 

Table 10-1 Calendar Types

Type Description Examples

List Calendar A calendar of dates you choose 
specifically. Use this type of 
calendar to specify a finite set of 
dates to run your job.

January 15th and 16th.

March 29th through April 1st

Daily Calendar Automatically chooses dates that 
repeat using the specified interval in 
days. You can also choose to 
exclude certain days of the week, 
using condition logic from the 
Condition dialog. Use this type of 
calendar when your jobs should run 
on a specific daily interval.

Every 3rd day unless the 3rd day is 
Sunday, in which case it should run 
on Monday.

Every day except Saturday and 
Sunday.

Weekly Calendar Automatically chooses dates that 
repeat using a specified interval in 
weeks. You can also choose the days 
within the week to run. Use this type 
of calendar when your jobs should 
run on a specific weekly interval.

Every 3rd week on Wednesday and 
Friday

Monday and Wednesday of every 
week.

Monthly 
Calendar with 
Days

Automatically chooses dates that 
repeat yearly in the months and 
dates specified. Use this type of 
calendar when your jobs should run 
on a consistent yearly schedule.

Every January, April, July, and 
October on the 1st and 15th of each 
month.

The 1st of every month.

Subset A subset of dates selected from 
existing calendars.

The 1st weekday of the fiscal 
quarter.

Monthly 
Calendar with 
Weeks

Automatically chooses dates that 
repeat yearly in the months and 
occurrence of days specified (i.e. 
first Monday, third Wednesday). 
You can also choose to offset all 
forecasted dates by an amount you 
specify. Use this type of calendar 
when your jobs should run on a 
consistent yearly schedule, and you 
want to specify the days on which it 
will run.

Every January, April, July, and 
October on the first and third 
Monday of each month.

The second Friday of every month.

Group Calendar Groups calendars of the above 
types, and excludes or includes their 
dates.

Include dates in calendar 
Workweek. Exclude dates in 
calendar holidays.
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Note The Condition dialog makes it possible to alter the functionality of calendars to precisely satisfy 
customized needs. For more information about calendar conditions, see “Condition Dialog” section on 
page 10-318.

Default Calendars
The following table lists all the predefined calendars provided with TES. 

Table 10-2 Default Calendars

Calendar Type Examples

Christmas Monthly (Days) This calendar consists of Christmas Day (December 
25th).

Christmas Eve Monthly (Days) This calendar consists of Christmas Eve (December 
24th).

Christmas 
Holiday Group

Group Includes Christmas and Christmas Eve

Daily Daily Every day including weekends and holidays.

Easter Easter This calendar consists of Easter.

Every other 
Friday

Weekly Friday every two weeks.

Every other 
Friday except 
Holidays

Group Includes every other Friday except for Fridays that 
fall on a holiday.

Every Wednesday 
and Friday

Weekly Wednesday and Friday of every week, including 
holidays.

Holidays List Christmas Holiday Group, Independence Day, Labor 
Day, Memorial Day, New Years, Presidents Day and 
Thanksgiving Holiday Group. This calendar 
definition contains those holidays most requested for 
inclusion by users.

Friday Daily Fridays

Independence 
Day

Monthly (Days) July 4th of every year.

Labor Day Monthly (Weeks) The first Monday in September.

Memorial Day Monthly (Weeks) The last Monday in May.

Monday Daily Mondays

Monday to Friday Weekly All days except Saturday and Sunday.

Month Begin Subset The first day of each month.

Month End Subset The last day of each month.

New Years Monthly (Days) First day of January.

Pay Day Monthly (Days) First and fifteenth day of the month.
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Note Be aware that these predefined calendars are only examples of calendars that you can create. They may 
not include the dates that you may expect because they may use other conditions to illustrate calendar 
principles. Before using these calendars for production purposes, verify that a calendar includes the 
dates that you expect and modify it for your needs if necessary.

Calendars Interface
From the Navigator pane, select Definitions>Calendars to display the Calendars pane.

Presidents Day Monthly with 
weeks

The third Monday in February.

Qtr 1 Monthly (Days) All days in the months of January, February and 
March.

Qtr 2 Monthly (Days) All days in the months of April, May and June.

Qtr 3 Monthly (Days) All days in the months of July, August and 
September

Qtr 4 Monthly (Days) All days in the months of October, November and 
December.

Quarter Begin Subset The first day of each quarter.

Quarter End Subset The last day of each quarter.

Saturday Daily Saturdays

Sunday Daily Sundays

Thanksgiving 
Day

Monthly (Weeks) The fourth Thursday in November.

Thanksgiving 
Holiday Group

Group Thanksgiving Day and the next day.

Thursday Daily Thursdays

Tuesday Daily Tuesdays

Wednesday Daily Wednesdays

Week Begin Subset First workday of the week.

Week Ending Subset Last workday of the week.

Weekend Weekly Every Saturday and Sunday.

Workdays Group Every Monday through Friday except for holidays.

Year Begin Subset First workday of the year.

Year End Subset Last workday of the year.

Table 10-2 Default Calendars

Calendar Type Examples
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Buttons
• Add —Displays the Add Calendar sub-menu to choose the type of calendar (including group) that 

you want to create. For more information about the Add Calendar sub-menu, see “Add Calendar 
Submenu” section on page 10-309.

•  Edit Calendar —Displays the Calendar Definition dialog to edit an existing calendar.

• Copy Calendar —Creates a copy of the selected action with the same information as the selected 
action, except for the name.

• Delete Calendar —Removes the selected calendar definition from the list database.

• Refresh —Updates the data in the current pane.

• Print —Displays the Reports pane to view and print your calendars. For more information, see 
“Monitoring Production” section on page 11-361.

Search Field
Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See “Searchable Columns” section on page 2-35.

Columns
• Name —The name of the calendar.

• Type —The type of calendar. For more information about calendar types, see “Calendar Types” 
section on page 10-304.

• Owner —The owner of the calendar. 

• Public —Whether or not the calendar is public, that is, available to all TES users.

• Modified —The last time the calendar definition was modified.

Calendars Preferences Dialog
If you select Preferences from the View main menu while viewing the Calendars pane, the Calendars 
Preferences dialog displays.

From the Calendars Preferences dialog, you can select which columns are displayed in the Calendars 
pane and in what order they appear.

• A checkmark to the left of a column title indicates that it will be displayed in the pane. No 
checkmark indicates that it will not be displayed.

• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.
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Navigator Context Menu
When you right-click in the Navigator pane while viewing the Calendars pane, the Navigator context 
menu displays. 

The Calendars Navigator context menu contains the following options:

• Add Calendar —Displays the Add Calendar sub-menu to choose the type of calendar (including 
group) that you want to create. Has the same function as the Add button. For more information about 
the Add Calendar sub-menu, see “Add Calendar Submenu” section on page 10-309.

• Refresh —Updates the data in the current pane.

• Print —Displays the Reports pane to view and print your calendar definitions. Has the same 
function as the Print button on the toolbar. For more information, see “Monitoring Production” 
section on page 11-361.

• Export —Saves the data in the current pane as an ASCII text file. You can then use the file data in 
other applications.

• Preferences —Displays the Preferences dialog for the Calendars pane. 

• New Root Folder —Allows you to create a new root folder for the Navigator pane.

Calendars Pane Context Menu
When you right-click in the Calendars pane, the Calendars pane context menu displays. The following 
describes the items in the Calendars pane context menu:

• Add Calendar —Add a calendar definition. Selecting this menu option leads to the Add Calendar 
sub-menu from which you can choose the type of calendar (including group) that you want to create. 
For more information about the Add Calendar sub-menu, see “Add Calendar Submenu” section on 
page 10-309.

• Edit Calendar —Edit the selected calendar definition.

• Delete Calendar —Delete the selected calendar.

• Copy Calendar —Copies the selected calendar.

• Refresh —Refreshes the data on the Calendars pane.

• Print —Prints the calendar(s) in a grid format to a new pane. You can then exit the pane or print the 
calendar to a printer. 

• Print Selected —Prints the selected calendar(s) in a grid format to a new pane. You can then exit 
the pane or print the calendar to a printer. 

• Where Used —Displays a submenu of By Jobs or By Calendars. Selecting By Jobs will display a 
report of which jobs are associated with the selected calendar. Selecting By Calendars will display 
a report of which calendars are using the selected calendar, for example, in a subset. 

• Change type to —Change the selected calendar’s type to another type.

• Recalculate —Recalculates the dates for all calendars. Useful if dates have been manually added or 
subtracted from the normal calendar.
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Note When you use the Recalculate feature, any days you have manually added or removed from the 
calendar(s) will be lost. Recalculating calendars do not affect the production schedules that have already 
been created. You must recompile the existing production schedules before the changes can take effect 
in those schedules.

Add Calendar Submenu

When you select Add from the Calendars pane context menu, the Add submenu displays. This menu 
also appears in a context form when you click the Add button on the TES toolbar from the Calendars 
pane.

The following describes the items in the Add Calendars submenu:

• Group —Add a calendar group, combining two or more calendars and including or excluding their 
associated dates.

• List —Add a list calendar to specify any set of non-repeating dates.

• Daily —Add a calendar that repeats at a daily interval that you specify. For example, every 2 days, 
every 3 days, etc. You can also exclude certain days, i.e. Saturday or Sunday, from the calendar.

• Weekly —Add a calendar that repeats at a weekly interval that you specify. For example, once a 
week, every 3 weeks, etc. You can also include the days in the week to run the job, i.e., Monday 
through Friday.

• Monthly with Days —Add a calendar that repeats in the months you specify. For example, January, 
April, July, and October. You also specify on which date(s) of the selected months to run jobs. For 
example, the 1st and the 15th of the specified months.

• Monthly with Weeks —Add a calendar that repeats on the months you specify. For example, 
January and June. You also specify on which day(s) of the selected months to run jobs. For 
example, the first and last Friday of each month. You can also specify offsets to the specified date. 
For example, 3 days before the 1st Monday of each month.

• Subset —Add a new calendar which is a subset of the dates encompassed by existing calendars. You 
can use calendar logic to target the exact dates that you want to include.

Calendar Group Definition Dialog
The Calendar Group Definition dialog displays when you add or edit a calendar group from the 
Calendars pane. 

Common to All

• Calendar Name —The name of the calendar group (up to 60 characters). The name must be unique.

• Owner —The owner of the calendar group. By default, this is the creator of the calendar group. An 
owner can be a TES user or Workgroup.

• Public —The Public option makes the calendar accessible by all TES users within the boundaries 
of their Security Policy. When cleared, only the calendar’s owner can see and use the calendar.
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Details Tab

• Inc/Exc —Lists whether the dates of the calendar or calendar group are to be included in or excluded 
from this calendar group.When TES calculates the calendar, included dates are added first, then 
excluded dates are removed.

Note When using the Inc/Exc calendar group feature, dates that are excluded have priority. If a date has been 
both included and excluded, the final result will be that it is excluded.

• Calendar —A calendar or calendar group to be associated with the calendar group, whether 
included or excluded.

• Include common days only —Includes only the dates that are common to all the calendars selected 
to be part of the calendar group.

• Add —Associates a calendar or calendar group to this calendar group and defines whether the dates 
are included or excluded. 

• Edit —Changes whether to include or exclude the selected calendar’s or calendar group’s dates from 
the calendar group and/or changes the calendar associated with the calendar group.

• Delete —Removes the selected calendar from the calendar group.

Note You can include or exclude individual dates by selecting a listed date and right-clicking to display a 
context menu providing the opposite option for the selected date, e.g., an included date has an Exclude 
option.

Calendar Dialog

The Calendar dialog displays when you click the Edit or Add button in the Details tab of the Calendar 
Group Definition dialog.

This dialog contains the following elements:

• Calendar —Offers a drop-down menu to select the calendar for which the dates are included or 
excluded from the calendar group. Calendar groups cannot be selected.

• Adjust by... days —You can select a positive or negative number to shift the calendar forward or 
backward (respectively) by the specified number.

• Include Dates —Includes the dates of the selected calendar into the calendar group.

• Exclude Dates —Excludes the dates of the selected calendar into the calendar group.

Note Exclude Dates takes precedence over Include Dates. For example, if “Calendar A” contains January 
3rd - 6th and is included, and “Calendar B” contains January 5th and is excluded, the resulting calendar 
group will contain January 3rd, January 4th and January 6th.

Conditions Tab

This tab contains the following elements:
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• If conflicts with —The If Conflicts With column works in tandem with the Action field. If 
conflicts with means “if a date matches.” In other words, if the calendar definition you are working 
with (the one named in the Calendar Name field) includes dates that are the same as those in 
another calendar that you specify, then you can take the action specified in the Action field.

• Action —The Action column works in tandem with the If Conflicts With field. In this field, you 
specify the action to take if a date included in the calendar definition you are working with (the one 
named in the Calendar Name field) conflicts with (is the same as) those in the calendar you specify 
in the If Conflicts With field.

• Add —Displays the Condition dialog to add a condition (to select an If Conflicts With calendar 
and an action to take). For more information about the Condition dialog, see “Condition Dialog” 
procedure on page 10-318. 

• Edit —Displays the Condition dialog to change the specifications of the selected condition. For 
more information about the Condition dialog, see “Condition Dialog” procedure on page 10-318

• Delete —Removes the selected condition from the calendar group definition.

Forecast Tab

Displays the dates in the calendar that were automatically generated using the settings configured on the 
Details tab. Dates that appear in red text on the Forecast tab are part of the calendar and are listed in the 
Selected Dates field. Dates in black text are not part of the calendar. Calendar dates can be added or 
removed from the calendar by double-clicking that date on the displayed Calendar tab (except on subset 
calendars). 

This tab contains the following elements:

• Calendar Section —Displays the forecasted dates in a calendar format for the calendar. The title 
bar displays the day, month and year of the present calendar view. Forecasted dates are displayed in 
red.

• Calendar control bar —Changes the month that displays in the Calendar section. The outer 
buttons move the dates in one-year increments. The inner buttons move the dates in one-month 
increments.

• Selected Dates Section —Displays a forecast of dates that are generated from the Details tab.

Selected Dates Context Menu

When you right-click in the Selected Dates section of the Forecast tab in any calendar definition dialog, 
the Selected Dates context menu displays. 

• Delete —Deletes only the date highlighted in the selected dates section.

• Delete All —Deletes all the dates in the selected dates section.

Note The Forecast tab data is regenerated every time there is a change to the Details tab of the calendar 
definition. Therefore, if you add or remove dates through the Forecast tab, then make further changes 
from the Details tab, your original edits (from the Forecast tab) will be lost.

Description Tab

Description —A free text field for up to 255 characters (optional).
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List Calendar Definition Dialog
The List Calendar Definition dialog displays when you add or edit a List calendar.

Common to All

• Calendar Name —The name of the calendar (up to 60 characters). The name must be unique.

• Owner —The owner of the calendar. By default, this is the creator of the calendar. An owner can be 
a TES user or workgroup.

• Public —The Public option makes the calendar accessible to all TES users within the boundaries 
of their Security Policy. When cleared, only the calendar’s owner can see and use the calendar.

Details Tab

The Details tab (Figure 10-10) contains the following elements:

• Calendar Section —Displays the forecasted dates in a calendar format for the calendar group. The 
title bar displays the day, month, and year of the present calendar view. Forecasted dates are 
displayed in red.

• Calendar control bar —Changes the month that displays in the Calendar section. The outer 
buttons move the dates in one-year increments. The inner buttons move the dates in one-month 
increments.

• Selected Dates Section —Displays a forecast of dates that are generated from the Details tab.

• Delete —Deletes dates that are selected in the Selected Dates section.

Description Tab

Description —A free text field for up to 255 characters (optional).

Daily Calendar Definition Dialog
The Daily Calendar Definition dialog displays when you add or edit a Daily calendar.

Common to All

• Calendar Name —The name of the calendar (up to 60 characters). The name must be unique.

• Owner —The owner of the calendar. By default, this is the creator of the calendar. An owner can be 
a TES user or workgroup.

• Starting on —Sets the starting date by which the dates are automatically selected for the calendar. 
Any dates before the starting date are not selected. Though the forecast is limited to a finite period, 
the calendar has no ending date. TES calculates calendars for the remainder of the current year, plus 
three more years.

• Public —The Public option makes the calendar accessible to all TES users within the boundaries 
of their security policy. When cleared, only the calendar’s owner can see and use the calendar.
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Details Tab

The Details tab (Figure 10-10) contains the following elements:

• Frequency —Sets the frequency in days by which the days are automatically selected for the 
calendar.

• Include the following days —Includes the selected days of the week in the date generation process. 
Excluded days will not be used as production dates, but will be counted during calendar calculation. 
When the calendar production date is calculated to fall on an excluded day of the week, the date 
generation process chooses the next included day and restarts the count starting from that day.

For example: 

If you set the frequency to 2 days, starting Monday, and exclude Saturday and Sunday, you will get 
Mon, Wed, Fri, (Sun skipped, go to next available day) 

Mon (reset count), Wed, ‚Ä¶. 

– Although Saturday and Sunday were excluded days of the week, they were counted during date 
generation. 

– Because Saturday and Sunday were excluded, when the next calendar production date was 
calculated as Sunday, the next non-excluded day of the week (Monday) was selected. 

– Since the count for date generation is restarted after an excluded day is skipped, the next 
calendar date was Wednesday.

Conditions Tab

Refer to the Conditions tab for a group calendar on page 310 for a description of the fields on this tab.

Forecast Tab

Refer to the Forecast tab for a daily calendar on page 311 for a description of the fields on this tab.

Description Tab

Description —A free text field for up to 255 characters (optional).

Weekly Calendar Definition Dialog
The Weekly Calendar Definition dialog displays when you add or edit a weekly calendar.

Common to All

• Calendar Name —The name of the calendar (up to 60 characters). The name must be unique.

• Owner —The owner of the calendar. By default, this is the creator of the calendar. An owner can be 
a TES user or Workgroup.

• Starting on —Sets the starting date by which the dates are automatically selected for the calendar. 
Any dates before the starting date are not selected. Though the forecast is limited to a finite period, 
the calendar has no ending date.
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• Public —The Public option makes the calendar accessible by all TES users within the boundaries 
of their Security Policy. When cleared, only the calendar’s owner can see and use the calendar.

Details Tab

The Details tab contains the following elements:

• Frequency —Sets the frequency in weeks by which the dates are automatically selected for the 
calendar.

• Include the following days —Sets the days of the week that should be included in the automatic 
week selection. The job repeats on each day selected.

Conditions Tab

Refer to the Conditions tab for a group calendar on for a description of the fields on this tab.

Forecast Tab

Refer to the Forecast tab for a daily calendar on for a description of the fields on this tab.

Description Tab

Description —A free text field for up to 255 characters (optional).

Monthly Calendar with Days Definition Dialog
The Monthly Calendar Definition dialog displays when you add or edit a monthly calendar with days.

Common to All

• Calendar Name —The name of the calendar (up to 60 characters). The name must be unique.

• Owner —The owner of the calendar. By default, this is the creator of the calendar. An owner can be 
a TES user or Workgroup.

• Starting On —Sets the starting date by which the dates are automatically selected for the calendar. 
Any dates before the starting date are not selected. Though the forecast is limited to a finite period, 
the calendar has no ending date.

• Public —The Public option makes the calendar accessible to all TES users within the boundaries 
of their Security Policy. When cleared, only the calendar’s owner can see and use the calendar.

Details Tab

The Details tab contains the following elements:

• Months —Select the months for which the calendar will generate dates.

• Days in Month —Select specific date occurrences in the month(s) for which the calendar will 
generate dates.
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Note You must have months selected in the Months section with corresponding dates selected in the Days in 
Month section in order to automatically generate the dates.

Monthly Calendar Definition Context Menu

The Monthly Calendar Definition dialog context menu displays when you right-click the Details tab of 
the Monthly Calendar with Days Definition and the Monthly Calendar with Weeks Definition dialogs.

This context menu contains the following options:

• Select All Months —Selects all months in the Months section of the Details tab.

• Clear All Months —Clears all months in the Months section of the Details tab.

• Select All Days —Selects all days in the Dates in Month (or Days in Week) section of the Details 
tab.

• Clear All Days —Clears all days in the Dates in Month (or Days in Week) section of the Details 
tab.

Conditions Tab

Refer to the Conditions tab for a group calendar on page 310 for a description of the fields on this tab.

Forecast Tab

Refer to the Forecast tab for a daily calendar on page 311 for a description of the fields on this tab.

Description Tab

Description —A free text field for up to 255 characters (optional).

Monthly Calendar with Weeks Definition Dialog
The Monthly Calendar with Weeks Definition dialog displays when you add or edit a monthly calendar 
with weeks.

Common to All

• Calendar Name —The name of the calendar (up to 60 characters). The name must be unique.

• Owner —The owner of the calendar. By default, this is the creator of the calendar. An owner can be 
a TES user or workgroup.

• Starting On —Sets the starting date by which the dates are automatically selected for the calendar. 
Any dates before the starting date are not selected. Though the forecast is limited to a finite period, 
the calendar has no ending date.

• Public —The Public option makes the calendar accessible by all TES users within the boundaries 
of their security policy. When cleared, only the calendar’s owner can see and use the calendar.
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Details Tab

The Details tab allows you to control how to automatically generate dates for the calendar.

This tab contains the following elements:

• Months —Allows you to choose the months for which the calendar generates dates.

• Days in Week —Choose the days of the week for which the calendar generates dates. 

• Occurrence —Choose which occurrence(s) of the days selected in the Days in Week section for 
which the calendar will generate dates. For example, if January is selected in the Months section, 
Monday is selected in the Days in Week section, and 1st is selected in the Occurrence section, the 
resultant set will be the first Monday in January.

• Adjust By—Allows you to shift the resultant date set forward or backward by the amount shown in 
this field. You can adjust dates forward and backward up to 31 days.

Note You must have a month(s) selected in the Months section, with a corresponding day(s) selected in the 
Days in Week section, and an occurrence(s) selected in the Occurrences section in order to 
automatically generate dates.

Monthly Calendar Definition Context Menu

The Monthly Calendar Definition dialog context menu displays when you right-click the Details tab of 
the Monthly Calendar with Days Definition and the Monthly Calendar with Weeks Definition dialogs. 

This context menu contains the following options:

• Select All Months —Selects all months in the Months section of the Details tab.

• Clear All Months —Clears all months in the Months section of the Details tab.

• Select All Days —Selects all days in the Dates in Month (or Days in Week) section of the Details 
tab.

• Clear All Days —Clears all days in the Dates in Month (or Days in Week) section of the Details 
tab.

Conditions Tab

Refer to the Conditions tab for a group calendar on page 310 for a description of the fields on this tab.

Forecast Tab

Refer to the Forecast tab for a daily calendar on page 311 for a description of the fields on this tab.

Description Tab

Description —A free text field for up to 255 characters (optional).
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Calendar Subset Definition Dialog

Common to All

• Calendar Name —The name of the calendar (up to 60 characters). The name must be unique.

• Owner —The owner of the calendar. By default, this is the creator of the calendar. An owner can be 
a TES user or workgroup.

• Starting On —Sets the starting date by which the dates are automatically selected for the calendar. 
Any dates before the starting date are not selected. Though the forecast is limited to a finite period, 
the calendar has no ending date.

• Public —The Public option makes the calendar accessible by all TES users within the boundaries 
of their security policy. When cleared, only the calendar’s owner can see and use the calendar.

Details Tab

The Details tab allows you to control how to automatically generate dates for the calendar.

This tab contains the following elements:

• Occurrence —From the Occurrence drop-down menu, select the instance of the dates of the 
calendar that you want to use. For example, if you want to use all the days this calendar includes, 
select Every.

• Calendar —Select the calendar for which this calendar will be a subset. The drop-down menu lists 
all available calendars.

• Time Frame —From the Time Frame field, you can select the exact time period for your subset 
calendar to run. For example, you can select the 13th week, or the month of March.

• Based on Fiscal —If you have any Fiscal calendars defined, they are listed and available from the 
Based on Fiscal field drop-down menu.

• Adjust by... days —The number of days by which to shift the new calendar you created forward 
(positive numbers) or backward (negative numbers).

Note With subsets, it is important that the source calendar include historic dates where necessary. For 
example: If you create a calendar called Daily that includes every day of the week, by default that 
calendar starts today. If you then create a subset that is the 1st Daily of the quarter, the first date in the 
current quarter ends up being today, since that is the first date in the calendar Daily. In this example, it 
is necessary to modify Daily's starting date to January 1.

Conditions Tab

Refer to the Conditions tab for a group calendar on page 310 for a description of the fields on this tab.

Forecast Tab

Refer to the Forecast tab for a daily calendar on page 311 for a description of the fields on this tab.
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Description Tab

Description —A free text field for up to 255 characters (optional).

Condition Dialog
The Condition dialog displays when you add or edit a condition from the Conditions tab of any calendar 
definition dialog.

This tab contains the following elements:

• If conflicts with calendar —Offers a drop-down menu listing all available calendars.

• Take action —The Take action field offers a drop-down menu with the following possible actions:

– Skip —Skips this date. Essentially, if there is a conflict between the two calendars, skip the date 
and do not take any action.

– Previous Day —Use the previous date before the conflicted date.

– Next Day —Use the next date after the conflicted date.

– Closest Calendar —Selects the date in the calendar specified in the Calendar field that is 
closest to the conflicted date, whether the date occurs before or after the conflicted date. A 
calendar offset can also be specified.

– Previous Calendar —Selects the date in the calendar specified in the Calendar field that 
occurs previous to the conflicted date. A calendar offset can also be specified.

– Next Calendar —Selects the date in the calendar selected in the Calendar field that next occurs 
after the conflicted date. A calendar offset can also be specified.

Note The Closest Day, Previous Day and the Next Day action options only apply to a specific day within a 
conflicting calendar-not to the entire calendar. If there is a conflict with more than one day within the 
calendar, you must individually apply the appropriate action to each day that conflicts with the calendar.

• Calendar —The first field can optionally be used to select the number of days to offset the calendar 
selected in the second field. The second field displays a drop-down list of available calendars to be 
used in conjunction with the Closest Calendar, Previous Calendar and Next Calendar options of 
the Take Action field.

Calendar Procedures

Adding a Calendar

To add a calendar:

Step 1 From the Navigator pane, select Definitions>Calendars to display the Calendars pane.

Step 2 Click the Add button on the TES toolbar or right-click and select Add Calendar from the context menu. 

Step 3 Select the type of calendar you want to add, then follow the instructions for editing a calendar in “Editing 
Calendars” section on page 10-320. For more information about a specific type of calendar, see its 
definition dialog description:
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– List Calendar — For more information about list calendars, see “List Calendar Definition 
Dialog” section on page 10-312.

– Daily Calendar —For more information about daily calendars, see “Daily Calendar Definition 
Dialog” section on page 10-312.

– Weekly Calendar —For more information about weekly calendars, see “Weekly Calendar 
Definition Dialog” section on page 10-313.

– Monthly Calendar with Days —For more information about monthly calendars with days, see 
“Monthly Calendar with Days Definition Dialog” section on page 10-314.

– Monthly Calendar with Weeks —For more information about monthly calendars with weeks, 
see “Monthly Calendar with Weeks Definition Dialog” section on page 10-315.

– Subset Calendar —For more information about subset calendars, see “Calendar Subset 
Definition Dialog” section on page 10-317.

Editing Calendar Groups

A calendar group is a combination of individual calendars each of which have their dates either included 
into or excluded from the group. The calendar group can then be used for scheduling jobs just like any 
other calendar. 

When combining calendars in a calendar group, date exclusions always take precedence over date 
inclusions. For example, if in one calendar in a calendar group you include the days Monday - Friday, 
and in another, you exclude the days Tuesday, Wednesday, and Thursday, the calendar group’s final set 
of run dates will be Monday and Friday. 

To edit a calendar group:

Step 1 From the Navigator pane, select Definitions>Calendars to display the Calendars pane.

Step 2 Double-click the calendar you want to edit or select the calendar and click the Edit button or right-click 
the calendar and select Edit Calendar from the context menu. 

Step 3 To make the calendar public, select the Public option. Public calendars can be used by all TES users, 
within the restrictions of their Security Policy.

Step 4 To add a calendar to your calendar group:

a. Click the Details tab.

b. Click Add to display the Calendar dialog.

c. From the Calendar field drop-down menu, select the calendar to add to your calendar group.

d. After selecting a calendar, click either:

Include Calendar to include the dates in the selected calendar into the calendar group.

Exclude Calendar to exclude the dates in the selected calendar from the calendar group.

e. Click OK. The calendar is now a part of the calendar group.

Step 5 Edit a calendar in your calendar group:

a. Select the calendar to edit in the Details tab.

b. Click the Edit button to display the Calendar dialog.
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c. From the Calendar field drop-down menu, select the calendar to associate with your calendar 
group.

d. After selecting a calendar, click either:

Include Calendar to include the dates in the selected calendar into the calendar group.

Exclude Calendar to exclude the dates in the selected calendar from the calendar group.

e. Click OK. 

Step 6 Click the Conditions tab and set any conditions you want to place on your calendar group. For more 
information about conditions, see “Condition Dialog” section on page 10-318.

Step 7 Click the Forecast tab to see the resultant dates for the calendar group are shown. 

Note You cannot add or delete unique dates from the Calendar Group Definition dialog. To add or delete 
special dates, do so in the calendar’s individual calendar definition dialog. The group will automatically 
reflect the updates.

Step 8 Click the Description tab. You can add or edit a description for the calendar group (up to 255 characters).

Editing Calendars 

Note Whenever you edit a calendar that has already been assigned to a job, or is being used by another 
calendar (for example, as a subset) you will be presented with a warning message informing you that the 
calendar is in use.
When you modify a calendar assigned to a job, the Effective Date dialog displays providing options for 
when the changes to the already compiled production schedule should take effect. You can select a date 
during the current production schedule for the calendar changes to take effect or let the changes occur 
during a manual or automatic compilation.

To edit a calendar:

Step 1 From the Navigator pane, select Definitions>Calendars to display the Calendars pane.

Step 2 Double-click the calendar you want to edit or select the calendar and click the Edit button or right-click 
the calendar and select Edit Calendar from the context menu. 

Step 3 Type the name of the calendar in the Calendar Name field (up to 60 characters). The name must be 
unique.

Step 4 To make the calendar public, select the Public option. Public calendars can be used by all TES users, 
within the restrictions of their Security Policy.

Step 5 Select dates for a calendar:

a. Use the calendar control bar to select the month for which to add or delete dates.

b. The outer buttons move the calendar in one year increments.

c. The inner buttons move the calendar in one month increments.

d. Double click the dates in the calendar section to select and deselect the dates for your calendar. 
The date cell text turns red, and the date appears in the Selected Dates section.
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Step 6 Remove dates from a calendar:

a. Click the Details tab.

b. Select the date to remove from the Selected Dates section.

c. Click Delete. The date moves back to the Calendar section and the date cell text turns black.

Note This option is not available for subset calendars.

Step 7 Specify repetition in weeks for a calendar (weekly calendar only):

a. Click the Details tab.

b. In the Frequency drop-down menu, select the frequency of the interval (in weeks).

c. In the Starting On field, type the date that the interval starts.
A seven-day period begins on the date you specify. For example, if you select an interval of 
every two weeks, starting on Wednesday of this week, and include Monday through Friday, you 
will get Wednesday through Friday of this week, and Monday and Tuesday of next week, which 
completes the seven day period. The seven-day period is then repeated every other Wednesday. 
(You can select a starting date from the calendar pane.) The calendar has no ending date.

d. In the Include the following days section, select the days to include in the seven day period.

Step 8 Specify common monthly dates for a calendar:

a. Click the Details tab.

b. In the Months section, select the months when the job should run.

c. In the Days in Month section, select the dates in the month(s) when the job should run.

Step 9 Specify repetition in months for a calendar (monthly with weeks):

a. Click the Details tab. 

b. In the Months section, select the months when the job should run.

c. In the Days in Week section, select the days of the week when the job should run.

d. In the Occurrence section, select the occurrence for the day(s) selected. For example, 2nd 
means the second time the day(s) selected in the Days of Week section occurs in the month.

e. In the Adjust by field, select the number of days by which to offset all the dates forecasted. For 
example, three days after the last Friday of each month. If the last Friday is the 31st, the job will 
run on the 3rd day of the next month.

f. Click the Forecast tab. The results of the computation from the specification made on the 
Details tab are shown.

Step 10 Set the Details tab for a subset calendar:

a. From the Occurrence drop-down menu, select the instance of the dates of the calendar that you 
want to use. For example, if you want to use all the days this calendar includes, select Every.

b. From the Calendar field drop-down menu, select the calendar for which this calendar will be a 
subset. The drop-down menu lists all available calendars.

c. From the Time Frame field, select the exact time period for your calendar to run. For example, 
you can select the 13th week or the month of March.

d. If you want to base your list calendar on a fiscal calendar, you must already have a fiscal 
calendar defined. If you have any fiscal calendars defined, they will be listed and available from 
the Based on Fiscal field drop-down menu.
10-321
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 10      Controlling Production
  Calendars Interface
e. In the Adjust by... days field, you select the number of days, if any, by which to shift the list 
calendar forward (positive numbers) or backward (negative numbers). 

Step 11 Click the Conditions tab, and set any conditions you want to place on your calendar. For more 
information about conditions, see “Condition Dialog” section on page 10-318.

Step 12 To type a description for the calendar, click the Description tab. You can add or edit a description for 
the calendar (up to 255 characters).

Deleting Calendars

You can delete a calendar that is no longer in use. You cannot delete a calendar that is associated with a 
job. Before deleting a calendar, you must first verify that the calendar is not associated with any jobs.

To delete a calendar:

Step 1 From the Navigator pane, select Definitions>Calendars to display the Calendars pane.

Step 2 Ensure that the calendar can be deleted. 

a. Right-click the calendar you want to delete and select Where used from the context menu to 
display the Jobs Using pane.

b. If an information dialog confirms that no jobs use the calendar you can delete the calendar. 
If the calendar is used in any jobs, a Jobs Using Calendar report displays that lists the jobs that 
use that calendar.

c. Go to the jobs listed in the Jobs Using Calendar report and change the calendar the job uses.

Step 3 When no jobs are using the calendar, right-click the calendar and select Delete Calendar from the 
context menu or select the calendar and either press the DELETE key on your keyboard or click the Delete 
button on the TES toolbar.

Step 4 Click Yes at the Confirmation prompt to delete the calendar.

Determining Which Jobs are Using a Specific Calendar

You can determine which jobs are presently using a calendar. The jobs do not have to be in the production 
schedule.

To determine which jobs are using a specific calendar:

Step 1 From the Navigator pane, select Definitions>Calendars to display the Calendars pane.

Step 2 Right-click the calendar and select Where Used from the context menu

Step 3 Choose either By Jobs or By Calendars. 

Step 4 In the Information pane, click OK.

Viewing Calendars

To view a calendar:
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From the Navigator pane, select Definitions>Calendars to display the Calendars pane. This pane 
displays all the calendars that are Public, owned by you and owned by workgroups to which you belong.

Viewing Calendar Dates

To view calendar dates:

Step 1 From the Navigator pane, select Definitions>Calendars to display the Calendars pane.

Step 2 Double-click the calendar to view, or right-click and select Edit Calendar from the context menu.

Step 3 If the calendar is a list calendar, the dates appear in the Details tab of the definition dialog. Otherwise, 
the dates appear in the Forecast tab.

Fiscal Calendar Pane
Many companies start their financial (fiscal) year on a date other than January 1. They may also have 
more than one fiscal calendar, for example, one calendar for the accounting department and one calendar 
for the operations department. 

TES’s fiscal calendar functionality allows you to set up one or multiple fiscal calendars. You can then 
use a fiscal calendar as a base for subsequent calendars that you create, instead of basing your calendars 
on the January-December year.

Fiscal Calendar Interface
From the Navigator pane, select Definitions>Fiscal Calendars to display the Fiscal Calendars pane.

Buttons
• Add Fiscal Calendar —Displays the Fiscal Calendar Definition dialog to add a fiscal calendar.

• Edit Fiscal Calendar —Displays the Fiscal Calendar Definition dialog to edit a fiscal calendar.

• Copy Fiscal Calendar —Creates a copy of the selected calendar with the same information as the 
selected calendar, except for the name.

• Delete Fiscal Calendar —Removes the fiscal calendar definition from the TES database.

• Refresh —Updates the data in the current pane.

• Print —Displays the Reports pane to view and print your fiscal calendars. For more information, 
see “Monitoring Production” section on page 11-361.

Search Field
Enter text that you want to search for within the columns displayed into this field.
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Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See “Searchable Columns” section on page 2-35.

Columns
• Name —The name of the fiscal calendar.

• Starting Month —The month that begins your fiscal calendar year.

• Starting Day —The day of the month that begins your fiscal calendar.

• Quarter Breakdown —The quarterly divisions of your fiscal calendar.

Fiscal Calendars Preferences Dialog
If you select Preferences from the View main menu while viewing the Fiscal Calendars pane, the Fiscal 
Calendars Preferences dialog displays.

From this dialog, you can select which columns will be visible in the Fiscal Calendars pane and in what 
order they will be displayed.

Navigator Context Menu
When you right-click in the Navigator pane while viewing the Fiscal Calendars pane, the Navigator 
context menu displays. 

The Fiscal Calendars Navigator context menu contains the following options:

• Add Fiscal Calendar —Displays the Fiscal Calendar Definition dialog to add a new fiscal 
calendar. Has the same function as the Add Fiscal Calendar button.

• Preferences —Displays the Preferences dialog for the Fiscal Calendars pane.

• Print —Displays the Reports pane to view and print your fiscal calendar definitions. Has the same 
function as the Print button on the toolbar. For more information, see “Monitoring Production” 
section on page 11-361.

• Export —Saves the data in the current pane as an ASCII text file. You can then use the file data in 
other applications. 

• Refresh —Updates the data in the current pane.

Fiscal Calendar Pane Context Menu

When you right-click in the Fiscal Calendar pane, the Fiscal Calendar pane context menu displays. 

The Fiscal Calendar pane context menu contains the following options:

• Add Fiscal Calendar —Displays the Fiscal Calendar Definition dialog to add a new fiscal 
calendar.

• Edit Fiscal Calendar —Displays the Fiscal Calendar Definition dialog to edit an existing fiscal 
calendar. You can change the dates, whether the calendar is public, and/or the name of the selected 
calendar. 
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• Delete Fiscal Calendar —Deletes the fiscal calendar selected.

• Modify Fiscal Year —Displays the Fiscal Year Definition dialog to change the fiscal year. You can 
select which quarter to add a week to and change how the quarter is broken down.

• Print —Displays the Reports pane to view and print your fiscal calendar definitions. For more 
information, see “Monitoring Production” section on page 11-361. 

Fiscal Calendar Definition Dialog
The Fiscal Calendar Definition dialog displays when you add or edit a fiscal calendar from the Fiscal 
Calendars pane.

This dialog contains the following elements:

• Fiscal Calendar Name —The name of your fiscal calendar here.

• Fixed Start —Checking this box ensures that the fiscal year always starts on the same date. Since 
a 4-4-5 quarter adds up to 91 days and 91 x 4 (quarters) = 364 days, the following fiscal year would 
begin a day early without an additional day being included. Checking this option also accounts for 
the additional day during leap years.

• If Fixed Start is not selected (specifying rolling fiscal or no fixed start), then the Effective Year 
option becomes available.

• Effective Year —This is a read-only field and automatically defaults to the previous year. Effective 
Year is to allow for the year 2000 dates when compiling calendars that use fiscal years.

• Starting Month —The month when your fiscal calendar begins.

• Starting Day —The day of the month when your fiscal calendar begins.

• Quarter Breakdown (Weeks in each month of quarter) —The number of weeks in each month of 
each fiscal quarter. A quarter has three months with one month consisting of 5 weeks and the other 
two months containing four weeks. You can rearrange the sequence of the weeks within the quarter.

The default for the Quarter Breakdown field is 4-4-5. The 4-4-5 value indicates: 

– There are 4 weeks in the first month of a quarter.

– There are 4 weeks in the second month of a quarter.

– There are 5 weeks in the last month of a quarter.

This adds up to 13 weeks per quarter: 13 weeks x 4 (quarters) = 52 weeks (one year).

Fiscal Calendar Procedures

Adding Fiscal Calendars

To add a fiscal calendar:

Step 1 From the Navigator pane, select Definitions>Fiscal Calendars to display the Fiscal Calendars pane.

Step 2 Click the Add button on the TES toolbar or right-click and select Add Fiscal Calendar from the context 
menu. 
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Step 3 The Fiscal Calendar Definition dialog appears. For more information about the Fiscal Calendar 
Definition dialog, see “Fiscal Calendar Definition Dialog” section on page 10-325.

Editing Fiscal Calendars

To edit a fiscal calendar

Step 1 From the Navigator pane, select Definitions>Fiscal Calendars to display the Fiscal Calendars pane.

Step 2 Select the calendar to edit and click the Edit button on the TES toolbar or right-click the calendar and 
select Edit Fiscal Calendar from the context menu to display the Fiscal Calendar Definition dialog.

For more information about the Fiscal Calendar Definition dialog, see “Fiscal Calendar Definition 
Dialog” section on page 10-325.

Editing the Fiscal Year

If the Fixed Start option is not selected for a fiscal calendar, the fiscal year must be modified to correct 
calendar progression. To compensate for the annual loss of a day (two days during leap year), a week 
must be added to one of the fiscal years. 

To edit a fiscal year:

Step 1 From the Navigator pane, select Definitions>Fiscal Calendars to display the Fiscal Calendars pane.

Step 2 Select one of the fiscal calendars and right-click to display a context menu. 

Step 3 Select Modify Fiscal Year to display the Fiscal Year Definition dialog.

Viewing Fiscal Calendars

To view a fiscal calendar, from the Navigator pane, select Definitions>Fiscal Calendars to display the 
Fiscal Calendars pane.

Job Classes Pane 
Job classes are used to organize and group jobs into categories. Job classes can be used in a queue’s filter 
to ensure that only jobs belonging to that class will run in that queue. This lets you control how jobs of 
a certain class run. 

For example, if you had a set of payroll jobs and a set of manufacturing jobs, you could categorize those 
jobs (and job groups) into a Payroll job class and a Manufacturing job class. Define two queues: one 
that only accepts jobs in the Payroll job class and one that only accepts jobs in the Manufacturing job 
class. 

If the Manufacturing jobs have a higher priority than the payroll jobs, you can set the manufacturing 
queue’s Queue Priority to a higher value than the Payroll queue. 
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Note If you assign a job class to a job group, all child jobs within that job group without an assigned job class 
are automatically assigned the group’s job class.

You can also associate job events to a designated job class so that those job events will apply to all 
members of the job class. The sequential order of these job events that are assigned to the job class can 
also be managed. The timing of the job events for the job class can divided into those job events that 
occur before and after the job’s individual job events. The sequence of these job class events that occur 
before and after can also be arranged in the order needed.

Job classes cannot be owned by any particular user or workgroup and do not have a Public option since 
they are intrinsically public; that is, available to all TES users. Anyone can use job classes unless their 
security policy expressly prohibits it.

TES does not provide any pre-defined or default job classes.

Job Classes Interface
From the Navigator pane, select Definitions>Job Classes to display the Job Classes pane.

Buttons
• Add Job Class —Displays the Job Class Definition dialog to add a new job class.

• Edit Job Class —Displays the Job Class Definition dialog to edit an existing job class definition.

• Copy Job Class —Creates a copy of the selected job class with the same information as the selected 
job class, except for the name.

• Delete Job Class —Removes the selected job class definition from the TES database.

• Print —Displays the Reports pane to view and print your job class definitions. For more 
information, see “Monitoring Production” section on page 11-361.

• Refresh —Updates the data in the current pane.

Search Field
Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See “Searchable Columns” section on page 2-35.

Columns
• Name —The name of the job class.

• Description —The description of the job class. Since the Description field of the Job Class 
Definition dialog is optional, this column may remain blank.

• Modified —The last time the job class definition was modified.
10-327
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 10      Controlling Production
  Job Classes Interface
Job Classes Preferences Dialog
If you select Preferences from the View main menu while viewing the Job Classes pane, the Job Classes 
Preferences dialog displays.

From this dialog, you can select which columns are displayed in the Job Classes pane and in what order 
they appear.

• A checkmark to the left of a column title indicates that it will be displayed in the pane. No 
checkmark indicates that it will not be displayed.

• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.

Navigator Context Menu
When you right-click in the Navigator pane while viewing the Job Classes pane, the Navigator context 
menu displays. 

The Job Classes Navigator context menu contains the following elements:

• Add Job Class —Displays the Job Class Definition dialog to add a new job class. Has the same 
function as the Add Job Class button. 

• Preferences —Displays the Preferences dialog for the Job Classes pane.

• Print —Displays the Reports pane to view and print your job class definitions. Has the same 
function as the Print button on the toolbar. For more information, see “Monitoring Production” 
section on page 11-361.

• Export —Saves the data in the current pane as an ASCII text file. You can then use the file data in 
other applications. 

• Refresh —Updates the data in the current pane.

Job Classes Pane Context Menu
When you right-click in the Job Classes pane, the Job Classes pane context menu displays. 

The Job Classes pane context menu contains the following options:

• Add Job Class —Displays the Job Class Definition dialog to add a new job class. 

• Edit Job Class —Displays the Job Class Definition dialog to edit an existing job class. 

• Delete Class —Deletes the selected job class definition. 

• Print —Displays the Reports pane to view and print your job class definitions. For more 
information, see “Monitoring Production” section on page 11-361

Job Class Definition Dialog
The Job Class Definition dialog displays when you add or edit a job class.

This dialog contains the following elements:

• Job Class Name —The name of the job class (up to 60 characters). The name must be unique.
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• Before tab —Lists the job events that must occur before the job instance’s own job events. You 
arrange the order of the job events listed here to specify the sequence that the job events should 
follow.

• After tab —Lists the job events that must occur after the job instance’s own job events. You arrange 
the order of the job events listed here to specify the sequence that the job events should follow.

The following fields are available on both tabs.

• Event Name column —The name assigned to the job event.

• Event Trigger column —The condition that triggers the associated job event. 

• Insert —This button displays the Select Job Event dialog where you can select one or more 
predefined job events to assign to the job class. Job events are created from the Job Events pane. 

• Edit —This button displays the Job Event Definition dialog to modify the selected job event.

• Delete —This button removes the selected job event from the list.

• Clear —This button deletes all of the defined job events clearing the field.

• Move Up —This button moves the selected job event up in the sequence of job events.

• Move Down —This button moves the selected job event down in the sequence of job events.

• Description —This tab is used to enter a description of the job class and its purpose.

Job Classes Procedures

Adding Job Classes

To add a job class:

Step 1 From the Navigator pane, select Definitions>Job Classes to display the Job Classes pane.

Step 2 Right-click and select Add Job Class from the context menu or click the Add button on the TES toolbar 
to display the Job Class Definition dialog.

Step 3 In the Job Class field, type a name for your job class. This is the name that you refer to when assigning 
a job class in the Job Definition or Job Group Definition dialog.

Step 4 Associate job events with a job class by clicking Insert on the Job Events tab to display the Select Job 
Event dialog and the defined job events. You can designate that these job events run before or after the 
job’s own job events. Use the Move Up or Move Down buttons to arrange the sequence that the job 
events should run. 

Step 5 Type a description of the job class in the Description field (optional).

Deleting a Job Class

You cannot delete a job class that is presently in use by a job.

To delete a job class:

Step 1 From the Navigator pane, select Definitions>Job Classes to display the Job Classes pane.
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Step 2 Right-click the job class and select Delete Job Class from the context menu or select the job class to 
delete and click the Delete button on the TES toolbar.

Editing a Job Class

To edit a job class:

Step 1 From the Navigator pane, select Definitions>Job Classes to display the Job Classes pane.

Step 2 Double-click the job class whose properties you want to view, or select the job class and click the Edit 
button or right-click the job class and select Edit Job Class from the context menu to display the Job 
Class Definition dialog.

Step 3 In the Job Class field, you can edit the name of the job class. This is the name that you refer to when 
assigning a job class in the Job Definition or Job Group Definition dialog.

Step 4 Edit the description of the job class in the Description field (optional).

Viewing the Properties of a Job Class

To view the properties of a job class:

Step 1 From the Navigator pane, select Definitions>Job Classes to display the Job Classes pane.

Step 2 Double-click the job class whose properties you want to view, or select the job class and click the Edit 
button or right-click the job class and select Edit Job Class from the context menu.

Viewing Job Classes

Job classes are displayed in the Job Classes pane using a three-column table in alphabetical order. Job 
classes can also be viewed from the Job or Job Group Definition dialogs when assigning a job class to 
a job or job group.

From the Navigator pane, select Definitions>Job Classes to display the Job Classes pane.

Resources Pane
Jobs often require external resources to run to completion. The term, resources, can be used to refer to 
any physical or virtual asset that is used during the processing of a job. This resource may be a piece of 
hardware such as a printer or it may be software like a database. Agents and queues are also considered 
resources that are used during the processing of a job. By officially designating an asset as a resource, 
the use of that resource can be quantified to limit how many jobs can use it at once. 
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It is important to remember that a resource can still be used in TES even if it is not designated as a 
resource. Designating something as a resource is just a more effective way to manage access to it. While 
multiple jobs can use the same resource at the same time, a numerical limit is imposed on the resource 
during its definition to restrict access by quantifying how much of the resource is available to each 
individual job.

While a job can still use an asset even if it is not specifically assigned to it, access management of that 
asset is bypassed. The purpose of designating an asset as a resource is to prevent the resource from being 
overwhelmed by simultaneous demand from multiple jobs and to impose order on the use of the resource. 
Once an asset is defined as a resource the operator should ensure that the resource is assigned to all jobs 
that need that resource to ensure that proper management of the resource is enforced. Jobs that use the 
resource without the constraints imposed by resource management negate the benefits gained from this 
feature and receive the lowest priority for access. 

If a resource is assigned to a job then that job cannot run without the resource. The resource is managed 
by imposing a limit to the number of jobs that can simultaneously use it, ensuring a more efficient 
allocation of the resource. A job with an assigned resource is guaranteed the use of that resource until 
the job completes. When the job runs, it locks up its share of the resource so that no other job can use 
that portion of the resource until the job is done. When the job completes, its share of the resource is 
released for other jobs to use. While a job can have multiple resources assigned to it, the job cannot run 
until all of the resources assigned to it are available. None of the resources are locked up by the job until 
all of the resources are available and the job can run. This “all or nothing” approach prevents resources 
from being tied up needlessly if they cannot be used. 

Note If you assign a job class to a job group, all child jobs within that job group without an assigned job class 
are automatically assigned the group’s job class.

System inefficiencies are created when too many jobs try to use a resource at the same time. Assigning 
a specific amount of a defined quantity of a resource to each job ensures that the resource is not deluged 
with more work than it can handle. Queues and dependencies can be used to control how many jobs 
access a resource at the same time but they are insufficient in certain instances. 

Queues offer a way to manage access to a resource if the job does not require more than one resource to 
run to completion. However, queues are ineffective at managing a job's access to a resource if the job 
requires more than one resource as it processes. On the other hand, if variable dependencies are 
constructed to control the use of a resource by a job, if the job rolls over to the next production day, then 
a situation arises where two copies of the job will be updating the variable. 

When defining a resource, a limit or numeric quantity is specified. If the limit is one, then the resource 
is single-threaded and only one job at a time can use it. If the limit is six then up to six jobs can use the 
resource at once. However, a job may require multiple quantities of the resource at a time. For example, 
one job may require three licensed connections to a database resource while another job needs two parts 
of the possible accesses to the resource. Even if a single use is available it is possible that it may go 
unused even if jobs are waiting to use the resource because the other jobs may require more than one 
access to the resource. 

Resources Interface
From the Navigator pane, select Definitions>Resources and then select either Virtual Resources or 
System Resources to display the Resources pane.

You can double-click a resource listed in the Resources pane to display its definition dialog to view 
information about it. 
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The Resources pane has the following features:

Buttons
• Add Resource —Displays the Resource Definition dialog to can add a new queue.

• Edit Resource —Displays the Resource Definition dialog to edit an existing queue.

• Copy Resource —Creates a copy of the selected resource with the same information as the selected 
resource, except for the name.

• Delete Resource —Removes the selected resource definition from the TES database.

• Refresh —Updates the data in the current pane.

• Print —Displays the Report window to view and print the defined resources that are listed. 

Search Field
Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See “Searchable Columns” section on page 2-35.

Columns
• Name —The name of the resource.

• Owner —The name of the owner of the resource. The user who defines the resource is the default 
user but ownership can be transferred by modifying the Owner field in the Resource Definition 
dialog.

• Limit —Indicates the quantity of a defined resource. Usually the limit is one but it can be any 
quantity. For example, a resource that is a database may be licensed for up to three simultaneous 
connections. Then that resource would have a limit of three.

• In Use —Indicates how much of the resource's limit is used by a job.

• Enabled —Whether or not the resource is enabled (or active) and available for use.

• Public —Whether or not the resource is available to other users.

• Description —The description of the resource.

Resources Preferences Dialog
If you select Preferences from the View main menu while viewing the Resources pane, the Resources 
Preferences dialog displays.

From the Resources Preferences dialog, you can select which columns are displayed in the Resources 
pane and in what order they appear.

• A checkmark to the left of a column title indicates that it will be displayed in the pane. No 
checkmark indicates that it will not be displayed.
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• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.

Navigator Context Menu
Right-clicking in the Navigator pane while viewing the Resources pane, displays a context menu. 

The Navigator context menu contains the following elements:

• Add Virtual Resource —Displays the Virtual Resource Definition dialog to add a new queue. 
This option has the same function as the Add Resource button. 

• Add System Resource —Displays the System Resource Definition dialog to add a new queue. This 
option has the same function as the Add Resource button. 

• Preferences —Displays the Preferences dialog for the Resources pane.

• Print —Displays the Reports pane to view and print your resource definitions. This option has the 
same function as the Print button on the toolbar. 

• Export —Saves the data in the current pane as an ASCII text file. You can then use the file data in 
other applications.

• Refresh —Updates the data in the current pane.

Resources Pane Context Menu
Right-clicking in the Resources pane, displays the Resources pane context menu. 

This context menu contains the following options:

• Add Virtual Resource —Displays the Resource Definition dialog to add a new resource. Once 
defined, a resource is assigned to a job from the Resources tab of a job definition.

• Add System Resource —Displays the Resource Definition dialog to add a new resource. Once 
defined, a resource is assigned to a job from the Resources tab of a job definition.

• Edit Virtual Resource —Displays the Virtual Resource Definition dialog to edit the selected 
queue. 

• Edit System Resource —Displays the System Resource Definition dialog to edit the selected 
queue. 

• Delete Virtual Resource —Deletes the selected virtual resource.

• Delete System Resource —Deletes the selected virtual resource.

• Print —Prints the selected resource’s data.

Virtual Resource Definition Dialog
The Virtual Resource Definition dialog displays when adding or editing a virtual resource in the 
Resources pane. 

Common To All Tabs

• Virtual Resource Name —The name of the virtual resource.
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• Owner —The owner of the virtual resource. This can be an individual user or a TES workgroup. By 
default the owner is the user that defined the resource.

From this field, the ownership can be transferred to another owner. 

• Limit —Indicates the quantity of a defined resource. By default, the limit is one but it can be any 
quantity. For example, a resource that is a database may be licensed for three simultaneous 
connections. Then that resource would have a limit of three.

• In Use —Indicates how much of the resource's limit is currently being used. This is a read-only 
field.

• Available —Indicates how much of the resource is still available to be used. This is a read-only field.

• Requested —The number of requested resources.

• Actual —The actual number of offline resources.

Description Tab

This tab is used to describe the resource and its purpose. This field can be used for notes about how the 
resource should be used and any special requirements or prerequisites.

Jobs Tab

The Jobs tab is a read-only tab providing information on the jobs that access this resource.

This tab contains the following elements:

• Job —The name of the job using this resource.

• Amount —The quantity of the resource allotted to the job. This is assigned from the Resources tab 
of the job’s definition. 

Locked Virtual Resources Tab

This tab lists the job instance that is currently locking up the virtual resource. When a job has all of its 
required resources and is ready to run, the job locks up the assigned resources for its exclusive use until 
the indicated job completes. Once a job starts running the resources assigned to it cannot be modified or 
deleted until the job completes. Once the job completes, the assigned resources are released to be used 
by other jobs. Any job listed without a value in this column is not currently running.

System Resource Definition Dialog
The System Resource Definition dialog displays when adding or editing a system resource in the 
Resources pane. 

Agents that support published system resources provide information about those resources when a 
connection is established. System resource definitions are automatically created for published resources 
if they do not already exist for that connection type. The command displays “Published”.

You can view a read-only dialog when you double-click a published resource from within the System 
Resource pane.

You can create new system resource definitions by specifying commands that will periodically run on 
the agent machine to obtain the resource values.
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Common To All Tabs

• Resource Name —The name of the system resource.

• Apply to all connection —Select this option if you want to apply the system resource to all 
connections. 

• Variables —When you are in the Value field, click this button to enter a system, job or job event 
variable. You can use this function to set the value of the variable to the value of another variable. 
You can also set the variable to a string based on the values of other variables. The values of the 
variables are substituted at the time that the action is executed. 

Command Tab

In the Command tab, provide the command to be executed, whether to use the command output or the 
exit code of the command as the resource value, the data type of the resource value, and the refresh rate. 

Agents Tab

The Agents tab allows for the selection of an agent(s) to collect the resource for.

• If “Apply to all <type> connections” is selected, then the resource is collected for all agents of this 
type. 

• If “Apply to all <type> connections” is not selected, then the agents to collect this resource for must 
be selected in this tab.

Agents that support published system resources will provide information about those resources when the 
connection is established. 

Agent Lists Tab

The Agents Lists tab allows for the selection of an agent list(s) to collect the resource from.

• If “Apply to all <type> connections” is selected, then the resource is collected from all agent lists 
of this type. 

• If “Apply to all <type> connections” is not selected, then the agent list(s) to collect this resource 
from must be selected in this tab.

Agents that support published system resources will provide information about those resources when the 
connection is established.

Description Tab

This tab is used to describe the resource and its purpose. This field can be used for notes about how the 
resource should be used and any special requirements or prerequisites.

Related Agents Dialog
The Related Agents dialog is accessed via the context menu on System Resource pane and contains a 
list of agents related to the selected system resource.

This dialog contains the following elements:
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• Agent Name — the name of the agent related to the selected resource

• Current Value— the current value of the selected resource for each agent

• Refresh Rate— the refresh rate for the resource. When the connection to the agent is made, the 
master will tell the agent what the refresh rate should be for published system resources. The refresh 
rate will be kept globally for all agents, but this can also be overridden for individual agents. 

• Last Refresh— the date of the last refresh for the resource

Resource Requirement Definition Dialog
The Resource Requirement Definition dialog is used to add or edit an existing virtual resource to a job 
from the Resources tab of a job definition. From this dialog, you specify which resource and how much 
of the resource is needed by a job. If the Enabled option is not selected in the resource's definition, then 
the resource does not display in the 
drop-down list.

This dialog contains the following elements:

• Resource —The name of the defined resource. Only resources that are enabled are available from 
this field. Once the resource is selected, its limit displays beside the Amount Needed field.

• Amount Needed —The amount of the resource's specified limit that the job requires. This number 
cannot exceed the limit of the resource noted as (Max) beside the field.

System Resource Requirement Definition Dialog
The System Resource Requirement Definition dialog is used to add or edit an existing virtual resource 
to a job from the Resources tab of a job definition. From this dialog, you specify which resource and 
how much of the resource is needed by a job. If the Enabled option is not selected in the resource's 
definition, then the resource does not display in the drop-down list.

This dialog contains the following elements:

• System Resource —The name of the defined resource. Only resources that are enabled are available 
from this field. 

• Operator —Select the conditional operator depending on the data type of the resource.

• Value —Enter the value for the selected resource.

Resources Procedures

Defining a Resource

Just about anything can be defined as a resource. The resource can be a physical item like a disk partition 
or a virtual item like a database. Normally you would not define something as a resource unless you want 
to manage the amount of access to that resource. 

To define a resource:

Step 1 From the Navigator pane, select Definitions>Resources to display the Resources pane.
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Step 2 Click the Add Resource button or right-click in the Resources pane and select the Add Resource option 
to display the Resource Definition dialog.

Step 3 In the Resource Name field, enter a name for the resource that helps you identify the resource.

Step 4 In the Owner field, select a user to own the resource.

Step 5 In the Limit field, specify a maximum number of shares on the resource. The value entered here will 
limit access to this resource to no more than the designated amount. The default is one but any number 
up to 32,767 can be entered here.

The In Use field will display the quantity of designated shares of the resource is being currently used 
while the Available field displays how much of the resource is still available to be used.

Determining Which Jobs are Using a Resource

You can determine which jobs are using a resource by examining the Jobs tab in the Resource Definition 
dialog. This is handy when you need to determine where a resource’s shares are being used, especially 
if you have a job that is waiting on access to that resource before it can run. 

To determine which jobs are using a resource:

Step 1 From the Navigator pane, select Definitions>Resources to display the Resources pane.

Step 2 Double-click the desired resource to display its definition.

Step 3 click the Jobs tab to display a list of the jobs that are assigned the resource.

Step 4 The number of resource shares assigned to the job is listed in the Amount column. Only the jobs that 
are currently running will display a value in the Locked column. This value is the job instance ID 
number.

Restricting Use of a Resource

To restrict the use of a resource to only designated users, clear the Public option at the bottom of the 
Resource Definition dialog. You can than assign ownership of the resource to a specific user account or 
assign it to a workgroup so that only members of that workgroup can access the resource.

Overriding a Locked Up Resource

If a resource is running at its designated limit, no other jobs can run until one of the currently running 
jobs completes, freeing up its share of the resource. If you are unable to wait until shares of the resource 
open up, you can always increase the number of shares of the resource.
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Queues Pane
TES includes a queue manager to optimize throughput and the allocation of system resources for both 
scheduled and unscheduled jobs. The queue manager assigns jobs to queues when they are ready to run 
and makes decisions about when to launch them based on available execution slots. The capacity that is 
available is determined either by the system queue limit or the sum of the job limit values for each 
licensed agent, whichever is smaller.

Queues can limit the number of jobs running on a computer (or network of computers) at any given time. 
The queue manager always decides which jobs to launch based on a priority structure that includes queue 
hierarchies, queue limit, job limits, queue priority levels and job priority levels. 

Queues are the main factor used to control when and how a job runs but there are other factors that 
influence when a job actually runs. Even if the queue manager releases a job to its queue, the job will 
not necessarily run at that time unless other factors that restrict the release of jobs are met. If the system 
is not running at the system queue’s capacity limit, if a slot is available on the job's designated queue, if 
a slot is available on the job’s designated agent and if any resources the job requires are available, then 
a job with all its dependencies met can run immediately. 

Queue Concepts

Hierarchical Queue Structure

Queues are hierarchical. You can see the level of each queue in the Queues console pane by observing 
the level of indentation from the left edge of the pane. System Queue, the default queue, is at the root 
level of the hierarchy. All other queues fall below the system queue.

You can expand or collapse parts of the queue tree using the collapsed and expanded signs, the same way 
you use the Navigator pane of the Tidal Web client. Each queue in the hierarchy can contain jobs, job 
groups and other queues. 

A parent queue displays above and to the left of its children on the Queues pane. All queues to the left 
of a queue are parent queues. A child queue is nested below and to the right of a queue. All queues to 
the right of the system queue are child queues. Child queues are restricted by the limits and priority level 
of their parents.

The queue record also shows each queue’s limit and priority level. The limit defines how many jobs can 
run from that queue at the same time. The priority indicates which queue takes precedence when the 
Queue Manager searches for the next job to run.

Queue Filters

Queue filters determine how jobs are assigned to queues when they are ready to run. Queue filters 
include and/or exclude jobs based on the job’s properties. When a job is ready to run, the queue manager 
uses the filters to find a queue for the job. If there is more than one queue that the job can be assigned 
to, the queue with the highest priority is chosen. If there is no queue that matches the job’s properties, 
the job will enter the system queue and will be evaluated with the lowest priority.
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How Jobs are Assigned to Queues

The queue manager is responsible for assigning jobs to queues. You cannot directly assign a job to a 
queue in the job definition, but you can set up queues so that you control which jobs get assigned to them. 
By setting up queues to accept jobs based on their job class (using job class queue filters), you can 
indirectly assign jobs to queues by directly assigning them to a job class in the job definition. 

When a job is ready to run, the queue manager begins its search through the queue hierarchy to find the 
most appropriate queue to assign the job to. Starting one level below the system queue, in priority order 
(high to low) it chooses the first match of job properties with queue filters, then moves to the next level, 
if any. This process is repeated until there are no more levels, or until there are no more queues that will 
accept the job. If a job cannot be matched with any queue, it is added to the system queue.

For example, the figure below shows how four jobs are assigned to four different queues. The second 
level of queues uses queue filters that accept either scheduled jobs or unscheduled jobs. The third level, 
under the queue that accepts scheduled jobs only (Queue A), has three queues that accept jobs based on 
their job class. There is a third catch-all queue (Queue E) in this level that accepts all scheduled jobs that 
are not of the Payroll or Accounting job class. Jobs can be assigned to the parent if no child queue 
qualifies.

The following table describes the job assignments:

How the Queue Manager Selects the Next Job to Run

The queue manager determines which job to run next according to a series of checks. The following list 
describes each check in order.

• Launch immediately —The queue manager continually monitors for jobs entering queues with this 
option set. When a job enters this queue it is run immediately, even if the system is running at full 
capacity (at the system queue limit, or at an agent’s job limit).

• System queue limit —The queue manager then monitors the total number of jobs running and 
compares it to the system queue limit value. If the system queue limit value is greater than the 
number of jobs currently running, the queue manager begins its search for the highest priority job 
starting with the following search criteria.

– Queue hierarchy —The queue manager recursively evaluates all active and open queues in 
priority order to determine whether it can launch jobs that are waiting in the queue. Queues with 
the same priority are selected at random.

Table 10-3 Job Assignments

Job Queue Reason

Job A Queue D Job A is a scheduled job that is assigned to the Accounting job class. It 
qualified for Queue A before reaching its final destination Queue D.

Job B Queue C Job B is a scheduled job that is assigned to the Payroll job class. It is 
also qualified for Queue A before reaching its final destination Queue 
C.

Job C Queue B Queue B is the only queue that accepts unscheduled jobs.

Job D Queue E Job D’s job class doesn’t match with Queue C or Queue D. Queue A 
isn’t chosen because Queue E has a higher priority than Queue A. If 
Queue E did not exist, Job D would be assigned to Queue A, because 
Queue A only requires that the job is scheduled.
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– Queue limit —The queue manager compares the number of jobs running in the queue with the 
queue’s limit. Queues running at their limit are skipped. Queues not running at their limit use 
the job priority check.

– Job priority —The job with the highest priority that is to be run on an agent not running at its 
limit is selected. If two or more jobs exist with the same priority, the job that was ready the 
earliest is the job that is run first.

The system queue is used for all default jobs and is the queue with the lowest priority.

Job Selection Examples

The following examples use a simple queue hierarchy made up of four queues. The examples assume 
that we have not reached the agent limits. The queue principles can apply to hierarchies of any size.

Example 1: Job Selection Based On Queue Hierarchy

In this queue setup, the system queue has a job limit of 10. This means that no more than ten jobs can 
run at the same time, no matter where they are run. The system queue has no queue priority level setting 
because no other queue can exist at the same level in the hierarchy. All queue limits and queue priorities 
are constant throughout the examples. The system is currently running at its limit.

If any one of the running jobs complete, the queue manager selects the highest priority job of the four 
waiting in Queue C, even though Queue A has a higher queue priority, because Queue C is at the lowest 
level in the hierarchy, is not running at its limit and has jobs waiting.

Example 2: Job Selection Based On Queue Limits and Queue Priority

Job Selected Based On Queue Limit

If a job completes in Queue B, the next job selected will be the highest priority job in Queue B, even 
though it is a lower priority queue than Queue C, and Queue C has jobs waiting in it. This is because 
Queue C is already running at its limit.

Job Selected Based On Queue Priority

Queue B is not running at its limit (10). This is because Queue B has a lower queue priority than Queue 
C. The queue manager has selected as many jobs as possible from the highest priority queue —up to it’s 
queue limit (5). What is remaining of the overall system limit is then run from the lower priority queue 
(10 —5 = 5).

Guidelines for Creating Queues

The following are a set of guidelines to help you create queues that meet your scheduling needs. These 
guidelines are suggestions, not requirements. The way your queue hierarchy is structured is entirely up 
to you.

• Queue Names —Use queue names that define what the queue is used for. A queue named 
Manufacturing Jobs makes more sense than a queue named A1.

• Queue Hierarchies and Queue Filters —Hierarchies, combined with queue filters let you create 
specific queues for specific types of jobs, giving you more task management control. Hierarchies 
also help you avoid mistakes by visually organizing how jobs run in the overall schedule. For 
example, you could have each queue parent only accept jobs of a particular class. You could then 
subdivide child queues by having each accept jobs that are owned by a particular workgroup or user.

• Child Queue Priority Levels —Give all sibling queues under the same parent different priority 
levels, otherwise the queues are selected randomly when a job is assigned.
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• Job Limits and Queue Limits —The settings that control the number of jobs that run on a machine 
or network are the agent’s job limit and the queue’s queue limit. Consider these limits carefully. 
Though the system queue limit controls how many jobs can run overall at any one time, make sure 
it is large enough to accommodate the sum of all the agents’ job limit values.

You could set queues in hierarchies with limits reflecting the maximum acceptable load for the 
queue, and then regulate the entire system load by setting the system queue limit to a percentage of 
its maximum. 

For example, suppose the system queue has three child queues only, Queue A, Queue B, and Queue 
C with a queue limit of 10 each. Thus, the maximum possible load is 30 jobs. However, you could 
set the system queue with a limit of 20, 66% of maximum, and only 20 jobs will run at one time, but 
the underlying queue functionality is the same. In effect, you decrease (or increase) your scheduling 
load with one control.

• Hours Available —You can submit jobs that do not need to be run immediately to a queue that is 
set to operate after hours. An example is to use this option to free up resources during the day.

When the time comes to operate, the jobs begin to run. When the queue closes, it continues to finish 
jobs that are being run, and halts all waiting jobs until the next time it is open.

• Launch Immediately —Create one or two queues with the launch immediately queue option for 
those emergency situations where a user absolutely needs a job to run as fast as possible. You will 
be able to use this for manually overriding a given assignment or for queue bumping.

• Queue Bumping —Add queue bumping for queues where some jobs never launch or wait too long 
to launch. The queue that is bumped to should have a higher priority than the previous queue, or the 
jobs may wait even longer to start.

• Catch All Child Queues —Lower-priority child queues with no queue filters at each family level 
will catch jobs accepted by the parent queue, but not accepted by its children’s queue filters. This 
reduces the chances that the system queue (the lowest priority queue) will run these jobs.

• Single Threading —You can use a queue to single-thread jobs that require exclusive access to a 
particular resource, such as to a database. For example, you can set up a queue with a job name mask 
queue filter to accept all jobs with the r1_* job name mask and give the queue a limit of 1. When 
you set up jobs that require the resource, add a job name prefix r1_ before the job name. The jobs 
with that particular prefix can now safely share the resource.

Compound Queue Filters

You can create compound queue filters by mixing queue filter types. Repeat the steps for creating each 
queue filter. With compound filters, all filter conditions must be true for a job to qualify for the queue.

If you include multiple queue filters of the same type, a job qualifies for the queue if any one of the 
conditions match for that type. 

Successive Compounding of Child Filters

When jobs are assigned to queues, they pass through each parent filter before they reach their destination 
queue. The job in the destination queue therefore meets all the criteria of the destination queue’s filter 
plus each of its parent’s and grandparent’s queue filters. During the search for the right queue to assign 
to a job, each successive queue filter acts using AND logic, further narrowing down which queue will 
become its destination queue.
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Assigning Jobs to Specific Queues 

You cannot directly assign a job to a queue. However, you can configure your definitions to consistently 
assign jobs to run in specific queues. TES is designed with intelligent queue software that determines 
the best queue based on each job’s properties. Once the queue structure has been set up for your business 
cases, jobs will automatically enter the appropriate queue. For details on how to send a job to a specific 
queue, see “Sending Jobs to a Specific Queue” section on page 10-351. 

Queues Interface
From the Navigator pane, select Definitions>Queues to display the Queues pane.

Buttons
• Add Queue —Displays the Queue Definition dialog to create a new queue.

• Edit Queue —Displays the Queue Definition dialog to edit the selected queue.

• Copy Queue —Creates a copy of the selected queue with the same information as the selected 
queue, except for the name.

• Delete Queue —Removes the selected queue definition from the TES database.

• Refresh —Updates the data in the current pane.

• Print —Displays the Reports pane to view and print your queues. For more information, see 
“Monitoring Production” section on page 11-361.

Search Field
Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See “Searchable Columns” section on page 2-35.

Columns
• Status Light —Shows whether the queue is accepting jobs or not.

• Name —The name of the queue.

• Priority —The queue’s priority number.

• Limit —The maximum number of jobs the queue will accept.

• Active —How many jobs in the queue are active.

• Waiting —How many jobs in the queue are waiting to run

• Enabled —Whether or not the queue is enabled.

• Modified —The last time the queue definition was modified.
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Queues Preferences Dialog

If you select Preferences from the View main menu while viewing the Queues pane, the Queues 
Preferences dialog displays.

From the Queues Preferences dialog, you can select which columns are displayed in the Queues pane 
and in what order they appear.

• A checkmark to the left of a column title indicates that it will be displayed in the pane. No 
checkmark indicates that it will not be displayed.

• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.

Navigator Context Menu

When you right-click in the Navigator pane while viewing the Queues pane, the Navigator context menu 
displays. 

The Queues Navigator context menu contains the following elements:

• Add Queue —Displays the Queue Definition dialog to add a new queue. Has the same function as 
the Add Queue button.

• Preferences —Displays the Preferences dialog for the Queues pane.

• Print —Displays the Reports pane so that you can view and print your queue definitions. Has the 
same function as the Print button on the toolbar.For more information, see “Monitoring Production” 
section on page 11-361.

• Export —Saves the data in the current pane as an ASCII text file. You can then use the file data in 
other applications. 

• Refresh —Updates the data in the current pane.

Queues Pane Context Menu

When you right-click in the Queues pane, the Queues pane context menu displays. 

The following describes the items in the Queues pane context menu:

• Add Queue —Creates a new queue through the Queue Definition dialog. TES will insert the queue 
as a child of whichever queue is selected at the time. (All queues have a parent, except the system 
queue.)

• Edit Queue —Edits the selected queue by displaying the Queue Definition dialog. 

• Delete Queue —Deletes the selected queue. 

• Enable —Reactivates the queue after having been disabled.

• Disable —Prevents the queue from accepting jobs.

• Print —Prints the selected queue’s data. 

Queue Definition Dialog
The Queue Definition dialog displays whenever adding or editing a queue. The queue can be available 
all of the time or it can be limited to operating only during a specified time window.
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Common To All Tabs

• Queue Name —The name of the queue (up to 30 characters).

• Parent —The queue one level above in the queue tree. The queues above another queue are called 
parent queues. Queues below another queue are called child queues. If no queue is named in the 
parent field, the queue will be a child of the system queue.

• Limit —The number of jobs that can run in the queue at the same time.

Note The limit of the system queue determines the overall number of jobs that TES can run at any time. Limit 
values are displayed after the queue name in the Queues pane.

• Priority —Sets a queue priority relative to other sibling queues (child queues with the same parent). 
If all child queue priority values are the same, there is no queue precedence. The job could equally 
go to any of the child queues.

Priority values are displayed after the queue name in the Queues pane. Jobs in queues with higher 
priority values will be launched before jobs in queues with lower priority values.

• Hours Available —Sets the time window during which the queue operates. For example, you can 
set queues to run only at night or only during the day. When a queue closes, the queue manager 
attempts to reassign jobs in that queue to another qualifying queue that is open. If it cannot reassign 
the jobs to another queue, the job will remain in the closed queue and will not launch until it reopens.

Specify times by either using am or pm after typing the time (with colon), e.g., 1:15pm for 1:15 pm 
or using the 24-hour clock (with colon) to separate the hours and minutes, e.g., 13:30 for 1:30 pm.

• Always —Sets the queue’s availability to 24 hours a day. If no times are specified in the From and 
To fields, the queue is assumed to be available at all times and the Always option is automatically 
selected. 

• Enabled —The Enabled option makes the queue active or inactive. You cannot make a queue that 
has jobs in it inactive.

Filters Tab

The Filters tab of the Queue Definition dialog displays queue filters associated with the queue. Queue 
filters define how jobs are assigned to queues. A combination of queue filters can provide precise control 
of which jobs run in a particular queue.

The Filters field displays queue filters associated with the queue. These queue filters define how jobs 
are assigned to queues. You can combine queue filters in any way you choose. 

Each defined filter is marked with a blue diamond and lists its criteria. If the filter has excluding criteria, 
it shows a red minus sign. If the filter has including criteria, it displays a green plus sign. 

This tab contains the following elements:

• Add —This button creates a new filter to the queue definition.

• Edit —This button edits an existing queue filter. 

• Delete —This button deletes an existing queue filter from the queue definition. 

Queue Filter Context Menu

When you right-click in the Filters field on the Filters tab of the Queue Definition dialog, the Queue 
Filters context menu displays. 
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The menu options echo the functions of the Add, Edit and Delete buttons.

The Queue Filters context menu contains the following elements:

• Add Filter Condition —Displays the queue filter condition menu to select a queue filter. Selecting 
one of the queue filters displays its Queue Filter Condition dialog. 

• Edit Filter Condition —Displays the Queue Filter Condition dialog to edit the selected queue 
filter. 

• Delete Filter Condition —Deletes the selected queue filter. 

Queue Filter Conditions Menu

The Queue Filter Conditions menu displays whenever adding a queue filter. TES provides precise 
control of which jobs run in a particular queue through the use of queue filters.

This menu contains the following options:

• Job Name —Includes or excludes only jobs with the given job name(s). Jobs need to be defined in 
the TES database. You can click the Browse button inside the dialog to search for a job name.

• Job Name Mask —Includes or excludes all jobs with the job name mask(s). You can include the 
wild cards * and? in the job name mask. An asterisk masks one or more characters or numbers, and 
a question mark masks a single character. 

• Job Group —Includes or excludes only jobs that are members of a particular job group. You need 
to define a job group before you can refer to it in a filter. 

• Job Class —Includes or excludes jobs based on their job class. You need to define a class before 
you can refer to it in a filter. 

• Command Name —Includes or excludes all jobs that execute that command.

• Command Name Mask —Includes or excludes all jobs that execute a command that matches this 
mask.

• Command Path —Includes or excludes all commands that execute from the specified directory or 
subdirectory. Note that you must specify the full path name; you cannot use relative path names.

• Job Owner —Includes or excludes all jobs owned by a user or workgroup.

• Runtime User —Includes or excludes jobs whose command and environment are owned by the 
runtime user. The job definition may or may not be owned by that user.

• Agent —Includes or excludes jobs that run on the agent specified. You can use this filter to manage 
jobs that run on a particular agent.

• Agent List —Include or exclude jobs associated with an agent list. You can use this filter to manage 
jobs that run on the agents listed in the agent list. 

• Priority Range —Includes jobs within a given job priority range. Job priority values range between 
0 and 100, where 100 is the highest priority.

• Estimated Duration —Includes jobs that have an estimated duration within a range of two specified 
values (in minutes).

• Scheduled vs. Unscheduled —Select either scheduled jobs or unscheduled jobs only. You can use 
this setting to control the submission of unscheduled jobs.

• Operator Release vs. Automatic —Select either jobs that are set to be released by an operator or 
only jobs that enter the schedule automatically.

• SAP Job (Intercepted) —Selects (or intercepts) SAP jobs according to specified criteria based on 
the SAP instance, user and/or job name.
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Bumping Tab

The Bumping tab of the Queues Definition dialog is used to specify the launch priority of a queue which 
determines which jobs the queue will launch or dispatch.

• No priority bumping —Disables priority bumping (default).

• Launch immediately —Bypasses other queues, overriding all launch priority criteria and limit 
tests. Jobs assigned to a queue with this option will launch immediately, regardless of how many 
jobs are currently running.

• Increase job priority —Ensures lower priority jobs eventually launch if they have been waiting for 
a long time. Jobs that are waiting in a queue will increase their priority by a designated number of 
priority points in proportion to the length of time spent in the queue.

When a job’s priority reaches 100, it can optionally bump to a higher priority queue, queue Z, with 
a job priority of 0. The job then bumps its priority level according to that queue’s bumping 
allowance.

Note When using this option, make sure that the designated queue where the job is being bumped to has a 
higher queue priority value than the original queue; otherwise, the jobs will wait even longer to launch.

• Nice Value —Defines the CPU scheduling priority assigned by TES for Unix jobs. TES uses a 0 to 
40 scale to rate the nice value. The value of one provides the lowest scheduling priority and 40 the 
highest priority with 21 as the default value. A value of zero means that TES does not modify the 
nice value assigned by the process's operating system. 

The following formula is used to convert the TES nice value to the Unix nice value as displayed by 
the ps command for the Solaris, HPUX and AIX operating systems: 40-(Scheduler nice 
value-1) = Unix nice value. As an example, a TES value of 24 converts to a Unix nice value 
of 17, 40-(24-1) = 6.
If using the Linux operating system, the formula used by TES is 20-(Schedulernice value-1) 
= Unix nice value. As an example, a TES value of 15 converts to a Unix nice value of 6, 
20-(15-1) = 6.

This setting only applies to jobs that run on Unix agents. 

Current Jobs Tab

The Current Jobs tab of the Queue Definition dialog displays details on the jobs currently residing in 
the queue. You can also release unscheduled jobs that are waiting from this tab.

This tab contains the following elements:

• Active Jobs —Selecting this option displays all jobs that are currently active in the queue. The 
adjacent number indicates the total of jobs currently active in the queue.

• Waiting Jobs —Selecting this option displays all jobs that are currently waiting in the queue to be 
launched. The adjacent number indicates the total of jobs currently waiting in the queue.

If neither of the options are selected, no jobs are displayed in the Current Jobs field. Each job 
displayed in the field has a color-coded status light to appraise a job’s status at a glance. The color 
green indicates a job that is in active or launched status, the color yellow indicates a job in a waiting 
status and the color red indicates a job unable to run due to an unavailable resource. The field listing 
the current jobs in the queue has the following columns of information about the jobs:

• ID —The identification number assigned to the job by TES.
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• Job —The name of the job.

• Status —The current status of the job in TES.

• Pri —The priority number assigned to the job.

• Duration —The time in minutes that a job has remained in its present status within the queue.

• External ID —The identification number assigned by jobs created in applications other than TES.

• Agent —The name of the agent assigned to the job.

A context menu displays by right-clicking within the list of queued jobs. It has the following 
options:

• Release —Launches the selected job that is in waiting status.

• Refresh —Updates the information for the current jobs in the queue.

• Auto Update —Automatically updates the information for the current jobs in the queue.

Description Tab

A free-text field of up to 255 characters (optional), for describing the queue. 

Queue Procedures
Queues let you optimize throughput and allocate system resources for scheduled and unscheduled jobs. 
The TES queue manager assigns jobs to queues when all their dependencies have been met, and decides 
when to launch jobs based upon the available system resource slots. The maximum number of slots 
available is determined either by the limit that you set in the system queue, the sum of each queue’s limit 
or the sum of each licensed agent’s job limit.

Queues can limit the number of jobs running on a computer or a network of computers at a given time.

• If the system is not running at its capacity, a job can run immediately provided that all of its 
dependencies are met.

• If the system is running at its capacity, the TES Queue Manager decides which jobs launch based on 
a priority structure that includes the following in order of importance:

• Queues are displayed in a hierarchy. Each item in the hierarchy is a queue and can contain jobs. You 
define the queue limit to set the number of jobs that can launch from any individual queue. You also 
define a priority for each queue.

Status Description

Queue priority levels Jobs in active and open queues at higher priority 
levels run first.

Queue limits Only jobs in queues not running at their allowable 
limit can be launched.

Agent job limits Only jobs assigned to agents not running at their 
allowable limit can be launched.

Job priority levels Jobs with the highest priority (assigned in the job 
definition) in the queue are run first.
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Adding a Queue

You can add a queue anywhere in the queue hierarchy. When you add a queue it is positioned under the 
parent queue that you select. The jobs that the queue can accept must first match the parent’s queue filter.

To add a queue:

Step 1 From the Navigator pane, select Definitions>Queues to display the Queues pane.

Step 2 Select the parent queue under which you want to place your queue.

Step 3 Click the Add button on the TES toolbar or right-click and select Add Queue from the context menu to 
display the Queue Definition dialog.

Step 4 Specify values in theQueue Name, Parent, Limit and Priority fields. For more information, see “Queue 
Definition Dialog” section on page 10-343. 

Note It is best if no two sibling queues have the same queue priority value.

Step 5 Specify the queue filter(s) you want to be associated with this queue. For more information, see “Queue 
Filters” section on page 10-338 and “Queue Filter Conditions Menu” section on page 10-345.

Step 6 Click the Bumping tab. 

a. If you want your queue to launch jobs immediately, select the Launch immediately option. 
Jobs will launch regardless of whether the system is running at its capacity or not.

b. If you want jobs to be bumped to different priorities and to different queues if they are waiting 
for a long time, specify the Priority bumping options. Be sure that the queue to which jobs 
bump has a higher priority than the current queue.

c. If you are running Unix jobs, you can select the Nice Value which defines the CPU scheduling 
priority for jobs from this queue. The value must be an integer from 1 to 40. The default value 
is 21. Higher nice values result in lower execution priority.

Step 7 In the Hours fields at the bottom of the dialog, type the queue’s hours of availability.

Step 8 Click the Description tab and type a description for the queue.

Step 9 To save the queue, click OK. The queue is added to the Queues pane and displays below the specified 
parent queue.

Adding a Queue Filter

Queue filters determine how jobs are assigned to queues. You can add filter criteria (conditions) to a 
queue at any time.

To add a queue filter:

Step 1 From the Navigator pane, select Definitions>Queues to display the Queues pane.

Step 2 Right-click the queue and from the context menu select the Edit Queue option or double-click the queue 
to display the Queue Definition dialog.

Step 3 Click the Filters tab and click the Add button. 
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Step 4 Select the type of queue filter you want to add from the context menu For more information about queue 
filters, see “Queue Filter Conditions Menu” section on page 10-345. The specific queue filter dialog 
appears. Note that most queue condition dialogs contain an option to exclude the jobs with the specified 
criteria. This option lets the queue accept all jobs that do not match the criteria.

Step 5 To accept the filter, click OK. Click Cancel to discard the filter.

Step 6 The filters you select will be added to the queue definition. They are displayed in the Filter field on the 
Filter tab of the Queue Definition dialog as follows:

– The filter name is marked by a diamond symbol.

– Included criteria are marked with a plus (+) symbol.

Deleting Queues

A queue can only be deleted if no jobs are waiting in it or currently running from it. 

To delete a queue:

Step 1 Disable the queue:

a. From the Navigator pane, select Definitions>Queues to display the Queues pane.

b. Right-click the queue and from the context menu select Disable Queue or double-click the 
queue, and clear the Enabled option in the Queue Definition dialog.

Step 2 When the queue is empty of jobs, select the queue to delete.

Step 3 Right-click and select Delete Queue from the context menu or click the Delete button on the TES 
toolbar or press the DELETE key on your keyboard.

Step 4 Click OK in the confirmation dialog to delete the queue.

Deleting Queue Filters

Queue filters determine how jobs are assigned to queues. You can delete queue filter criteria from a 
queue definition at any time.

To delete a queue filter:

Step 1 From the Navigator pane, select Definitions>Queues to display the Queues pane.

Step 2 Right-click the queue and from the context menu select the Edit Queue option or double-click the queue 
to display the Queue Definition dialog.

Step 3 Click the Filters tab. 

Step 4 Select the filter you want to delete and click Delete. 

Excluded criteria are marked with a minus (-) symbol.
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Disabling Queues

If you disable (deactivate) a queue that is currently in use, it will no longer accept new jobs, but all jobs 
that are currently running in it will run to completion. 

To disable a queue:

Step 1 From the Navigator pane, select Definitions>Queues to display the Queues pane.

Step 2 Right-click the queue and from the context menu select Disable Queue or double-click the queue and 
clear the Enabled option in the Queue Definition dialog.

Editing a Queue

You can change the properties of a queue at any time, even while it is in use.

To edit a queue:

Step 1 From the Navigator pane, select Definitions>Queues to display the Queues pane.

Step 2 Double-click the queue whose filters you want to view or right-click and from the context menu select 
the Edit Queue option to display the Queue Definition dialog.

Step 3 Edit the Queue Name field to change the name of the queue.

Step 4 Edit the Parent field to move the queue to the new parent. Remember that jobs must match the parent’s 
filter before a child queue is evaluated.

Step 5 Edit the Limit to increase or decrease the number of jobs that can run in the queue.

Step 6 Edit the Priority field to increase or decrease the priority relative to sibling queues. Remember not to 
assign the same priority to multiple queues with the same parent.

Step 7 Select the Enabled option to enable the queue. Clear this option to disable the queue (make it inactive). 
Note that inactive queues cannot accept jobs.

Step 8 In the Filters field, add/edit the queue filter(s) as desired.

Step 9 Click the Bumping tab. On this tab, set whether you want your queue to Launch immediately or if you 
want to enable Priority Bumping and its parameters.

Step 10 If necessary, adjust the queue’s hours of availability in the Hours fields.

Step 11 Click the Description tab to edit the queue’s description.

Editing a Queue Filter

Queue filters determine how jobs are assigned to queues. You can modify queue filter criteria for a queue 
at any time.

To edit a queue filter:

Step 1 From the Navigator pane, select Definitions>Queues to display the Queues pane.

Step 2 Right-click the queue and from the context menu select the Edit Queue option or double-click the queue 
to display the Queue Definition dialog.
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Step 3 Click the Filters tab. 

Step 4 Select the filter you want to edit and click the Edit button.

The Queue Filter Condition dialog for the queue filter displays. You can now edit the filter criteria.

Moving a Queue to a New Parent

You can move a queue to any location in the queue hierarchy below the system queue.

To move a queue:

Step 1 From the Navigator pane, select Definitions>Queues to display the Queues pane.

Step 2 Double-click the queue that you want to move, or right-click and from the context menu select Edit 
Queue to display the Queue Definition dialog.

Step 3 Change the name of the parent queue in the Parent field using the drop-down menu. 

Note Keep in mind that a child queue can only accept jobs that first pass the filter criteria of its parent.

Sending Jobs to a Specific Queue

You can indirectly send jobs to a queue by using the job class feature. 

To send a job to a specific queue, follow this example:

Step 1 Define a job class called To Queue B.

a. From the Navigator pane, select Definitions>Job Classes to display the Job Classes pane.

b. Right-click and select Add Job Class from the context menu.

c. In the Job Class Name field, type To Queue B.

d. In the Description field, type This Job Class is used to route Jobs to Queue B.

e. Click OK.

Step 2 Create Queue B with a To Queue B job class filter.

a. From the Navigator pane, select Definitions>Queues to display the Queues pane.

b. Select System Queue.

c. Right-click and select Add Queue from the context menu.

d. In the Queue Name field, type Queue B.

e. Set the Limit value and queue Owner as desired.

f. Set the Priority value to a value higher than the queue that would normally accept the job. For 
example, if the default queue, Short Unscheduled Jobs, normally accepts the job and its 
priority is at the default of 50, set Queue B’s priority to 55.

g. On the Filters tab, click Add and select Job Class from the drop-down menu.

h. Select the To Queue B job class.
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i. Click OK to close the Queue Filter Condition dialog.

j. Click OK to close the Queue Definition dialog and return to the Queues pane.

Step 3 Edit the definition for your job by associating it with the To Queue B job class.

a. From the Navigator pane, select Definitions>Jobs to display the Jobs pane.

b. Double-click the job you want to run from Queue B.

c. In the Job Class field, select To Queue B.

d. Click OK. 

The job will now type Queue B, even though you did not directly assign it to the queue.

Viewing Queues

From the Navigator pane, select Definitions>Queues to display the Queues pane.

Viewing a Queue’s Filters

To view a queue’s filters:

Step 1 From the Navigator pane, select Definitions>Queues to display the Queues pane.

Step 2 Double-click the queue whose filters you want to view, or right-click and from the context menu select 
Edit Queue. The Queue Definition dialog displays.

Step 3 Click the Filters tab. The filters associated with this queue are listed in the Filters field.

Agent Lists Pane
An agent list is any set of licensed nodes in your network. You can assign jobs to run using agent lists 
similar to the way you assign them to individual agents. With agent lists, however, you have access to 
useful functions not available with individual agents. You can specify alternate agent(s) to run your jobs 
if the primary agent is unavailable, you can balance the workload of many jobs among the agents in the 
list, or you can broadcast jobs to run on all the machines in the agent list at the same time.

The master does not pick an agent from the agent list assigned to a job until that job is ready to run. 
Because the agent is not assigned to a job until the last minute, if a user looks at a Job Details dialog 
before the job runs (e.g., the job is in a Waiting on Dependencies state), the Agent field on the Override 
tab is empty. The master does not select an agent from the agent list displayed in the Agent List field 
until the job’s dependencies are met and the job is ready to run. Once the job is submitted to run and the 
agent is selected, the name of the agent displays in the Agent field. If the job reruns, the master may 
assign a different agent from the agent list according to the demands of the production schedule. If you 
make a change to the Agent field, then the Agent List field is cleared since you, not the agent list, are 
selecting the agent.

TES supports Windows, Unix, z/OS (formerly MVS or OS/390) and O/VMS agent platforms, but you 
cannot combine agents of different platform types in one agent list.
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Agent List Concepts

Types of Agent Lists

• Ordered Agent List —You can use an ordered agent list to provide alternative agent(s) in case the 
primary agent is not available when a job is ready to run. When there is a network or machine failure 
on the primary agent, the job is automatically routed to the next available alternate agent in the list. 
Agents are tried in the order that they appear in the list until an operational agent is found. The 
primary agent is always the first in the list. Alternative agents follow the primary agent.

• Broadcast —Simultaneously runs a job on every agent in the list. For example, you might use a 
broadcast list to backup each machine’s files. 

• Workload Balancing —You can use workload balancing to distribute jobs evenly among all the 
agents in the list. There are three kinds of agent lists that support workload balancing:

– Balanced —Launches jobs on the agent which currently has the lightest load. Use this type of 
list with TES agents on platforms that provide load information.

– Rotation —Launches jobs by selecting agents successively. When the end of the agent list is 
reached, TES starts at the beginning of the list again.

– Random —Launches jobs by selecting agents randomly. Use this type of list to approximate 
workload balancing with remote shell agents.

Agent List Hierarchies

You can manage your agent lists by placing them into hierarchies of parent agent lists and child agent 
lists. A job using a parent agent list uses all agents belonging to the child agent lists.

Agent list hierarchies are a convenient way to organize a large set of agents into smaller more 
manageable sets. When a job is slated to run on an agent list, each child agent list in the parent agent list 
is treated as if it were a single agent list. For example, in a lightest load agent containing four child agent 
lists, the child agent list with the lightest load is chosen. The job then chooses among the agents with the 
lightest load inside the child agent list.

An agent list hierarchy can only consist of agent lists of the same type. For example, you can have 
balanced lists under balanced lists, but not ordered lists under balanced lists.

Agent Lists Interface
From the Navigator pane, select Definitions>Agent Lists to display the Agent Lists pane. Then, select a 
type of agent folder.

Buttons 

Note Buttons will not be available until you open a platform folder.

• Add Agent List —Displays the Agent List Definition dialog to add an agent list.

• Edit Agent List —Displays the Agent List Definition dialog to edit an agent list.
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• Delete Agent List —Removes the agent list definition from the TES database.

• Refresh —Updates the data in the current pane.

• Print —Displays the Reports pane to view and print your agent lists. For more information, see 
“Monitoring Production” section on page 11-361.

Search Field
Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See “Searchable Columns” section on page 2-35

Columns 

Note There are no columns in the Agent Lists pane until you open a platform folder.

The console view for each platform type contains the same columns:

• List Type Icon —An icon that represents the type of agent list.

• List Type —The type of agent list: Ordered, Random, Balanced, Broadcast or Rotation.

• (Expand/Collapse) —This column indicates whether or not the agent list is expanded to show all 
agents in the list, or collapsed to show only the agent list name.

• Name —The name of the agent list.

• Description —A description of the agent list. Since the Description field of the Agent List 
Definition dialog is optional, this column may be blank.

• Modified —The last time the agent list definition was modified.

Preferences

Note Preferences will not be available until you open a platform folder.

If you select Preferences from the View main menu while viewing an Agent Lists pane, the Agent Lists 
Preferences dialog displays.

From the Agent Lists Preferences dialog, you can select which columns are displayed in the Agent Lists 
pane and in what order they appear.

• A checkmark to the left of a column title indicates that it will be displayed in the pane. No 
checkmark indicates that it will not be displayed.

• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.
10-354
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 10      Controlling Production
  Agent Lists Interface
Navigator Context Menu 

Right-click in the Navigator pane while viewing the Agent Lists pane, to view the Navigator context 
menu. 

The Agent Lists Navigator context menu contains the following options:

• Add Agent List —Displays the Agent List Definition dialog to add a new agent list. This option 
has the same function as the Add Agent List button.

• Preferences —Displays the Preferences dialog for the Agent Lists pane.

• Print —Displays the Reports pane to view and print your agent list definitions. This option has the 
same function as the Print button on the toolbar. For more information, see “Monitoring 
Production” section on page 11-361.

• Export —Saves the data in the current pane as an ASCII text file. You can then use the file data in 
other applications. 

• Refresh —Updates the data in the current pane.

Agent Lists Pane Context Menu

Right-click in one of the Agent Lists platform panes to display the Agent Lists pane context menu. 

The Agent Lists pane context menu contains the following options:

• Add Agent List —Displays the Agent List Definition dialog to create a new agent list.

• Edit Agent List —Displays the Agent List Definition dialog for the selected agent list. 

• Delete Agent List —Deletes the selected agent list. 

• Print —Prints the selected agent list. 

Agent List Definition Dialog
The Agent List Definition dialog displays when adding or editing an agent list definition.

Common to All Tabs

• List Name —The name of the agent list (up to 60 characters). The agent list name must be unique. 
Note that the type of agent platform (operating system) you initially selected displays next to the 
List Name field. To select a different platform, cancel the dialog, select the folder of the correct 
platform type, and Add a new agent list.

• Parent List —From the drop-down menu in the Parent List field, you can select a parent agent list. 
If you specify a parent agent list, the agent list you are editing will be a child agent list of the parent 
and will appear below its parent in the agent list hierarchy.

• List Type —The type of agent list based on how you want jobs assigned to the agents in the list:

–  Ordered —TES chooses the first available agent to run the job based on the order in which the 
agents appear in the Agents Selected field. For example, if the first (primary) agent listed is not 
available, TES tries the second (alternative) agent in the list. You might want to use this list type 
for critical jobs —specifying substitute agents in case the primary agent becomes unavailable.
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– Random —TES chooses agents from the Agents Selected field randomly. This is a form of 
workload balancing that works well with Unix rsh agents. However, if you are working with 
TES agents on platforms that track load information, you should choose the Balanced option.

– Balanced —TES chooses an agent from the Agents Selected field based on lightest load when 
the job is ready to launch. You can choose this option to balance your workload on all the 
available agents in the list. If you are working with Unix rsh agents, you should choose the 
Random or Rotation option.

– Broadcast —TES runs the job on every agent in the Agents Selected field. For example, you 
can use this option to schedule backups on each machine in the list using the same job.

– Rotation —TES cycles through the list of agents in the Agents Selected field and launches jobs 
assigned to that list in rotation. When the end of the agent list is reached, the first agent in this 
list is chosen. This is a form of workload balancing where you can predict where the next job 
will run.

List Tab

• Agents Selected —Displays the list of agents that comprise the agent list selected from the list of 
licensed agents. 

• Agents Available —Displays the list of available licensed agents of the platform type shown in the 
Platform field. All agents that are inactive have a red X over the agent icon.

• Up Arrow —Click to move the selected agent in the Agents Selected field up in the list (for ordered 
lists).

• Down Arrow —Click to move the selected agent in the Agents Selected field down in the list (for 
ordered lists).

• Left Arrow —Click to move the selected agent in the Agents Available field to the Agents Selected 
field.

• Double Left Arrow —Click to move all agents in the Agents Available field to the Agents Selected 
field.

• Right Arrow —Click to move the selected agent in the Agents Selected field to the Agents 
Available field.

• Double Right Arrow —Click to move all agents in the Agents Selected field to the Agents 
Available field.

Agent List Definition Context Menu

The Agent List Definition context menu displays by right-clicking in the Agents Selected field in the 
Agent List Definition dialog.

This context menu contains the following options:

• Remove from List —Returns the selected agent to the Agents Available field so that it is no longer 
a part of the agent list.

• Remove All from List —Clears all agents from the Agents Selected field.

Description Tab

Description —A free text field for up to 255 characters (optional).
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Agent Lists Procedures

Adding an Agent List

You can add an agent list under a parent agent list of the same type, or under the root platform folder. 
When you add an agent list under a parent agent list, the parent agent list treats the agent list as if its 
agents were direct members of the list. 

To add an agent list:

Step 1 From the Navigator pane, select Definitions>Agent Lists to display the Agent Lists pane. Then, select 
a type of agent folder.

Step 2 Right-click and select Add Agent List from the context menu to display the Agent List Definition 
dialog. Specify the properties for the agent list. For more information, see “Agent List Definition Dialog” 
section on page 10-355. 

Step 3 Click OK to add the agent list. The agent list appears in the Agent Lists pane.

Changing the Order of the Agents in the List

To change the order of the agents in the list:

Step 1 From the Navigator pane, select Definitions>Agent Lists to display the Agent Lists pane. Then, select 
a type of agent folder.

Step 2 Double-click the agent list you want to edit or right-click the agent list and select Edit Agent List from 
the context menu.

Step 3 In the Agents Selected field, select the agent whose position you want to change.

Step 4 Click the up-arrow (^)or down-arrow (v) button(s) to move the agent up or down in the list or right-click 
and use the context menu selections to move the agent up or down in the list. 

Note If you are specifying an ordered list, the first agent in the list is considered the primary agent. All 
subsequent agents are alternate agents if the primary agent or other alternate agents are unavailable

.

Deleting an Agent List

You can delete an agent list from an Agent Lists pane. You cannot delete the platform folder that contains 
the agent lists. If you delete a parent agent list, you also delete its child agent lists.

To delete an agent list:

Step 1 From the Navigator pane, select Definitions>Agent Lists to display the Agent Lists pane. Then, select 
a type of agent folder.

Step 2 Click the agent list to delete and click the Delete button on the TES toolbar, or right-click the agent list 
and select Delete Agent List from the context menu.
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Step 3 Click Yes in the confirmation dialog to delete the agent list and all its child agent lists (if any) from the 
TES database.

Editing an Agent List

You can edit an agent list to add or remove agents, to change its name, or to change its parent agent list. 
You cannot change its platform type, agent list type, nor can you change its parent to a list of a different 
type.

To edit an agent list:

Step 1 From the Navigator pane, select Definitions>Agent Lists to display the Agent Lists pane. Then, select 
a type of agent folder.

Step 2 Double-click the agent list you want to edit, or right-click the agent list and select Edit Agent List from 
the context menu.

Step 3 Edit the properties for the agent list. For more information, see “Agent List Definition Dialog” section on 
page 10-355.

Step 4 Click OK to update the agent list in the TES database or Cancel to discard your changes and close the 
dialog. The update takes effect the next time the master is refreshed.

Moving an Agent List

You can move agent lists to a different location in the agent list tree. You cannot move agent lists from 
one platform to another, nor can you move agent lists to an agent list of a different list type (Ordered, 
Random, Balanced, Broadcast, or Rotation), nor can you move a parent agent list into one of its own 
child agent lists.

To move an agent list:

Step 1 From the Navigator pane, select Definitions>Agent Lists to display the Agent Lists pane. Then, select 
a type of agent folder.

Step 2 Double-click the agent list you want to edit, or right-click the agent list and select Edit Agent List from 
the context menu.

Step 3 In the Parent List field, select a new parent agent list from the drop-down menu.

Selecting Agents for an Agent List

You select the agents that belong to an agent list from the Agent List Definition dialog. You can also 
order the selected list. This is necessary for ordered list types where you can specify the primary agent 
by placing it first in the list.

To select an agent for an agent list:
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Step 1 From the Navigator pane, select Definitions>Agent Lists to display the Agent Lists pane. Then, select 
a type of agent folder.

Step 2 Double-click the agent list you want to edit, or right-click the agent list and select Edit Agent List from 
the context menu.

Step 3 From the Agents Available field drop-down menu, select the agent(s) to include in the agent list. The 
agents shown in this field are all licensed agents on your system with the specified platform. Note that 
any agents with a red X are not available for use, although they are licensed agents.

Step 4 To add agents to the agent list, click:

a. The left arrow button (<) to transfer the selected agent(s) to the Agents Selected field.

b. The double left arrow button (<<) to transfer all agents to the Agents Selected field.

Step 5 To remove agents from the agent list, click:

a. The right arrow button (>) to transfer the selected agent(s) from the Agents Selected field.

b. The double right arrow button (>>) to transfer all agents from the Agents Selected field.

Viewing Agent Lists

Agent lists are displayed in a hierarchical format in the agent lists panes. Each platform that TES 
supports has its own agent lists pane. Each agent list displays its associated agents as child nodes, and 
displays any child agent lists. 

From the Navigator pane, select Definitions>Agent Lists to display the Agent Lists pane. Then, select a 
type of agent folder.

Viewing Agent List Properties

To view an agent list’s properties:

Step 1 From the Navigator pane, select Definitions>Agent Lists to display the Agent Lists pane. Then, select 
a type of agent folder.

Step 2 Double-click the agent list you want to view, or right-click the agent list and select Edit Agent List from 
the context menu.
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C H A P T E R 11

Monitoring Production

TES includes a reporting mechanism that supports numerous reports, such as:

• Data displayed in every window

• Operator alerts and responses

• Job statuses

• Event history

• Dependency cross-references

• Production schedule summary

Reports Pane
TES reports let you print out information that exists in the TES database. A report can be generated from 
the information displayed in any Scheduler pane by clicking the Print button that is placed in each button 
bar. (In some windows, you must select a sub-category in the window to display the button bar.) Clicking 
the Print button displays a preview of the report. You can print the report by clicking the Print button in 
the preview toolbar. 

There are also specialized reports available from the Reports main menu. The four reports available are 
Job Last Status, Schedule Summary, Dependency Cross Reference and Event History. 

Note For reports to display and print properly, your machine must have a default printer configured. It is 
recommended that reports be printed in the landscape configuration.

Reports Interface
TES supports numerous reports, such as:

• Data displayed in every window

• Operator alerts and responses

• Job statuses

• Event history

• Dependency cross-references

• Production schedule summary
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From the Reports main menu on the TES Web client, select the type of report that you want to see or 
print.

The four reports available from the Reports main menu are Job Last Status, Schedule Summary, 
Dependency Cross Reference and Event History.

You can reach the Reports interface for other types of TES reports by clicking the Print button while in 
those areas.

Buttons

• First Page —Displays the first tab of the report.

• Prior Page —Displays the previous tab of the report.

• Next Page —Displays the next tab of the report.

• Last Page —Displays the last tab of the report.

• Print —Prints the report using the current print settings.

• Zoom to fit —Fits an entire report tab onto the screen. If you change the window size, the contents 
resize to show a complete tab.

• Save Report —Saves the report to a text file.

• Open Report —Allows you to open a previously saved report.

• Help —Accesses the online help system for relevant context information. 

Note You can also use the tab UP, TAB DOWN, HOME and END keys on your keyboard to navigate any Reports 
window: Tab Up = next tab, tab Down = previous tab, Home = first tab, End = last tab.

Search Field

Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based.

Columns

The set of columns displayed in a Reports window depends on the specific report that is being 
previewed.

Reports Window Context Menu
When you right-click in any Reports preview window, the Reports window context menu displays. 

The Reports window context menu contains the following element:

• First Page —Displays the first tab of the report. This option has the same function as the First Page 
button.
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• Next Page —Displays the next tab in the report. This option has the same function as the Next Page 
button.

• Previous Page —Displays the previous tab in the report. This option has the same function as the 
Previous Page button.

• Last Page —Displays the last tab of the report. This option has the same function as the Last Page 
button.

• Zoom —Fits an entire report tab onto the screen. This option has the same function as the Zoom to 
fit button. If you change the window size, the contents resize to show a complete tab.

• Print —Prints the report using the current print settings. This option has the same function as the 
Print button.

• Save —Saves the report to a text file. This option has the same function as the Save button.

• Open —Loads a previously saved report. This option has the same function as the Open button. 

Main Menu Reports

Job Last Status Report

The Job Last Status report shows a snapshot of the status of all the latest occurrences of jobs in the 
production schedule and reveals actual start times vs. estimated start times.

Table 11-1 Column Meaning in Job Last Status Report

Column Name Description

Job No The job occurrence number.

Job 
Name/Command

The name of the job as defined in the job’s definition and the executable 
file specified in the Command Name field.

Parent The parent job group (if any) to which the job belongs.

Status The last status of the job at the time the report was generated. If the job 
has not yet run, this field will be blank.

Time The actual date and time the job started.

Prod. Date The production date for which the job was originally scheduled.

Est. Time The estimated job start date and time based on the job’s dependencies 
and time window.
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Schedule Summary Report

This report provides a general understanding of job throughput in the production schedule. It reveals the 
number of successful jobs vs. failed jobs and shows all the current statuses. If you report on multiple 
days, daily job totals and an overall sum total are given.

Dependency Cross Reference Report

This report provides information about dependencies on jobs that are in the production schedule. 

Direct dependents are jobs that are directly dependent on the job defined by job name. Indirect 
dependents are all other jobs in the dependency chain that are affected by the direct dependents.

For example, if Job A‚Job B‚J C‚J D were the dependency chain, and Job A was listed, Job B would be 
the direct dependent, and Job C and Job D would be the indirect dependents.

Table 11-2 Column Meaning in Schedule Summary Report

Column Name Description

Date Displays the date of the schedule covered by the summary report.

Scheduled Displays the number of jobs and job groups that were scheduled using a 
calendar.

Inserted Displays the number of jobs that were manually added to the schedule.

Failed Displays the number of jobs that failed (statuses of Error Occurred and 
Completed Abnormally).

Timed Out Displays the number of jobs that didn’t run within their time window.

Reruns Displays the number of jobs that were rerun by an Operator (through the 
job control menu Rerun option).

Current Statuses Lists all the current statuses in the production schedule.

Table 11-3 Column Meaning in Dependency Cross Reference Report

Column Name Description

Job Name Displays the root job for which to show dependencies.

Direct Dependents Displays all the dependencies that are last in line to be completed before 
all other dependencies are met.

Indirect Dependents Displays all the dependencies that must be completed before the direct 
dependents can complete.
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Event History Report

This report displays information about the events that occurred in the time interval specified in the Event 
History Selection dialog. Optionally, you can include in the report details about the action that was triggered 
by the event. 

Event History Selection Dialog
The Event History Selection dialog displays by selecting Event History from the Reports main menu. 
In this dialog, you select the criteria to be used as the report is compiled.

This dialog contains the following elements:

• All Days —Includes each day of available event history in the Event History report.

• Date Range —Specifies a range of dates and a starting time and ending time. To compile a report 
on a specific time window, specify the same date in the From and Until fields and enter the starting 
and ending times of the time window.

• All Types —Includes all types of events in the Event History report.

• By Type —Specifies a single type of event to exclude the other event types from the Event History 
report.

• Include Action Detail —Includes details about the action that the event triggered in the Event 
History report.

Report Range Dialog
The Report Range dialog displays by selecting Schedule Summary from the Reports main menu.

The Report Date Range dialog is used to select the dates that are used for the report. The default date is 
today (the current day). You can either type dates directly in the fields or click the down-arrow button to 
select a date from the graphical calendar. No information displays for dates that extend beyond your job 
history (past or future).

Table 11-4 Column Meaning in Event History Report

Column Name Description

Trigger Time Displays the time that the event was triggered.

Event Name Displays the name of the event that was triggered.

Trigger Displays the condition that triggered the event action that was taken in 
response to the event.

Status The current status of the event.

The fields below are displayed only if the Include Action Detail option is selected.

Action Time Displays the status of the action.

Action Name The name of the action that was triggered by the event.

Action Type Displays the type of action that was taken.

Action Status Displays the status of the action.
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Individual Pane Reports
Most pane reports will not print reports on individual items listed in the pane. These reports require a 
minimum of two items or more in the report. If you select just one item before selecting the Print button, 
the entire contents of the pane are included in the report. The only panes that allow a report on a single 
item are the Job Activity, Jobs and Calendars panes. 

You can select multiple items in a window that are adjacent to each other by holding down the SHIFT 
key and clicking the first and last items in a desired range of items. 
You can select multiple items in a window that are non-adjacent to each other by holding down the CTRL 
key and clicking the desired item.

Actions Report

The Actions Report preview window displays by clicking the Print button or by right-clicking and 
selecting Print from the context menu in any Actions pane. 

The Actions report contains the following columns:

Agent Lists Report

The Agent Lists report preview window displays by clicking the Print button or by right-clicking and 
selecting Print from the context menu in the Agent Lists pane. 

The Agent Lists report contains the following columns:

Alerts/Response Report

The Alerts/Response report preview window displays by clicking the Print button or by right-clicking 
and selecting Print from the context menu within the Alerts pane. 

Table 11-5 Column Meaning in Actions Report

Column Name Description

Owner Displays the owner of the action.

Action Name Displays the name of the action.

Public Indicates if the action is available to other users.

Action Description Displays any description that is entered on the Description tab of the 
action's dialog.

Modified Displays the date and time that the action was modified.

Table 11-6 Column Meaning in Agent Lists Report

Column Name Description

List Name/Agent 
Name

Displays the name of the agent list with the names of the agents.

List Type Displays the type of agent list. Agent lists can be Ordered, Random, 
Balanced, Broadcast or Rotation.

Modified Displays the date and time that the agent list was modified.
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The Alerts/Response report contains the following columns:

Calendars Report

The Calendars report preview window displays by clicking the Print button or by right-clicking and 
selecting Print from the context menu within the Calendars pane. 

The Calendars report contains the following columns:

Connections Report

The Connections report preview window displays by clicking the Print button or by right-clicking and 
selecting Print from the context menu, from the Connections pane. 

The Connections report contains the following columns:

Table 11-7 Column Meaning in Alerts/Response Report

Column Name Description

Time Displays the time the alert was issued.

Status The last status of the job at the time the report was generated. 

Job No The job occurrence number.

Job Name The name of the job as defined in the job’s definition.

Alert Message The message the operator receives when viewing the alert.

Response The response entered by the operator.

Table 11-8 Column Meaning in Calendars Report

Column Name Description

Name Displays the names of the calendar.

Type Displays the type of calendar.

Public Indicates if the calendar is Public; that is, available to all TES users.

Modified Displays the date and time that the calendar was modified.

Rules/Conditions Displays any rules or conditions applied to the calendar.

Table 11-9 Column Meaning in Connections Report

Column Name Description

Name Displays the name of the machine displayed in TES panes and dialogs. 
This is not necessarily the same name the machine uses on the network.

Type Displays the TES component type. This column can show either master, 
agent, adapter, backup master, or fault monitor.

Operating System Displays the operating system used by the component.

Active Displays whether the connection is active and available to be used.

Limit Displays the job limit for an agent or adapter connection.
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Event Activity Report

The Event Activity report preview window displays by clicking the Print button or by right-clicking and 
selecting Print from the context menu, from the Event Activity pane. 

The Event Activity report contains the following columns:

Fiscal Calendars Report

The Fiscal Calendars report preview window displays by clicking the Print button or by right-clicking 
and selecting Print from the context menu, from the Fiscal Calendars pane. 

The Fiscal Calendars report contains the following columns:

Machine Name Displays the machine name as recognized by the network.

Ports Displays the port number(s) the component uses to communicate with 
the master. The master row contains the port number that Tidal Web 
clients use to communicate with it.

Table 11-9 Column Meaning in Connections Report

Column Name Description

Table 11-10 Column Meaning in Event Activity Report

Column Name Description

Name Displays the name of the event.

Type Displays the type of event.

Count Displays how many times the event occurred.

Modified Displays the last time that the event definition was modified.

Trigger Displays the event trigger that initiates the job event.

Status Displays the current status of the event.

Agent Displays the name of the connection being watched by the monitor. Job 
and system events do not monitor a connection so this column is blank 
for those event types.

Owner Displays the user that owns the event.

Table 11-11 Column Meaning in Fiscal Calendars Report

Column Name Description

Name Displays the name of the event.

Starting Month Displays the month that the fiscal calendar begins in.

Starting Day Displays the first day of the starting month of the fiscal calendar.

Quarter Breakdown Displays the number of weeks in each month of a quarter in the fiscal 
year.
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Schedules Report

The Schedules report preview window displays by clicking the Print button or by right-clicking and 
selecting Print from the context menu in the Schedules pane. 

The Schedules report contains the following columns:

Job Activity Report

The Job Activity report displays by clicking the Print button or by right-clicking and selecting Print 
from the context menu in the Job Activity pane. 

Note There are four job activity reports that are not available from the Print button. These reports are the Job 
Last Status, Schedule Summary, Dependency Cross Reference and Event History reports. For 
information about the Job Last Status, Schedule Summary, Dependency Cross Reference and Event 
History reports, see Main Menu Reports, page 11-363.

The Job Activity report contains the following columns: 

Table 11-12 Column Meaning in Connections Report

Column Name Description

Date Displays the date of the production schedule.

Compile Start Displays the date and time when the schedule compile began.

Compile End Displays the date and time when the schedule compile finished.

Duration The overall length of time of the compile.

Scheduled Jobs The number of scheduled jobs.

Adhoc Jobs The number of unscheduled jobs.

Reruns The number of jobs that were rerun jobs (not original instances).

Carry-Over The number of jobs that were carried forward from a previous schedule.

Table 11-13 Column Meaning in Job Activity Report

Column Name Description

Job No Displays the job instance identification number.

Job Name Displays the name of the job or job group as defined in the job’s or job 
group’s definition.

Status Displays the present status of the job.

Parameter Displays the associated parameter.

Start Time Displays the time the job is (or became) active.

Duration Displays the estimated or actual runtime duration.

Agent Displays the name of the agent on which the job runs.

Queue Displays the queue from which the job runs.

Runtime Use/Owner Displays the runtime user and/or owner the job or job group runs as.
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Job Classes Report

The Job Classes report preview window displays by clicking the Print button or by right-clicking and 
selecting Print from the context menu in the Job Classes pane. 

The Job Classes report contains the following columns:

Job Events Report

The Job Events report preview window displays by clicking the Print button or by right-clicking and 
selecting Print from the context menu in the Job Events pane.

The Job Events report contains the following columns:

Jobs Report

The Jobs report preview window displays by clicking the Print button or by right-clicking and selecting 
Print from the context menu in the Jobs pane when a job or job group is selected. 

The Job Events report contains the following columns: 

Table 11-14 Column Meaning in Job Classes Report

Column Name Description

Job Class Name Displays the name of the job class.

Description Displays the description of the job class (optional), as specified in its 
definition.

Modified Displays the date and time that the job class was modified.

Table 11-15 Column Meaning in Job Events Report

Column Name Description

Owner Displays the owner of the job event.

Event Name Displays the name of the job event.

Event Trigger Displays the event trigger associated with the job event.

Enabled Indicates if a job event is enabled and available to use.

Modified Displays the date and time that a job event was modified.

Table 11-16 Column Meaning in Job Report

Column Name Description

Job Name Displays the name of the selected job or job group.

Parent Displays the name of the parent job group for the selected job or job 
group.

Enabled Displays whether the job is active or inactive. The job must be enabled 
before it can run. It has nothing to do with the status of the job or job group 
in the production schedule.

Job Class Displays the job class that this job or job group belongs to.
11-370
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 11      Monitoring Production
  Reports Pane
System Logs Report

The System Log report preview window displays by clicking the Print button or by right-clicking and 
selecting Print from the context menu in the Logs pane. 

The System Logs report contains the following columns:

Command Displays the command and its parameters that is associated with the job. 
Commands cannot be associated to job groups

Environment File Displays the environment file that is associated with the job. Environment 
files cannot be associated to job groups.

Working 
Directory

Displays the pathname for the working directory for the program or script 
specified in the Command field.

Calendar Displays the calendar name that is associated to the job or job group.

Time Window Displays the time window in which the job or job group can run, as 
specified in the job or job group definition.

Repeat Displays the number of times the job or job group repeats.

Agent Name Displays the name of the agent on which the job runs.

Runtime User Displays the runtime user name that is used to run the job.

Description Displays the description of the job or job group. This is the user-defined 
description that exists on the Description(s) tab.

Table 11-16 Column Meaning in Job Report

Column Name Description

Table 11-17 Column Meaning in Job Report

Column Name Description

Log ID Displays the Log ID number for the log message. This number is always 
unique.

Time Displays the date and time the log message was generated.

(Continued)

Message Displays the text of the log message.

Sender Displays the system component that was the source of the log message, 
e.g., master, agent, Tidal Web client, Job Manager, etc.

Job Name Displays the name of the job that generated the message. This field is 
blank for user edits.

Job ID Displays the unique ID number of the job (if any) that generated the log 
message.

User Displays the user name of the job that generated the log message. User 
names appear on audit messages relating to login/logout of users and any 
edits made by users.

Agent Displays the name of the agent if the log message originated from an 
agent.
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Queues Report

The Queues report preview window displays by clicking the Print button or by 
right-clicking and selecting Print from the context menu in the Queue pane. 

The Queues report contains the following columns: 

Security Policies Report

The Security Policy report preview window displays by clicking the Print button or by right-clicking and 
selecting Print from the context menu in the Security Policies pane. 

The Security Policies report contains the following columns:

System Events Report

The System Events report preview window displays by clicking the Print button or by right-clicking and 
selecting Print from the context menu, in the System Events pane. 

The System Events report contains the following columns:

Table 11-18 Column Meaning in Queues Report

Column Name Description

Queue Name Displays the name of the queue.

Active Displays whether the queue is active or disabled.

Limit Displays the number of jobs that can run from the queue at one time.

Priority Displays the priority value assigned to the queue with respect to other 
queues in the system.

Bumping Displays whether jobs can migrate from this queue to other higher priority 
queues if jobs are not being launched after a certain period of time.

Hours Available Displays the hours of operation assigned to the queue.

Modified Displays the date and time that the queue was modified.

Table 11-19 Column Meaning in Security Policies Report

Column Name Description

Security Policy Displays the name of the security policy.

Modified Displays the date and time that the security policy was modified.

Category Displays the function categories that are included in the security policy.

Functions Displays the functions that are included in each selected category.

Table 11-20 Column Meaning in System Events Report

Column Name Description

Owner Displays the owner of the system event.

Event Name Displays the name of the system event.

Event Trigger Displays the event trigger associated with the system event.
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Users Report

The Users report preview window displays by clicking the Print button or by 
right-clicking and selecting Print from the context menu in the Users pane. 

The Users report contains the following columns:

Variables Report

The Variables report preview window displays by clicking the Print button or by right-clicking and 
selecting Print from the context menu in the Variables pane. 

The Variables report contains the following columns:

Workgroups Report

The Workgroups report preview window displays by clicking the Print button or by right-clicking and 
selecting Print from the context menu in the Workgroups pane. 

Enabled Displays whether the system event is enabled for use.

Modified Displays the date and time that the system event was modified.

Table 11-20 Column Meaning in System Events Report

Column Name Description

Table 11-21 Column Meaning in Users Report

Column Name Description

User Displays the login name of the TES user. This is the name TES uses to 
validate a user. When specifying a runtime user, it is this user name that is 
referred to.

Full Name Displays the name specified as the user’s full name in their user definition.

Security Policy Displays the user’s assigned security policy name.

(Continued)

Email Displays the user’s email address.

Phone Displays the user’s phone number.

Table 11-22 Column Meaning in Users Report

Column Name Description

Owner Displays the owner of the variable. Owners can be users or workgroups.

Variable Name Displays the name of the variable including its id number.

Type Displays the type of variable (string, number or date).

Variable Value Displays the current value of the variable.

Modified Displays the date and time that the variable was changed.
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The Workgroups report contains the following columns:

Logs Pane
You can use the Logs pane to view and print a history of Error, Audit, Warning and Diagnostic messages 
that were generated by TES. These messages are part of normal TES operations but diagnostic messages 
are logged only when troubleshooting.

If there are a lot of logging messages, it may take a long time to load them when this window is selected. 
If there are more than 10,000 messages in the Logs pane, a dialog with the following message displays 
when the window displays: There are <number> log messages for the current production day. 
It is recommended that you enable Server Side Filtering and redefine your selection 

criteria. Would you like to display the Log Filter dialog now?

It is recommended that you select the Yes option and filter the log messages from the Server Side to 
download and display only the messages that you are interested in. If you do not use the Server Side filter 
with the log messages, all of the log messages are downloaded and it may take a long time to display 
these messages. For more information on filtering the logs, refer to the Log Filter Dialog, page 11-379.

With each message, TES includes a message source to help you determine where the error occurred. 

The possible sources are:

• Clients

• Masters

• Agent Manager

• Fault Tolerance

• Dependency Manager

• Job Manager

• Action Manager

• Queue Manager

• Users 

• Fault Tolerance

• Client Manager

• Compiler

• Database

• Communication

Table 11-23 Column Meaning in Workgroups Report

Column Name Description

Workgroup Displays the name of the workgroup.

Users Displays a list of users belonging to the workgroup.
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Error Messages
Error messages all concern a failure or abnormal operation of some kind. Origins include agent 
problems, fault tolerance components, and actions that were not executed. An Error message gives you 
information that helps you determine where to look to resolve the error. By default, error messages 
appear in red text but this color can be modified in the Preferences dialog.

Audit Messages
Audit messages generally relate routine details of TES operations. Operating system errors are the 
exception, and are included under TES audit messages. By default, Audit messages appear in green text 
but this color can be modified in the Preferences dialog.

Audit messages fall into the following categories:

• Master —Records all accounts of when the master started and stopped.

• Purging —Records all accounts of when job occurrences and audit messages are purged from the 
database.

• Production Schedule —Records all accounts of when jobs change status, and of when the 
production schedule is recreated.

• User Actions —Records when TES items are added or edited, such as jobs, job groups, job events, 
job actions, etc. Impersonate User activities are also logged.

• Operator Actions —Records job control performed on job occurrences in the production schedule. 

• Fault Tolerance —Records activities of the fault tolerance mechanism when installed.

Audit messages include:

• Master status

• Purging of old jobs from the production schedule

• Purging of audit, error, and diagnostic messages

• Production date turnover

• Job occurrence status change

• Add, edit and delete actions from different TES panes

• Job control performed by a user or through an action

• Normal fault tolerance activities

• System error messages

Warning Messages
Warning messages are generated by conditions that can lead to potential problems. They are 
precautionary alerts to a user to investigate a condition before it becomes a problem. Warning messages 
always appear in the log in gray text because their color cannot be configured. 
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Diagnostic Messages
Diagnostic messages are used for internal debugging purposes as a tool for better analysis of product 
code. Diagnostics for the various system components that comprise TES are configured from the 
Logging tab of the System Configuration dialog. The level of diagnostic logging detail can be configured 
for each individual component. While the default diagnostic setting is Severe, the settings range from 
None to High Debug. The higher settings should only be used under the supervision of Tidal’s Support 
personnel. The amount of information collected on the higher settings can consume large volumes of 
disk space on your machine. 
The default location for diagnostic logs on a Windows master machine is C:\Program 
Files\Tidal\Scheduler\master\logs.
The default location for diagnostic logs on a Unix master machine is: opt/Tidal/master/logs.

Selecting the Client Diagnostics option on the Logging tab will collect diagnostic information on the 
connection socket between the master and the Tidal Web client. 

Note Other information about the Tidal Web client is collected from the Poll Activity pane in the Master 
Status pane. Right-clicking in this pane and selecting the Client Debug option enables Tidal Web client 
diagnostic logging that gathers information into a file in the Master directory called sadiags.txt. Refer 
to <Jumps>“Troubleshooting” on page 407 for more information.

Logs Pane Interface
From the Navigator pane, select Operations>Logs to display the Logs pane. 

You can change the sort order of the display by clicking the head of the column that you want to use as 
a sort key. 

Buttons 

•  Filter —Displays the Logs Filter dialog to customize the data that displays in the Logs pane.

•  Prior Day —Displays the log records for the day before the one currently displayed.

•  Select Day —Displays the log records for today or any other day.

•  Next Day —Displays the log records for the day after the one currently displayed. 

•  Print —Displays the Reports window to view and print the contents of the Logs pane. For more 
information, see System Logs Report, page 11-371.

Search Field

Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based.
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Columns

• Log ID —The identification number of the message. This identification number is unique to each 
message. Any log ID with a minus sign refer to log entries from a backup master. The minus sign 
helps identify log entries that occurred during a failover.

• Time —The date and time the message was logged.

• Type —The type of log message (Error, Audit or Warning).

• Message —The text of the log message.

• Source —The source of the message.

• Job Name —The name of the originating job.

• Job No. —The unique job ID number.

• User Name —The name of the originating user.

• Agent —The name of the originating agent.

• Msg ID —The message number that corresponds to the message text (also corresponding with the 
Message drop-down list log filter). You can search for all messages based on the message number.

• Computer —The computer from which the log message originated.

• Job Alias —The unique code that identifies a job or job group.

Logs Preferences Dialog

If you select Preferences from the View main menu while viewing the Logs pane, the Logs Preferences 
dialog displays.

Columns Tab

From the Columns tab () of the Logs Preferences dialog, you can select which columns are displayed in 
the Logs pane and in what order they appear.

• A checkmark to the left of a column title indicates that it will be displayed in the window. No 
checkmark indicates that it will not be displayed.

• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.
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General Tab

From the drop-down menu in the Error Messages and Audit Messages fields, you can select a color to 
represent each of these log message. 

Navigator Context Menu

When you right-click in the Navigator pane while viewing the Logs pane, the Navigator context menu 
displays. 

The Logs Navigator context menu contains the following options:

• Filter —Displays the Log Filter dialog. Has the same function as the Filter button on the toolbar. 
You can filter the job occurrences that are displayed in the Jobs pane according to criteria you select. 
You can also custom-sort log records. For more information about the Log Filter dialog, see Log 
Filter Dialog, page 11-379.

• Prior Day —Displays the logs for the day before the one currently displayed. This option has the 
same function as the Prior Day button on the toolbar. 

• Next Day —Displays the logs for the day after the one currently displayed. This option has the same 
function as the Next Day button on the toolbar. 

• Select Day —Displays a calendar to select the date whose logs you want to view. This option has 
the same function as the Select Day button on the toolbar. 

• Preferences —Displays the Preferences dialog for the Logs pane.

• Print —Displays the Reports window to view and print your log records. This option has the same 
function as the Print button on the toolbar. For more information about the Reports window, see 
Reports Interface, page 11-361.

• Export —Saves the data in the current pane as an ASCII text file. You can then use the file data in 
other applications. 

• Refresh —Updates the data in the current pane.

Logs Pane Context Menu

When you right-click in the Logs pane, the Logs pane context menu displays. 

The Logs pane context menu contains the following options:

• Details Displays the details of a selected log message.

• Filter —Displays the Log Filter dialog to filter the job occurrences that are displayed in the Jobs 
pane according to criteria you select. This option has the same function as the Filter button on the 
toolbar. For more information about the Log Filter dialog, see Log Filter Dialog, page 11-379) You 
can also custom-sort log records. 

• Prior Day —Displays the logs for the day before the one currently displayed. This option has the 
same function as the Prior Day button on the toolbar: 

• Next Day —Displays the logs for the day after the one currently displayed. This option has the same 
function as the Next Day button on the toolbar: 

• Select Day —Displays a calendar to select the date whose logs you want to view. This option has 
the same function as the Select Day button on the toolbar. 

• Print —Displays the Reports window to view and print your log records. This option has the same 
function as the Print button on the toolbar. For more information about the Reports window, see 
Reports Interface, page 11-361.
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• Auto Update —Sets the Logs pane display to refresh automatically. 

Log Filter Dialog
To open the Log Filter dialog, click the Log Filter button on the TES toolbar from the Logs pane, or 
select Filter from the Logs pane context menu. The settings in this dialog are the parameters for which 
log messages are displayed in the Logs pane. 

Note All times within the logs are adjusted relative to the master’s time zone.

This dialog contains the following elements:

• Source —The source of the message. Leaving this field empty includes messages from all sources.

• Agent —From the drop-down menu, you can select a specific agent whose messages you want to 
see. Making no selection in this field includes all agents’ messages. 

• Job Name —You can select or manually type the name of any job whose messages you want to see. 
Leaving this field empty includes messages from all jobs. 

• To search for a job, click the Browse button, to open the Job Search dialog.

• Errors —Selecting this option includes TES error messages in the Logs pane (according to the other 
filters specified). Error messages note failures or abnormal TES operations.

• Audits —Selecting this option includes TES audit messages in the Logs pane (according to the other 
filters specified). Audit messages primarily track normal status changes and actions that affect TES 
operations though operating system errors are also noted.

• Warnings —Selecting this option includes TES warning messages in the Logs pane (according to 
the other filters specified). Warning messages are precautionary alerts to potential problems.

• Hours —Displays messages that occurred only during the hours selected. The default is to have all 
hours selected.

• Current day —Messages from today only.

• Date Range... From ... To ... —Select a specific period of days to see log messages. You can type 
directly into these fields using the date format specified in your Windows Regional Settings Control 
Panel or click the Browse button to select dates from a graphical calendar.

• Computer —The name of the computer where the message originated.

• User —The user who owns the event that generated the message.

• Message Text —Type text here if you want to see only logs containing certain text strings. Leaving 
this field blank displays all messages.

• Last —Select this option to start filtering from the most recent entry in the log.

• Minutes —Specify how far back in time within the current log to filter. Clicking the arrows changes 
the minutes in increments of 60.

• Server Side Filter —This option can improve performance by reducing network traffic. Select this 
option if the log filter criteria does not change very often. With this option selected, only logs 
meeting the defined criteria are downloaded to the Tidal Web client when the Logs pane is selected. 
Once the filter criteria is changed, logs are filtered again according to the new criteria and 
downloaded again. 
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If the option is not selected, all logs are downloaded first and then filtered by the Tidal Web 
client to meet the defined criteria. After the initial download it is quicker to refilter the logs 
from the Tidal Web client since they do not have to be downloaded again.

• Defaults —Resets the criteria to both Errors and Audits types and all hours.

Log Details Dialog
To open the Log Details dialog, double-click any individual record in the Logs pane.

Scheduler Error Messages

The following table lists the TES errors that may appear in log messages

Table 11-24 Error Message Descriptions

Column Name Log # Description

Job %%1 terminated on signal. 2101 The job on the agent was aborted by the TES 
system or terminated in some other manner.

Problem with spool file for job 
%%1.

2102 There was a problem with the job script or the 
environment file for the given job:

The job’s script file does not exist or cannot be 
read.

The job data string sent by the master was 
corrupt.

There was an error transferring the job script 
from the master to the agent.

There was an error transferring the environment 
file from the master to the agent.

Effective user was not found on 
agent for job %%1.

2103 The effective or runtime user (the user for 
whom the job runs) does not exist on the agent.

Job name was not provided for job 
%%1.

2104 The system attempted to launch a job that had 
no name.

Could not set group id for job %%1. 2105 The agent could not set the group id of the 
process executing the job to that of the runtime 
user.

Could not set user id for job %%1. 2106 The agent could not set the user id of the 
process executing the job to that of the runtime 
user.

Could not change to home directory 
for job %%1.

2107 The agent could not change directories to the 
product directory on the agent.

Could not execute user script for job 
%%1.

2108 The agent could not execute the script for the 
job.

Was not able to fork child process 
for job %%1.

2109 The agent was not able to create a process to run 
the user’s script.
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Job %%1 is already running on 
agent.

2110 The named job is already running on the agent.

Pipe to output command failed for 
job %%1.

2111 The agent failed to run the output command for 
the job.

SAP failure launching job %%1. 2112 The SAP job failed to launch.

Failure launching PeopleSoft job 
%%1.

2113 The PeopleSoft job failed to launch.

Status Update query failed for job 
%%1.

2150 The job status could not be updated.

Launch failure for job %%1 [%%2]. 2151 The job could not be launched.

Failed to send mail regarding %%1 
to %%2 for alert (Error %%3).

2160 There was an error in the mail system that 
prevented mail from being sent.

Failed to make SNMP connection to 
send message: %%1.

2170 There was an error in the SNMP system that 
prevented the SNMP connection from being 
made.

Failed to send SNMP message: 
%%1

2171 There was an error in the SNMP system that 
prevented the SNMP message from being sent.

Primary master lost connection to 
FaultMon.

2200 This error occurs when the fault monitor 
machine or connection fails.

Primary master lost connection to 
backup.

2201 This error occurs when the backup master 
machine or connection fails.

Primary master lost connections to 
FaultMon and backup 
master‚Äìshutting down.

2202 The backup master and fault monitor machine 
or connection fail at the same time.

FaultMon not responding. 2203 Fault monitor connection is up, but fault 
monitor does not respond to polls. This is an 
intermediate error message that precedes 
Primary master lost connection to 
FaultMon.

Backup master not responding. 2204 Fault monitor connection is up, but backup 
master does not respond to polls. This is a 
temporary error message and precedes 
Primary master lost connection to backup.

Backup master lost connection to 
FaultMon.

2205 This error occurs when the backup master 
machine loses connection to the fault monitor. 
There is no fault tolerance until this problem is 
corrected.

FaultMon lost connection to backup 
master.

2206 This error occurs when the Fault Monitor 
machine loses connection to the backup master. 
There is no fault tolerance until this problem is 
corrected.

Backup master is taking over all 
master functions.

2207 Primary master is down. The backup master is 
taking over.

Table 11-24 Error Message Descriptions

Column Name Log # Description
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Audit Messages

The following table lists TES Audit messages:

Incomplete configuration for fault 
tolerance.

2208 There is incomplete information about the 
primary backup or faultmon components in the 
database.

Unable to start backup master 
because fault tolerance is disabled

2209 Fault tolerance is not in operation so the backup 
master could not be started.

Table 11-24 Error Message Descriptions

Column Name Log # Description

Table 11-25 Audit Messages

Message Log # Description

Master Audit Messages

Master starting. 1001 A record of when the Master attempted to start.

Master started. 1002 A record of when the Master completed its 
initialization.

Master shutdown. 1003 A record of when the Master was shut down. 
You cannot run a job on a Master that has been 
shut down.

Purging Audit Messages

Purged jobs older than their 
retention date.

1004 TES purged occurrences of jobs that are older 
then the retention specified in the job’s 
definition.

Purged audit messages from logs 
older than %%1.

1005 TES purged audit messages according to the 
audit log message retention setting in the 
System Configuration dialog.

Purged error messages from logs 
older than %%1.

1006 TES purged error messages according to the 
error log message retention setting in the 
System Configuration dialog.

Production Schedule Audit Messages

New production date %%1. 1008 A create schedule was performed on this date 
and time, recreating job occurrence in the 
production schedule.

Job %%1[%%2] status change to 
%%3.

1100 The specified job occurrence has changed its 
status. This audit message occurs for all jobs in 
the production schedule.

Sent request to insert job %%1. 1215 Records when a job was added to the schedule 
for a particular date only. The job may or may 
not have an associated calendar.

Production Schedule Audit Messages
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Sent request to replace job %%1 in 
schedule.

1217 Records when a job scheduled to run at a future 
time is replaced by an updated version of the 
job.

Added %%1 %%2. 1201 This audit is generated whenever a user adds a 
job, job group, job action, job event, security 
policy, user, variable, workgroup, queue, agent 
list, or job class.

Modified %%1 %%2 %%3. 1202 This audit is generated whenever a user 
modifies a job, job group, job action, job event, 
security policy, user, variable, workgroup, 
queue, agent list, or job class.

Deleted %%1 %%2. 1203 This audit is generated whenever a user deletes 
a calendar, job, job group, job action, job event, 
security policy, user, variable, workgroup, 
queue, agent list, or job class.

User %%1 impersonated user 
%%2

1218 Records when a user impersonates another user. 
Both users are shown.

User %%1 stopped impersonating 
user %%2

1219 Records when a user stopped impersonating 
another user. Both users are shown.

User Action Audit Messages

Sent request to override job %%1. 1204 Records when the operator manually performed 
job control to override the job’s dependencies.

Sent request to cancel job %%1. 1205 Records when the operator cancelled the job 
while it was waiting to run.

Sent request to set job status for 
%%1 to %%2.

1206 Records when the operator changed the 
completion status of the job.

Sent request to stop job %%1. 1207 Records when the operator stopped a job while 
it was running in the production schedule.

Sent request to hold job %%1. 1208 Records when the operator put a job on hold, 
preventing it from running when its 
dependencies are met.

Sent request to rerun job %%1. 1209 Records when the operator reran the job.

Sent request to abort job %%1. 1210 Records when the operator aborted the job 
while it was running.

Sent request to release job %%1. 1211 Records when the operator released the job that 
was specifically waiting on the operator to 
release it before launch.

User Action Audit Messages

Sent request to restart job %%1. 1212 Records when the operator restarted the 
stopped job.

Table 11-25 Audit Messages

Message Log # Description
11-383
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 11      Monitoring Production
  Schedules Pane
TES Diagnostic Messages

Diagnostic messages are intended for Technical Services troubleshooting purposes only.

 Schedules Pane 
The Schedules pane displays a record of TES production statistics. The Schedules pane uses a matrix 
format rather than a graphical approach to provide much the same information as the Master Status pane 
provides in the General Information pane.

Each time a production schedule is compiled, TES adds a log entry to the Schedules pane. Each record 
includes the date, beginning and end times of the compile and totals for different types of jobs.

There are two types of schedules, Scheduled and Forecast. The scheduled type are actual compiled 
schedules ready to run. The forecast type is more of a prototype of a production schedule and is used as 
a beta model of a proposed production day. The forecast schedule is recompiled into an actual production 
schedule when it is time to run.

Double-clicking any schedule listed in the Schedules pane displays the selected schedule in the Job 
Activity pane.

Schedules Pane Interface
From the Navigator pane, select Operations>Schedules to display the Schedules pane. 

You can change the sort order of the display by clicking the head of the column that you want to use as 
a sort key. 

Buttons 

 Print —Displays the Reports window to view and print the contents of the Schedules pane. For more 
information about the Schedules pane report, see Schedules Report, page 11-369.

Run data for job %%1 has been 
modified.

1213 Records when the run data for the job has been 
modified from the production schedule. The 
modified data is not reflected in the job’s 
definition.

Fault Tolerance Audit Messages

Primary Master connected to 
FaultMon

1250 Records when the Primary Master connects to 
the Fault Monitor during startup. This message 
indicates normal operation.

Primary master connected to 
backup

1251 Records when the Primary Master connects to 
the backup master during startup. This message 
indicates normal operation

Table 11-25 Audit Messages

Message Log # Description
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Search Field

Enter text that you want to search for within the columns displayed into this field.

Note This field at the top right of the grids will only search text columns that are not grayed out and are 
string-based. See <Jumps>“Searchable Columns” on page 35.

Columns

• Date —The date of the compile.

• Compile Start —When the compile began.

• Compile End —When the compile finished.

• Duration —The overall length of time of the compile.

• Sched Jobs —The number of scheduled jobs.

• Adhoc Jobs —The number of unscheduled jobs.

• Reruns —The number of jobs that were rerun jobs (not original instances).

• Carry-Over —The number of jobs that were carried forward from a previous schedule.

• Compile Type —The compile type of schedule. If a scheduled compile, the schedule will run as 
soon as the production day starts. If a forecast compile, the schedule is recompiled at the start of the 
production day before the schedule runs.

Schedules Preferences Dialog

If you select Preferences from the View main menu while viewing the Schedules pane, the Schedules 
Preferences dialog displays.

From the Schedules Preferences dialog, you can select which columns are displayed in the Schedules 
console window and in what order they appear.

• A checkmark to the left of a column title indicates that it will be displayed in the window. No 
checkmark indicates that it will not be displayed.

• To rearrange the order in which the columns are displayed, select the column and click the up or 
down arrow.

Navigator Context Menu

When you right-click in the Navigator pane while viewing the Schedules pane, the Navigator context 
menu displays. 

The Schedules Navigator pane context menu contains the following options:

• Refresh —Updates the data in the current pane.

• Print —Displays the Reports window to view and print your schedules records. This option has the 
same function as the Print button on the toolbar. 
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• Create Schedule —Recompiles the selected schedule. If the current day's schedule is selected, then 
a warning displays requesting confirmation that you want to completely replace today's schedule.If 
you replace today's schedule, then any repeating jobs in today's schedule without a time window will 
begin repeating as soon as possible. More control over creating schedules is available from the 
Create Schedule dialog accessed from the Activities main menu. 

• Export —Saves the data in the current pane as an ASCII text file. You can then use the file data in 
other applications. 

• Preferences —Displays the Preferences dialog for the Schedules pane.

• New Root Folder —Allows you to create a new root folder for the Navigator pane.

Schedules Pane Context Menu

When you right-click in the Schedules pane, the Schedules pane context menu displays. 

The Schedules pane context menu contains the following options:

• Edit Schedules —Allows you to edit the selected schedule.

• Refresh —Updates the data in the current pane.

• Print —Displays the Reports window to view and print your schedules records. This option has the 
same function as the Print button on the toolbar. 

• Print Selected —Displays the Reports window to view and print the selected schedules records. 
This option has the same function as the Print button on the toolbar. 

• Create Schedule —Recompiles the selected schedule. If the current day's schedule is selected, then 
a warning displays requesting confirmation that you want to completely replace today's schedule.If 
you replace today's schedule, then any repeating jobs in today's schedule without a time window will 
begin repeating as soon as possible. More control over creating schedules is available from the 
Create Schedule dialog accessed from the Activities main menu. 

• Accept Schedule —When you first create a schedule it is a projected schedule and is only tentative. 
Selecting the Accept Schedule option confirms the projected schedule should become the actual 
schedule. 

• Revert to Forecast —Changes a schedule to tentative.

• Remove Schedule —Deletes the selected schedule. 

Master Status Pane
The Master Status pane displays TES production activity and statistics. It is divided into tabs, with each 
tab displaying a different area of activity. The Master Status display is automatically updated every 60 
seconds. The master version number displays at the top of the Master Status pane.

Master Status Pane
From the Navigator pane, select Operations>Master Status to display the Master Status pane. 
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General Information Pane

The General Information pane shows important production data. Listed are the total number of jobs 
scheduled to run and also breakdowns into different categories.

This pane contains the following elements:

• Start Time —When the master was brought online.

• Last Poll —The last time this Tidal Web client polled the master for information.

• Production Date —The current date of production. Note that this date may differ from the current 
date (today) depending on the settings on the System Configuration dialog, Master tab. For more 
information about the System Configuration dialog, see <Jumps>“Getting Started” on page 29.

• Scheduled Jobs —The number of jobs that are scheduled to run.

• Adhoc Jobs —The number of jobs inserted into the schedule manually.

• Jobs Carried Forward —The number of jobs carried forward from the previous day.

• Carry Forwards to Go —The number of jobs carried forward from the previous day that have not 
run yet.

• Reruns —The number of rerun jobs. This value does not include the original instance of a job, or 
jobs with new instance numbers.

• Total Jobs —The total number of jobs to be run.

• Jobs Done —The total number of jobs that have completed.

• Jobs To Go —The number of jobs that are waiting and still eligible to run.

• Jobs Cancelled —The number of jobs that have been cancelled.

Columns

• Description —The statistic to be counted.

• Value —The value for the statistic.

Poll Activity Pane
The TES master continually polls Tidal Web clients to determine if jobs are ready to launch, to check 
job status, to process Tidal Web client requests, etc. The Poll Activity pane gives you a real-time view 
of polling activity within the last two or three minutes. You can scroll through the list of poll activity.

Columns

• Time —The time of activity.

• Activity —The master activity.

Poll Activity Pane Context Menu

This context menu displays when you right-click in the Poll Activity pane.

This context menu contains the following options:

• Refresh —Updates the data in the Poll Activity pane.
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• Print —Prints the status data in the Poll Activity pane.

• Print Selected —Prints the status of the selected data in the Poll Activity pane.

Within the Polling Activity pane, various four‐letter command codes are used to indicate 
master activity. 

Table 11-26 Error Message Descriptions

Poll Code Description

AG88 An OpenView client connected to the master.

DCHG Generic data changed.

DNOD The master deleted the node.

DSTA The job dependency status was checked.

IMST Intermaster dependency status was checked.

JADD A new job definition was added.

JCAN The job was cancelled.

JCNA All selected job instances were cancelled.

JDEL The job was deleted.

JHLD The job was placed in HOLD status.

JINA The job is inactive.

JINS An ad-hoc job was inserted into schedule.

JOVD The job’s dependencies were overridden.

JOVR The job was overridden.

JREL The job was released.

JREM The job instance was removed.

JRMA All job instances within specified date range were removed.

JRRN The job was rerun.

JRRS The job step was rerun.

JREL The job was released.

JRPL The job rule was changed-replaced job instance.

JSET The job status was set manually.

LICN The license was checked.

PING The master was pinged.

QZRO The queue limit was set to zero (used with alerts).

RAGT The master reconnected to the node.

RCON The configuration status of the agent was refreshed.

REQD The agent requested data.

REST The agent requested estimate times.

RJBR The agent refreshed job run.

(Continued)
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Queue Activity Pane
The Queue Activity pane lists each TES queue and the queue’s limits, and shows how many jobs are 
currently active in the queue as well as how many jobs are waiting to run in it.

Columns

• Name —The name of the queue.

• Priority —The queue priority order.

• Limit —The maximum number of jobs the queue is allowed to accept.

• Active —How many jobs in queue are active.

• Waiting —How many jobs in the queue are waiting to run.

• Enabled —Whether the queue is available. If the current time is outside of the hours of operation 
specified in the Hours field of the Queue Definition dialog, the queue displays No.

• Modified —Last modified date.

Connected Users Pane
The Connected Users pane shows which users are currently running a Tidal Web client connected to the 
master.

RLST The master’s agent list was refreshed after the agent list is modified.

RNOD The master refreshed the node.

RQCL The master shut down the system queue.

RQOP The master opened the system queue.

RQUE The master refreshed the system queue.

RVAR The master refreshed the variables.

RVCA The master refreshed the cache.

RVUP The master updated the variables.

SCMP The master compiled the schedule.

SNDC The master sends the Tidal Web client a message.

SPAU The master stopped the production schedule.

SRES The master resumed the production schedule.

SRFR The master was refreshed.

STOP The master was stopped.

TRMC The master terminated the Tidal Web client connection.

UNOD The master updated the node.

Table 11-26 Error Message Descriptions

Poll Code Description
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Columns

• User —Displays the user name and domain of origin.

• Connected —Displays the time the user started working with TES.

• Client Version —Displays the version number of the connected Tidal Web client.

• Computer —Displays the name of the Tidal Web client machine.

Connected Users Pane Context Menu

Select a connection within the Connected Users pane and right-click to display a context menu.

This context menu contains the following options:

• Send Message —Opens a text field to send a message to the specified Tidal Web client/user.

• Broadcast Message —If an agent connection is not selected, this option opens a field that will 
broadcast the message to all connected Tidal Web clients.

• Terminate Session —Terminates the selected Tidal Web client connection.

Unavailable Connections Pane
The Unavailable Connections pane displays which connections are currently unavailable for use, if any. 

Columns

• Connection —The name of the connection.

• Type —The type of connection that is unavailable.

• Port(s) —The port(s) the connection uses.

Messages Pane
The Messages pane displays contains a log of the last 200 messages shown in the digital display.

Columns

The Messages pane contains the following columns:

• From —The sender of the message.

• Time —The time when the message was received.

• Text —The text of the message.

• Untitled field —The text of the message.

Messages Pane Context Menu

When you right-click in the Messages pane, the Messages pane context menu displays. 

The Messages pane context menu contains the following options:
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• Send Message —Sends a message to a Tidal Web client.

• Broadcast Message —Broadcasts a message to all Tidal Web clients.

Send Message to Client Dialog 

From the Messages tab on the Master Status pane, double-click a message to send a new message to a 
Tidal Web client or to broadcast a message. 

-or-

Right-click a message and select Send Message or Broadcast Message from the context menu.

The Send Message to Client dialog displays.

Type your message and click Send. Your message displays in the Messages tab.
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C H A P T E R 12

Event ID Tables

Job Event Triggers
The following table lists the event triggers for various job events supported by TES.These event triggers 
are supported throughout the various integration channels.Using the event ID number displayed in the 
Windows application log you can reference its meaning from this table. All job events have an ID number 
that begins with 12. (These event ID numbers do not apply to the Unix platform.)

Table 12-1 Job Event Trigger

Event ID Job Event Trigger Event Type Description

12000 Job added to schedule 
on demand

Status Change/Job 
Control

The job was added to the production 
schedule on an unscheduled basis.

12001 Job completed Status Change The job completed with a Completed 
Normally or Completed Abnormally 
status.

12002 Job completed 
abnormally

Status Change The job completed with a Completed 
Abnormally status. The job’s exit code is 
non-zero.

12003 Job completed 
normally

Status Change The job completed with a Completed 
Normally status. The job’s exit code is 0.

12005 Job waiting for 
operator release

Status Change All the job’s dependencies have been met. 
This event trigger only occurs when you 
select the Require operator release option 
in its job definition. The job is now waiting 
for the operator to release it.

12006 Job put on hold Job Control The operator put the waiting job on hold.

12007 Job waiting on 
resource

Status Change All the job’s dependencies have been met 
and the job is waiting for an execution slot 
to become available.

12008 Job not ready by end 
of its time window

Schedule 
Irregularity

The end of the job’s time window was 
reached before its dependencies were met.

12009 Job launched Status Change The queue manager released the job from 
its queue to an agent, and the job entered the 
Launched status. Launch is the status prior 
to the job becoming Active.
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12010 Job Active Status Change The job started running.

12011 Job Stopped Job Control The job was stopped by an operator.

12012 Error occurred while 
launching job

Status Change The job status changed to Error Occurred. 
The job did not run.

12013 Job skipped Schedule 
Irregularity

The job did not run because another 
occurrence of this job was already running. 
The job must have the concurrency option 
set to Skip in its job definition for this to 
occur.

12014 Job deferred Schedule 
Irregularity / 
Status Change

Because another occurrence of this job was 
running when this job was ready to launch, 
the job is waiting for the previous 
occurrence to complete. The job must have 
the concurrency field set to Defer until 
completion in the Job Definition dialog 
box for this to occur.

12015 Agent unavailable for 
job

Status Change The agent or the network has gone down 
prior to the job running. Therefore, the job 
cannot complete on this agent. If the job 
uses an agent list, this event trigger occurs 
in different ways based on the agent list:
Ordered, Random, Balanced, or Rotation 
Agent List: If the job uses any of these 
lists, the event trigger occurs when all 
agents in the list are unavailable to run the 
job.
Broadcast Agent List: If the job uses a 
broadcast list, the event trigger occurs for 
each agent in the list that is unavailable to 
run the job.

12016 Agent for job inactive Status Change The agent’s Enabled flag is set to disabled, 
or inactive. As a result, the job cannot 
launch on this agent. If the job uses an agent 
list, this event trigger occurs in different 
ways based on the agent list:
Ordered, Random, Balanced, or Rotation 
Agent List: If the job runs on any of these 
agent lists, the event trigger occurs if all 
agents in the agent list are inactive.
Broadcast Agent List: If the job runs on a 
broadcast list, the event trigger occurs for 
each agent in the agent list that is inactive.

12017 Job status changed Status Change Your job status changed. You can use this 
event trigger to catch all status changes for 
this job. The associated action occurs for all 
changes to the status of a job.

Table 12-1 Job Event Trigger

Event ID Job Event Trigger Event Type Description
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12018 Job might start later 
than expected

Schedule 
Irregularity

Other jobs which the job depends on are 
running behind schedule. This could cause 
your job to run later than expected. This 
event trigger occurs when one or all of the 
prerequisite jobs run longer than their 
estimated duration. The job might start later 
than originally forecast.

12020 Job might not be 
ready by end of its 
time window

Schedule 
Irregularity

The end of the job’s time window might not 
be reached before its dependencies are met. 
This trigger is activated approximately 7 
seconds before the job’s estimated start 
time becomes later than the end of the job’s 
time window.

12021 Job running longer 
than expected

Schedule 
Irregularity

The job is running longer than its estimated 
duration value. The job continues to run 
unless you stop it with a Job Control action 
that is associated with this event trigger, or 
unless an operator stops it. You initially set 
the Estimated Duration value in the Job 
Definition dialog box when you create the 
job. TES adjusts the value to a historical 
average after each run of the job.

12022 Job running past end 
of its time window

Schedule 
Irregularity

The job is running past the time window set 
for it in its job definition. The job continues 
to run unless it is stopped with an associated 
job control action, or unless it is stopped by 
an user.

12023 Job might run past 
end of its time 
window

Schedule 
Irregularity

The job might run past the time window set 
for it in its job definition. The job will 
continue to run unless it is stopped with an 
associated job control action, or unless it is 
stopped by the user. This trigger is activated 
at the end of the job’s time window minus 
the job’s estimated duration.

12025 Job finished later than 
expected

Schedule 
Irregularity

The job ran longer than the time specified in 
the Estimated Duration field in its job 
definition.

12026 Job running longer 
than its maximum 
time

Schedule 
Irregularity

The job is running longer than its 
Maximum Duration value, as defined in 
its job definition. The job continues to run 
unless you stop it with a job control action 
that is associated with this event trigger, or 
unless it is stopped by an user.

12027 Job ran shorter than 
its minimum time

Schedule 
Irregularity

The job ran in less time than the time 
specified in the Minimum Duration field 
in its job definition.

Table 12-1 Job Event Trigger

Event ID Job Event Trigger Event Type Description
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12028 Operator reran the job Job Control The operator ran a job again after it already 
completed. Once set, this trigger will only 
apply to jobs that were not already in the 
schedule.

12029 Operator cancelled 
the job

Job Control The operator cancelled the job before it had 
a chance to run.

12030 Operator aborted the 
job

Job Control The operator aborted the job while it was 
running. The job could have taken too many 
resources, or some other problem could 
have occurred to justify the abort.

12031 Operator override of 
job dependencies

Job Control The operator launched the job, even though 
all of its dependencies weren’t met.

12032 Job status is 
LAUNCH on startup.

Job Control A job status of Launched means that a 
request to launch the job has been sent to 
the agent, and is pending notification from 
the agent that the job has started executing.

12033 Job added to schedule 
based on calendar

Status Change/Job 
Control

The job was added to the production 
schedule automatically.

12034 Job orphaned Status Change The master lost connection to the agent 
running the job and can not determine the 
job’s current status.

12035 Job rerun would 
exceed maximum 
reruns

Job Control Rerunning the job would exceed the 
maximum reruns allowed.

12036 Job completed with 
specified exit code(s)

Job Control The job completed within the specified exit 
code range. The exit code can denote 
normal or abnormal status for a job to 
trigger different actions.

12037 Job completed 
normally (output 
pending)

Job Control Job completed normally (output pending) 
The job has completed normally but the job 
output is still being gathered and is not yet 
available.

12038 Job completed 
abnormally (output 
pending)

Job Control Job completed abnormally (output pending) 
The job has completed abnormally but the 
job output is still being gathered and is not 
yet available.

12039 Job externally defined 
(output pending)

Job Control Job externally defined (output pending) The 
job status was determined by an external 
user or program and the job output is still 
being gathered and is not yet available.

12043 Job not ready by start 
time

Schedule 
Irregularity

The job’s scheduled start time was reached 
before the job was ready to launch due to 
other dependencies.

Table 12-1 Job Event Trigger

Event ID Job Event Trigger Event Type Description
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System Event Triggers
The following table lists the event triggers for various system events supported by TES.These event 
triggers are associated with system events through the System Event Definition dialog.These event 
triggers are supported throughout the various integration channels.Using the event ID number displayed 
in the Windows application log you can reference its meaning from this table. All system events have an 
ID number that begins with 20.

Table 12-2 System Event Triggers

Event ID Job Event Trigger Description

20001 System queue limit set to zero The system queue’s (master queue under which all 
other queues reside) limit has been set to zero, 
eliminating the possibility for any jobs to enter the 
production schedule.

20002 Any queue limit set to zero A queue’s limit was set to zero. This may have been 
done to prevent jobs of a certain class from running. 
Note that a queue can be set to accept a certain class 
of jobs based on the queue’s filters. To refer to the 
queue in an alert message, use the Queue Name 
variable in the assigned action.

20003 System queue reached its job limit The number of jobs running in the overall system 
queue has reached the overall system queue limit, 
and no other jobs can run until a slot becomes 
available. Slots become available when a job 
running in the queue completes, or the queue’s limit 
is increased. When this trigger occurs, it indicates 
that either too many jobs are being scheduled for the 
capacity of the system, or the system capacity has 
been underestimated, and the system queue limit 
needs to be raised.

20004 Any queue reached its job limit A queue cannot launch any more jobs until a slot 
becomes available in the queue. This may indicate 
that a certain class or type of job is overloading the 
system. To refer to the queue in an alert message, 
use the Queue Name variable in the associated 
action.

20005 Agent reached its job limit The number of jobs an agent is executing is equal to 
its job limit. The agent cannot start any more jobs 
until other jobs complete. To refer to the agent in an 
alert message, use the Agent Name variable in the 
assigned action. This system event can notify users 
when an agent is operating at capacity.

20006 Compile started The production schedule compile has started. 
Compiling usually begins at midnight, when the 
master is started on a new day, or when you select 
the Create Schedule menu item from the 
Operations menu. You can use this system event to 
notify users that a new schedule is being created.
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20007 Compile finished The production schedule compile has completed. 
Compiling time is based on, among other factors, 
the number of jobs. Use this system event to alert 
users that a new schedule is in effect.

20008 Master paused. The master was paused. Waiting jobs are suspended 
until the master resumes operation. You can use this 
system event to notify users that the master was 
temporarily paused, and jobs will not launch until 
the master resumes.

20009 Master resumed. The master has been resumed from paused state. 
You can use this event to notify users that the master 
has resumed launching jobs. Depending on how 
long the master was paused, many jobs may have 
their dependencies met at once, which may cause a 
spike in system resource utilization.

20010 Lost connection to agent/adapter An agent/adapter network connection was lost. To 
refer to the agent, use the Agent Name variable in 
the assigned action. You can use this event to warn 
users that an agent/adapter is no longer connected.

20011 Master program shut down The master has been shut down normally. You can 
use this system event to notify users that all waiting 
jobs will not run until the master restarts.

20012 Backup master took over A fault occurred on the primary master (such as the 
master going down, or a network failure occurred) 
which caused scheduling to be transferred to the 
backup master. You can use this system event to 
warn users that the backup master took over the 
scheduling process. Any jobs that were manually 
updated after the last database replication update 
prior to the takeover will have to be re-entered. See 
the TES Fault Tolerance Guide for more 
information on Fault Tolerance.

20013 Primary master started. The primary master has started. You can use this 
system event to notify users that jobs will resume 
being launched. Depending on how long the Master 
was stopped, many jobs may have their 
dependencies met at once, which may cause a spike 
in system resources.

20014 New production day The master has recognized a new production day for 
which jobs are automatically compiled. You can use 
this event to trigger initializing variables used in 
dependencies.

20015 Lost connection to fault monitor The network connection to the fault monitor was 
lost.

20016 Lost connection to backup master The network connection to the backup master was 
lost.

Table 12-2 System Event Triggers

Event ID Job Event Trigger Description
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20017 Lost connection to database The connection to the database was lost. Operator 
alerts and TES logging actions are not available 
because they access the database. However, the 
logging action can be used with the Windows event 
log.

20018 Lost connection to remote master The network connection to the remote master was 
lost.

Table 12-2 System Event Triggers

Event ID Job Event Trigger Description
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Parameters

Settings and Default Values

Base Properties

JMX

• JmxRmiHost (localhost) – The host of the RMI registry where the JMX Agent is registered

• JmxRmiPort (1100) – The port of the RMI registry where the JMX Agent is registered

• JmxRmiPath – The path in the RMI registry where the JMX Agent is registered

• JmxDefaultNamespace (none) – The default setting is recommended.

• JmxSecurityPasswordsFile (none) – The path to a properties-based text file specifying 
username/password pairs for authenticating incoming JMX connections

• JmxSecurityAccessRulesFile (none) – The path to a properties-based text file specifying 
username/access level pairs.

Message Broker

• MessageBroker.MemoryLimit – The amount of memory (in MB) to allocate to ActiveMQ for 
storing in-flight messages. If queues become full, ActiveMQ will page messages to disk, which is 
more expensive than keeping them in memory. Default is low. Increasing is recommended.

• MessageBroker.TempLimit – The amount of memory (in MB) to allocate to ActiveMQ for storing 
temporary messages. If queues become full, ActiveMQ will page messages to disk, which is more 
expensive than keeping them in memory.

• MessageBroker.StoreLimit – The amount of disk space (in MB) to allocate to ActiveMQ for storing 
in-flight messages when memory is full.
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Master Properties

General

• JmsPort (6215) – The port where the ActiveMQ Broker listens on. All communication from the 
DSPs will be through the ActiveMQ broker.

JMX

• JmxRmiPath (Scheduler) – The path in the RMI registry where the JMX Agent is registered.

ActiveMQ

Tuning for DSP to Master message traffic (all DSP connections)

• MinSessionPoolSize (5)

• MaxSessionPoolSize (10)

• MaxConcurrentMessages(10)

Tuning for Master to DSP message traffic (per DSP connection)

• ClientConnection.MinSessionPoolSize (2)

• ClientConnection.MaxSessionPoolSize (5)

• ClientConnection.MaxConcurrentMessages (5)

Tuning for Remote Master to Master message traffic (per Remote Master)

• RemoteMasterClient.MinSessionPoolSize (2)

• RemoteMasterClient.MaxSessionPoolSize (5)

• RemoteMasterClient.MaxConcurrentMessages (5)

Tuning for Master to RemoteMaster message traffic (per Remote Master)

• RemoteMasterServer.MinSessionPoolSize (2)

• RemoteMasterServer.MaxSessionPoolSize (5)

• RemoteMasterServer.MaxConcurrentMessages (5)

Fault Monitor Properties
• ToleranceTime – The number of minutes before FM treats a connection as down.

• CMDMasterPort (6600) – The command line listening port on the master and on the fault monitor.

• FMMasterPort (6703) – The port on FM that Master connects to.

• FMClientPort (6705) – The ActiveMQ port on FM that DSP connects to.
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Tuning for DSP to FM message traffic (all DSP connections)

• MinSessionPoolSize (2)

• MaxSessionPoolSize (5)

• MaxConcurrentMessages (5)

Data Source Provider (CM Plugin) Properties

General

• ClientType (default) – The folder inside ClientManager/cache containing the DSP to install. This is 
usually configured automatically during CM installation.

Data Cache

• DataCache.ReadConnectionsMin (2) – The minimum number of JDBC connections kept pooled to 
read from the data cache. Having connections always available to handle read requests reduces the 
cost of allocating connections on demand.

• DataCache.ReadConnectionsMax (4) – The maximum number of JDBC connections allowed to be 
allocated concurrently to read from the data cache. If this number is exceeded, read requests will be 
queued and blocked. It is recommend that you increase this setting to handle more concurrent users. 

• DataCache.WriteConnectionsMin (4) – The minimum number of JDBC connections kept pooled 
to write to the data cache. Having connections always available to handle write requests reduces the 
cost of allocating connections on demand.

• DataCache.WriteConnectionsMax (8) – The maximum number of JDBC connections allowed to be 
allocated concurrently to write to the data cache. If this number is exceeded, write request will be 
queued and blocked. Recommend increasing to handle more data update activity between the Master 
and DSP.

• DataCache.PageCacheSize (50000) – The number of pages (of size DataCache.PageSize) in 
memory allocated to the data cache. The in-memory data cache allows for the fastest possible 
read/write access. Thus, for very large data caches, it is recommended that the data cache be given 
as much memory as possible. 

• DataCache.PageSize (4096) – The size (in bytes) of each page in the data cache. The data cache 
stores records in page-size chunks. Larger pages may improve read/write access when the data cache 
needs to fetch records from disk, with the added cost of a larger data cache in-memory and on disk. 
Another factor to keep in mind is the OS disk block size. Usually, it is recommended to keep the 
data cache page size the same as the OS disk block size.

• DataCache.PageReservedSize – The recommend default setting.

• DataCache.CacheSizeDefault (1000) – The number of objects each table in the data cache is 
allowed to keep in memory. More objects equals faster read/write access from and to the data cache.

• DataCache.CacheTypeDefault (SoftWeak) – The default setting is recommended.

• DataCache.CacheShared (true) – The default setting is recommended.
13-403
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 13      Parameters
  Settings and Default Values
Cache Synchronization

• CacheSynchronizer.Purge (N) – Y to purge leftover deleted records during sync. Leftover records 
may exist in the cache if the Master deletes the records from its database when the CM is not 
connected.

• CacheSynchronizer.NumThreads (4) – The number of concurrent threads spawned to sync the 
cache. More threads increase throughput, but use more CPU and memory. Recommend to set at or 
below number of physical cores on machine.

• CacheSynchronizer.StreamCommitSize (1000) –The number of records committed to the cache in 
a batch. Larger batches improve throughput, but use more memory.

ActiveMQ

Tuning for Master to DSP message traffic

• ClientNode.MinSessionPoolSize (5)

• ClientNode.MaxSessionPoolSize (10)

• ClientNode.MaxConcurrentMessages (10)

Tuning for FM to DSP message traffic

• FTNode.MinSessionPoolSize (2)

• FTNode.MaxSessionPoolSize (5)

• FTNode.MaxConcurrentMessages (5)

Client Manager Properties

JMX

• JmxRmiPath (ClientManager) – The path in the RMI registry where the JMX Agent is registered.

ActiveMQ

Tuning for DSP to a user's browser session message traffic 
(per browser session)

• ClientSession.MinSessionPoolSize (4)

• ClientSession.MaxSessionPoolSize (8)

• ClientSession.MaxConcurrentMessages (8)

Tuning for a user's browser session to DSP message traffic 
(all browser sessions)

• DataSource.MinSessionPoolSize (4)

• DataSource.MaxSessionPoolSize (8)
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• DataSource.MaxConcurrentMessages (8)

Security

• Security.Authentication (LDAP) – The method to use for authenticating users. Can be LDAP or 
ActiveDirectory.

ActiveDirectory (Security.Authentication = ActiveDirectory)

• ActiveDirectory.Host (blank) – The ActiveDirectory server URL.

• ActiveDirectory.Port (389) – The ActiveDirectory server port.

• ActiveDirectory.AuthenticationMethod (simple) – How users will be authenticated against the AD 
server. Currently support only simple method.

• ActiveDirectory.UserSearchPrefix (blank) – The prefix of AD node containing user records. The 
CM will scan these records when authenticating a user.

• ActiveDirectory.GroupSearchPrefix (blank) –The prefix of AD node containing group records. The 
CM will scan these records when determining the groups a user belongs to.

LDAP (Security.Authentication = LDAP)

• LDAP.HostName (localhost) – The LDAP server URL.

• LDAP.Port (389) – The LDAP server port.

• LDAP.ContextFactory

• LDAP.BindDN

• LDAP.UserBindDN

• LDAP.GroupBindDN

• LDAP.BindPassword

• LDAP.AuthenticationMethod

• LDAP.ForceBindingLogin

• LDAP.UserObjectClass

• LDAP.UserRdnAttribute

• LDAP.UserIdAttribute

• LDAP.UserPasswordAttribute

• LDAP.RoleObjectClass

• LDAP.RoleMemberAttribute

• LDAP.RoleNameAttribute

DSP Properties
• BackupServer – Backup Master hostname & port (Backup_Master_Hostname:6215)

• PrimaryServer – Master hostname & port (Master_Hostname:6215)
13-405
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 13      Parameters
  Settings and Default Values
General Property Info

ActiveMQ

• MinSessionPoolSize – The minimum number of ActiveMQ sessions kept pooled. Having sessions 
available to handle requests reduces the cost of allocating sessions on demand.

• MaxSessionPoolSize –The maximum number of ActiveMQ sessions kept pooled. Note: if more 
sessions are needed to process messages, the system will still allocate them. This setting only limits 
the number of sessions allowed to be pooled.

• MaxConcurrentMessages  – The maximum number of ActiveMQ messages allowed to be processed 
concurrently. This setting is important for increasing throughput and utilizing all the cores on a 
system when there are many messages waiting in the ActiveMQ queues.

SSL Properties
• MessageBroker.SSL.enabled

• MessageBroker.SSL.keyStore

• MessageBroker.SSL.keyStorePassword

• MessageBroker.SSL.keyPassword

• MessageBroker.SSL.trustStore

• MessageBroker.SSL.trustStorePassword
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Troubleshooting

Overview
When issues arise during TES operations, the operator must gather as much information as possible to 
troubleshoot the problem. Each release of TES undergoes rigorous testing before it becomes available 
to customers. Problems that are discovered during in-house testing can be resolved but the large variety 
of system configurations that exist outside our Quality Assurance labs mean that unknown issues 
inevitably arise as TES enters the field. 

Some difficulties commonly reported by our customers are noted later in this troubleshooting section but 
most of the issues that users encounter are unknown until they are discovered in a customer’s individual 
system environment. 

Our Technical Services team works with our developers to diagnose and fix issues as they are reported. 
A vital part of this process is collecting diagnostic information on the processes occurring in TES at the 
time of the problem. While any information that the operator can recall during the time is useful, the best 
method is to turn on diagnostic logging and record in detail information on system processes when the 
problem occurs. 

If a problem occurs during operation of TES, Support will ask you to enable the diagnostic logging for 
the system component that seems most likely as the source of the problem. To be proactive and to reduce 
our customers downtime as much as possible, we recommend that you follow the procedures provided 
below for turning on diagnostic logging. Try to reproduce the problem so the state of the system can be 
recorded when the problem occurs. 

Collecting diagnostic information before you contact Technical Services provides a head start to 
resolving the problem. When you are experiencing problems with TES as indicated by error messages, 
turning on diagnostic logging for that system component collects information that can be used to 
pinpoint the problem.

Note If an anti-virus program will be scanning folders where TES components reside, configure the program 
to avoid scanning the log and diagnostic files of the master and client components. The constant updating 
that these files undergo will consume a large amount of processing resources.

Collecting Diagnostic Information
The Logs pane in TES shows basis auditing information and some error gathering from normal 
operation. This is enough to tell us that there is a problem, but it is usually not enough to explain why 
there is a problem.
14-407
Cisco Tidal Enterprise Scheduler 6.2 User Guide



Chapter 14      Troubleshooting
  Troubleshooting the Master
The term, logging, generally refers to an auditing level of information that is always available without 
special configuration. Diagnostic logging refers to information that is gathered only for troubleshooting 
purposes and is not normally turned on.

When trying to troubleshoot an issue with the master, client or agent components of Tidal TES the 
diagnostic and logging tools that come standard with the application can narrow down and pinpoint 
where the existing problem might be. 

Other systems that TES is working with such as SAP, PeopleSoft, Oracle Applications and various 
operating systems provide their own diagnostic and logging information. This diagnostic information 
may be needed to get to the root of any given problem, so working with the appropriate system 
administrators is crucial to troubleshooting success. Anything from a database trace or a network sniffer 
to the operating system’s own internal logging can be helpful.

Diagnostic Logging
When a problem occurs that prevents TES from running correctly, diagnostic logging collects 
information about the various processes that are running on the system as the problem occurs. You 
collect information to find clues in the various system messages about the cause of the problem. 

Often the error messages displayed in the client console that are generated by a problem, provide an 
indication of the source of the problem revealing which component should be monitored. If no source is 
indicated in the error message, check the messages in the system log for clues to the source of the 
problem. Once the source of the problem is identified, you can enable diagnostic logging for that system 
component. Select the level of logging detail for the system components being monitored from the 
Logging tab of the System Configuration dialog.

Be careful when using the diagnostic logging function as logging messages can consume a large amount 
of disk space very quickly. Carefully monitor the size of the log file being created as excessive logging 
consumes system resources as well as disk space. Try to repeat the scenario that produced the problem, 
so system activity can be recorded for Technical Services to interpret. Once the problem occurs again, 
contact Technical Services and send them the logging file that is generated.

Note It is recommended that anti-virus software either be disabled during diagnostic logging or configured to 
not check the diagnostic files that are created during diagnostic logging. The constant writing of 
diagnostic information to these files will consume too much attention from the anti-virus software and 
consume an extensive amount of system resources. The default location for diagnostic logs on the master 
machine is C:\Program Files\Tidal\Scheduler\master\logs.

Troubleshooting the Master 

Verifying the Master’s Version Number
Technical Services need to know which version of the TES master is being used. This information is 
available in the Master Status window.

To verify the master’s version number:

Step 1 In the Navigator pane of the client, select Operations>Master Status to display the Master Status 
pane.
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Step 2 The version of the master being used is noted at the top of the Master Status pane.

Diagnostic Logging for the Master
If you are enabling diagnostics before contacting Technical Services, start at the Info level and Technical 
Services will provide additional instructions after receiving the diagnostic files you have recorded. 

The following components are monitored:

• Scheduler Log – Records system level messages regarding the master.

• Client Manager Log – Records messages about client activity.

• Agent Manager Log – Records messages from agents running jobs.

• Compiler Log – Records messages about the status of production schedules being compiled.

• Job Manager Log – Records messages about the status of jobs.

• Event Manager Log – Records messages about events defined in TES.

• Queue Manager Log – Records messages about queue activity.

• Database Log – Records messages relating to the state of the database.

• Communications Log – Records messages concerning all defined connections and sockets. Be 
aware that setting this component to a high level of logging results in a large amount of information 
that consumes large amounts of disk space. 

Each component has a drop-down list with seven levels of progressively more detailed logging. Each 
level includes the messages of the previous levels of logging. The levels of logging are:

• None – No logging for the component.

• Severe – Logs only serious problems for that component (default).

• Warning – Logs potential problems for the component as well as messages from the Severe logging 
level.

• Info – Logs status messages about the normal operation as well as messages from lower logging 
levels. 

• Low Debug – Logs important debugging messages as well as messages from lower logging levels.

• Medium Debug – Logs an increasing amount of debugging information as well as messages from 
lower logging levels.

• High Debug – Logs the largest amount of debugging information as well as messages from lower 
logging levels.

Diagnostic data is recorded to the log file until it reaches one megabyte in size. Once the log file reaches 
a megabyte in size, it is saved, named and another log file is started. The diagnostic log files are located 
in the Log directory of the master. The current log file is named Master-YYYYMMDDHHMMSS.xmllog 
where the name provides the year, month, day, hour (24 hour clock), minute and second of the log file, 
e.g., Master-20020814042231.xml log. 

There are two reasons why a log file may be less than one megabyte in size.

• The master shut down (whether by design or not) before the log file could reach one megabyte.

• It is the current log file that the master is still creating. 
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Note Do not delete the current log file, which is always the log file with the latest timestamp. Even if the file 
does not exist, the master will continue to relay diagnostic information to the log file until it has relayed 
1 MB of information. At that point, the master starts a new log file but any diagnostic information from 
the time between the deletion of the current log file and the creation of a new log file is lost.

Adjusting the Log File Retention 

Each time the log file for the master reaches one megabyte in size, it is saved and another log file started. 
By default, the master is configured to store the 25 most recent log files. When the log files exceed the 
maximum number, the oldest log file is automatically deleted to make room for a newer log file. 

You may need to adjust the log file retention number whenever you are running diagnostic logging. A 
higher level of diagnostic detail will create log files that add up quickly. Increase the log file retention 
number whenever you run diagnostic logging to compensate or you will start deleting the earliest log 
files before you have a chance to examine them. 

To adjust the log file retention:

Step 1 From the command line of the master machine, stop the master:

tesm stop

Step 2 Locate the Master.Props file in the config directory of the master machine and open it.

Step 3 Add the following line to the Master.Props file:

MaxLogFiles=<number of log files>

where <number of log files> is the maximum number of log files to retain before deleting the 
oldest file.

The minimum number of log files to be retained is three. There is no maximum number.

Step 4 From the command line, restart the master:

tesm start

Purging Old Job Data

On occasion, the Admiral database and Tidal schema will not stop growing in size and very old data 
builds up in the database. This old data should be purged on a regular basis or the database will continue 
to bloat.

To purge old job data:

Step 1 Select the System Configuration option from the Activities main menu to check the data retention value 
in the System Configuration dialog.

Step 2 On the Master tab, verify that the Automatic Daily History Cleanup option is selected and select it if 
it is not already selected. If you are using a database alias other than the default “Admiral,” this feature 
may not operate correctly. 
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Running Diagnostic Logging as a Job

If a problem is occurring at a time that is difficult for an operator to monitor, say when a certain job deep 
in the production schedule runs, you can run a job to enable diagnostic logging just as the suspected job 
runs. You can create a logging job from the command line using a Java utility that TES provides. 
Configure the job to run just before the problem occurs and then create another similar job to return the 
diagnostic logging levels to their original settings after recording the system information. This job will 
limit how long the diagnostic logging runs to prevent massive amounts of information from clogging 
your disk space.

To run diagnostic logging as a job:

Step 1 Click the Add Job button on the TES toolbar or right-click in the Jobs pane and select Add Job to 
display the Job Definition dialog.

Step 2 Type a name for the job.

Step 3 In the Command field on the Program tab, type java.

Step 4 In the Command Parameters field, modify the following command parameters as needed:

java -DTidal_HOME=/opt/Tidal/master -cp/opt/Tidal/lib/scheduler.jar 
com.tidalsoft.scheduler.SetDebugLevel
-m <Master Machine Name>
-p ClientPort(defaults to correct number)
-S (Scheduler Log)SEVERE|WARNING|INFO|LOW|MEDIUM|HIGH
-CL (Client Manager Log)SEVERE|WARNING|INFO|LOW|MEDIUM|HIGH
-A (Agent Manager Log)SEVERE|WARNING|INFO|LOW|MEDIUM|HIGH
-CO (Compiler Log)SEVERE|WARNING|INFO|LOW|MEDIUM|HIGH
-J (Job Manager Log)SEVERE|WARNING|INFO|LOW|MEDIUM|HIGH
-E (Event Manager Log)SEVERE|WARNING|INFO|LOW|MEDIUM|HIGH
-Q (Queue Manager Log)SEVERE|WARNING|INFO|LOW|MEDIUM|HIGH
-D (Database Log) SEVERE|WARNING|INFO|LOW|MEDIUM|HIGH
-COM(Comununcations Log)SEVERE|WARNING|INFO|LOW|MEDIUM|HIGH

Do not include any of the explanatory text that is in parentheses or brackets. Replace the text in 
brackets with the name of the machine that the master resides upon. The section of the first line 
“opt/Tidal” should be the directory location where the master is installed. Select just one of the 
logging levels to use with only the components you wish to enable for diagnostic logging. Any 
component log that is not included in the parameters is not affected by the logging job and retains 
its original setting. Don’t forget to run another job to return the diagnostics to the original setting.

Running the Windows Master in Debug Mode

Even if you have configured the master to log diagnostic information, there is still a period of time 
between when the master starts and when it begins logging information. If the issue you are trying to 
troubleshoot occurs in this time window before diagnostic information is recorded than you should 
configure the master to run in debug mode. This will ensure that information is collected the entire time 
the master runs.

To run the Windows master in Debug mode:

Step 1 Open a command prompt screen from the Start button menu by selecting 
Programs>Accessories>Command Prompt. 

Step 2 Type the directory path to the master executable file and then place a debug parameter after, e.g., 
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“C:\Program Files\Tidal\TES\master\samaster.exe” -debug

Turn off the debugging mode by killing the samaster.exe process that you started.

Running the Unix Master in Debug Mode

Even if you have configured the master to log diagnostic information, there is still a period of time 
between when the master starts and when it begins logging information. If the issue you are trying to 
troubleshoot occurs in this time window before diagnostic information is recorded than you should 
configure the master to run in debug mode. This will ensure that information is collected the entire time 
the master runs.

From the command line program on the Unix master machine, type:

tesm -debug start

Turn off the debugging mode by killing the debug process that you started.

OCSEXIT Jobs

If you find that jobs created using the OCSEXIT variable, and that run on Windows agents, consistently 
end in Completed Abnormally you may need to update your system path.

To update your system path:

Step 1 Click the Windows Start menu button and select Settings>Control Panel.

Step 2 Start the System Properties control panel.

Step 3 Click the appropriate tab and append %systemroot%\system32 to your system’s Path variable.

Master Error

The Windows TES master runs as a Windows service. Services need to be started and controlled through 
a service manager, such as the TES Service Control Manager utility. Double-clicking directly on the 
samaster.exe file or an icon shortcut associated with the samaster executable will result in application 
errors and an access violation.

To resolve this issue, always start and stop the TES master through the Service Control Manager or the 
Windows Services program.

Email Problems 

Note If you are having trouble sending email through Scheduler, examine the Windows Event Viewer for 
application errors attributed to TidalSAMASTER. The information provided in these logs can help 
diagnose the problem.
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Internet Email

For TES to use internet mail effectively, the master machine must have a continuous internet connection. 
If the mail system goes offline, you will miss email notifications. Verify that you have followed the email 
prerequisites and configured the email functions of TES.

Microsoft Exchange and Novell GroupWise

To use email in TES with Microsoft Exchange and Novell GroupWise, the master service must run as a 
user with access to the mail system and the advanced user right logon as a service. If the user account 
does not have administrative capabilities, an Administrator must run the dcomcnfg utility on the TES 
master machine to add the user to the access and launch permissions for the idsMail server. If this is not 
done, TES and the Windows Event Viewer will log an error attributed to idsMail32 and email will not 
function properly.

Making the Master Service Run as a User

To make the master service run as a user:

Step 1 Click the Windows Start menu button, then select Programs>Tidal 
Software>Scheduler>Master>Service Control Manager. 

Step 2 Select the Scheduler Master service from the Service field drop-down menu.

Step 3 Click Configure to display the Service Configuration dialog.

Step 4 In the Logon Information section, select the Other Account option.

Step 5 Type the complete user account (include domain) and password information. 

Step 6 Click OK, then exit the Service Control Manager.

Adding Access Permissions to an Account with dcomcnfg 

Note This procedure must be run as Windows Administrator.

To add access permissions to an account:

Step 1 Click the Windows Start button, then select Run and type dcomcnfg in the Open field.

Step 2 Click the Applications tab in the DCOM dialog. 

Step 3 Select the idsMail server from the Applications list (listed as This server object provides a universal 
Email send/receive...) and click Properties.

Step 4 When the idsMail dialog displays, click the Security tab. 

Step 5 In the first section on the tab, select the Use custom access permissions option.

Step 6 Click the Edit button for access permissions to display the Registry Value Permissions dialog.

Step 7 Click Add to display the Add Users and Groups dialog.

Step 8 Select and add the TES master user account from the Add Users and Groups dialog. 
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Step 9 Click OK and click OK again in the Registry Value Permissions dialog to return to the Security tab.

Step 10 In the second section on the tab, select the Use custom launch permissions option.

Step 11 Click the Edit button to display the Registry Value Permissions dialog. 

Step 12 Click Add and select the TES master user account from the Add Users and Groups dialog. 

Step 13 Click OK and click OK again to close the Registry Value Permissions dialog.

Step 14 Click OK to exit the idsmail dialog. 

Step 15 Click OK again at the DCOM dialog to save your changes and exit.

Step 16 Reboot the master machine.

Troubleshooting the Client Manager

Client Manager Cache Database
As of TES 6.0.3, the option of deploying a stand-alone TES 6 cache database as oppose to using the 
default embedded Derby cache database is supported.  A stand-alone cache database allows for a faster 
synchronization time upon Client Manager startup. Additionally, a stand-alone cache database improves 
the overall UI experience by offering faster filtering and scrolling response times.

Suported Databases

Supported TES stand-alone databases are MSSQL 2005 & 2008, Oracle 10g and 11i.  These are the same 
database versions currently being supported by the TES Master.

• Client Manager Operating System

– Windows

• MSSQL 2005

• MSSQL 2008

• ORACLE 10g

• ORACLE 11i

– Linux

• ORACLE 10g

• ORACLE 11i

Database Sizing

The Client Manager cache database maintains the same data in a slightly different format compared to 
the Master database.  The sizing of the cache database should be identical to that of the Master database. 
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Database Location

For ideal performance, it is recommended that the stand-alone TES cache database be located 
exclusively on its own server and have optimal network connection between the Client Manager server 
and the TES cache database server.

How to clear the cache when needed 

Clearing the cache involves truncating all tables in the schema except the table CACHEPROPERTY. 
CACHEPROPERTY holds the value of Cache.Version.  Optionally, dropping all tables in the schema can 
also clear the cache. A SQL script will be provided to the customer for clearing cache via table drops.

To clear the cache:

Step 1 Locate the clearcache.sql script.

Step 2 Execute script as the user for the cache database. 

Verifying the Version of the Client Manager
When consulting with Technical Services about a problem with the Client Manager, one of the most 
basic pieces of information they need is which version of the Client Manager is being used.

To verify the version of the Client Manager:

In the Client Manager log folder, open any log file. Verify at the top of the file the four digit version 
number. For example, 6.0.0.1192.

You can also check the clientmgr.out file located in the same folder.

Diagnostic Logging for the Client Manager
clientmgr.props file contains several logging categories. The following two are the main logging 
categories that apply to the Client Manger:

• DspLog – For items related to the DSP module.

• CommonsLog – For items related to core component logging, such as the Jetty embedded Web 
server.

The following is an example clientmgr.props file:

PrimaryServer=tcp://server:6215

Security.Authentication=ActiveDirectory

ActiveDirectory.Host=adhost

ActiveDirectory.Port=389

ActiveDirectory.UserSearchPrefix=DC=testdomain,DC=local

ActiveDirectory.GroupSearchPrefix=DC=testdomain,DC=local

JAVA_HOME=C:\Program Files\Java\jre6

JVMARGS=-Xms8192m -Xmx8192m -XX:PermSize=128m -XX:MaxPermSize=128m

MaxLogFiles=1000

JmxRmiPort=1100
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JmxOn=Y

<DSP>.dsp contains the following properties for the DSP:

• CacheLog – Applies to writing to the cache during synchronization.

• DspLog – For items related to the DSP module.

• RequestLog – Relates to all requests of the DSP.

• RPCLog – Communication between the Client Manager and Master.

• ClientLog – Client related logging. 

• CommonsLog – Relates to core component logging.

The following is an example <DSP>.dsp file:

BackupServer=<BackupServer>:6215

ClientType=tes-6.0.0.0

PrimaryServer=<PrimaryServer>:6215

DspLog=FINEST

CacheLog=FINER

RequestLog=FINE

RpcLog=WARNING

ClientLog=SEVERE

Monitoring the Client Manager
To turn JMX monitoring on:

Step 1 In clientmgr.props, set the JMX setting to yes, JmxOn=Y.

Step 2 Stop the Client Manager.

Step 3 Restart the Client Manager.

Configuring the DSP
The DSP config file, <DSP>.dsp, needs to know where the primary master and backup master is located. 

To point the ClientManager/DSP to a different primary and/or backup master:

Modify the PrimaryServer and BackupServer settings in the <DSP>.dsp file. For example:

PrimaryServer=tcp://<hostname>:<port>

BackupServer=tcp://<hostname>:<port>

Note These settings are automatically set by the installer when you install the ClientManager. Modify these 
only if you wish to change the primary and backup master locations after install or if you did not specify 
them during the install.
14-416
Cisco Tidal Enterprise Scheduler 6.2 User Guide

OL-32248-01



Chapter 14      Troubleshooting
  Troubleshooting the Client Manager
Synchronization
Synchronizing may take a while. If a record is not synched for any reason, set the CacheLog level to 
FINEST. This will log every record synchronized from the master. 

To check the status of the synchronization, see the clientmgr.out file in the logs folder. 

Web Client is Slow

If the Web client is slow, change the logging levels of the following log settings in the DSP configuration 
file, <DSP>.dsp. This allows for more verbose logging details.

• DspLog

• ClientLog

• RequestLog

• CommonsLog 

Working with JConsole
If adjusting the logging levels fails to fix a problem, you can point JConsole to the Client Manager JVM 
to monitor the internals.

To configure:

Step 1 From the JConsole:Connect to Agent dialog, select the Advanced tab.

Step 2 Input the JMX URL to the destination.

For example:

[hostname]:[port]

-or-

service:jmx:rmi://[hostname]/jndi/rmi://[hostname]/ClientManager

Step 3 Enter the username and password for the connection.

Step 4 Click Connect.

Monitoring Memory Usage and Thread State of CM and DSP

You can use this to diagnose situations where the CM appears to be stuck or 
non-responsive. Refer to the JMX Guide for further information.
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Troubleshooting the Agent

Verifying the Version of the Agent
When consulting with Technical Services about a problem with an agent, one of the most basic pieces 
of information they need is which version of the agent is being used.

To verify the version of the agent:

Step 1 In the Navigator pane of the Tidal Web client, select Administration>Connections to display the 
Connections pane.

Step 2 In the various connections listed in the pane, locate the agent with the problem.

Step 3 Look in the Version column of that agent to see the version of the agent being used. 

Proper Configuration of the Windows Agent

The Agent for Windows should have been configured properly at the time of installation but sometimes 
the configuration is unintentionally changed and causes problems. 

The Agent for Windows will not operate correctly unless it is configured as follows:

• The agent service must be configured to run as a Windows user, either as local to the agent server 
or a domain user.

• This Windows user must be an administrator on the local machine and have the following four user 
rights assigned

– Act as part of the Operating System

– Logon as a batch

– Logon as a service

– Replace a process level token

• All runtime users must have the Logon as a batch user right on every Windows server that the 
runtime user will run jobs on.

Note If you have to change any of the above, it is best to restart the server, as Windows does not always 
make those changes effective without rebooting.

• In the Client Manager, edit each runtime user (and regular user if those are being used to run jobs) 
and type the Windows password on the Passwords tab of the user’s definition. If a Windows domain 
is not specified, a runtime user is assumed to be local to the agent where it is running a job.

• Also in the Client Manager, from the main menu, select Activities>System Configuration to 
display the System Configuration dialog and select the Use Passwords to Run Windows Jobs 
option.

After confirming that the agent service has been configured as recommended, run this test job from a 
command prompt:
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C:\WINNT\system32\cmd.exe
/c set

Look at the output for the Username variable to see if the runtime user's name listed. If that is working, 
then you should be able to run jobs wherever the Windows Authentication is accepted.

Unix Agents
The first line of every Unix agent shell script must adhere to standard Unix scripting guidelines and refer 
to a shell; for example, #!/bin/sh. For more information, refer to your Unix system documentation or 
consult your System Administrator.

Diagnostics for the Agent for Unix

When the Agent for Unix generates errors and doesn’t operate properly, you need to contact Technical 
Services to help you resolve the technical issues. However, Technical Services requires specific 
information on how the Agent for Unix is operating before they can track down the source of the 
problem. Before contacting Technical Services about an agent issue, you should turn on diagnostic 
logging to collect information about the way the agent is functioning. This is the first step that Technical 
Services will have you do, if you have not done it before contacting them. 

To turn on diagnostic logging: 

Step 1 On the agent machine type the following command to stop the agent:

./tagent <agent name> stop

Step 2 Go to the /bin directory and locate the tagent.ini file for the desired agent. 

Step 3 Inside the tagent.ini file, under the port setting, type the following:

ovb=Tidaldebug

Step 4 Save the file and its changes.

Step 5 Start the agent:

./tagent <agent name> start

Ideally, you want to reproduce the situation that caused the issue so the diagnostics can log what 
occurred in the system at that time. As soon as the problem reoccurs, contact Technical Services.

Step 6 Once the problem repeats itself and the diagnostic information is recorded, turn off the agent diagnostics 
by commenting out the debugging parameter:

#ovb=Tidaldebug

Step 7 Go to the Log directory to get the diagnostic file to send to Technical Services:

cd <agent directory>/<agent name>/logs

Each agent instance has its own directory. The diagnostic files are named <agent name>.log and 
<master server>.log.

Restarting the agent does not override the recorded information. Though only a small amount of 
information is normally recorded without the debug parameter, the file will continue to grow in size. You 
should delete or rename the file after you finish debugging the agent.
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Note Whenever diagnostic logging is being used, you must carefully monitor the amount of disk and 
database space being consumed. Diagnostic logging can generate large amounts of data and 
affect system performance.

Diagnostics for the Windows Agent

To run diagnostics for the Windows agent:

Step 1 Login to the agent console as the same user that the agent service is configured to run as.

Step 2 Create a shortcut by right-clicking the Windows Desktop and selecting New>Shortcut from the context 
menu to display the Create Shortcut dialog. 

Step 3 In the Type the location of the item field, type the following command path:

"C:\Program Files\Tidal\tsagent\bin\Agent.exe" Agent=TidalSAAgent_0 Port=5912 
Verbosity=Tidaldebug Debug=Yes sysadmiral=yes

Note Your installation path and port number may be different.

Step 4 Using the Service Control Manager, stop the agent. 

Step 5 Double-click the agent shortcut you created to start the agent in debug mode.

A window named after the agent displays scrolling messages as the agent does its work. The same 
data displayed in the window is also logged to the Application Log of the Windows Event Viewer. 
The system must remain logged on and the agent must continue to run in this Application Mode to 
gather diagnostics.

It is important to modify the properties for the Application Log so it saves an appropriate amount of data. 

To modify the properties:

Step 1 In the Event View tree, select the Application Log.

Step 2 Right-click and select the Properties option to display the Application Log Properties dialog.

Step 3 In the Log size section, adjust the value in the Maximum log size field.

Step 4 The value will vary significantly from agent to agent, depending on the environment and usage. Start 
with 5-10 megabytes of data and increase as needed. You can configure the Event Viewer to either 
overwrite the previously written data or stop logging when the log size reaches the maximum size.

To stop diagnostics, close the agent application window and restart the agent from the Service Control 
Manager.
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Other

Unable to scroll using scroll buttons, Runtime User - FireFox 3.6.x

If you can use a slider to drag down the list, but not a down button of a scroll bar, this is happening 
because of the following bug in Firefox.

https://bugzilla.mozilla.org/show_bug.cgi?id=511075

This Firefox bug is already fixed by Firefox and is part of Firefox 3.6.4 Beta release.

http://www.mozilla.com/en-US/firefox/all-beta.html.
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A
Aborted status The job occurrence was deliberately aborted and 

cannot be resumed.

action An action is a user-defined response to a job or 
system event. An action can be an email message, 
an SNMP message (trap), an operator alert, the 
insertion of a new job, a log update, a variable 
change or a job control action.

Active status The job occurrence is actively running in the 
production schedule.

adapter A component that integrates one application with 
another application. An adapter provides 
connectivity and business logic so two different 
applications can work together.

agent Agents are licensed computers with Scheduler 
installations that are attached to a Scheduler 
master and are licensed to run jobs for the 
Scheduler master. Every agent facilitates the 
execution of scheduled and unscheduled jobs, and 
relays vital information back to the Master (i.e. 
workload data, job output, and job status). 
Scheduler agents provide dynamic rerouting fault 
tolerance, workload balancing and a central point 
of schedule maintenance and control. Each agent 
has a job limit value, and communication port 
specifications which can be set from the Tidal 
Web client Connections window.

Agent Disabled status The agent for the job is disabled, and the job 
occurrence cannot run. If a job is using an agent 
list, no agent in the agent list is active. An agent 
can be changed to enabled by selecting its 
Enabled property in the Agent Definition dialog.

agent limit The number of jobs that are allowed to run on an 
agent, specified in the agent’s definition in 
Scheduler.

agent list An collection of agent names which define a 
group of computers that jobs can run on. Agent 
lists are used for workload balancing, dynamic 
rerouting fault tolerance, and for broadcasting.
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Agent Unavailable status The agent is not connected, or is not running, and 
therefore the job occurrence cannot run on its 
agent. If the job is using an agent list, this status 
indicates that all agents in the list are unavailable.

agentd Agent daemon (service). Handles file transfers 
and remote connections from master to agents.

audit message A record of a Scheduler activity, such as:

A user adds, edits or deletes a Scheduler object. A job is overridden by a user using the Job Details 

dialog while the job is in the schedule.

Job control is performed by a user or through a 

manual job control action.

All audit messages, error and diagnostic messages 
can be displayed from the Logs pane. 
Alternatively, you can view audit messages from 
the Job Activity window via the Job Details 
dialog.

auto arrange A set of properties in the View Properties dialog 
that configures the logic used to arrange how 
objects in a graphical View are displayed.

Available status The status of a defined resource that indicates it is 
available for use. Even if a resource needed by a 
job is available, a job may still not run. That job 
may require a greater amount of the resource than 
is currently available or one of the other resources 
that the job requires is not available. If a resource 
is not in an Available status, it is in either an 
Locked status or a Waiting status. 

B
backup master A computer licensed to run the Scheduler master 

software in Fault Tolerance mode. The backup 
master is available to run master processes if the 
primary master fails.

batch (.bat) job or file In Windows, series of commands that are batched 
(or bunched) together in a single file to run in 
sequence without further user interaction. The 
equivalent in Unix is a shell script. In z/OS, an 
EXEC file serves the batch file function. A batch 
file ends with a .bat file extension.
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Bird’s Eye View An option in the graphical View to reduce or 
enlarge selected objects in a graphical View until 
all of the objects fit in the visible portion of the 
View window. A selection box with a dotted line 
boundary displays at the cursor. The size of the 
selection box varies according to the view 
magnification being used. Placing the selection 
box over a portion of the view and clicking, 
magnifies that area to the original zoom scale. 

broadcasting An agent list function where a job is run on every 
agent in the list.

C
calendar group A collection of calendars that is used to specify a 

set of dates to run jobs. The calendar group 
includes and/or excludes the dates specified by 
each individual calendar in the group.

callout A text balloon associated with one of the objects 
defined in a graphical View. A callout provides 
additional information that can consist of text or 
a hyperlink to an associated website or directory. 
Callouts are created and configured for 
individual objects using the Callout Properties 
dialog.

Canceled status The job is canceled and cannot be resumed. A job 
can be canceled before it becomes active while it 
is in the Waiting On Dependencies or Waiting 
On Resources statuses. A job that is active 
cannot be canceled but must be aborted.

Canceled Normally status The job was previously placed in a Canceled 
Pending status while the job dependencies were 
released. Once the job’s dependencies were 
satisfied, the job goes to a Canceled Normally 
status. This status is treated by other jobs as a 
Completed Normally status.

Canceled Pending status The job is canceled but the job’s dependencies 
are released so the job stream can be maintained. 
In essence, the job goes into a Waiting on 
Dependencies state as the dependencies run. 
Once all of the job’s dependencies are satisfied, 
the job ends with a Canceled Normally status that 
is equivalent to a Completed Normally status. 
This status only occurs through a user-initiated 
job control action or a predefined job action.
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child agent list An agent list that belongs to a parent agent list. 
Child agent lists may also be parent agent lists if 
they contain other child agent lists. A child agent 
list must be the same type as its parent, i.e., 
rotational, workload balanced, ordered, etc.

child job A job that is a member of a job group. By default, 
a child job inherits scheduling and run properties 
from its parent job group. When a parent job 
group is submitted, all of its qualified child jobs 
are submitted.

child job group A job group that is a member of another job 
group. By default, child job groups inherit 
scheduling and run properties from their parent 
job groups. When a parent job group runs, all of 
its children (jobs and job groups) are run.

child queue A queue that is a sub-queue of another, called the 
parent queue. The number of jobs that a child 
queue can run is constrained either by its own 
limit setting, or by the job limit setting of its 
parent, whichever is smaller. Child queues can 
only accept jobs that have passed through it 
parent’s queue filter.

command The executable file that is run by a job. For 
Windows, commands can be.bat, .cmd, .exe or 
other executable files and DOS scripts. For Unix, 
commands can be shell scripts, programs and 
commands. Commands can include command 
parameters are passed to the executable file when 
it runs.

command parameters The runtime parameters that are passed to a 
command before Scheduler runs the command.

Completed Abnormally status The job completed with a non-zero exit code 
indicating that it did not run normally.

Completed Normally status The job completed normally. If the status is 
determined within Scheduler, the exit code is 0. 
If the status is set by an external program, the exit 
code may be non-zero.

concurrency Refers to the situation when more than one 
occurrence of the same job is running at the same 
time, regardless of which agent they are running 
on. For each job, you have the option to Skip, 
Defer until completion, or Run anyway when an 
occurrence of the job is already running. The 
default is Skip.
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Connector The Connector is a component that allows a 
Windows machine to translate the Unix master's 
job requests. If you are using a Unix master and 
you intend to run PeopleSoft, SAP or Oracle 
Applications jobs, then you must install the 
Connector. If you are using a Windows master 
with a Windows adapter than you do not need the 
Connector.

console alert A notification to the Scheduler console that a 
job's pre-defined Job Event has occurred. An 
alert often indicates that the operator should view 
the alert message from the Alert Information 
dialog and take an appropriate action.

cqd The communications queue daemon is 
responsible for network communication between 
the different modules of Scheduler and between 
multiple Scheduler masters and agents.

create schedule Create Schedule compiles all the jobs that are 
scheduled to run and creates a production 
schedule. Schedule creations are incremental, 
that is, only jobs that were not previously added 
through a schedule creation, are added. Schedule 
creations can also delete jobs from the 
production schedule if they are deleted from the 
Scheduler database, and they haven't run yet.

Create Hyperlink A feature in the graphical View that creates a 
hyperlink by displaying the Choose a View for 
Link dialog to create a hyperlink from the current 
view to another existing view. You click the link 
icon to display the linked view. 

D
default working model The default working model comprises a set of 

default Security Policy Templates of which you 
can designate one to each type of user of 
Scheduler. When all templates are assigned 
within a network of Scheduler users, each user 
operates and is responsible for a piece of the 
entire scheduling process. When taken as a 
whole, the entire scheduling process is 
complete.

Deferred status Another occurrence of the job was running 
when a new occurrence tried to execute, and the 
concurrency option for the job was set to Defer 
until completion. The job occurrence will run 
after the running occurrence completes.
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dependency A dependency is a condition that must be met 
before a Job can run. Dependencies are 
specified in a job’s definition. Scheduler 
includes time dependencies, job dependencies, 
variable dependencies and file dependencies.

diagnostic message A diagnostic message is a type of message used 
for internal debugging purposes and help-desk 
support.

dynamic rerouting The ability of an ordered agent list to reroute a 
job from a primary unavailable agent to another 
available agent in the list.

E
environment file A file that includes a set of constants that define 

the environment for a command or executable. 
The command or executable refers to the 
environment file for information such as local 
path names. Environment files allow a command 
or executable to be portable among different 
machines.

error message A message indicating that an error occurred 
somewhere in Scheduler. All Scheduler error 
messages are defined in the System 
Configuration dialog.

All error messages, audit and diagnostic messages 
can be displayed from the Logs pane.

Error Occurred status An internal computer error or security breech 
occurred that prevented the job from running.

estimated duration The part of a job’s definition where you enter an 
estimate of how long a job should run. If a job has 
run one or more times, this value is the historical 
average of actual run durations. 

event trigger Scheduler monitors every point in a job’s life 
cycle, and changes in a job’s status are event 
triggers. Other triggers include schedule 
irregularities such a job running shorter or longer 
than expected, and operator job control such as 
stopping, starting, and overriding jobs. (also see 
Job Event triggers)

execution slot An execution slot is an opening for a job to run. 
The total number of available slots are determined 
either by the system queue limit, the sum of all the 
queue limits, or the sum of all the job limits that 
are on every licensed Scheduler agent in your 
network, whichever is less.
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exit code An exit code is the value returned at the end of every 
completed process. A Scheduler agent relays this 
value to the master to be used in deciding what status 
to assign the completed job. The job definition 
usually defines what job status is denoted by a 
specified exit code. Normally, an exit code is 0, but 
the OCSEXIT command can be used to specify a 
different exit code at the end of a script. The exit 
code can range from 0 to 30,000.

If you are running a batch script, only the last 
process that completed is used by the operating 
system to set the exit code.

Externally Defined status The job is waiting for the status to be set 
externally.

F
fault monitor The component of Scheduler Fault Tolerance that 

monitors the primary master for system, network, 
or hardware faults. If a fault occurs, the fault 
monitor switches scheduling control over to the 
backup master.

fault tolerance A fail safe mechanism that ensures uninterrupted 
scheduling. Fault Tolerance is software that is 
optionally supplied with Scheduler on a licensed 
basis. It uses a primary and backup master with 
replicated databases and uses a fault monitor 
system that monitors the primary master for a 
network or system failure. If failure occurs, 
scheduling control is switched over to the backup 
master until the primary master is fixed.

file dependency A condition associated with a job where a file 
must exist, not exist, be less than a certain size, be 
greater than a certain size, or be stable for a 
certain amount of time before the dependency is 
resolved.

flag A flag-shaped icon that is assigned to individual 
objects defined in a graphical View. Flags serve as 
markers to highlight designated objects. A text 
message can be attached to the flag that can be 
read by pausing the cursor over the flag.

G
Gant-style chart A chart containing visual styles, wallpapers, 

application skins, etc.
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Grant All Edit option The Grant All Edit option grants the Edit Queue 
function but not the more advanced functions of 
Edit System Queue or Edit Nice Queue Value.

Group option If the Group option is selected then the 
User/Group Name drop-down list only displays 
the groups that belong to the selected domain.

H
Held status The job occurrence was temporarily put on hold 

by an operator. A job can be held only when it has 
the Waiting On Resources or Waiting On 
Dependency statuses.

I
intermaster dependency You can create jobs with variable dependencies 

that are determined by jobs processed on another 
master. A job with an intermaster dependency 
resides on a local master subscribing to a remote 
master that publishes the value of a variable. The 
variable is defined on the remote master and made 
available to other masters. 

J
job A job is the basic scheduling unit in Scheduler. 

Also called a job definition, or a job, a job consists 
of a command script or executable, and a set of 
scheduling criteria and runtime instructions, 
including dependency information. Command 
executables can include any number of system 
activities. Scheduling criteria include when and 
how often to run the executable file.

Job Activity pane The central point of control for monitoring and 
controlling jobs. The Job Activity pane lists each 
job occurrence in the production schedule. It also 
shows and lets you take action on operator alerts 
that are generated by jobs.

job alias A unique 8-digit code that identifies a job or job 
group. Job aliases are particularly useful when 
using the command-line interface, since some 
operating systems still have an 8-character 
restriction, and because a job name can specify 
more than one job.
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job class Job classes are be used to organize when, where 
and/or how jobs are run, and are created from the 
Job Classes pane.

job control Scheduler lets you manage jobs in the Job Activity 
window including aborting, stopping, holding, 
and releasing jobs, overriding job dependencies, 
rerunning jobs, and setting job completion 
statuses. Job control can be performed by an user 
or through a job control action.

job dependency A job that prevents a job from running until an 
associated job reaches a particular status.

job event A feature of Scheduler that provides a link 
between job event triggers and actions. Each job 
event responds to a single job event trigger, but 
can respond with multiple actions, which can be 
sending an email, an SNMP message (trap), an 
alert, adding a new job, controlling a job, 
changing a user-defined variable, or posting a log 
message. A job can also respond to system events.

job event trigger A condition such as a job occurrence status 
change, schedule irregularity, or job control action 
which causes a job event to occur and subsequent 
actions to be issued. Scheduler continually 
monitors for event triggers.

job group A set of jobs and other job groups which have 
properties and runtime instructions inherited from 
the job group to which they belong. Job groups 
allow for the hierarchical organization of jobs. 
You can define dependencies that refer to job 
groups as well as individual jobs.

job ID The job ID is used interchangeably with the term 
job number. Both terms are often loosely used and 
refer to two distinctly different things depending 
upon the context the terms are used in. When used 
in association with job definitions, the term job ID 
(or job number) refers to the job ID, the unique 
identifier of the job definition. When job ID (or 
job number) is used in association with the Job 
Activity window, the term refers to the job 
instance ID, the unique identifier that 
distinguishes between different instances or 
occurrences of the same job. See the definition for 
job instance.

job instance The basic unit of a production schedule used in the 
Job Activity pane to designate a specific 
occurrence of a job within the schedule. A job may 
run numerous times during the day so the job 
instance distinguishes between different instances 
or occurrences of the same job. Each job instance 
is given a job instance ID number to uniquely 
identify it.
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job limit A value assigned to a licensed Scheduler agent 
that limits the number of jobs it can run 
concurrently. Job limits are defined from the 
Connections window.

job number See job ID definition.

job occurrence The basic unit of a production schedule that 
represents a specific occurrence of a job within the 
schedule. The production schedule can have more 
than one occurrence of a job running at the same 
time. Also called the job instance.

job pane The portion of the Job Activity pane which 
displays the status and other properties of each job 
occurrence in the schedule.

job priority A job’s launch importance set in the job’s 
definition. This value is relative only to other jobs 
in the same queue.

job tree The hierarchical structure Scheduler uses to 
display jobs and job groups in the Jobs pane.

JVM Java Virtual Machine (JVM) is needed by the 
Scheduler components that run on the Unix 
platform so they can respond to Java commands. 
Verify that the correct version of JVM is used with 
Scheduler. Check the installation prerequisites for 
each component for the recommended version of 
JVM. The JVM can be downloaded for free from 
the Sun Microsystems website.

K
Key File The key file must be generated by an SSH open 

system. To use a private key file, you must supply 
the password and directory location of the private 
key file.

L
Launched status The job occurrence is in the process of being 

started on its agent. This status is between 
Waiting On Resource and Active. 

life cycle A job occurrence life cycle consists of all the 
phases that the job occurrence enters into and 
exits while it is in the production schedule. Each 
phase is determined by the job’s status. A job 
occurrence begins its life cycle when it is added to 
the production schedule, and ends when it 
completes its execution or exceeds its schedule 
time frame.
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Locked status The status of a defined resource that indicates the 
resource is being used to its defined limit. No 
other job may use the resource until the current 
jobs using the jobs complete and release a 
sufficient amount of the resource. If a resource is 
not in a Locked status, it is in either an Available 
status or a Waiting status.

log message action A log message action is a type of Action that posts 
a message of your choice to the Scheduler Logs 
window when a job event occurs. You can also 
route the message to the Windows Event Viewer 
utility.

log viewer see logs pane

logs pane A Scheduler window that enables the user to view 
and to search through a record of all audit, error, 
and diagnostic messages created by Scheduler 
throughout the process of creating, scheduling 
and running jobs. In Scheduler releases prior to 
v2.2, logs were viewed through the Log Viewer.

M
mask A string with wildcards used to search for job 

names from the Job Search dialog and in queue 
filters. Masks include the * and ? wildcard 
characters. The * wildcard is a mask for any 
number characters, while the ? wildcard is the 
mask for a single character.

For example, AA* masks AA, AAB and AAB1, 
but not ABB. AA? masks AAB, but not AABB or 
ABB.

master Any Windows system running the Scheduler 
scheduler with its own database and production 
schedule.

Master.Props File The properties of the Unix master are managed in 
a file called Master.Props that resides in the config 
directory on the master machine. You change the 
configuration properties of the Unix master by 
manually adding a new property or modifying the 
value for an existing property. The Master.Props 
file stores information on the machine names, port 
numbers and drivers used by the Unix master.
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maximum duration The maximum length of time you will allow your 
job to run. Scheduler has an event trigger that 
monitors whether the job ran past its maximum 
duration. This event trigger can be used to trigger 
an action(s) of your choice.

minimum duration The minimum length of time you expect the job to 
run. Scheduler has an event trigger that monitors 
whether the job’s run duration was less than its 
minimum duration. This event trigger can be used 
to trigger an action(s) of your choice.

N
new job A type of action that inserts a job with optionally 

modified properties into the production schedule. 
A new job action can be used to run recovery jobs 
in case the primary job fails.

nice value Relative CPU scheduling priority, assigned when 
Scheduler launches a job on a Unix agent, and 
determined from the job's assigned queue. See the 
Unix manual page under nice (1) for more 
information.

O
OCSEXIT The command, OCSEXIT, is used to set a batch 

job’s completion status to Completed 
Abnormally by specifying a non-zero exit code 
when a job finishes. Any non-zero exit code means 
the job completed abnormally. If the OCSEXIT 
command is omitted, the exit code is assumed to 
be 0 and the job completed normally. The 
OCSEXIT command should be the last executed 
statement in the script. 

operator A Scheduler user with a security policy that 
enables access to the Job Activity pane, and Job 
Control actions. According to the Default 
Working Model, the Operator is responsible for 
compiling and running the production schedule, 
monitoring job occurrences, watching for and 
responding to operator alerts, and controlling jobs 
as necessary.

operator alert see console alert
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Orphaned status The master lost track of the job’s status while the 
job was running and the job's final status is 
unknown. This status occurs when either the agent 
goes down or the connection between the agent 
and the master fails. 

override The job control which allows a job to run by 
ignoring all dependencies and making the job 
available for immediate launching.

owner The user or workgroup that created the Scheduler 
object (job, calendar, event, etc.).

P
Pan and Zoom See Bird’s Eye View.

parent agent list An agent list containing other agent lists called 
child agent lists. A child agent list must be of the 
same type as a Parent Agent List.

parent job group A job group that includes other jobs or job groups. 
A job or job group, by default, inherits its 
scheduling and run properties from its parent job 
group.

parent queue Any queue that has subqueues, called child 
queues.

primary agent In a primary alternate agent list, the primary agent 
is the agent of choice to run jobs. Alternate agents 
function as substitutes for the primary agent if it 
becomes unavailable.

primary master The master from which normal scheduling 
operations are executed. When using Scheduler 
Fault Tolerance, the primary master accompanies 
a backup master which can take over scheduling 
operations should the primary master fail.

production schedule The database of all jobs selected to run within a 
given production date range. Scheduler compiles a 
production schedule by using your job definitions 
to create job occurrences that will run within the 
production period. Dependency and progress 
information is included with the schedule and 
updated according to the master’s polling interval.

purge frequency The frequency in days when Scheduler looks for 
job occurrences to purge from the production 
schedule. Purging takes place for job occurrences 
which are older than their respective job's 
Retention Period option setting.
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Q
qualified job A job that has the qualifications that allow it to be 

added to the production schedule when the 
schedule is created. Qualified jobs have their 
active flag set, and have an associated calendar 
such that the job's next run date falls within the 
days that are included for the schedule creation.

queue Controls job execution priority and sequencing by 
allowing limited collections of jobs to run with 
different priorities. Queues are assigned job 
quantity limits and queue priorities in a hierarchy 
of queues. All jobs are assigned to a queue 
according to their job properties using queue 
filters.

queue filter Queue filters contain definitions used to 
determine the jobs that will be assigned to the 
queue when all their dependencies are met. The 
queue manager assigns jobs to queues based on 
each job’s properties. Using queue filters, you can 
control and organize when and where to launch 
jobs.

queue limit The maximum number of job occurrences a queue 
can run at any time.

queue manager The part of Scheduler that controls job launch 
activity. The queue manager is responsible for 
assigning jobs to queues based on the match 
between each job’s properties and each queue’s 
queue filter criteria. If more than one queue can 
accept a job, the queue with the highest queue 
priority value is chosen.

queue priority The priority rank of a queue relative to other 
queues at the same level in the queue hierarchy. 
Jobs in higher priority queues are generally run 
before jobs in lower priority queues.

R
remote shell agent A Unix computer that has remote shell (rsh, 

remsh, or rcp) services. Scheduler can run 
Unix-only jobs on these types of agents, but 
cannot take advantage of some of the advanced 
features such as workload balancing, and fault 
tolerance that Scheduler agents offer.
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resource A system asset that is required by a job for its 
successful completion. This resource can be either 
hardware like a printer or simply access to a 
designated database. Though a job can still run if 
an asset is not defined as a resource in TES, by 
defining the asset as a resource, access to that 
resource can be managed. Limiting the 
simultaneous demand on a resource can streamline 
production and improve efficiency. 

resource limit A value designated during the definition of a 
resource that determines the quantity of a resource 
available for jobs, similar in principle to agent 
limit. A quantity of the resource is allocated to 
each job as required by a job’s definition until the 
resource limit is reached. No other jobs can use the 
resource until jobs currently running complete, 
freeing up enough of the resource for another job 
to run. 

retention period The number of days that job occurrence data is 
retained in the production schedule. Job 
occurrences that have occurred beyond the 
retention period are automatically purged 
according to the History Retention setting on the 
Options tab of a job definition. 

runtime user The user logon used for a job. The Runtime User 
option gives the job the user's environment when 
running a job. Runtime users are defined on your 
agents and in the User Definition dialog.

S
Scheduled status The initial status all jobs and job groups enter 

when they have just been compiled into the 
production schedule, before their true status is 
determined.

scheduler An Scheduler user who schedules jobs for another 
user. Scheduler users have access to the 
applications and environments of other users 
listed in their Runtime User list. Runtime Users 
are defined in the User Definition dialog.

script In Unix terminology, a file containing Unix 
commands for the shell to execute as a job. A 
script can also be a file containing MS-DOS 
commands.

security policy A list of system features that can be assigned to a 
Scheduler user. Scheduler has default security 
policy templates you can customize to fit the 
needs of Scheduler users in your organization.
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security policy template Security policy templates contain a predefined set 
of system features. Each default security policy 
can be used to help you create your own security 
policies. The default working model comprises all 
the default security policy templates.

Skipped status Another occurrence of this job was running when 
the agent tried to launch the job, and the 
concurrency option for the job was set to Skip. 
This job occurrence never runs.

SNMP SNMP (Simple Network Management Protocol) is 
a messaging protocol used for sending network 
management data. Actions can include messages 
(also called Traps) that are collected by SNMP 
agents, and sent to managers that make the 
information available to network administrators, 
and/or display the messages on an SNMP console.

Stopped status The job has been stopped by a user or through a 
job control action. A job can be stopped only if it 
is Active.

super user A user with a security policy containing all 
available application functions. Super User is an 
option in the User Definition dialog.

Scheduler database The central repository for storing all Scheduler 
scheduling data. The database is stored on the 
master system and is shared between all users of 
the Scheduler system.

Scheduler desktop The desktop on which all Scheduler windows 
appear as tab pages.

Scheduler toolbar The toolbar is located above the Scheduler 
desktop. For more information about the 
Scheduler interface, see <Jumps>“Getting Started” 
on page 29.

system administrator The user of Scheduler who has a System 
Administrator security policy. The System 
Administrator is usually responsible for 
configuring Scheduler for the needs of users. Can 
also mean the site’s System Administrator, the 
person in charge of computer security and other 
critical responsibilities.

system event A feature of Scheduler that provides a link 
between system event triggers and actions. Each 
system event responds to a single system event 
trigger, but can respond with multiple actions, 
such as sending an email, an SNMP message 
(trap), an operator alert, adding a new job or 
controlling a job. A job can also respond to job 
events.

system event trigger An event that originates from the system, as 
opposed to originating from a job, that can be used 
to issue an action associated with the job.
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system queue The queue at the top of the queue hierarchy. The 
number of jobs running on Scheduler at any given 
time can be limited to the queue limit value 
assigned to this queue. The system queue has the 
lowest queue priority, and is used as the default 
queue for jobs that cannot be accepted into other 
queues according to their queue filters.

system queue limit The system queue value that determines the 
overall number of jobs Scheduler can run at any 
given time. This value must be less than the sum 
of all the agent’s Job Limit values and the sum of 
all the individual queue limit values for this 
control to work effectively, since the job 
scheduling capacity is limited to the system queue 
value, the sum of the Job Limit values, or the sum 
of all of the individual queue limit values, 
whichever is smaller.

T
time dependency A condition where time controls whether a job is 

ready to run not. A time dependency is determined 
by a job's calendar and time window.

time window A job property that specifies the period of time 
during the day (24 hour period) when the job can 
run. The Time Window setting is optional. The 
default is 24 hours.

Timed Out for Day status The job's dependencies were not met by the end of 
its time window today. The job will be a candidate 
to run tomorrow during its time window if its 
dependencies are satisfied.

timed out status The job's job or file dependency was not met by 
the end of its time window. The job will not run.

tracking method The part of a job’s definition that instructs 
Scheduler how to determine whether a job 
completed successfully or not.

U
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unscheduled job A job that is not scheduled to run on a regular 
basis, and is added to the production schedule on 
an “as needed” basis. You can add unscheduled 
jobs to the production schedule any time while 
production is running. Unscheduled jobs include 
all job definition properties, except a calendar.

user A registered user of Scheduler. Users can have 
ownership (along with workgroups) of jobs, job 
events, actions, variables, and calendars. Each 
user has access to a limited set of Scheduler 
features as defined by the user’s security policy.

V
variable A data item that can be added to action message 

text, or as a command parameter. The variable’s 
value is based on the type of variable used. 
Variable types include system variables, job 
variables, job event variables, action variables, 
and user-defined private and public variables.

variable dependency A dependency that prevents a job from running 
until a specified user-defined variable has a 
specified value. Variables can be updated 
manually, or by other jobs through a variable 
update action.

variable update action A variable update action is a type of action that 
changes a user-defined variable when a job event 
occurs. The variable's value can be used as the 
criteria to meet a variable dependency.

W
Waiting on Dependencies status The job occurrence has been scheduled and is 

waiting on dependencies to be satisfied before it 
will run.

Waiting on Group status The status a job occurrence enters when it is 
waiting on its parent job group's dependencies.

Waiting on Operator status All the job occurrence’s dependencies have been 
met, and it is waiting for a user to release it.

Waiting on Resource status All the job occurrence’s dependencies have been 
met, and it is in a queue waiting to be launched.
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Waiting status The status of a defined resource needed by a job 
displayed on the Resources tab of a job's Job 
Details dialog. This status indicates a job is 
waiting to use the resource. Anytime that the 
amount needed of the resource exceeds the 
amount available of the resource it will show a 
Waiting status. If a resource is not in a Waiting 
status, it is in either an Locked status or an 
Available status. 

workload balancing The ability of Scheduler to distribute jobs among 
a group of agents in an agent list, thereby reducing 
the load on any single agent. There are three types 
of workload balancing: 1) Lightest Load, 2) 
Random, and 3) Rotation. Lightest load 
distributes a job on the machine in the list with the 
lightest load. Random distributes a job on a 
machine in the list randomly. Rotation distributes 
a job on the next machine in sequence on the list.

workgroup A collection of users who can share jobs, job 
events, system events, actions, variables, and 
calendars. Any user can create a workgroup and 
invite other users into it. In order to belong to a 
workgroup, you must be invited in by its owner, 
the originator of the workgroup.

X
XML file The Extensible Markup Language (XML) is a 

W3C-recommended general-purpose markup 
language that supports a wide variety of 
applications.

Y
Year option Select this option to include the year in your 

custom date format. 

Z
Zoom In/Zoom Out This is a toggle option controlling the view 

perspective of the job flow
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